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Introduction

Console is aweb-based application which allows users to centrally manage, monitor and control Aspera servers
(nodes) and transfers. Console offers the following features:

Feature Description

Transfer monitoring and View transfers, pause/ resume/ cancel, change transfer rates.

control

Transfer Initiation Initiate and schedule transfer jobs remotely.

Node Configuration An administrator can configure all nodes directly from Console such for options such
as bandwidth, priority, and encryption.

Email Notification Notify users of transfer events with customizable messages.

Reporting Create detail and summary reports of transfer activity.

Role-based access control | Manage what transfers are visible and controllable to Console users with security
groups.

Console Nodes
Aspera servers can be added to Consol e as managed nodes or unmanaged nodes.

Managed nodes can be configured and their transfer activity managed from the Console Ul through an SSH
connection. The transfer activity of managed nodes is logged to the Consol e database. For nodes that run an Aspera
server application version 3.4.6 or newer ("regular" nodes), Console makes REST callsto the Node API to pull
transfer details into console as well asto start and control transfers. For nodes than run older versions of Aspera
server applications ("legacy" nodes), Console processes data that gets pushed to the database by the hode. Console
also communicates with legacy nodes via SOAP calls to start and control transfers and to check for cases where nodes
failed to log the end of atransfer.

Unmanged nodes are not under control of Console. These can be used as transfer destinations, but only transfer
activity with managed nodes is reported to Console.

The following figure shows the relationship between Console, two managed nodes (Node 1 and Node 2) and an
unmanaged node. All transfer activity on the managed nodes, such as Transfer 1, can be monitored and controlled. In
contrast, Console is only aware of transfers that are between the unmanaged node and a managed node (for example,
Transfer 2 between Node 1 and the unmanaged node).

X

\ ¥
sole

C'G-' o
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Console Endpoints

An endpoint isan individual user account on a node (managed or unmanaged) that can perform Asperatransfers
without requiring the user to enter credentials in the Console Ul. Y ou can have one or multiple endpoints on a node
depending on your business needs. The following figure shows a simple endpoint arrangement. Node 1 has two
endpoints, Endpoint A (aspl@nodel) and Endpoint B (asp2@nodel), and Node 2 and Node 3 have one endpoint
each (Endpoint C and Endpoint D, respectively). A Console user can run transfers between endpoints from the
Consoel Ul. For example, Transfer 1 between Endpoint A and Endpoint D, and Transfer 2 between Endpoint B
and Endpoint C. Both transfers originate from Node 1, but from different Endpoints and have different destination
Endpoints.

T
(111}

J J

Mode2 Mode3
E {= "Endpoint D
jana@node? johnEnode3

Transfer 2 J ‘
Transfer 1

Installing Console

Firewall Requirements

Firewall (on the Console Machine)
Open the following ports on the Console machine:

« For the Web Ul, alow inbound connections for HTTP or HTTPS Web access (for example, TCP/80, TCP/443).

« Allow outbound connections for SSH (to be used for node administration) on a non-default, configurable TCP
port (for example, TCP/33001).

e Allow an outbound connection for TCP/9092 to allow Console to connect with nodes through the Node API

» Allow an outbound connection for TCP/40001 and an inbound connection for TCP/4406 to alow Console to
connect with legacy nodes.

Firewall (on the Node Machines)

« Toensurethat your server is secure, Aspera strongly recommends allowing inbound connections for SSH on
TCP/33001 (or on another non-default, configurable TCP port), and disallowing inbound connections on TCP/22.
If you have alegacy customer base using TCP/22, you can alow inbound connections on both ports. For details
on securing your individual Asperatransfer server product, review the corresponding user manuals.

e Allow inbound connections for FASP transfers, which use UDP/33001 by default, although the server may aso
choose to run FASP transfers on another port.

» For current nodes and legacy nodes that have been converted to current nodes, allow an inbound connection on
TCP 9092.

» For legacy nodes (unconverted), allow an inbound connection for Aspera Central (for example, TCP/40001).

» For legacy nodes (unconverted), allow an outbound connection for logging to Console on TCP/4406.

Note: No serversare listening on UDP ports.

When an Aspera client initiates atransfer, the client opens an SSH session to the SSH server on the designated TCP
port and negotiates the UDP port over which the data transfer will occur.



| Installing Console | 9

Data Storage Recommendation

Console generates data for every transfer session. Plan the size-growth of your databae depending on the number of
transfer sessions each day.

In terms of planning for the size growth of the database, the per-file records generate 1-2KB per file transfer, and the
session records generate 8-12KB per session. For some size estimates, here are afew examples:

» 100 sessions per day of 1000 files each, all external transfers between managed and unmanaged nodes = approx
201 MB per day db growth, 6.03 GB per month, 73.4 GB per year.

» 1000 sessions per day of 1 file each, all internal between managed nodes = approx 28 MB per day, 840 MB per
month, 10 GB per year.

» 1000 sessions per day, 10,000 files each, 50% internal between managed nodes, 50% external with unmanaged
node = approx 30 GB per day, 900 GB per month, 11 TB per year.

Installing Console

. Warning: Dueto incompatible common components, IBM Aspera Console and IBM Aspera Faspex cannot

¢ _1 be installed on the same machine. IBM Aspera does not support this combination.

Perform the following steps as an Administrator .

1. Download Console installation components. Use the credentials provided by Asperato download the installer.

2. If you want to specify the system user and group to use for each component, you must set environment variables
before running the installation component. If you do not specify custom users, Console creates default users.

Y ou can configure common components with the following environment variables:

Environment Variable Default YAML Config File

ashtt pd [ opt / asper a/ conmon/ apache/

ASPERA_APACHE_USER
- — system user.ym

ASPERA_APACHE_GROUP

[ opt / asper a/ conmon/ nysql /

ASPERA_MYSQL_USER mysql
system user.ym

ASPERA MYSQL_GROUP

If the system users and groups do not exist, Console creates them and then associates them to the corresponding
components. If the users and groups already exist, Console associates them to the corresponding components.

Note: There are some specific requirements when using existing users and groups:

« |f you are associating an existing system for MySQL, the user must have shell access. If the user does not have
shell access, theinstallation will fail.

» |f Console creates a new system user for apache, it creates the user without shell access. Console does not
change the shell access if associating a pre-existing user.

« |If you want to specify an LDAP user for acommon component, first create a system group with the same
name as the LDAP user, and then assign that user to the group. Y ou can use the following commands to
perform these tasks:

# sudo groupadd | dap_user _nane
# sudo usernod -a -G | dap_user nane | dap_user _name

Console stores the configurationsinayani config file (see table above for locations) after running the following
asct | setup commands:

# export ASPERA APACHE USER=new _apache_user
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# export ASPERA APACHE CGROUP=new apache_group
# export ASPERA MYSQ. USER=new nysql _user
# export ASPERA MYSQ._GROUP=new_nysql _group

3. Run the downloaded installation components.

Run these commands with proper administrative permissions. Replace file names accordingly:

# rpm - Uvh aspera-common-version. rpm
# rpm -Uvh aspera-consol e-version.rpm

4, 1If you want to specify the system user associated with Console, you must set the ASPERA CONSOLE_USER
environment variable before running the installation component. If you do not specify a custom user, Console
creates the default user, consol e_user.

To set the environment variable for the custom user, run the following command:
# export ASPERA CONSOLE USER=new consol e_user

Note: When creating a new system user for Console, Console creates the user without shell access. Console does
not change the shell accessif associating an existing user.

The system user configuration is stored inayani config file for later use after running theasct | setup
command. Y ou can find the config file at:
[ opt/ asper al/ consol e/ system user.yn

5. Runtheasct| setup command.

# asctl consol e: setup

6. Perform astreamlined setup or adetailed setup. Press Enter to select astreamlined setup unless you need to
configure non-standard ports or to configure components running on other servers. Follow the instructions to
complete the setup.

7. When prompted, enter the |P addresses and host names (separated by commas) that are allowed to access Console.

Y ou can only access the Console web application from an accepted | P address or host name. If you do not include
the current 1P address, you cannot log into Console.

Note: After installation, you can edit the list of accepted | P addresses and host names by modifying

Accept edHost s intheconsol e. rb. ym (/ opt/ asper a/ consol e/ confi g/ consol e. ym)

configuration file. For more information, see Allowing Access to Console at Defined Hostnames on page 13.
8. Update the Asperalicense from the command line.

Console administrators can update the license in the Console web Ul, see Logging Into Console for the First Time
on page 11. However, if you are automating Console installation, you can use a rake command to set the
license without logging into the web Ul.

a. Set the license text as an environment variable.

# export LI CENSE TEXT=' <ASPERA LI CENSE> <DETAI LS expiration_date=... </
KEY> </ ASPERA_LI CENSE>'

In this example, only part of the license text is shown. Y ou must paste the entire license text for the license to
bevalid.
b. Update the Asperalicense:

# asctl consol e:rake aspera:update_|icense
To access the Console interface, go to the following address with abrowser: ht t p: //

server _i p_or_nane: port/asperal/ consol e. For instructions on logging in for the first time, see Logging
Into Console for the First Time on page 11.
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Logging Into Console for the First Time

1. Accessthe Console interface by entering its hostname or 1P address followed by /asper a/console in your web
browser. For example, enter ht t ps: // | P_addr ess/ asper a/ consol e.

Console requires avalid license key before a user can access and interact with the Console interface. An
administrator must log in to paste avalid license or upload a valid license file before other users can log into
Console. No other user interaction is permitted until avalid licenseisinstalled.

2. Enter the username and password and click L ogin. At this point, Console prompts you to change your password.
Verify the old password. Then, enter and confirm a new password. Click Change Password to save your new
password and login.

Note: Passwords must be at least six characters long, with at |east one letter, one number, and one symbol.

3. Console directs you to the Console configuration page to update your Console license with the license Aspera
provided to you. Click Upload a license file to upload a license file or paste the license text into the text window.

Upgrading Console to the Current Version

Important: 1BM Aspera supports direct upgrades to the current General Availability (GA) version from only two
GA versions prior to the current release. To upgrade to the latest version, you must be within two GA versions of the
current version. Upgrading from older version requires upgrading in steps. For example, if you are four GA versions
behind, upgrade to two GA versions behind (GA - 2), and then upgrade to the current GA version.

' Warning:
=1 Prior to performing any upgrade, IBM Aspera strongly recommends customers:

1. Perform afull environment back up and ensure the back up is successful. In case the upgrade fails, the
only reliable, short-term fix isto roll back the environment using the back up.
2. Test the upgrade in atest environment comparable to the production environment.

3. If upgrading the test environment is successful, upgrade the production environment, but do not bring the
production environment back online.

4. Prior to bringing the production environment back online, the customer must test the application to
determine if an immediate rollback is needed. Otherwise, customersrisk losing all data generated between
upgrade and rollback.

Note: Asof Console 3.0.3 and later, Console stores license information in the database, rather than in afile located
at/ opt/ asperal/ consol e/ confi g/ . If alicenseis added to the directory before the upgrade script is run, the
script migrates the license information from the file into the database and del etes the file. To modify your license, see
Updating your Console License on page 101.

1. Back up Console's database using the following asct | command in a Terminal:

$ asctl -v consol e: backup_dat abase

2. Stop Console and all related services.
Run the following asct | command:

$ asctl all:stop
3. Back up my. cnf if you have customized it.
Upgrading the Aspera Common Components overwrites the existing ny. cnf with default values.
Create a backup of the existing file, which can be found in the following location:
/opt/asperalcommon/mysgl/my.cnf
Save the backup outside the asper a directory.
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4. Download Console installation components. Use the credentials provided by Asperato download the installer.
5. Install components.

Run the following commandsto install the downloaded files:

$ rpm -Uvh aspera-common-version.rpm
$ rpm - UWh aspera-consol e-versi on.rpm

6. Runthefollowingasct| command to upgrade Console:

$ asctl consol e: upgr ade

7. When prompted, enter alist of hosthames at which users can access the Console Ul or API. If you have SAML
configured, include the SAML server hostname to allow redirection.

For example, to allow access to Console at:

e |l ocal host

* consol e. exanpl e. com

e 10.0. 1. 128 (the server hostname)

e shi b-idp. exanpl e. com(SAML server hostname)

Accept edHost s: | ocal host, consol e. exanpl e. com 10. 0. 1. 128, shi b-
i dp. exanpl e. com

In this configuration, clients can access Console at those three addresses, but cannot access Console from any
other address.

Important: You must whitelist the hostname of your SAML redirect URL to allow SAML users to authenticate
through SAML and access Console.

8. Restoreany ny. cnf customizations.
Copy the custom configurations from your backup to: / opt / asper a/ comon/ ny. cnf .

9. Asperahighly recommends upgrading all nodes to the latest version of IBM Aspera High-Speed Transfer Server.
For more information, see Converting L egacy Nodes on page 31.

Uninstalling Console

1. Prior to removal, stop the Console application and its services in a Command Prompt window using the asct |
command.

# asctl all:stop

2. Run the following commands:

$ rpm -e aspera-consol e
$ rpm -e aspera-conmon

3. Removethe/ opt/ asper a/ common and/ opt / asper a/ consol e directories.
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Allowing Access to Console at Defined Hosthnames

Define alist of hosthames at which users can access the Console Ul or API. To allow clients to access Console at
an alternate hostname, whitelist the alternate hostname by adding it to Accept edHost s inthe/ opt / asper a/
consol e/ confi g/ consol e. ynml file.

Thelist of hostnames does not refer to the client's hostname or |P address, but to the server's host name.
Accept edHost s does not restrict which hostnames can access Console, but does restrict the address at which
clients can access Console.

For example, to allow access to Console at:

e |l ocal host

* consol e. exanpl e. com

e 10.0. 1. 128 (the server hostname)

e shi b-idp. exanpl e. com(SAML server hostname)

Accept edHost s: | ocal host, consol e. exanpl e. com 10. 0. 1. 128, shi b-i dp. exanpl e. com

In this configuration, clients can access Console at those three addresses, but cannot access Console from any other
address.

Important: You must whitelist the hostname of your SAML redirect URL to allow SAML users to authenticate
through SAML and access Console.

Configuring Email Notifications

Email Server Configuration

IBM Aspera Console needs to connect to a Simple Mail Transfer Protocol (SMTP) server to send email notifications.
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Email Server

= Configure Email Server

server smtp.example.com
E) o 25
Domain example.com

E Use TLS if available

E Authentication type = Open authentication Login required
"Erom" address aspera_admin@example.com
"Erom" name Aspera Console Admin

Save setiings

Go to Notifications > Email Server.

Enter the SMTP server information [A, B, C].

Optional: Enable Transport Layer Security (TLS) [D] if available.
Choose the authentication type [E] of your email server.

If your SMTP server requires login credentials, select L ogin required under Authentication type and enter your
login credentials. Otherwise, select Open authentication.

5. Inthe'From' address[F] and 'From' name [G] fields, enter the default sender email address and sender name
that appear in email notifications when they receive an email notification.

Note:

v DN

Expect the email address set in the 'From' addressfield to receive every email notification sent by Console.
Console sends email notifications to that email address and only CC's (or BCC's) recipients to optimize the email
sending process.

6. Enter your email address and select Save settings and send test email.

Check your email inbox for the confirmation email titled Email settings test. If you do not receive the email,
review your settings or check your spam folder.

Configuring Notification Time Zones and Cutoff Times

1. Goto Notifications> Email Notification Options.
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Email Motification Options

= Configure Email Notification Options

Default time zone (GMT+00:00) UTC v
Skip non-error emails older than 1 hour(s)
Skip error emails older than 24 heur(s)

Save Options

2. Select adefault time zone for email timestamps.
3. Enter a cut-off time for delivering older emails.

Configuring Advanced Rulesets for Email Notifications

Configure advanced rulesets for automated generation of additional email notifications beyond the simple
announcement of transfer events. Console checks configured rulesets whenever atransfer starts, completes
successfully, or errors out for the final time (the transfer runs out of retries or Console detects atransfer that was
supposed to retry but never did). If the transfer matches the ruleset, Console sends an email notification to the
designated recipients.

1

2
3.
4

Go to Notifications > Advanced Rulesets and click Create New Ruleset.

. Enter a description of the ruleset.
Optional: Disable the ruleset to control when the ruleset comes into effect.
. Select afilter.
Filter Description
Address Filter by the |P address of a node machine.
Cookie Filter by information in atransfer cookie. For more information on
transfer cookies, see Creating a Cookie Parsing Rule on page 62.
Contact Filter by the contact assigned by Console. A contact can be a Console user

name, a Faspex user name, a SSH account, or a customized value obtained
from atransfer cookie. For example, a contact can be "admin console”,
"aspera ssh", or "asperafaspex" and so on.

Failover Group Name

Filter by the failover group name of the node. For more information about
failover groups, see Configure Failover Groups on page 61.

Faspex Metadata Filter by metadata found in a Faspex file package.
File Path Filter by the file path of the transfer.
SSH User Filter by the username of the SSH user that started the transfer.
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Filter Description
Note: Thisworks only for Console-triggered transfers with endpoints
matching the SSH User.

Tags Filter by the JSON hash used to tag the transfer. For more information on

transfer tags, see Working with Tags on page 108.

5. Select the side to apply thefilter.

Side Description

Either Apply thefilter to both sides.

Source Apply thefilter to the source node.

Destination Apply thefilter to the destination node.

Client Apply thefilter to the node initiating the transfer
request.

Server Apply thefilter to the node receiving the transfer

request.

6. Select the comparator and enter the value.

Note: Select NOT to exclude entries matching the value.

For example, set the following parameters to send an email notification every time a node with the defined IP

address participates in atransfer.

MATCH

SIDE

NOT

COMPARISON VALUE

Address

Either

= 10.0.0.1

7. Designate email recipients.
Enter an email address and click Add. Select an email template for each transfer event.

8. Click Create.

The newly created template appears on the Advanced Rulesets page where you can disable or enable, edit, copy, and

deleterules.

View Email Notification Statistics

Y ou can monitor notification activity in the Session Notifications report for each transfer. To view the report,
go to atransfer's Sessions Details page. Click The Statistics column contains either alink describing the type of
notifications configured for that session or None if no notifications were configured. Click the link to display the

Session Notifications page.
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Statistics
Started: 2015-10-13 13:05:21
Stopped: 2015-10-13 13:05:21
Elapsed: Os
Bytes written: 0 Bytes
Bytes transferred: 0 Bytes
Average rate: 0 bps
Network delay: 0ms
Motifications: start. success & err

The Session Notifications page provides the following information about the transfer:

» Session Details: This section gives basic information about the transfer, such asits name, status, and start and
stop times

» Configured Naotifications: This section shows which types of notification were configured for this transfer (start,
success, or error) and the name of the template configured for each.

« Email Messages Sent (or Attempted) This section shows which types of notification were actually sent or
attempted for this transfer (start, success, or error) and the name of the template used for each. Y ou can see more
detail about a message by clicking on it to launch the Email Message Details page, which provides more detail
about a message, including its content. Y ou can also resend messages listed in this section by clicking resend.
This may be useful in cases where recipients are not receiving messages due to email server or configuration
issues.

Configuring Personal Email Notifications

Individual users can manage personal email notifications from their Preferences menu.

1. Open the Preferences page and select Email Notifications.

Search

2. Select email templates for notifications that are triggered by the following events: transfer start, transfer success,
or transfer error.

Y ou can create new templates or modify existing templates by going to Notifications > Email Templates. For
more information on how to create and modify email templates, see Editing Email Templates on page 19.

3. Select or clear globa email notifications. By default, Console notifies you for transfers that you start when those
transfers start, succeed, or fail.

4. For each specific transfer path listed, select or clear notifications for transfer path. These notifications are disabled
by default.

5. Click Update.
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Configuring Email Notification Templates

Creating a New Email Notification Template

Console alows you to create and modify email notification templates based on three transfer events: transfer start,
transfer success, and transfer error. Y ou can customize emails based on recipient needs by creating a new template.
For example, an error natification email to an internal admin typically contains as much information as possible,
while a notice to an outside party might contain a bare minimum of information. Y ou can edit the included default
templates, create and edit new templates, and change which templates are used as defaullts.

1. Goto Notifications> Email Templates.

2. Click on the appropriate "Create new..." link.

= Email Notifications for Transfer Start

@Cre:—:e new transfer start email template

NAME DEFAULT ACTIONS

Default Start o edit

= Email Notifications for Transfer Success

@'-.,I".l-\.'-f'.'.l new transfer success email template

NAME DEFAULT ACTIONS

Default Success o edit

= Email Notifications for Transfer Error

eilr-;:-.'.e new transfer error email template

NAME DEFAULT ACTIONS

Default Errar o edit

@ new_error_template_1

To create anew template, click Create new transfer start email template (A), Create new transfer success

email template (B), or Create new transfer error email template (C) depending on the situation for which you
want to send an email notification.

The new template (D) appears listed under the default template.

o
[4E]
=%]

]
[4E]
i
[4E]
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3. Rename the template.

Click Edit Plain Template to open the plain text editor. Enter a descriptive name of this template in the Template
name field. At this point, you can edit the template. For more information on editing templates, see Editing Email
Templates on page 19. Otherwise, click Save to rename the template and return to the template preview page.

Note: To ensure that information displays correctly in the email, edit both the plain text and HTML code versions
of the template.
4. Optional: Make this template the default template.

Return to the Email Templates page by clicking the Email Templates tab. Find your renamed email template and
click default.

= Email Notifications for Transfer Error

N TT I I —— T
L= 2 Ll =1 k=] = LA = o L =i -]

NAME DEFAULT ACTIONS
Default Errar o edit
Customer Transfer Errar edit Jdefault | delete

Editing Email Templates

Console alows you to create and modify email notification templates based on three transfer events: transfer start,
transfer success, and transfer error. Y ou can customize emails based on recipient needs by creating a new template.
For example, an error natification email to an internal admin typically contains as much information as possible,
while a notice to an outside party might contain a bare minimum of information. Y ou can edit the included default
templates, create and edit new templates, and change which templates are used as defaullts.

1. Goto Notifications> Email Templates.

2. Click edit for the email template you want to configure.

Note: To ensure that information displays correctly in the email, edit both the plain text and HTML code versions of
the templ ate.

3. Click Edit Plain Template.

Field

Description

Template name

Modify the name of the template displayed in Console.

From Name

Enter the name displayed as the email sender.

Reply-to Address

Enter the email address receiving replies from the email recipient.

Subject

Modify the email subject line.

Body

Modify, add, or remove the default text. The yellow box at the top of the
page lists special text strings you can use in the message body. Console
replaces the strings with the appropriate value in the actual email. The
available text strings differ depending on the type of template (transfer
start, transfer success, or transfer error)

For an example of how to edit the plain text version of the template, see Email Template Example: Creating a
Simple Notification for a Successful Transfer on page 130.




4. Click Save.
5. Click Edit HTML Template.
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Field

Description

Template name

Modify the name of the template displayed in Console.

From Name

Enter the name displayed as the email sender.

Reply-to Address

Enter the email address receiving replies from the email recipient.

Subject

Modify the email subject line.

Body

Modify, add, or remove the default text. The yellow box at the top of the
page lists specia text strings you can use in the message body. Console
replaces the strings with the appropriate value in the actual email. The
available text strings differ depending on the type of template (transfer
start, transfer success, or transfer error)

For an example of how to edit the HTML code of the template, see Email Template Example: Adding Company

Branding to Y our Template on page 131.
6. Click Save.
7. Optional: Test the email template. Enter an email addressin the field and click Send Test Email.
8. Optional: Make this template the default template.

Return to the Email Templates page by clicking the Email Templates tab. Find your renamed email template and

click default.

= Email Notifications for Transfer Error

Mraata naw Fran i
ol == 5 - L= [= alE

]
T
fie]
T
T

NAME DEFAULT ACTIONS
Default Errar o edit
Customer Transfer Errar edit Jdefault | delete

Y ou can take the following actions for the new template:

« Setthistemplate as your persona default from your Personal Preferences page.
e Sdlect thistemplate when creating atransfer.
e Select thistemplate for an Advanced Ruleset.

Displaying Email Notification Templates for an Email Address

See alist of email notifications enabled for agiven email address. The results show the email recipient's node
endpoints, smart transfers, and user preferences. The results also list the email templates selected as the default for

each transfer event (start, success, failure).

1. Goto Notifications> Email Templates
2. Inthe Search field, enter the email address (full or partial) and click Sear ch.

In the example below, the results display al pre-configured email notification templates related to the email address

"jdean".
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Email Template Search

Configured Email Notifications Matching 'aspera_user'

= Node Endpoints
EMAIL NODE HAME NODE TYPE ENDPOINT  ADDRESS START SUCCESS ERR

aspera_usen@asperaexample.com  1000.201.213 Managed rosoit 10.0.201.213 Default Start Default Success Defs

EMAIL SMART TRAMSFER NAME DESTIMATION START SUCCESS ERA
aspera_usen@asperacxample.com  Distribute Content to Customer A rooti@10.0.201.213  Default Start  Default Success  Def
aspera_usen@asperaexample.com  Distribute Content to Customer B root@10.0.201.184  Default Start  Default Success Def

®» User Preferences - "Send notifications for transfers | start”

EMAIL USER LOGIN - START SUCCESS ERRCR

a5 pera_usen@asperasyample.com aspera_user Default Start  Default Success Customer Transfer Error

= User Preferences - Transfer paths chosen

EMAIL USER LOGIN - SOURCE DESTIMATION START SUCCESS

aspera_usen@asperasxample.com A5QEra_USer 10.0.201.184 {10.0.201. 184 Ay Default Start Default Succes
aspera_usen@asperasxample.com aspera_user  Any 0.0.201.18 Default Start Default Succes
aspera_usen@asperasxample.com A5QEra_USer 10.0.201.213 {(10.0.201.213 Ay Default Start Default Succes
aspera_usen@asperasxample.com aspera_user  Any 10.0.201.213 Default Start Default Succes

Adding Nodes to Console

Adding Nodes to Console

In Console, anode is acomputer that has an Asperatransfer product installed and is enabled to make transfers. A
node can be a managed node or an unmanaged node.

* Managed Node: Console can initiate transfers with this node, monitor this node's activity, and configure settings
for this node.

* Unmanaged Node: Console cannot initiate transfers with this node or configure its settings. Console can only
monitor transfers between this node and managed nodes.

Y ou can aso add an Aspera Transfer Cluster to Console. A transfer cluster is a provisioned cluster of Aspera servers
in the cloud that autoscales with traffic and use. Console can monitor transfers running on managed clusters using
access key authentication for each node. Y ou can aso run reports on managed clusters. For more information, see
Adding Managed Clusters to Console on page 29.

Adding Managed Nodes

A node must be configured for use with Console. For instructions, see:
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e Setting Up aLinux Node on page 22
»  Setting Up a Windows Node on page 23
»  Setting Up an OS X Node on page 24

Once the node is configured for use with Console, add it as a managed node and configure it. This processes includes
the following steps:

1. Create a new managed node in Console; see Creating a Managed Node in Console on page 25.
2. Authorize access to the node; see Managing Nodes on page 30.
3. Set up permissions for the node; see Accounts and Permissions on page 35.

Adding Unmanaged Nodes
To add an unmanaged node to Console, you do not need to have access to the node or configure it. As described in
Adding Unmanaged Nodes on page 27, the processis a simpler version of adding a managed node:

1. Create a new unmanaged node in Console; see Adding Unmanaged Nodes on page 27.
2. Set up permissions for the node; see Accounts and Permissions on page 35.

Setting Up a Linux Node

A node is any server running IBM Aspera High-Speed Transfer Server. Asperaweb applications, such as IBM Aspera
Console, communicate with a node through the IBM Aspera Node API.

Console uses SSH to authenticate to the node to remotely configure nodes and uses the Node API to start and monitor
transfers between nodes. Different nodes may use different Node APl username and password pairs.

The instructions below assume you have already installed HSTS on your server. For instructions on installing IBM
Aspera High-Speed Transfer Server Admin Guide: Installing HSTS.

1. Asperarecommends setting up the node asther oot user. If you do not have accessto ther oot user, you
must give the current system user permissions to make changesto the/ opt / asper a/ et ¢/ asper a. conf
configuration file.

Change ownership of theasper a. conf fileto the current system user:

# chown system user:root /opt/asperaletc/aspera.conf

2. Create asystem user account on the node.
Run the following command:

# useradd usernane
For example:
# useradd xfer _user

The examplesin thistopic use xf er _user asan example username.

Theasconfi gur at or utility modifiestheasper a. conf configuration file, located at: / opt / asper a/ et c/
asper a. conf.

3. Set the IP address or hostname for the node inthe asper a. conf filewith the following asconf i gur at or
command:

# asconfigurator -x "set_server_data; server_nane,ip_or_host nane"
For example:

# asconfigurator -x "set_server_data; server_nane, asper a. exanpl e. conf
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4. Configure aHSTS transfer user account with a Node APl username and password.

Console communicates to the HSTS transfer user account through the Node API to start and monitor transfers on
the node.

For instructions on adding usersto HSTS, see the IBM Aspera High-Speed Transfer Server Admin Guide: Setting
Up Users.

a) Set up the Node API user:

# [ opt/asperal bi n/asnodeadnin -a -u node_api _usernane -
p node_api passwd -x system usernanme --acl-set inpersonation, adnmin

Note: Asperarecommends that you use different names for the system user account and transfer user account
in order to minimize confusion when tracing transactions and events.

For example:

# [ opt/ asperal bi n/asnodeadmi n -a -u node_user -p XF324cd28 -
x xfer_user --acl-set inpersonation,adnin

b) Run the following command to check the system user was successfully added to asnodeadmi n:
# [ opt/ asperal/ bi n/ asnodeadmi n -1

Given anode user named node_user and a system user named xfer_user, the result should be similar to the
following example:

user systentransfer user acl s

node_user xfer _user [ 1 npersonati on, adm n]

Y ou can now add this node to Console.

Setting Up a Windows Node

A node is any server running IBM Aspera High-Speed Transfer Server. Asperaweb applications, such as IBM Aspera
Console, communicate with a node through the IBM Aspera Node API.

Console uses SSH to authenticate to the node to remotely configure nodes and uses the Node API to start and monitor
transfers between nodes. Different nodes may use different Node APl username and password pairs.

The instructions below assume you have already installed HSTS on your server. For instructions on installing IBM
Aspera High-Speed Transfer Server Admin Guide: Installing HSTS.

1. Set up asystem account on the node to run Aspera services.

When you install IBM Aspera High-Speed Transfer Server, the installer automatically creates a system account to
run Aspera services. Asperarecommends using this default account (svcAspera) to run Aspera services.

The examplesin thistopic use svcAsper a as the example transfer user.
If you do not wish to use svcAsper a asthe transfer user, create a new Windows system user account. Login as
that user for Windows to set up the user's home folder.

Theasconfi gur at or utility modifiestheasper a. conf configuration file, located at: C: \ Program Fi | es
(x86)\ Aspera\ Enterpri se Server\etc\aspera.conf.

2. Set the IP address or hostname for the node inthe asper a. conf filewith the following asconf i gur at or
command:

> asconfigurator -x "set_server_data; server_nane, i p_or_host nane"
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For example:

> asconfigurator -x "set_server_data; server_nane, asper a. exanpl e. conf

3. Configure aHSTS transfer user account with a Node API username and password.

Console communicates to the HSTS transfer user account through the Node API to start and monitor transfers on
the node.

For instructions on adding usersto HSTS, see the IBM Aspera High-Speed Transfer Server Admin Guide; Setting
Up Users.

a) Run thefollowing commands to set up the Node API user:

> asnodeadmi n -a -u node_api _usernane -p node_api _passwd -
X system usernane --acl-set inpersonation, admn

Note: Asperarecommends that you use different names for the system user account and transfer user account
in order to minimize confusion when tracing transactions and events.

For example:

> asnodeadnmi n -a -u node_user -p XF324cd28 -x svcAspera --acl-set
i mper sonati on, adni n

b) Run the following command to check that the system user was successfully added to asnodeadni n:
> asnodeadm n -|
Given anode user named node_user and asystem user named svcAsper a, the output should be:

user system transfer user acl s

node_user SvCcAsper a [i mper sonati on, admi n]

Y ou can now add this node to Console.

Setting Up an OS X Node

A nodeisany server running IBM Aspera High-Speed Transfer Server. Asperaweb applications, such as IBM Aspera
Console, communicate with a node through the IBM Aspera Node API.

Console uses SSH to authenticate to the node to remotely configure nodes and uses the Node API to start and monitor
transfers between nodes. Different nodes may use different Node APl username and password pairs.

The instructions below assume you have already installed HSTS on your server. For instructions on installing IBM
Aspera High-Speed Transfer Server Admin Guide: Installing HSTS.

1. Create a system admin account on the node.
a) Goto System Preferences# Users& Groups.
b) Click thelock button and enter your admin credentials to make changes.
¢) Click the add button.
d) Sedect Administrator from the New Account drop-down menu.
€) Name the account.
f) Enter and verify apassword for the account.
g) Click Create User.
h) Click Login Optionsin the users pandl.
i) Click the Join button next to Network Account Server.
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j) Click Open Directory Utility.

k) Inthe Directory Utility window, click the lock button and enter an administrator account and password to
make changes.

I) From the menu bar, select Edit # Enable Root User.
m) Enter and verify the password.
n) Click OK.

The following examples use xf er _user asan example username.

Theasconfi gur at or utility modifiestheasper a. conf configuration file, located at: / Li br ary/ Asper a/
et c/ aspera. conf.

2. Setthe |P address or hostname for the nodein theasper a. conf filewith the following asconf i gur at or
command:

# asconfigurator -x "set_server_data; server_name,ip_or_host nane"

For example:

# asconfigurator -x "set_server_data; server_name, asper a. exanpl e. cont

3. Configure aHSTS transfer user account with a Node API username and password.

Console communicates to the HST S transfer user account through the Node API to start and monitor transfers on
the node.

For instructions on adding usersto HSTS, see the IBM Aspera High-Speed Transfer Server Admin Guide: Setting
Up Users.

a) Run the following commands to set up the Node API user:

# / Li brary/ Asper al/ bi n/ asnodeadnm n -a -u node_api _usernane -
p node_api passwd -x system usernane --acl-set inpersonation, admn

Note: Asperarecommends that you use different names for the system user account and transfer user account
in order to minimize confusion when tracing transactions and events.

For example:

# [ Li brary/ Asper a/ bi n/ asnodeadnm n -a -u node_user -p XF324cd28 -
x xfer_user --acl-set inpersonation,adnn

b) Run the following command to check the system user was successfully added to asnodeadmi n:
# [ Li brary/ Asper a/ bi n/ asnodeadmi n -|

Given anode user named node_user and a system user named xfer _user, the result should be similar to the
following example:

user systenftransfer user acl s

node_user xf er _user [ 1 npersonati on, adm n]

Y ou can now add this node to Console.

Creating a Managed Node in Console

It is best practice to keep al your nodes up to date with the latest version of IBM Aspera High-Speed Transfer Server
or IBM Aspera High-Speed Transfer Endpoint.
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To verify your node machine's product version, run the following command on your node machine:
$ ascp -A

If you have an older version, you can download the latest from http://asperasoft.com/downl oads.

1. GotoNodesand click New Managed Node.
2. Enter your managed node's | P Address and Name.
Important: When adding the Console server itself as a managed node, don't enter 127.0.0.1 as the IP address

unlessit isthe only node you are planning to add to Console. Even then it is not recommended. Do thisonly if
your network or firewall configuration interferes with Console communicating with its own external address.

3. Configure the communication settings.

Update SSH Port, SSH Encryption, and Node API Port if you do not want to use the default values. Select
adefault endpoint type from the drop-down menu. Y ou can still change the endpoint type when you add an
endpoint to this node.

4. Add the node to afailover group.

Select Enablefailover and load balancing for Console-initiated transfers on this node. Add the node to an
existing group or select enter new name from the Failover Group Name drop-down menu to create a new group.
If you select enter new name, enter anew failover group name in the prompt. For more information on failover
groups, see Configure Failover Groups on page 61.

5. Optional: Create the three default Console groups. Select Create default Console groups.
The default transfer Console groups have the following permissions:
e Transfer Admin: Usersin this group can manage transfers on this node. This includes initiating, canceling,
and deleting transfers.
e Transfer Initiator: Usersin this group can only initiate transfers.
* Transfer Monitor: Usersin thisgroup can only monitor transfers.

For more information on Console groups, see Creating Console Groups on page 36
6. Click Create.

Console redirects you to the Credentials page. For more information on configuring admin credentials, see Updating a
Node's Admin Credentials on page 26.

Updating a Node's Admin Credentials

If you have not already configured an administrative account on your node machine for use with Console, see the
following instructions:

* Windows node: Setting Up a Windows Node on page 23.
e OS X node: Setting Up an OS X Node on page 24.
e Linux node: Setting Up aLinux Node on page 22.

Console connects to a managed node through SSH for file browsing and node configuration. Y ou must update
Console with the node's SSH credential s before Console can access the node.

If Console automatically redirected you to the Admin Credentials page as part of the process of adding a new
managed node, skip the first step.
1. Goto Nodes. Click the edit link for the managed node, and click the Credentialstab.
2. Select Edit Credentials.
3. If you want to configure the node from Console, enter the node machine's SSH login credentials.
Enter the administrative account username and password to allow Console to connect to the node machine. Y ou
can authenticate the account in one of two ways:

» Password authentication: Enter the account password.
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* Public key authentication: Select Use SSH Key and select your uploaded key. To use public key
authentication, you must have your SSH private key configured in Console. For instructions, on how to
configure SSH keysin Console, see SSH Keys on page 84.

Enter the node machine's Node API credentials.
Click Update.
Click Test Credentials to make sure Console has a working connection to the node.

If successful, the message " Successfully connected to node via SSH and Node API" appearsin green at the top of
the page.

A connection is established between Console and your managed node. To edit or remove anode, go to Nodes for a
list of managed nodes and click edit or delete for the designated node.

Adding Unmanaged Nodes

Itis best practice to keep all your nodes up to date with the latest version of IBM Aspera High-Speed Transfer Server
or IBM Aspera High-Speed Transfer Endpoint. Verify the machine's product version with the administrator of the
node.

1
2.
3.

Go to Nodes. Click List Unmanaged Nodes.

Click New Unmanaged Node.

Enter the node's Address (1P or domain name) and Name.

Note: Console does not send notifications when an unmanaged node is using afully qualified domain name

(FQDN) instead of an IP address if the transfer is started by IBM Aspera High-Speed Transfer Server. Console
still sends notifications for transfers started by Console.

Select the default endpoint type from the drop-down menu.

Y ou can till change the endpoint type when you add an endpoint to this node.

Configure SSH.

Enter the SSH Port number and select the SSH Encryption method from the drop-down menu.
Click Create when finished.

To verify that your new node has been created, select List Unmanaged Nodes and ook for your unmanaged node
in the table.

A connection should be established between Console and your unmanaged node. To edit or remove a node, go to
Nodes and click List Managed Nodes for alist of managed nodes. Click edit or delete for the designated node.

Connecting Aspera Shares to Console

If you want to initiated a Consol e transfer with an Aspera Shares application as an endpoint, follow the steps below:

1

4,

Add Shares as an unmanaged node to Console with default endpoint type as Shar es and Node API port as443.

Adding the Shares application as an unmanaged node makes it easier to save Shares credentials for usein
transfers. Aspera does not recommend adding Shares applications as managed nodes because they lack the
capabilities necessary for monitoring.

For more instructions on adding an unmanaged node, see Adding Unmanaged Nodes on page 27.
Create a Shares endpoint for the unmanaged node.

For instructions on adding an endpoint to the node, see Adding Endpoints on page 28.

Add nodes used by the Shares application as managed nodes in Console for transfer monitoring.
For instructions on adding a managed node, see Creating a Managed Node in Console on page 25.
Create asimple or smart transfer with the Shares endpoint.
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For instructions on creating simple or smart transfers, see Starting a Simple Transfer on page 50 and Creating
a Smart Transfer on page 52, respectively.

Important: You cannot initiate transfers between Shares endpoints and SSH endpoints, or between two Shares
endpoints. For more information about restrictions on endpoint combinations, see Console Transfer Special
Conditions on page 49.

Understanding Endpoints

An endpoint serves as atransfer source or destination for transfersinitiated in the Console Ul between nodes
(managed or unmanaged) and between nodes and clusters. It is defined by alogin credential and address. These
appear in the Transfer drop-down menus for Sour ce and Destination as login@address, such as xasp1@10.0.0.2 for
anode or ats-aws-us-east-1.aspera.io for a managed cluster.

Whenever anode or cluster is added to Console, Console automatically creates a"wildcard" endpoint with the format
* @address (for example, * @192.168.0.100. The wildcard endpoint is listed as just the | P address or domain name.
When a user selects the wildcard endpoint as a source or destination, they must enter credentials to authorize the
transfer. Wildcard endpoints enable you to monitor all transfers on a node per user account or access key.

Console admins can add more endpoints to nodes and clusters, and configure them with credentials. The credentials
reguired to set up and use an endpoint depend on the endpoint type:

e SSH: An Asperatransfer user's username and either a password or SSH key.
* Node API: An Asperanode username and password. (Only supported for managed nodes)
« AccessKey: An Aspera access key and secret. (Only supported for clusters)

When you create a new endpoint, you can enter the credentials or leave the password/secret field blank (you must
provide alogin - a username or access key). Sharing a credentialled endpoint with a user who does not have login
credentials allows that user to send or receive files without compromising the security of your nodes. When the
password for the endpoint is not set, the user must enter it when initiating a transfer. These credentials are then stored
in the user's Saved Endpoints under the Prefer ences tab.

Adding Endpoints

An endpoint serves as atransfer source or destination for transfersinitiated in the Console Ul between nodes
(managed or unmanaged) and between nodes and clusters. It is defined by alogin credential and address. These
appear in the Transfer drop-down menus for Sour ce and Destination as login@address, such as xaspl1@10.0.0.2 for
anode or ats-aws-us-east-1.aspera.io for amanaged cluster.

For more information about endpoints, see Understanding Endpoints on page 28.

Tip: To usedomain names as transfer endpoints, create an unmanaged node using a domain name, then add an
endpoint to this unmanaged node.

1. Open the Endpoint dialog for a node or cluster.

¢ Toadd an endpoint to a managed node or cluster, go to Nodes and click edit for the node or cluster to which
you want to add an endpoint.

» To add an endpoint to an unmanaged node, go to Nodes > L ist Unmanaged Nodes and click edit for the node
or cluster to which you want to add an endpoint. Click the Endpoints tab.
2. Add anew endpoint.

Click Add Endpoint and enter the following information:

* Endpoint type: Select the endpoint type from the drop-down menu.

* Login: The username or access key.

« Password: The password, SSH public key, or secret. If Ieft blank, users must enter the password, SSH public
key, or secret to authorize atransfer with the endpoint. The credentials required to set up and use an endpoint
depend on the endpoint type:
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e SSH: An Asperatransfer user's username and either a password or SSH key.
* Node API: An Asperanode username and password. (Only supported for managed nodes)

e AccessKey: An Aspera access key and secret. (Only supported for clusters) To use SSH keys, the user
must have their private key configured in Console. For instructions, see SSH Keys on page 84.

Important: When using SSH key authentication, make sure that the key file on the node is not a shared
key. On the node computer, the key file should be a"private" key in the specified user account.
« Label: Optional descriptive name for the endpoint. Default islogin@node_address
« Email address: The email address to receive notifications of transfer activity on this endpoint. Y ou can enter
multiple email addresses by clicking Add after each one, then select which notifications to send to which
email addresses from the drop-down menus.
Click Create.
3. Verify that your endpoint is configured correctly and that the connection works.

The new endpoint appears in the list of endpoints. To test the connection, click test and, on the following page,
Test Connecting to Host. If successful, a confirmation message appears in green at the top of the page. If
unsuccessful, a description of the error appearsin red at the top of the page and the SSH Client Log appears at the
bottom of the page.

The endpoint is now configured. If Password Saved is selected in the Endpoints table, the endpoint contains a
password, an SSH key, or a secret, depending on the endpoint type, and permitted users are not required to enter
credentials to use this endpoint. To edit or remove an endpoint, click edit or delete.

Set a Global Docroot for the Node

A document root, or docroot, isthe area of a machine that a system user has permission to access. Setting docroots are
important for maintaining security by keeping unqualified users from accessing confidential information.

1. GotoNodesand click edit for the node.

2. Goto Accountsand click edit for the user or group you want to configure.

3. Expand the Docroot configuration section and click Browse. Choose the file directory you want to set as the
docroot.

The docroot is a security feature that allows you to restrict the areaasper awat chf ol der d can access. If you
need to acces the entire file system, you can set the docroot path as/ or leave it empty. The directory you choose
isconfigured intheasper a. conf configuration file on the transfer node.

4. Click Save changes.

Adding Managed Clusters to Console

Adding a Managed Cluster to Console

A transfer cluster isa provisioned cluster of Aspera serversin the cloud that autoscales with traffic and use. Console
can monitor transfers running on managed clusters using access key authentication for each node. Y ou can also

run reports on managed clusters. For information on configuring the Aspera Transfer Cluster, see the IBM Aspera
Transfer Cluster Manager Admin Guide.

To add acluster to Console, follow the instructions below.

1. GotoNodesand click the New Managed Cluster button.
2. Enter the cluster's domain name address in the Domain Name field.
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3. Namethe cluster in Console.
4. Configurethe cluster API port. Port 443 is the default port for communicating with Aspera clusters.

5. If you want to use HTTPS to connect to node, select Use HTTPS to connect to nhode. Aspera recommends using
this feature for security reasons.

6. If youwant Consoleto verify the SSL certificate of cluster nodes, select Require signed SSL certifcate.
7. Click Create.

Console redirects you to the Credential s page to add access keys for authentication. For more information about
adding access keys, see Adding Access Keysto a Managed Cluster on page 30.

Adding Access Keys to a Managed Cluster

Aspera Transfer Clusters use access keys to authenticate to other Aspera products. Each transfer cluster can have
multiple access keys. For more information about access keys and access key management, see the entriesin the IBM
Aspera Transfer Cluster Manager Admin Guide: Managing a Cluster section.

Follow the instructions below to add access keys to a managed cluster.

1. GotoNodes. Click the edit link for the managed cluster and click the Credentials tab.
Click the Add Access K ey hutton.

Give the access key a name to differentiate it from other keys.

Enter the ID and Secret associated with the key.

Click Update.
Console redirects you to the list of Access Keysfor this cluster. Verify that your new access key isin thelist.

6. Test your new access key by selecting test.

a s~ w D

Managing Nodes

Editing the User or Group on a Node

Console can configure user and group account settings for managed nodes that have valid admin credentials saved

in Console. For more information on updating admin credentials, see Updating a Node's Admin Credentials on page

26.

1. GotoNodesand click edit for the node you want to edit. Click Accounts.

2. Make sure that the group or user you want to configure has already been created and is available on the node
machine. Console automatically detects new groups and users and lists them under the node's Accounts tab, but if
the group or user is not listed, click Add Group or Add User.

3. Depending on whether you want to configure a node user or a node group, select Usersor Groups.

4. Select the edit link for the user or group account you want to edit.

5. Configure the user or group account's transfer options. For more detailed information on these options, see Node
Account-Level Configuration Options on page 142.
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Open all Open overridden Close all

» Docroot

»  Authorization

» Bandwidth

¢ Advanced File Handling

» Advanced Network Options

6. When you are finished, click Save changes.

Set a Docroot for a Node User or Group

A document root, or docroot, isthe area of amachine that a system user has permission to access. Setting docroots

are important for maintaining security by keeping unqualified users from accessing confidential information. To set a

docroot for anode user or group, you must have already added them into Console. For more information about adding

node users or groups to Console, see Editing the User or Group on a Node on page 30.

1. Goto Nodesand click edit for the node.

2. Goto Accountsand click edit for the user or group you want to configure.

3. Expand the Docroot configuration section and click Browse. Choose the file directory you want to set asthe
docroot.

The docroot is a security feature that allows you to restrict the areaasper awat chf ol der d can access. If you
need to acces the entire file system, you can set the docroot path as/ or leave it empty. The directory you choose
isconfigured intheasper a. conf configuration file on the transfer node.

4. Click Save changes.

Converting Legacy Nodes

A node running an Asperatransfer product with aversion prior to 3.4.6 is considered alegacy node and continues to
report to Console using the legacy mechanism. To take full advantage of Consol€e's architecture, upgrade the Aspera
transfer products on legacy nodes to the latest version and convert legacy nodes to use the Node API in the Console

3.0+ Node Maintenance page.

Important: Once you convert from alegacy node to aregular node, you cannot revert back to alegacy node.

1. Onthe node machine, upgrade your Asperatransfer product to its latest version. To check the version of the
running transfer product, run the following command:

# ascp -A

2. Configure an administrative account and APl user on your node machine.



| Managing Nodes | 32

* Windows node: Setting Up a Windows Node on page 23.

e OS X node: Setting Up an OS X Node on page 24.

* Linux node: Setting Up aLinux Node on page 22.
3. From the Console menu, select Nodes. Select the edit link for a node that Console showsisa"Legacy Node".
4. Click Node API and enter your Node API credentials for the node machine.

For more information on updating a node's admin credentials, see Updating a Node's Admin Credentials on page
26.

5. Click Convert and then click Convert to use Node API. When prompted by the browser to confirm conversion,
click OK.

Note: If you do not see Convert to use Node API, make sure you have correctly configured your Node API
credentials on the machine and entered them into Console. Edit the node in Console, click Credentials, and click
Test Credentials.

6. Select Open all to expand all available configuration options. Clear any overridden values in the Database and
Transfer Server sections.

7. Select Save changes.
8. Restart the Aspera Central service on the node.

« Windows:

Use the Computer Management window. Go to M anage > Services and Applications >Services.
e Linux:

# service asperacentral restart

e« OSX:

$ sudo | aunchct!l stop com aspera. asperacentral
$ sudo | aunchct!l start com aspera. asperacentral

Console now displays your legacy node as a regular node in the node list.

Configuring Virtual Links

Configure Virtual Links (Vlink) on anodeto create a"virtual" bandwidth cap for the node. Transfer sessions assigned
to the same VIink take up equal shares of the capped bandiwdth.
1. Goto Nodes, find the desired node, and click edit. Click VIinks > New Vlink.

2. Enter anumber for the VIink I D and name the VIink. Sessions assigned with the same ID share the same
bandwidth cap.

3. Select Trueto activate the VIink.

4. Enter avalue for the capacity. When applying this Vlink to atransfer, the transfer's bandwidth will be restricted by
thisvalue.

5. Click Create.

After creating anew VIink, you have the option of configuring the VIink to run on a schedule by clicking Edit Time
Varying Schedule and then New Schedule. For more information on scheduling VIinks, see Scheduling Virtual
Links on page 32.

Scheduling Virtual Links

After creating anew virtual link, you have the option of configuring the VIink to run on a schedule.
1. Goto Nodes, find the desired node, and click edit. Click VIinks, find the desired VIink, and click edit.
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2. Click Edit Time Varying Schedule and click New Schedule.

Configure the following options.

Options Description

On the following Select the days or set of days for which the bandwidth rate cap is enforced.
days

From thefollowing [ Enter atime to start the bandwidth rate cap.

time

To the following Enter atime to stop the bandwidth rate cap.

time

Set the rateto Enter avalue for the scheduled virtual bandwidth cap. When applying thisVlink to a
transfer, the transfer's bandwidth will be restricted by this value based on the configured
schedule.

Note: Overlapping time schedules are not supported. If there are overlapping schedules, they are not accurately
reflected in the VIinks chart, and precedence is indeterminate.

3. Click Update.

Setting Up Cloud Storage from the Console

Enabling S3 Storage Using Console
IBM Aspera Console can use S3 storage for anode transfer user by specifying the storage in the user docroot. Use
this user to transfer files to and from your S3 storage. The steps below assume the following:

* You have purchased and booted up your Aspera On Demand product.

* You have created an S3 bucket.

* You have permissions to create IAM roles or change the policies of your IAM.

e You know how to SSH as root to your Aspera On Demand instance.

1. InConsole, select anode and edit its transfer user from the Accounts tab.

2. Expand Docroot, click Override, and paste the S3 docroot for that user using the following syntax:

S3://access_id: secret_key@3. anazonaws. com nmy_bucket / ny_pat h

+ Docroot
EFFECTIVE VALUE
L
Abechite Path SiNaccess idsecret_key@s3 amazona
Read Allowed ® frue " false
Write Allowed ® true ' false
Browse Allowed ® true " false

Use URL encoding for specia charactersin your S3 Access ID and secret key. For example, encode a slash
character (/) by replacing it with %2 F and encode a plus character ( +) by replacing it with %2B.

Click on the Save Changes button.

For more information about setting a user's docroot, see Editing the User or Group on a Node on page 30.
3. Restart the Aspera NodeD service on the node.
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SSH into the node and run the following command:

# ssh -i identity file -p 33001 ec2-user@c2_host _ip
# service asperanoded restart

Configure advanced S3 storage settings and test your configuration.
4. Optional: Enable advanced S3 storage settings.

« Enable Reduced Redundancy Storage (RRS): Append the following to the docroot:
?st or age- cl ass=REDUCED REDUNDANCY

For example, enter:

S3://access_id: secret_key@3. anmazonaws. conl ny_bucket / nmy_pat h?st or age-
¢l ass=REDUCED_REDUNDANCY

« Enable S3 Server Side Encryption (SSE). Append the following to the docroot:
?server-si de-encrypti on=AES256

For example, enter:

S3://access_id: secret _key@3. amazonaws. conl ny_bucket/ my_pat h?ser ver -
si de- encrypt i on=AES256

5. Test your configuration. Perform atest transfer using an Asperaclient to the account configured with the S3
docroot. For information on starting atransfer, see Starting a Simple Transfer on page 50.

Enabling SoftLayer Storage Using Console

IBM Aspera Console can use SoftLayer storage for anode transfer user. Use this user to transfer filesto and from
your SoftLayer storage.

. CAUTION: When transferring files larger than 64 MB to SoftLayer storage, an . asper a- segnent
{ '_1 directory is created at the destination. Do not move this directory or modify any filesin it. Doing so may
cause corruption or loss of data.

1. Goto Nodes and click the edit button for the node.
2. Goto Accountsand click edit for the account to configure with SoftLayer access.

Note: You can aso create a new account by clicking on the Add User button. For information on how to add a
new account, see Editing the User or Group on a Node on page 30.

3. Enter the SoftLayer docroot.
Expand Docr oot, click Override, and paste the SoftLayer docroot for that user using the following syntax:

swi ft://usernane: api key@hbject Storage URI/bucket nane?
aspera. swi ft.endpoi nt. aut h- pat h=02Faut h92Fv1. 0

+ Docroot
EFFECTIVE VALUE
Absolute Path v : —
swift: /VIBMOS303446-2% 3Ahhemant: 3¢ 1
Read Allowed ® true " false
Write Allowed ® true ' false

Browse Allowed * true false
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Use URL encoding for special characters. For example, encode the colon ( : ) by replacing it with %BA.
4. Click on the Save Changes button.
5. Restart asperanoded on the node.

SSH into the node and run the following command:

# service asperanoded restart

6. Test your configuration. Perform atest transfer using an Aspera client to the account configured with the
SoftLayer object storage docroot. For information on starting a transfer, see Starting a Simple Transfer on page
50.

Managing User Accounts

Accounts and Permissions

Definition of Terms

e User: A user isaConsole login account with customizable access permissions.
e Group: A group defines the transfer permissions of al its users.

« Transfer Path: A transfer path consists of two endpoints, the transfer direction (one-way or two-way), and a set of
permissions that authorize starting transfers, monitoring transfers, and enabling email notifications.

Overview

Console uses a combination of groups, transfer paths, and user accounts to manage to user permissions. A user that
belongs to a group inherits permissions defined within the groups it belongs to. A group's permissions are defined by
its transfer paths. If you have a non-admin user and you want them to be able to see certain transfers, you need to add
them to agroup. This group must have one or more transfer paths that specify the kinds of transfers that members of
the group are allowed to see or control.

Each group can contain one or more transfer paths. In the figure below, Group 1 contains two transfer paths, #1 and
#2. A Console user inherits transfer permissions from all of the groups he or she belongs to. For example, Console
User 2 belongs to both Group 1 and Group 2, and has the permissions to use Transfer Paths #1, #2, and #3.
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Group1 Group2

Transfer Path #1 Transfer Path #3
Transfer Path #2

I |

Console User 1 Console Usear 2 Consola User 3

Transfer Path #1 Transfer Path #3

Transfer Path &1
Transfer Path #2 Transfar Path #2
Transfer Path #3

Tip: Console administrators are able to view and control all transfers. They automatically inherit permissions of any
existing Console groups. They can add, edit, and delete any nodes, Console users, and Console groups.

Default Console Groups
When adding a new node, you have the option of creating three default groups associated with that node.

Group name Description

Transfer Administrators The users in this group can monitor, control, and set up email notifications
of all transfers on the node. They can start simple and smart transfers
between this node and any node, and share smart transfer templates with
other users.

Transfer Initiators The usersin this group can start simple and smart transfers between this
node and any node.

Transfer Monitors The usersin this group can monitor and set up email notifications of all
transfers on this node.

Creating Console Groups and Users
For instructions on creating a new Console group, see Creating Console Groups on page 36.

For instructions on creating a new Console user, see Creating Console Users on page 38.

Creating Console Groups

Console uses a combination of groups, transfer paths, and user accounts to manage to user permissions. A user that
belongs to a group inherits permissions defined within the groups it belongs to. A group's permissions are defined by
itstransfer paths. If you have a non-admin user and you want them to be able to see certain transfers, you need to add
them to agroup. This group must have one or more transfer paths that specify the kinds of transfers that members of
the group are allowed to see or control.

Tip: Console administrators are able to view and control all transfers. They automatically inherit permissions of any
existing Console groups. They can add, edit, and delete any nodes, Console users, and Console groups.
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Important: You must first manually add a group to the node OS before you can add it in Console.

1. Goto Accounts> Groupsand click New Group.
2. Enter the group name and a brief description. When finished, click Create.
Y ou are redirected to a page that allows you to configure the group.
3. Click Add Transfer Path.
A transfer path determines a user's permissions to create, initiate, and monitor transfers from one endpoint to

another. A transfer path consists of two endpoints, the transfer direction (one-way or two-way), and a set of
permissions that authorize starting transfers, monitoring transfers, and enabling email notifications.

4. Select the endpoints for the transfer path.
For aunidirectional transfer path, set Endpoint 1 as your source endpoint and Endpoint 2 as your destination
endpoint. Order does not matter for a bidirectional transfer path. If you specify a node user in an endpoint, users
in the group are limited to monitoring only transfers on the node machine that involve the specified node user. An
example of such atransfer isatransfer initiated using the specified node user's credentials. Selecting "Any" grants
users transfer path permissions to all nodes.

Important: When you select Any as an endpoint and permit users to start simple or smart transfers, users can
enter arbitrary addresses for file transfers.
5. Choose the direction of the transfer path.
A transfer path can be unidirectional or bidirectional.
< Unidirectional (to): Console users can create, initiate, and monitor transfersinitiated from Endpoint 1 to
Endpoint 2 (depending on the transfer path permissions) but not the other way around.

« Bidirectional (to/from): Console users can create, initiate, and monitor all transfers (depending on the transfer
path permissions) between Endpoint 1 or Endpoint 2.

6. Choose the permissions you want to give usersin the group.

Item Description
Start Simple Transfers Users can start a simple transfer.
Start Smart Transfers Users can start smart transfers.

Create Smart Transfers Users can to create a smart transfer template.

Share Smart Transfers Users can to share smart transfer templates with other users.

Control Transfers started | Users can control other users' transfers. For example, they can stop, pause, and set
by others the rate of atransfer, and so on.

View Transfers started by | Users can view other users transfers on the same transfer paths.

others

Opt-in to email Users can enable email notifications for this transfer path.

notifications

7. Optional: Enter adescription for this transfer path.

8. When finished, click Create.
The Editing Group Details screen displays the new transfer path in the Transfer Pathslist. To modify or remove
the transfer path, click edit or delete, respectively.

9. Add usersto the group.
Select a Console user from the members drop-down and click Add.
Tip: Alternatively, you can assign group members through user management. See Creating Console Userson

page 38.
10. Click Update.
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Creating Console Users

Console user is a Console login account with customizable access permissions. Except for administrator accounts,
Console user permissions are managed through group assignment. A Console user inherits permissions from its
groups.

Note: Console users are not directly related to the login account to a node.

1. GotoAccounts> Usersand click New User.
2. Enter alogin username, the user's first and last name and an email address. Set the user's time zone.

Important: All activity on the Console is dated according to the user's time zone.

3. Optional: Select Set password to create a password for the user account. If you do not set a password, Console
generates atemporary password for the account and emails the password to the user.

Tip: You can change password requirementsin the Console Password Options section. Go to Configuration >
Defaults For more information on password reguirements, see Configuring Console Defaults on page 104.

4. Optional: Disable user login by clearing Active (allow user to login).

If you wish to finish setting permissions for the user account before allowing the user to log in, disable the account
by clearing Active (allow user to login). To re-enable the account, return to these settings and select Active
(allow user tologin). User login is enabled by default.

5. Optional: Disable reporting features for the user by clearing Reports Allowed.
6. When finished, click Create.
The system sends an account creation notification email to the designated email with the account's username and

password. If you do not set a password, Console generates atemporary password for the account and include that
in the email.

Thefollowing step is only applicable when creating non-admin users. All admin users have full permissionsto all
groups and transfer paths. After creating a non-admin user, Console redirects you to the user permissions page.
7. Assign the user to Console groups.

Assign the user to groups with the desired transfer-path permissions. To assign the user to agroup, select a group

from the drop-down menu and click Add. Y ou can review the Console user's transfer permissionsin atablelisting
all transfer paths accessible by this user

Once the Console user account is created, users can log in to Console with the proper account credentials. To
deactivate this account or make other changesto it, go to Accounts > Users. Locate the account you want to change
inthelist of all Console users.

« To deactivate or reactivate the account, change it to a Console administrator, or modify any of the basic account
information, click edit.

* To modify transfer permissions and group membership, click permissions.
» Toremove a Console user from the system, click delete.

Monitoring Console

The Console Dashboard

The Dashboard provides a quick overview of all transfer activities and the statuses of nodes for which you have
monitoring permissions. It gives continuous updates and hel ps identify transfer and node problems.

Go to Dashboar d. The Dashboard contains the following six panels.
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Current Transfers

Current Transfers lists up to ten ongoing transfers on all monitored nodes. To view all active transfers, click the
Current Transfers header.

» Current Transfers

NAME CONTACT ETA STATUS

SLES to Fedora admin (console)  10:31am
100MB root (ssh) 10:31am
NAB Demo Transfers user01 (console)  10:38am [ 8% ]
Test Transfer admin (console) Queued

Scheduled Transfers

Scheduled Transfers lists up to ten scheduled transfers on all monitored nodes. To view all scheduled transfers, click
the Scheduled Transfers header.

» Scheduled Transfers
NAME CONTACT SCHEDULED START

From Mew York to London admin (console) 10:00am 7-Jul {r)

Weekly Transfer admin (console) 10:29am 12-Jun (r)

Recent Transfers

Recent Transfers lists up to ten recent transfers on al managed nodes. To view all recent transfers, click the Recent
Transfers header.

» Recent Transfers

NAME CONTACT ENDED TRANSFERRED
Test Transfer admin (console) 10:35am 329 MB

MAB Demo Transfers userdq (console) 10:34am a2 MB

SLES to Fedora admin (console) 10:32am 10.7 MB

100MB root (ssh) 10:30am 100 MB

Problem Transfers

Problem Transfers lists up to ten transfers with errors on al managed nodes. To view all transfers with errors, click
the Problem Transfers header.



= Problem Transfers

TRANSFER CONTACT
SLES to Fedora #3 admin (consaole)
testtransfer 3 admin (console)

From Mew York to London admin (consale)

Map

TIME
10:42am

10:42am

10:38am
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STATUS

ser aborted
session

Cancelled while
waiting in queue

ser aborted
session

The map shows the status of all your monitored nodes and shows the transfers between them. If anode fails, theicon
becomes red in the map, and the node and the problem are listed in the table bel ow the map.

Nodes are not automatically added to maps. They must be configured. For more information, see Configuring the

Map on page 44.

= Map
NODE PROBLEMS ADDRESS
fedora 10.0.203.250

NODE STATUS

S0AF Connection Prablem

Note: You can choose to hide or display the map and bandwidth chart by clicking the blue arrow ( ’ ) next to the

map.

Bandwidth

The Bandwidth chart shows bandwidth usage of your monitored nodes. If you select one or more nodes on the map,
the chart shows the cumulative bandwidth of the selected nodes.



= Bandwidth
INBOUND CUTBOUND
90.0 Mb/s ﬂ n = 90.0 Mb/s
(1N
80.0 Mb/s W 80.0 Mb/s
70.0 Mb/s ’ “ ' l 70.0 Mb/s
&0.0 Mb/s " I &60.0 Mb/s
!
50.0 Mb/s 50.0 Mb/s
40.0 Mb/s 40.0 Mb/s
30.0 Mb/s 30.0 Mb/s
20.0 Mb/s 20.0 Mb/s
10.0 Mb/s | 10.0 Mbys
0.0 Mb/s | — ———— 0.0 Mb/s
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Note: Y ou can choose to hide or display the map and bandwidth chart by clicking the blue arrow ( ’ ) next to the

map.

The Activity Overview

The Activity Overview page lists all transfers on all managed nodes. View the Activity Overview page by going to
Activity. You can narrow down the list with the filter and advance into atransfer's session detail page. The Activity
Overview screen displays the following information:

[tem Description

NAME The transfer's name.

DETAILS The transfer initiator, source, and destination.

START Thistransfer's start time.

END The estimated time of arrival, or the transfer completion time.

STATUS Current status of this transfer.

AVG RATE The transfer rate of the active transfer, or the average rate of a past transfer.

ACTIONS Show all available actions. For example, pause and cancel for arunning transfer or rerun
for apast transfer.
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Transfers Syne Jobs

History: | Past hour ¥ Scheduled: | None ¥ Status: | A ¥ Search: | Transfer Mame ¥ advances
= Current

NAME DETAILS START  END STATUS RATE ACTIONS
Long Transfer aspl {console), Mode 1 fo Mode 2 3:03pm  3:08pm (ETA 319 M8 B.T Mbps e n
Long Transfer admin {console), Node 1 fo Node 2 3:03pm  3:04pm (ETA 319 M8 B.7T Mbps e n
= Past

NAME DETAILS START  END STATUS AVG RATE ACTIONS
Small Transfer to Un  admin {console), Node 2 fo Nede 3 {Unmanaged J:03pm  3:03pm Error: failed to authenticate rernan

Small Transfer admin {console), Node 1 fo Mode 2 3:0ipm  3:01pm Completed BB Mbps  rerun

The Current pand lists al currently active transfers, including running and queued transfers. The Past panel shows
previous transfers, including those that were completed, canceled, or those that generated errors.

The filter options on the top can be used to narrow down the list.

Item Description

History Select the time frame to display the started transfers.
Scheduled Select the time frame to display the scheduled transfers.
Status Select a specific transfer statusto display.

Search Search for keywordsin transfer sessions.

Y ou can a'so perform an advanced search by clicking on the advanced link. For more information on searching, see
Search for a Transfer on page 46.

Transfer Details

Overview
Details about a particular transfer can be accessed by clicking on atransfer shown in listings of past, current, and
scheduled transfers. These lists can be found in three locations:

* TheActivity Overview page
* The Console Dashboard
« The Managed Node Detail page (the specific node from Nodes in the Console menu)

Ongoing Transfers
For an ongoing transfer, the Session Detail page provides the transfer monitor that displays current transfer status.
Y ou can control the transfer through the options shown at the top of the graph.

Important: The failed files counter may count "directories" if the network failed at some point or the user cancelled
the transfer.

Finished or Failed Transfers

For afinished or failed transfer, the Session Detail page provides detailed information about the transfer's state,
endpoints, and statistics.
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The Session Files panel lists al files being transferred in this session. Click on afile to review itsinformation. You
can use the search box to show only specific files or groups of files.

Note: When searching for files, "*" is not awildcard. Any string you enter istreated as a "search within". In other
words, the string "foo" will match "123foo", "foo456", and " 123foo456".

Console a'so lets you monitor notification information that includes messages about transfer starts, successes, errors,
and what notification templates were used under the Statistics column. Next to Notificationsis alink describing some
combination of start, success, and error depending on what notifications were configured for the transfer, or None

if no notifications were configured. Select the link to see the Session Notifications page. For more information, see
View Email Notification Statistics on page 16.

Multiple-Session Transfer

A multiple-session transfer is a smart transfer with more than one destination. In the Activity Overview page, clicking
on amultiple-session transfer reveals al sessionsin the transfer. To drill down to the particulars of each session, click
the Session Detail button to open its Session Detail page.

Monitoring File Validation

Console reports on the validation states of transferred files on nodes that are validated by IBM Aspera Validator.
Validator isinstalled separately and has its own documentation. Y ou can find the IBM Aspera Validator Admin Guide
on the IBM Aspera Faspex downloads page: https.//downl oads.asperasoft.com/en/downl oads/6.

Validation Status Monitoring

If configured to validate transferred files for anode, Validator updates the validation status on the node, which
Console then reports. The possible validation states are:

e to be validated
« validating
« conpl eted

Console displays the validation state for each file. Go to the Transfer Details on page 42 page to monitor the
validation status.

Optimizing Node Reporting

By default, managed nodes report the filenames of the first 1,000,000 files of atransfer to Console. However,
reporting this many filenames, especially if multiple managed nodes are reporting transfer sessions of several
thousands of files, can slow transfers.

Y ou can decrease the number of filenames that are reported by each endpoint by configuring all managed nodes. This
configuration affects all transfer reporting, including transfers initiated by Aspera Hotfolders and Aspera Sync. The
total number of files transferred, completed, failed, and skipped are till reported, but filenames are logged only for
the files up to the specified number.

Perform the following steps on every managed node:

1. Decrease the number of filesthat are reported.
Run the following command:

# asconfigurator -x "set _central server_data;fil es_per_session, 1000"

With this setting, only the first 1000 filenames are reported to Console and logged.
2. Restart asperacentral and asperanoded to activate your changes.


https://downloads.asperasoft.com/en/downloads/6
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Run the following command in a Terminal window to restart asperacentral:
# /etc/init.d/ asperacentral restart
Run the following commands to restart asperanoded:

# /etc/init.d/ asperanoded restart

Monitoring Nodes

Y ou can monitor the node status and manage the transfers on a node. Navigating to Nodes from the Console menu
will bring you to the list of managed nodes. To view alist of unmanaged nodes, click the List Unmanaged Nodes
button. To monitor a hode, click on the node.

Monitor Transfers on a Node
On the Node Detail page, the transfer chart shows all inbound and outbound transfers on this node. To control a
transfer session, select a session from the graph, and use the control options above the graph to control it.

mEou... Node 2 inbound total: 3,73 Mz D0 1E0dNE
10.0 M 10.0 M
Node 1 ‘ r
5.0 Mz Lpizading L= B.0 Mifz
Mode 2
Long Transl=r
5.0 Miy's Userizzpera 6.0 Mby's
Rate; 2,73 Mo's
4.0 Mby/'s 4 Mby'=
2.0 Miy's 2.0 M=
0.0 Mb/'= 0.0 Mby'=
Thetablelists al sessions on this node. Use Pause and Cancel to control an ongoing session.
Transfers Inbound Queus Outbound Queue
= Current
NAME DETAILS START END STATUS RATE ACTIONS
Long Transfer admin {console), Nede 1 fo Node 2 3:38pm  3:48pm {ETA} 975MB 48 Mbps pause zancel s
[~ e—

Configuring the Map

Y ou can configure Console to display the locations of your nodes on the dashboard map.

1. Goto Configuration > Map.
2. Select or upload a map image for use on the Console dashboard.

« Upload anew map image: Click Upload M ap File. Upload the file and then click select. For best results,
Aspera strongly recommends using an image with aratio of 16:9 (for example, 800 x 450).
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e Select existing map image: Choose one of two default map images or any previously uploaded image as the
dashboard map by clicking the select link.

Note: To delete amap image you have uploaded, click the delete link.

3. Configure node to show on map.

Edit your node and click the Map tab. Select Show on Map. Click and drag the green icon to its proper location

on the map.

The configured nodes appear on the map on the Dashboard. Ongoing transfers between nodes are represented by a

line between the nodes.

= Map

Access Logs

Once you have created accounts for Console users, you can monitor their activity from the Accounts > Access L og
tabs. The User Access Log displays user logins and logouts, concurrent logins and session timeouts.

Users  Groups  Directories

= User Access Log
ACTION

Login
Login
Login
Logout
Login

Login

Access Log

DESCRIPTION

User (2, admin 1) from 10.0.200.82
User (2, admin 1) from 10.0.200.82
User (2, admin 1) from 10.0.200.82
User (2, admin 1) from 10.0.200.82
User (3, user 1) from 10.0.200.82

User (2, admin 1) from 10.0.200.82

AT

322pm

1:53pm

1.4¥pm

1:47pm

1:23pm

12:54pm




Search for a Transfer
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Y ou can search for atransfer from any page in Console by using the search bar in the top right corner of the page. If
you want to refine your search, you can access the Advanced Search dialog by selecting the blue drop-down arrow

next to the search bar.

Console will search dl transfers within the last 24 hours for transfers that match the search criteria.

For more information about the advanced search form, see Advanced Search on page 116.

Monitoring Sync Jobs

Enabling Sync Client Node Reporting

The instructions below describe how to configure the IBM Aspera Sync client reporting to Console when the client is

amanaged node.

Note: If both client and server involved in a Sync job are Console managed nodes, then reporting can come from
either node, both nodes, or neither node using theasync_acti vi ty_| oggi ng settingin asper a. conf . For
example, to receive reporting from both the client and server, set async_acti vi ty_| oggi ng tot r ue on both.
The server isreported as the local host. For more information on server reporting, see Enabling Async Server Node

Reporting on page 47.
Transfer Reporting

The Sync client reports transfers associated with Sync jobs if <async_managenment _acti vi ty_| oggi ng>is
settot rue inasper a. conf , which isthe default configuration. The transfer name is listed as the Sync session

name. In the example below, the Sync session "ny-push-london" is reported under Transfers.

& aspera console

Dashboard Activity Nodes Accounts Transfer Reports Notifications

Activity Overview

Transfers  Sync Jobs

History: | Past hour v Scheduled: | None v Status: | All v Search: | Transfer Name ¥
= Current

NAME DETAILS START END
ny-push-london aspera (ssh), San Francisco to 10.0...  1:45pm

This setting can be modified by running the following command:

# asconfigurator -x

"set _client_data; async_managenent activity_ Il oggi ng, val ue”

RATE ACTIONS

9.5 Mbps pause cance

Setting the value to f al se disables reporting transfers associated with Sync jobs to Console. Y ou do not need to

restart the Aspera Node API service for the new setting to be activated.
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If you are syncing empty directories then no transfers are reported; the creation of the empty directories at the
destination is not reported as a transfer.

Sync Job Reporting

The Sync client reports Sync jobsto Consoleif <async_kvstore_activity_| oggi ng>issettotruein
asper a. conf . Thedefault valueisf al se, such that no Sync jobs are reported. To modify this setting, run the

following command:

# asconfigurator -x "set_client_data;async_kvstore_activity_| oggi ng, val ue"

Sync jobs are listed under Activity > Sync Jobs.

& aspera console

Dashboard Activity Nodes Accounts Transfer Reports Notifications Configuration

Activity Overview

Transfers Sync Jobs

= Sync Jobs
NAME LOCALNODE LOCALPATH DIRECTION REMOTE NODE REMOTE PATH STATUS TRANSFERRED S/P ACTIONS
ny-push-london  San Francisco  fvar/aspera/Project X push 10.0.111.200 [Project X running 2426 MB 3679 /4858
sf-push-ny New York fsync/Project X push 10.0.163.22 [Project X stopped 1GB 8537/0 e e ] data

Y ou can click on a Sync job to view more detail s about the session, including the endpoints, the status of individual
file transfers, and the transfer rate. For more information, see Monitor Sync Jobs on page 48.

Enabling Async Server Node Reporting

By default, Console does not report transfers with a server that are associated with IBM Aspera Sync jobs or the Sync
job information. If the server is a Console managed node and is runnning IBM Aspera High-Speed Transfer Server
version 3.1.5 or later, then it can be configured to report transfers and Sync jobs.

1. Enable server activity logging for Sync jobs.
Run the following asconfigurator command to enable activity logging for Sync jobs:

# asconfigurator -x "set_node_data;async_activity_ | ogging,true"

This command adds the following text to the <def aul t > section of theasper a. conf file, located at: / opt /
asper a/ et c/ asper a. conf.

<CONF version="2">
<def aul t >

.<é'sync_act ivity | oggi ng>true</async_activity_| oggi ng>
</ def aul t >

</ bCNF>
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2. Restart the Aspera Node API service to activate your changes.

# service asperanoded restart

3. Confirm Sync jobs and transfers associated with them are reported in Console.
After initiating a sync session, go to Console and go to Activity > Sync Jobs page to monitor the job.

Note: Sync job reporting (from the Sync Jobs screen) may not appear immediately.

Monitor Sync Jobs

To monitor Aspera Sync jobs, you must first configure Console to poll the Node API. For more information, see
Enabling Async Server Node Reporting on page 47 to configure server reporting, and Enabling Sync Client
Node Reporting on page 46 to configure client reporting.

Once you have initiated a Sync transfer, you can monitor it by going to Activity > Sync Jobs. This shows alist of
active and recently completed Sync jobs. Y ou can aso remove log data from the Sync Jobs page by clicking remove
log data.

Note: Sync jobs may not appear immediately.

From the Sync Jobs table, you can view ajob's transfer details by clicking the corresponding row. The job's transfer
details page displays the following:

» Local and remote server details

« Session statistics including the number of paths that are synced, pending, conflicted, deleted, or in error state
« Transfer rate graph, which is only active during the transfer

* Removelog data button, which deletes the job's log data from the Console and Aspera Sync databases.

The example below shows a running Sync job.



& aspera console

Da nard

Activity

N
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Sync Job Detail: ny-push-london

ny-push-london

Status: running

Direction push

Start Time: Mar 29 2017 01:45 PM
Checksum: shal-sparse

Local Node

San Francisco

Local User: root

Local Host: debB4-22

Local Address: 10.0.163.22

Local Path: fvar/aspera/Project X
Remote User: aspera

Remote Host: 10.0.111.200

Remote Address: 10.0.111.200

Remote Path: Project X

Dedupe Mode Off

Search Files:

All Files

File Status

PATH

12007 September 05/Picture low 29.jpg
/2007 September 05/Picture high 28.jpg
12007 September 05/Picture normal 10.jpg
12007 September 05/Picture low 10.jpg
/2007 September 05/Picture normal 22 jpg

12007 September 05/Picture high 14.jpg

PINAT Santrmbar AEDirkrs b 43 inm

Transferring Files

v

Current Status

Synchronized Paths: 4063
Pending Paths: 4474
Conflict Paths: 0

Error Paths: 0

Last Session

Deleted Paths: 0

Deleted Bytes: 0 Bytes
Deduped Bytes: 0 Bytes
Transferred Bytes: 2912 MB

Cumulative Stats

Deleted Bytes:
Deduped Bytes:
Transferred Bytes:

0 Bytes
0 Bytes
291.2 MB

STATUS

pending

pending

pending

pending

pending

pending

10.0

5.0

0.0

Il Transfer Rate (Mbps) for ny-push-london

‘

Ve

Session Detail

SIZE

58.6 KB

2344 KB

2344 KB

E0 & wD

LAST MODIFIED

March 29 2017, 01.57:04 PM

March 29 2017, 01:57:04 P

March 29 2017, 01:57:03 PM

March 29 2017, 01:57:01 PM

March 29 2017, 01.57:05 PM

March 29 2017, 01:57:02 PM

Marsh 90 3047 [4-E2-ET DA

Console Transfer Special Conditions

Console transfers have restrictions for some endpoint combinations. For more information about endpoints, see

Understanding Endpoints on page 28.

Incompatible Endpoint Combinations

Console does not support transfers with the following endpoint combinations:

« Transferring between SSH and Shares endpoints
» Transferring between two Shares endpoints

Restricted Endpoint Combinations

The following four endpoint combinations require transfers to be initiated from a specific endpoint:
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Endpoint Combination Initiating Endpoint

SSH and Node API endpoints The Node API endpoint must be theinitiator and a
managed node

SSH and Access Key endpoints The SSH endpoint must be the initiator and a managed
node

Shares and Node API endpoints The Node API endpoint must be the initiator and a
managed node

Shares and Access Key endpoints The Access Key endpoint must be the initiator and a
managed node

Starting a Simple Transfer

Console can be used to initiate transfers between nodes when the Console user has the permission to start transfers.
Console provides two types of transfer methods: simple transfers and smart transfers. Simple transfers are one-time
transfer sessions that require entering all transfer information. Smart transfers are reusable templates with saved
transfer settings.

1. Goto Transfer.
2. Click Simple Transfer.

Start a Simple Transfer

Begin a high-speed transfer now. Specify transfer rates,
encrypticn, and email notifications.

Simple Transfer

3. Enter the transfer name and optional comments. The name and comments can be helpful if you want to search for
thistransfer later.

4. Optional: Add new tags or modify existing tags.

Click the button to add a new tag. Enter the tag name and the tag value. Click the E] button to delete an

existing tag. Select the@' button to prevent a user from changing or deleting the locked tag when starting this
transfer. For more information about tags, see Working with Tags on page 108.

Tag Name Tag Value &
Company Aspera E3

5. Inthe Source section, click the Connect drop-down menu and select the source node, cluster, or saved endpoint.

* Node: A nodeislisted as the node name (by default, its 1P address) and | P address. Select the Endpoint type
from the drop-down menu and enter your credentials or select your SSH key.

o Cluster: A cluster islisted as the domain name. Select the Endpoint type from the drop-down menu and enter
your credentials.

» Endpoint: A saved endpoint islisted as login@address and is associated with login credentials for the
username or access key. Selecting a saved endpoint does not prompt you for credentials.

e Any: Choosing Any alows the user to create a new endpoint instead of choosing from thellist.
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6. Select content to transfer by clicking Browse, selecting the content, and clicking Add.

Note: When browsing the node, you can narrow your search by applying afilter. When specifying afilter, the
asterisk (*) isnot awildcard. Any string you enter as afilter istreated as a "search within". In other words, the
string "foo" matches "123foo", "foo456", and "123foo456".

By default, the parent folders of the selected files and folders are not transferred. If a sourceitem isafile, then
only thefileistransferred. If asourceitem isafolder, then the folder and its entire contents are transferred.

For example, if the source pathisasper a/ t np/ sent _fi | es, the only folder that will be transferred to the
destinationisthesent _fi | es folder. Neither / asper a nor / t np appear at the destination location.

To transfer only the contents of a selected folder, select Specify base for sour ce path(s) and enter the filepath to

the folder. For example, if the source folder isasper a/ t np/ sent _fi | es and you specify that same path as

the base for source paths, the contentsof / sent _f i | es istransferred to the destination directory as separate

items that are not containedina/ sent _fi | es folder.

7. Inthe Destination section, click the Connect drop-down menu and select the source node, cluster, or saved

endpoint.

* Node: A nodeislisted as the node name (by default, its 1P address) and | P address. Select the Endpoint type
from the drop-down menu and enter your credentials or select your SSH key.

e Cluster: A cluster islisted as the domain name. Select the Endpoint type from the drop-down menu and enter
your credentials.

» Endpoint: A saved endpoint islisted aslogin@address and is associated with login credentials for the
username or access key. Selecting a saved endpoint does not prompt you for credentials.

* Any: Choosing Any allows the user to create a new endpoint instead of choosing from the list.

8. ClickBrowse, select the destination directory, and click Add.
9. Optional: Configure settings in the M or e Options section.
Click the toggle arrow next to each section to view settings.

Section Description

Connection Configure fasp settings.

Transfer Configure transfer rates and policies.

Security Encrypt the transfer.

File Handling Configure source file attributes, archive sourcefiles

after transfer, and set filters for source files.

Notifications Configure email notification options. For more
information on email notifications, see Configuring
Email Notifications on page 13.

Advanced Configure transfer initiator, fasp MTU, and read and
write block sizes on source and destination nodes.

Transfer Time Schedule your transfer to run Now or Later. If you

choose L ater, click the = button and choose the date
and time you want the transfer to run.
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Section Description

< Movember ¥ | 2015 ¥ >

F S

6 7
8 9 13 14
15 20 21

22 27 28

prit]

CREIRA EA now ok

For information on these options, see Simple Transfer Options on page 149.
10. Click Transfer to start the transfer (or Scheduleif you set atransfer time).

Note: You can cancel scheduled simple transfers by going to Activity > Transfers. Click the Scheduled drop-
down menu and select All. In the row for the transfer, click Cancel.

Transfers
. Scheduled: : .
= Future
NAME DETAILS SCHEDULED ACTIONS
Cancel Scheduled Transfer admin (console), Mode 1 o Mode 1 4:38pm 30-Oct start cancel

Creating a Smart Transfer

Console can be used to initiate transfers between nodes when the Console user has the permission to start transfers.
Console provides two types of transfer methods: simple transfers and smart transfers. Simple transfers are one-time
transfer sessions that require entering all transfer information. Smart transfers are reusable templates with saved

transfer settings.
1. To create asmart transfer template, go to Transfer > New Smart Transfer.

Create a New Smart Transfer

Create a reusable transfer template with the ability to add
multiple destinations.

MNew Smart Transfer

2. Enter atransfer name.
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3. Optional: Select Sharethissmart transfer to share this smart transfer with any user who has permissions for the
transfer paths.

For more information on sharing smart transfers, see Sharing a Smart Transfer on page 57.

4. Optional: Select Allow changesto transfer settingsat submit time to allow the user who starts this smart
transfer to change settings before submitting the transfer request.

5. Optional: Add new tags or modify existing tags.
Click the button to add a new tag. Enter the tag name and the tag value. Click the E] button to delete an

existing tag. Select the&' button to prevent a user from changing or deleting the locked tag when starting this
transfer. For more information about tags, see Working with Tags on page 108.

Tag Name Tag Value &
Company Aspera E3

The highlighted box in the Smart Transfer Diagram indicates whether you are configuring the Source or Destination
for the smart transfer. Make sure Sour ce is selected.

= Smart Transfer Diagram

adds a new destination node

[E] removes a destination node

Source Destination

6. Select the source node or saved endpoint from the Connect drop-down menu.

* Node: A nodeislisted as the node name (by default, its 1P address) and | P address. Select the Endpoint type
from the drop-down menu and enter your credentials or select your SSH key.

e Cluster: A cluster islisted as the domain name. Select the Endpoint type from the drop-down menu and enter
your credentials.

« Endpoint: A saved endpoint islisted as login@address and is associated with login credentials for the
username or access key. Selecting a saved endpoint does not prompt you for credentials.

« Any: Choosing Any allows the user to create a new endpoint instead of choosing from the list.

7. Choose your Sour ce directory.

Click Choose Sour ce Directory to browse the node for the directories and files you want to transfer. Console
displays the source path you choose once you have chosen your source directory.

Note: When browsing the node, you can narrow your search by applying afilter. When specifying afilter, the
asterisk (*) isnot awildcard. Any string you enter as afilter istreated as a "search within". In other words, the
string "foo" matches "123foo", "foo456", and "123f00456" .

8. Select Specify base for source path(s) to place the transferred files directly into the destination folder without its
hierarchy of directories. The specified base for the source path is removed from the source path when transferring
directories.

For example, if the source pathis/ shared_fi | es/ proj ect s/ present ati on, asuccessful transfer
resultsinthefolder desti nati on_f ol der/shared_fil es/ proj ects/presentationonthe
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destination node. A successful transfer with "/shared_files/projects’ specified as the base path resultsin the folder
destinati on_f ol der/ present ati on on the destination node.

For more information on specifying a base path, see Specify Base for Source Path on page 154.
9. Select one of the following file-transfer rules from the [temsto transfer drop-down list:

« Alwaystransfer the entire directory: The transfer always transfers all filesin the source directory.

e Allow initiator to select items when starting manually: The user starting this smart transfer can choose the
itemsin the directory included in the transfer.

10. Expand the settings under More Options to configure addition settings.
Click the toggle arrow next to each section to view settings.

Section Description

Connection Configure fasp settings.

Transfer Configure transfer rates and policies.

Security Encrypt the transfer.

File Handling Configure source file attributes, archive source files

dfter transfer, and set filters for source files.

Notifications Configure email notification options. For more
information on email notifications, see Configuring
Email Notifications on page 13.

Advanced Configure transfer initiator, fasp MTU, and read and
write block sizes on source and destination nodes.

Transfer Time Schedule your transfer to run Now or Later. If you

choose L ater, click the = button and choose the date
and time you want the transfer to run.

< Movember ¥ | 2015 ¥ >

F §

5 6 7
&8 9 12 13 14
15 18 19 20 21
22 25 26 27 28
29

@EEETRE EA vow 0k

For more information on these options, see Smart Transfer Options on page 152.

The highlighted box in the Smart Transfer Diagram indicates whether you are configuring the Source or Destination
for the smart transfer. Make sure a Destination is selected. Y ou can create additional destination endpoints by clicking

the button. To remove a destination, click the E] button inside the destination box.
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adds a new destination node

E] removes a destination node

= Smart Transfer Diagram

Source

Destination

Destination

11. Select the destination node or saved endpoint from the Connect drop-down menu.

* Node: A nodeislisted as the node name (by default, its 1P address) and | P address. Select the Endpoint type
from the drop-down menu and enter your credentials or select your SSH key.
o Cluster: A cluster islisted as the domain name. Select the Endpoint type from the drop-down menu and enter

your credentials.

» Endpoint: A saved endpoint islisted as login@address and is associated with login credentials for the
username or access key. Selecting a saved endpoint does not prompt you for credentials.
« Any: Choosing Any allows the user to create a new endpoint instead of choosing from thellist.

12. Select your Destination directory.

Click Choose Destination Directory to browse the node for the directories and files you want to transfer. Console
displays the source path you choose once you have chosen your source directory.

Note: When browsing the node, you can narrow your search by applying afilter. When specifying afilter, the
asterisk (*) is not awildcard. Any string you enter as afilter istreated as a "search within". In other words, the
string "foo" matches "123foo", "foo456", and "123foo456".

13. Optional: Allow the user starting this smart transfer to change the directory on this destination node. The Change
Destination Path button appears for a destination with this option enabled.

14. Optional: Allow the user starting this smart transfer to remove this destination node. The E3 button appears for a

destination with this option enabled.

15. Optional: Configure additional settings for thisindividual destination node.

Note: Thisoptionisonly available for a smart transfer with multiple destination nodes.

Select Set transfer optionsindividually for this destination. The M ore Options appears at the bottom of the

page.
Section Description
Connection Configure fasp settings.
Transfer Configure transfer rates and policies.
Security Encrypt the transfer.
File Handling Configure source file attributes, archive sourcefiles
after transfer, and set filters for sourcefiles.
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Section Description

Notifications Configure email notification options. For more
information on email notifications, see Configuring
Email Notifications on page 13.

Advanced Configure transfer initiator, fasp MTU, and read and
write block sizes on source and destination nodes.

For information on these options, see Smart Transfer Options on page 152.
16. Click Save.

Once a smart transfer template has been saved, it is accessible from the Transfer page. Go to Transfer to start, edit,
copy, and delete existing smart transfers.

Starting a Smart Transfer

Console can be used to initiate transfers between nodes when the Console user has the permission to start transfers.
Console provides two types of transfer methods: simple transfers and smart transfers. Simple transfers are one-time
transfer sessions that require entering al transfer information. Smart transfers are reusabl e templates with saved
transfer settings.

1. Goto Transfer to see all the smart transfers you have permission to access. For instructions on creating a smart
transfer, see Creating a Smart Transfer on page 52.

2. Find the smart transfer listed under Saved Smart Transfers and click Start.

3. Optional: Modify the Transfer Name and leave a comment describing the transfer.
4, Optional: Add new tags or modify existing tags.

Tags

Tag Mame Tag Value

Company Aspera

Division Development E]

Click the button to add a new tag. Enter the tag name and the tag value. Click the E] button to delete an
existing tag. Locked tags are greyed out and cannot be modified. For more information, see Working with Tags on
page 108.

5. Optional: Configure email notification options.

Expand the Notifications section. Add or delete email addresses and configure notifications for existing email
addresses. For more information, see Configuring Email Notifications on page 13.

6. Optional: Schedule the transfer to run Now or L ater.

If you choose L ater, click the [ button and choose the date and time you want the transfer to run.
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7. Click Start.

Sharing a Smart Transfer

Smart transfers are reusable templates with saved settings. The primary use case for sharing smart transfersisto set
up pre-defined transfers for non-admin usersto run. Y ou can decide what transfers a user can monitor and start by
limiting the user's permissions and access to a smart transfer. By default, shared transfers require you to use endpoints
created by an admin using the Edit Nodes > Endpoints page. Once configured in Console settings, you can also
share smart transfers saved with personal login credentials and domain names.

For more information about sharing smart transfers with personal logins, see Sharing a Smart Transfer with Personal
Login Credentials on page 58
1. Create endpoints on the nodes you want to use for this smart transfer.
For detailed instructions, see Adding Endpoints on page 28.
Tip: To use domain names as transfer endpoints, create an unmanaged node using a domain name, then add an
Endpoint to this unmanaged node.
2. Goto Transfer and click New Smart Transfer.
3. Sdlect Sharethissmart transfer.

Diescription
Transfer name
#|  Share this smart transfer

Allow changes to transfer settings at submit time
Tags

Note: When creating a smart transfer with Any as an endpoint, you must first save the smart transfer before
selecting Sharethis smart transfer.

4. Select endpoints for the Source and Destination.
Tip: Create new personal saved endpoints by selecting the desired node and entering the SSH user login
credentials.

5. Finish configuring the smart transfer. Click Save when finished.

6. Enable auser to start this smart transfer.
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» Create agroup with permissionsto start smart transfers for this transfer path (see Creating Console Groups on

page 36).
e Add the user to this group (see Creating Console Users on page 38).

Admin users have permissions to all transfers and do not need to be added to a group to use a shared smart transfer.
By default, admins do not have the ability to edit Smart Transfers that are shared with them but owned by another
admin. To enable admins to edit each other's smart transfers, go to Configuration > Defaults and select Smart
Transfer Editing: Allow administratorsto edit each other's Smart Transfers.

Note: Even with this feature enabled, admins can only edit smart transfers that do not contain personally saved login
credentials.

Tip: Editing another admin's smart transfer changes ownership of the smart transfer to the admin who made the last
change.

Sharing a Smart Transfer with Personal Login Credentials

Smart transfers are reusable templates with saved settings. The primary use case for sharing smart transfersisto set
up pre-defined transfers for non-admin usersto run. Y ou can decide what transfers a user can monitor and start by
limiting the user's permissions and access to a smart transfer. By default, shared transfers require you to use endpoints
created by an admin using the Edit Nodes > Endpoints page. Once configured in Console settings, you can also
share smart transfers saved with personal login credentials and domain names.

Personal login credentials are automatically created and saved when a user creates a transfer, chooses a node, and
enters authentication credentials for an SSH user on that node. The following describes how to share a smart transfer
with personal login credentials.

Note: To share asmart transfer, an administrator must enable smart transfer sharing. To enable smart transfer
sharing, go to Configuration > Defaults and select Allow usersto share Smart Transfersthat contain personal
Saved Endpoints.

1. Create anew smart transfer, select Sharethissmart transfer.

Description
Transfer name
#|  Share this smart transfer

Allow changes to transfer settings at submit time
Tags

(+]

Note: When creating a smart transfer with Any as an endpoint, you must first save the smart transfer before
selecting Sharethis smart transfer.

2. Select persona saved endpoints for the Source and Destination.

If you have no personal saved endpoints, create a new one by selecting the desired node and entering the SSH user
login credentials.

3. Finish configuring the smart transfer. Click Save when finished.
4. Enable auser to start this smart transfer.

« Create agroup with permissions to start smart transfers for this transfer path (see Creating Console Groups on

page 36).
e Add the user to this group (see Creating Console Users on page 38).



| Transferring Files | 59

Admin users have permissions to all transfers and do not need to be added to a group to use a shared smart transfer.
By default, admins do not have the ability to edit Smart Transfers that are shared with them but owned by another
admin. To enable admins to edit each other's smart transfers, go to Configuration > Defaults and select Smart
Transfer Editing: Allow administratorsto edit each other's Smart Transfers.

Note: Even with this feature enabled, admins can only edit smart transfers that do not contain personally saved login
credentials.

Tip: Editing another admin's smart transfer changes ownership of the smart transfer to the admin who made the last
change.

Queue Transfers

Overview
The Console queueing feature provides two useful capabilities:

e Admins can limit the number of Console-initiated transfers that can run concurrently for a given destination or
from agiven source. This can be useful if network connections have limited bandwidth or if particular destination
nodes have difficulty handling more than a small number of transfers at atime. For example, if the concurrency
limit for aconnectionis"2", and two transfers are in progress, any new transfers initiated while the first two are
still in progress will be queued in the order in which they were initiated.

» All users can change the priority order of queued and in-progress transfers. This can be useful in situations where
users need to respond to emergencies or shifting priorities.

Important: Queueing only appliesto transfers started from Console or viaits API. Transfers started outside Console
are not subject to queueing and do not count towards concurrency limits.

Concurrency limits are always assigned on a per-node basis, and per outbound or inbound direction. However, the
overall, actual limit on a set of concurrent transfers between two nodes is governed by the node with the lowest limit.
That is, if NodeA has an outbound limit of "2" and NodeB has an inbound limit of "1", concurrent transfers from
NodeA to NodeB are limited to one transfer at atime, with subsequent transfers queued up in the order in which they
wereinitiated.

Adjusting the Queueing Properties of In-Progress Transfers

If queuing is enabled on a node (see Configuring Queues for Nodes on page 60), the queueing properties of in-
progress transfers can be adjusted in severa ways.

» Their relative priorities can be raised or lowered.

e They can be paused and resumed.

* The concurrency limit in effect can be raised or lowered.

» Concurrency (and therefore queueing) can be disabled completely.

These adjustments can be made while monitoring the node from the Node Detail page. Y ou can view the Node Detail
page by going to Nodes and clicking on the node.

Tip: You can aso reach this page from the Queing page on the current queue contents link next to an enabled

Limit concurrency: s

Max. concurrent transfers: 3 current queue contents

concurrency limit.

On the Node Detail page, below the transfer chart, you may see the Inbound Queue tab, the Outbound Queue tab,
or both. These tabs are visible if the node is configured with inbound or outbound queueing. Clicking the tab displays
the node’ s inbound or outbound transfers - both those currently in progress and those in the queue.
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To view past transfers, open the Transfer s tab. The Transfer stab also shows both outbound and inbound transfers,
but does not include controls to promote, demote, pause, or resume transfers.

Controlling In-Progress Transfers

STATUS RATE ACTIONS
414.5 MB - 8amops |1 Y| X
Cueued here il A X
Icon Action
11 Pause Transfer
- Resume Transfer
A Promote Transfer to Highest Priority
A Promote Transfer
A Demote Transfer
v Demote Transfer to Lowest Priority
X Cancel Transfer
o Highlight this session on the graph

Configuring Queues for Nodes

Both managed and unmanaged nodes can be configured for queuing. For more information on queuing, see Queue

Transfers on page 59.
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Go to Nodes. Find your node in the Managed Nodes or Unmanaged Nodes page . Click edit and then click
Queueing.

Enable queueing by selecting Limit concurrency (disabled by default) for Inbound Transfers.

Choose the maximum number of concurrent transfers allowed for this node. The default setting is"1".
Repeat the previous two steps for Outbound Transfers.

Click Update.

In the example below, queueing is disabled for inbound transfers. For outbound transfers, queueing is enabled for at
most three transfersin progress at the same time.

Inbound Transfers

Limit concurrency:

Max. concurrent transfers: 1

Outbound Transfers

Limit concurrency: v

[¥¢]

Max. concurrent transfers: 3 current queue content

Configure Failover Groups

Overview

A failover group contains a group of different nodes that act as substitutes for the original node in the case that the
origina node becomes unavailable. When a node goes offline, Console al so restarts any transfers in progress on that
node, submitting them to a different node in the group.

Note: Transfer failover only activatesif the status of anodeis set to error. Transfers that are inactive do not failover.

Node Requirements
Nodes must have identical passwords, transfer accounts, and docroots to be grouped together. Make sure each node
hasidentical configurations for each item in the following list before adding them to a failover group:

System User Accounts
Transfer User Accounts
Node APl User Accounts
Docroots

Endpoints on Console
Directory Structure

Adding a Node to a Failover Group

When adding or editing a node, select Enable failover and load balancing for Console-initiated transferson this
node. Add the node to an existing group or select enter new name from the Failover Group Name drop-down menu
to create a new group.
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Failover

¥ Enable failover and load balancing for Conscle-initiated transfers on this node
Failower Group Mame | FAILOVER GROUP 1 ¥ |

fnong)

FAILOVER GROUP 1

If you select enter new name,enter anew failover group name in the prompt.

Endpoint Synchronization
Editing an endpoint on anode of afailover group makes those changes to the same endpoint on the other nodes in the
failover group.

Note: Only saved and synchronized endpoints should be selected as a destination when starting a transfer.

Configuring Load Balancing
Go to Configuration > Console Defaults and configure the Failover / Load balancing Behavior option.

» Failover + Load Balancing: The transfer uses the least busy nodes first.
» Failover only: Thetransfer will usesthe original endpoints that the user specified.

Creating a Cookie Parsing Rule

Note: Cookie configuration applies only to the use of custom cookies. Console does not apply parsing rulesto
cookies it recognizes as standard cookies used by Aspera products.

Inan ascp command-line transfer, you can specify the transfer cookie with an environment variable.
set ASPERA SCP_COCKI E=cust om cooki e

Using arule, Console can match the set cookie string and then substitute it for selected transfer information.

1. Goto Configuration > Cookies. Click New Rule.
2. Nametherule.
3. Configure the cookie.
Enter the regular expression Console uses to filter transfers. If this string matches a transfer, Consol e includes the
cookiein the transfer and the information in the other fieldsis used in the transfer session.
Tip: Theregular expression follows Ruby regular expression format currently documented on the Ruby web site.
4. Configure the cookie with the following information:

Field Description
Started via Name of the transfer initiator.
Contact description Description of thistransfer initiator.
Transfer name Name for this transfer.

5. Click Create.

When you have multiple cookie parsing rules, Console uses the first rule listed that matches the cookie string.
To modify the order of the parsing rules, drag-and-drop the rulesin the list. If two rules have identical regular
expressions, therule that is higher in thelist is applied.
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It is possible to capture parts of the cookie and reuse the value in the three parameters. For instance to enable
setting the three transfer fields directly from the initiating application, one can fill in the fields with the following
configurations:

Field Description

Rule name MyCustomCookieRule

Regexp "setcustontfields: (.+7?): (.+?):(.+?):$
Started via \1

Contact description \2

Transfer name \3

For example, the following cookie replaces Started via with "My App", Contact description with "My Contact",
and Transfer name with "My Transfer".

set ASPERA_SCP_COCKI E="set custonfi el ds: My App: My Contact: My Transfer:"

Working with Watchfolders

Watch Folders automate file transfers from afolder on a source node to a destination node. Files placed into a source
folder are automatically transferred to the destination.

Creating a Push Watch Folder

A local-to-remote (push) Watch Folder monitors a directory on the source node where the Watch Folder runs. If it
detects new filesin the source directory, it transfers those files to a directory on the destination node.

To use Watch Folders, you must enable the feature (Configuration > Defaults and select Enable Watchfolder
management) and add Watch Folder-enabled nodes to Console as managed nodes. For instructions on enabling
Watch Folders on anode, see IBM Aspera High-Speed Transfer Server Admin Guide: Watch Folders and the Aspera
Watch Service.

1. GotoActivity > Watchfoldersand click Create New Watchfolder.
. Enter aname for your watch folder in the Name field.

2
3. Select Push for the Watch Folder type.
4. Configure the source node and directory. Files dropped into the source directory are transferred to the destination
node and directory.
a) Select your source node from the drop-down menu. Only Watch Folder-configured nodes appear in the list.
b) Select the source directory.
Y ou can Browse and select the source directory, or manually enter the source path.

Important: The path isrelative to the associated system user's docroot. For example, if you enter
proj ect 1/ fi nal andtheuser'sdocrootis/ asper a/ proj ect s, thesource pathis/ asper a/
proj ects/projectl/final.

5. Enter authentication credentials for the destination node in the Target pane.

a) Enter the IP address or hostname of the target node.
b) Choose the type of credentials you want to use for authentication. Enter the credentials to authenticate to the
destination node and authorize transfers.
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Authentication Type Ul Option Credentials
SSH with password SSH Password SSH user and SSH password
SSH with key SSH Key SSH user and SSH private key

Note: You must give the full
path to the SSH key, not the path
relative to the docroot.

HTTPS with Node API Node API Node API user and Node API
password
HTTPS with Shares API Shares Aspera Shares APl user and

Aspera Shares APl password

Important:

1) To authenticate using SSH with password, the source node must be running IBM Aspera High-Speed
Transfer Server 3.7 or later.

2) To authenticate using HTTPS with Node API or HTTPS with Shares API, both the source and destination
nodes must be running IBM Aspera High-Speed Transfer Server 3.8 or later.
If you want, you can also enter atoken string to authenticate the transfers, with the syntax "Basic token_string".

For instructions on creating an access key on the remote node and generating a token from it, see the IBM Aspera
High-Speed Transfer Server Admin Guide: Access Key Authentication.

If you want to specify an Asperaforward proxy for the Watch Folder, enter the proxy address in the following
format:

dnat:/ /1 ogi n: passwor d@ddr ess: port

For more information on forward proxies, see the IBM Aspera Proxy Admin Guide.

Set ports for SSH/TCP or Node API (depending on your authentication type) connections, and for fasp™ (UDP)
connections.

Target Authentication Default Ports
SSH Password SSH Port: 22
UDP: 33001
SSH Key SSH Port: 22
UDP: 33001
Node API

Node API Port: 9092
UDP: 33001

Shares Shares AP Port: 443

UDP: 33001

Select the destination directory.
Y ou can Browse and select the destination directory, or manually enter the destination path.

Important: Just like for the source path, the destination path is relative to the associated system user's docroot.

If you are using an SSH key for authentication and you want to browse for the destination, you need to first add
the key to Console to authenticate Console to browse the node. Y ou do not need to add the key to Console if
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you know the destination path and enter it manually. For more information on adding SSH keysto Console, see
Storing SSH Keys on Console on page 84.

10. Configure additional watchfolder settings. See Watchfolder Options on page 71.
11. Click Create.
12. Test your watch folder.

Add files to the source directory. Watch Folder detects the new files and transfers the new files to the target
directory. Y ou can see the transfer on the Activity Overview page.

Creating a Pull Watch Folder

In aremote-to-local (pull) Watch Folder scenario, the destination node (managed node receiving files) runs the Watch
Folder service. The destination node remotely monitors the source directory on the source node using the Node

API. If the destination node detects new filesin the source directory, it transfers those files to the configured, local
directory on the destination node.

Important: Pull-type Watch Folders require both source and destination nodes run HSTS version 3.8 and later.

To use Watch Folders, you must enable the feature (Configuration > Defaults and select Enable Watchfolder
management) and add Watch Folder-enabled nodes to Console as managed nodes. For instructions on enabling
Watch Folders on anode, see IBM Aspera High-Speed Transfer Server Admin Guide: Watch Folders and the Aspera
Watch Service.
1. GotoActivity > Watchfoldersand click Create New Watchfolder.
2. Enter aname for your watch folder in the Name field.
3. Select Pull for the Watch Folder type.
4. Configure the destination node and directory. Files dropped into the source directory are transferred to this node
and this directory.
a) Select your target node from the drop-down menu. Only Watch Folder-configured nodes appear in the list.
b) Select the destination directory.
Y ou can Browse and select the destination directory, or enter the source path.

Important: The destination directory is relative to the associated system user's docroot. For example, if you
enter pr oj ect 1/ fi nal andtheuser'sdocrootis/ asper a/ proj ect s, thesource pathis/ asper a/
proj ects/projectl/final.

5. Enter authentication credentials for the source node in the Source pane.

a) Enter the IP address or hostname of the source node.

b) Choose the type of credentials you want to use for authentication. Enter the credentials to authenticate to the
destination node and authorize transfers.
Pull Watch Folders must use the Node API or the Shares API to authenticate to the source node. The source
node must be running HSTS 3.8.0 and later.

Authentication Type Ul Option Credentials

HTTPS with Node API Node API Node API user and Node API
password

HTTPS with Shares AP Shares Aspera Shares APl user and
Aspera Shares APl password

6. If youwant, you can also enter atoken string to authenticate the transfers, with the syntax "Basic token_string".

For instructions on creating an access key on the remote node and generating a token from it, see the IBM Aspera
High-Speed Transfer Server Admin Guide: Access Key Authentication.
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7. 1f you want to specify an Asperaforward proxy for the Watch Folder, enter the proxy address in the following
format:

dnat :/ /1 ogi n: passwor d@ddr ess: port

For more information on forward proxies, see the IBM Aspera Proxy Admin Guide.
8. Set portsfor Node API connections, and for fasp™ (UDP) connections.

Target Authentication Default Ports

Node API Node API Port; 9092

UDP: 33001

Shares API Shares APl Port: 443

UDP: 33001

9. Select the source directory.
Y ou can Browse and select the source directory, or manually enter the source path.

Important: Just like for the destination path, the source path is relative to the associated system user's docroot.
10. Configure additional watchfolder settings. See Watchfolder Options on page 71.
11. Click Create.
12. Test your watch folder.

Add files to the source directory. Watch Folder detects the new files and transfers the new files to the target
directory. Y ou can see the transfer on the Activity Overview page.

Creating a Push Watch Folder with ATS Node Destination

Create alocal-to-remote (push) Watch Folder with an Aspera Transfer Service (ATS) node as the destination node. If
Watch Folder detects new filesin the source directory, it transfers those files to a directory on ATS node.

Important: Using Watch Folders with an ATS node requires that both source and destination nodes run IBM Aspera
High-Speed Transfer Server version 3.8 and later.

To use Watch Folders, you must enable the feature (Configuration > Defaults and select Enable Watchfolder
management) and add Watch Folder-enabled nodes to Console as managed nodes. For instructions on enabling
Watch Folders on anode, see IBM Aspera High-Speed Transfer Server Admin Guide: Watch Folders and the Aspera
Watch Service.

1. GotoActivity > Watchfoldersand click Create New Watchfolder.

2. Enter aname for your watch folder in the Name field.

3. Select Push for the Watch Folder type.
4

. Configure the source node and directory. Files dropped into the source directory are transferred to the destination
node and directory.

a) Select your source node from the drop-down menu. Only Watch Folder-configured nodes appear in the list.
b) Select the source directory.

Y ou can Browse and select the source directory, or manually enter the source path.

Important: The path isrelative to the associated system user's docroot. For example, if you enter

proj ect 1/ fi nal andtheuser'sdocrootis/ asper a/ proj ect s, the source pathis/ asper a/
proj ects/projectl/final.

5. Enter Node APl authentication credentials for the ATS node in the Target pane.

a) Enter the IP address or hostname of the target node.
b) Enter the Node API usernamein the L ogin field.
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¢) Choose Node API for the target authentication credential type.
d) Enter the Node API usernamein the L ogin field.
6. If you want, you can also enter atoken string to authenticate the transfers, with the syntax "Basic token_string".

For instructions on creating an access key on the remote node and generating a token from it, see the IBM Aspera
High-Speed Transfer Server Admin Guide: Access Key Authentication.

7. 1f you want to specify an Asperaforward proxy for the Watch Folder, enter the proxy address in the following
format:

dnat :/ /1 ogi n: passwor d@ddr ess: port

For more information on forward proxies, see the IBM Aspera Proxy Admin Guide.
8. Set portsfor the Node API:
 NodeAPI: 443
+ UDP: 33001
9. Select the destination directory.
Y ou can Browse and select the destination directory, or manually enter the destination path.

Important: Just like for the source path, the destination path is relative to the associated system user's docroot.
10. Configure additional watchfolder settings. See Watchfolder Options on page 71.
11.Click Create.
12. Test your watch folder.

Add files to the source directory. Watch Folder detects the new files and transfers the new files to the target
directory. Y ou can see the transfer on the Activity Overview page.

Creating a Pull Watch Folder with ATS Node Destination

In aremote-to-local (pull) Watch Folder scenario, the destination node (managed node receiving files) runs the Watch
Folder service. The destination node remotely monitors the source directory on the source node (Aspera Transfer
Service (ATS) node). If the destination node detects new filesin the source directory, it transfers those files to the
configured, local directory on the destination node.

Important: Using Watch Folders with an ATS node requires that both source and destination nodes run IBM Aspera
High-Speed Transfer Server version 3.8 and later.

To use Watch Folders, you must enable the feature (Configuration > Defaults and select Enable Watchfolder
management) and add Watch Folder-enabled nodes to Console as managed nodes. For instructions on enabling
Watch Folders on anode, see IBM Aspera High-Speed Transfer Server Admin Guide: Watch Folders and the Aspera
Watch Service.

1. Goto Activity > Watchfoldersand click Create New Watchfolder.

2. Enter aname for your watch folder in the Name field.

3. Select Pull for the Watch Folder type.
4

. Configure the destination node and directory. Files dropped into the source directory are transferred to this node
and this directory.

a) Select your target node from the drop-down menu. Only Watch Folder-configured nodes appear in the list.
b) Select the destination directory.

Y ou can Browse and select the destination directory, or enter the source path.

Important: The destination directory is relative to the associated system user's docroot. For example, if you

enter pr oj ect 1/ fi nal andtheuser'sdocrootis/ asper a/ proj ect s, the source pathis/ asper a/
proj ects/projectl/final.

5. Enter authentication credentials for the source node in the Source pane.
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Pull Watch Folders must use the Node API to authenticate to the source node. The source node must be running
HSTS 3.8.0 and later.

a) Enter the IP address or hosthame of the ATS node.
b) Enter the username of a Node API user on the ATS node.
c) Enter the Node API password of the Node API user.

6. If youwant, you can also enter atoken string to authenticate the transfers, with the syntax "Basic token_string".

For instructions on creating an access key on the remote node and generating a token from it, see the IBM Aspera
High-Speed Transfer Server Admin Guide: Access Key Authentication.

7. 1f you want to specify an Asperaforward proxy for the Watch Folder, enter the proxy address in the following
format:

dnat:/ /1 ogi n: passwor d@ddr ess: port

For more information on forward proxies, see the IBM Aspera Proxy Admin Guide.
8. Set portsfor the Node API:
* NodeAPI: 443
« UDP: 33001
9. Select the source directory.
Y ou can Browse and select the source directory, or manually enter the source path.
Important: Just like for the destination path, the source path is relative to the associated system user's docroot.
10. Configure additional watchfolder settings. See Watchfolder Options on page 71.
11.Click Create.
12. Test your watch folder.

Add files to the source directory. Watch Folder detects the new files and transfers the new files to the target
directory. You can see the transfer on the Activity Overview page.

Monitoring and Managing Watch Folders
Monitor Watch Folder transfers from the Activity page.

Go to Activity > Watchfoldersto see alist of Watch Folders and their status. Y ou can edit and delete Watch Folders
from this page.

If aWatch Folder is configured for nodes running IBM Aspera High-Speed Transfer Server 3.9.3 and later, you can
pause, stop, and resume the Watch Folder.

Working with Growing Files

Growing files are "in-progress’ files that continue to grow in size, such as videos generated at live events. Watch
Folders can detect and transfer these growing to atarget directory.

Requirements

« Both the source host and remote host must be running IBM Aspera High-Speed Transfer Server 3.6.0 and later to
support the f aspst r eamtechnology used to transfer growing files.

« Thetransfer user on the node running the Watch Folder service transfer must not have a docroot.

» Pull Watch Folders do not support growing files.
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When creating or editing a Watch Folder in Console, you can configure how Console handles growing filesin the
Growing Files section under More Options:

Option

Description

Default

Example

Maximum parallel transfers

The maximum number

of concurrent transfers of
growing files watchfol der
can initiate.

8

4

Target rate

The target transfer rate.

10000

10000

Bandwidth policy

The bandwidth policy used
for prioritizing growing file
transfers.

fair

high

Transport encryption

Transfer with an encryption
method.

none

aesl28

TCP port

TCP port to use for this
Watch Folder. If different,
Console connects to the
target node using this port
instead.

22

22

fasp™ port (UDP)

UDP port to use for this
Watch Folder. If different,
Console connects to the
target node using this port
instead.

33001

33001

Completion timeout

Duration in seconds of
inactivity after which
Console considersthe
growing file transfer to be
complete.

10

15

Memory

The maximum amount of
memory that the faspstream
binary is allowed to use.

128

128

Chunk size

The size of data to pack
before sending over the
network.

128

128

Growing filefilters

Defineswhich filesare
considered growing files.

Click the 2] button to add
anew filter to identify the
growingfile. You can set a
filter to include or exclude
files by globbing or by
regular expression.

*. nm2p

Note: Sessionswith growing files are not affected by settingsin the Transfer section.
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Controlling Transfer Order with File Lists

Control the transfer order for files added to a Watch Folder by configuring the Watch Folder to transfer filesin
packages, which are defined by file lists. The file list determines what files goes into a packaged and the order in
which they are transferred.

Thelast filein afilelist istransferred last; it will not be transferred until all other filesin the file list have been
transferred.

Use file lists with workflows that trigger on the presence of a particular file, but require the presence of other filesto
function correctly. For example, aworkflow that builds a project dependent on the existence of other filesfailsif the
trigger file is transferred before those other files have been transferred. Using afile list ensures the trigger file is not
transferred until the rest of the files have been transferred.

Creating a File List

Thefilelistisasimpletext filewith#aspera-fil el i st inthefirst lineand alist of files. Console only transfers
thelast filein the list after the other files have finished transferring. Here is an examplefilelist:

#aspera-filelist

super her o_epi c_t he_nusi cal - engl i sh. np4

super her o_epi ¢_t he_nusi cal - spani sh. np4

super her o_epi ¢_t he_nusi cal - chi nese. np4

super her o_epi ¢c_t he_nusi cal . png

super hero_epi c_the_nusical -english-trailer.np4
ADI . XML

Note: The pathslisted in afilelist are relative to the Watch Folder directory. Pathsto other directories are not
supported.

Configuration

When creating or editing a Watch Folder in Console, you can configure file list handling in the Packages/Drops
section under More Options:

Option Description Default Example
Package timeout The duration in secondsfor | 10 30
which the Watch Folder

waits for files defined in
thefilelist. If the required
files do not appear within
the duration, files with
dependencies are not
transferred because of
unsatisfied dependencies.

Final transfer Defineswhich fileis Last filein list Last filein list
transferred last.

e« Lastfileinlist: The
last file in the package
list istransferred last.

* Filelist: Thefilelist
istransferred last,
but the other files are
transferred without any
specific order.
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Option Description Default Example
Filelistfilters Click the ] button to add Glob
anew filter to identify file Include*. package

lists. You can set afilter
to include or exclude files
by globbing or by regular
expression.

Example

One of our workflows monitors a Watch Folder destination directory for new files. When it detects an XML file, it
starts aprocessto move all the files listed in that XML file to another directory and packages those filesin amedia
project according to metadata that the XML also provides. If the XML fileistransferred before the other files (which
islikely, given its small size), our workflow runs and fails due to missing files. To solve thisissue, we include afile
list with our mediafiles and the XML file:

#aspera-filelist

super hero_epi c_t he_nusi cal -engl i sh. np4

super her o_epi c_t he_nusi cal - spani sh. np4

super her o_epi c_t he_nusi cal - chi nese. np4

super her o_epi ¢_t he_nusi cal . png

super hero_epi c_the_nusical -english-trailer.np4
ADI . XML

We name our filelist super her o_epi c. package.

Next, we configure our Watch Folder to detect the file list by adding a glob filter that looks for files that include the
* . package pattern. We set our timeout to 30 seconds for buffer, and keep the default L ast filein list, to make sure
ADI . XM transfers last.

When we move our filesinto the monitored source directory on the source node, Watch Folder detects the

super her o_epi c. package filelist and waits 30 seconds before checking that all the files are present in the
source directory. Finding all the files present, Watch Folder transfers al the. np4 filesand the . png file to the target
directory on the destination node first, and then transfers ADI . XML.

Our workflow detects the the ADI . XM file and successfully performs its task.

Excluding Files from Watch Folder Monitoring

Use filters to determine what Watch Folders detects and transfers.

When creating or editing a Watch Folder in Console, you can configure file filtersin the Watchfolder Settings section
under More Options.

Click theEj button to add anew filefilter. Y ou can set afilter to include or exclude files using globbing or regular
expression matching.

For example, to exclude text files (. t xt ) and backup files (. bak), create two filters, one that uses glob matching to
exclude file matching the * . t xt pattern, and on that uses glob matching to exclude matching the * . bak pattern.

Watchfolder Options

The following tables provide information on additional configurable settings that are available when creating
watchfolders.
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Watchfolder Settings

Note: A watchfolder groups new or updated filesit detects in its source folder into "drops’. A drop is defined by the
duration set by the snapshot creation period. All filesin agiven drop are transferred in the same transfer session, post-

processed together, and reported as a unit.

Option

Description

Drop detection
strategy

The strategy this watchfolder uses to detect files dropped into the source folder.

« Cool off only: Create adrop that includes new files added within the duration by the
snapshot creation period.

e Top leve files: Create adrop for each file placed in the top level of the source folder.

e Top leve directories: Create adrop for each directory placed in the top level of the
source folder. This drop also includes the sub-directories and filesin the top level
directory.

Drop detection cool
off

The duration allowed for new files to be included in a drop. Aspera recommends choosing a
multiple of the specified snapshot _creati on_peri od for predictable results.

Snapshot creation
period

The duration used to determine what files are included in the current drop.

Connect timeout

The duration the source node waits to connect to the destination node.

Sample period

The frequency of the system estimateing the available bandwidth.

Queue threshold

The duration watchfolder adds files to a session. Use this feature to limit the number of files
transferred based on the computed available bandwidth.

Retry duration

The duration in which the source node tries to establish a connection with the destination
node.

Wait between retries

The duration the source node waits in between retries.

File detection cool
off

The duration watchfolder in which placing anew file in the source folder does not trigger a
new drop.

Note: This setting does not apply to the Cool off only detection strategy.

Flefilters Click theEj button to add a new filter to identify filelists. Y ou can set afilter to include or
exclude files by globbing or by regular expression.

Transfer

Option Description

Target rate The transfer target rate.

Minimum rate The transfer minimum rate

Bandwidth policy Choose atransfer policy among fixed | high | fair | low.

Transport Encryption | Select aes-128 to transfer with this encryption method.

Retry policy

The number of attempts and the duration between each retry.
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Option

Description

Content Protection

Select Encrypt transferred fileswith a password to enable content encryption. Enter and
confirm the password the recipient must use to decrypt the transferred files.

Note: When editing a watchfolder with content protection enabled, you must re-The
content protection password. A password must be provided in order to save changes to the
watchfolder.

File Handling

Option

Description

Resume policy

Specify aresume policy and the overwrite rule when the file exists on the destination.

File attributes

Preserve file UIDs, GIDs, or timestamps.

Source Archiving

The designated directory source files are moved to after completing atransfer. The transfer's
session details page display the archive directory's filepath as the After transfer path.

Note: The After transfer path will only be visible in the session details of the Console that
initiated the transfer. Another Console monitoring the same managed nodes will not have
access to the After transfer path.

Note: Re-running the transfer may generate a"No such file or directory" error since the
source files were moved to the archive directory.

Y ou can use archive directory variablesin the filepath to define specific archive paths for
each drop. Hover over the Archive directory variableslink for alist of available variables.

Source deletion

Delete the transferred files from the source computer after transfer.

Growing Files

Option

Description Default Example

Maximum parallel transfers [ The maximum number 8 4

of concurrent transfers of
growing files watchfol der
can initiate.

Target rate

The target transfer rate. 10000 10000

Bandwidth policy

The bandwidth policy used | fair high
for prioritizing growing file
transfers.

Transport encryption

Transfer with an encryption | none aesl28
method.

TCP port

TCP port to use for this 22 22
Watch Folder. If different,
Console connects to the
target node using this port
instead.

fasp™ port (UDP)

UDP port to use for this 33001 33001
Watch Folder. If different,
Console connects to the
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Option Description Default Example
target node using this port
instead.

Completion timeout Duration in seconds of 10 15

inactivity after which
Console considersthe
growing file transfer to be
complete.

Memory The maximum amount of | 128 128
memory that the faspstream
binary is allowed to use.

Chunk size The size of datato pack 128 128
before sending over the
network.

Growing filefilters Defines which files are *.nep
considered growing files.

Click theEJ button to add
anew filter to identify the
growing file. You can set a
filter to include or exclude
files by globbing or by
regular expression.

Packages / Drops

Option Description Default Example
Package The duration in seconds for which the Watch Folder waits for 10 30
timeout files defined in thefile list. If the required files do not appear

within the duration, files with dependencies are not transferred
because of unsatisfied dependencies.

Final transfer | Defineswhich fileistransferred last. Last filein list | Last filein list
e Ladt filein list: Thelast file in the package list is transferred
|ast.

» Filelist: Thefilelist istransferred last, but the other files are
transferred without any specific order.

Filelistfilters | ;0 the[#] button to add anew filter to identify file lists. Glob

You can set afilter to include or exclude files by globbing or by Include* . package
regular expression.

Configuring Proxies

Use a proxy to connect to nodes for transfer initiation and node browsing.

Go to Configuration > Proxy to configure global HTTP and FASP proxies.



HTTP Proxy Vs. Fasp Proxy

Console supports using two types of proxies: HTTP and FASP proxies.
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The FASP proxy is only used when browsing a node through an SSH endpoint. Console uses the HTTP proxy for all

other

scenarios:

» Browsing a source or destination node using a Node API endpoint

» Retrieving atransfer token from the destination node when starting a token-based transfer

« Starting atransfer at the source node

The following diagrams show different scenarios in which Console goes through a proxy to communicate with a

node;

Browsing a node

(global)

HTTP
Mode AP
Consaole ——| PIOXY o i
(global) Endpoint
FASF ZSH
Console ™ proxy " Endpoint




Token-based transfers
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Getting the transfer token (transferSpec)

Console

L HTTR | ol Mode API

< proxy
(global)

source node

- — Endpaoint

Initiating the transfer {with token or S5H authentication)

Console

(global)

sgurce node

Mode AP
Endpoint

kA
FASP prozy
(transter-specihc)

k
destination node

S5H
Endpoint

Note: When the FASP proxy between the source node and destination node is different from the global FASP
proxy used by Console. The proxy between the nodes is defined during creation of asimple or smart transfer (More

Options > Connection).

Configuring Proxies

Go to Configuration > Proxy to configure global HTTP and FASP proxies. Y ou can enable one or both proxies.
Both HTTP and FASP proxies take similar parameters:

Field Description

Address Proxy IP address or domain name

Port Proxy port number

SSL (FASP proxy only) Enable or disable use of SSL
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Field Description
Username Proxy username
Password Proxy user password

Creating Proxy Exclusion Rules

Y ou can exclude arange of |P addresses and domain names from going through proxies by creating proxy exclusion
rules. Define arule by selecting the rule type and providing a range of addresses.

For example, you can exclude all IP Addresses starting with 192 and all domain names ending ini bm comwith the

following two rules:

Order Rule Type Address
1 Exclude 192. *
2 Exclude * . ibmcom

Console applies the first matched rule. The order of your rulesisimportant, especialy if you are including some
addresses and excluding others. For example, toinclude 10. 0. 71. 51, but exclude all other 10. X addresses:

Order Rule Type Address
1 Include 10.0.71.51
2 Exclude 10. *

Console uses configured proxies to connect to anode at 10. 0. 71. 51, even though all 10. X addresses are
excluded, because the address matched the inclusion rule first. In the reverse case, however, Console does not use
configured proxiesfor 10. 0. 71. 51, even though the address is included, the address matched the exclusion rule

first:

Order Rule Type Address

1 Exclude 10. *

2 Include 10.0.71.51

If an address doesn't match any of the rules, Console applies the global proxy as usual.

Running Reports

Creating a Basic Report

Console alows you to create and export custom reports, as well as apply filters and scheduling options. The steps
below demonstrate how to configure new, basic reports. To view an example of abasic report, see the three samples
in thistopic. To learn about creating advanced reports within Console, see Creating an Advanced Report on page
78. To create an advanced report, click the New Advanced button instead. Y ou can also copy and edit Console's
built-in, advanced reports, which are listed on the Manage Report Types page. For further information on advanced

reporting, see Creating an Advanced Report on page 78.

1. GotoReports> Manage Report Types. Click the New Basic button.

2. Enter aname for your report (limited to 75 characters) and a detailed description about the report.
3. Choosethe level of detail to show on your report.
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Select afield from the drop-down list to be used as the basis for organizing your report. Console generates a report
with arow for each item that matches a chosen field. If you choose more than one field, Console generates a
multi-level report. The datain the generated report is grouped in ascending order by the fields selected from the
drop-down list. For example, if you select Client addr ess, the datain the report is grouped by the transfer initiator
IP addresses. For example, Console groups the five transfers initiated by 1P Address 1 in the first grouping,the
three transfersinitiated by IP Address 2 in the second grouping, and so on..

Note: Once afield is selected, the drop-down list updates automatically to allow for multiple levels of
organization. To remove alevel of organization, click the Remove link that appears next to the selected field.

The drop-down list includes al Console built-in fields and custom fields. For alist of built in fields, see
Reference: Basic Report Organization Options on page 155. For more information on custom fields, see
Creating Custom Fields on page 82.

4. Select the data columnsto include in your report. These include built-in and custom fields.
Select whether to use basic fields only or both basic fields and advanced fields from the Available Columns drop-
down menu. Use the blue arrows to add and remove selected data columns.
Note: The columns available in the list are determined by the organizational fields chosen in the step before.
5. Configure result sorting.
Select fields to sort by and whether to sort the datain ascending or descending order
Grouping and sorting options appear based on the data columns that you chose to include in the report. By defaullt,
the report is sorted by the organization field selected in the previous step.
6. Add afilter to show only results matching the entered value.
For detailed information on Consol€e's filters, please see Reference: Reporting Filters on page 158.
7. Createyour report. You can also run it at thistime.

» Click Create: Save the report without running it. Y ou are redirected to the Manage Report Types page
where you can see the new report in the list of reports. Custom reports have edit and delete links, which
differentiate them from Consol€'s built-in reports. Both custom reports and built-in reports include a copy link
for duplicating the report and arun link to view run settings and generate the report.

e Click Create and Run: Save the report and run it. The new report is added to the Manage Report Types page,
but first, you are redirected to the New Report page where you must finalize the report run settings and click
the Run Report button to run the report.

Creating an Advanced Report

The following instructions describe how to create advanced reports. To view an example of an advanced report, see
Advanced Report Example: Transfer Sessions with High Packet L oss on page 189. For more informationabout
creating basic reports, see Creating a Basic Report on page 77.

Important: Asperarecommends you read through the Advanced Report Usage Notes on page 170 before
configuring an advanced report.

1. GotoReports> Manage Report Types. Click the New Advanced button.
Note: You may also modify an advanced report by clicking the edit action for an advanced report that islisted on
the Manage Report Types page.

2. Enter aname for your report (limited to 75 characters) and a detailed description about the report.

3. Configure the SQL script text.
For information on available SQL variables or database field references, click on the Help link.
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SOl ScnptText CREATE TABLE $FIMAL_RESULT_TABLE
Help SELECT DISTINCT
T.name

t.contact

.last_source_ip AS “from®
.last_dest_ip AS "to’
.started_at

.stopped_at

.s5tatus
.bytes_transferred

.files complete

.files failed

.files skipped

wwwwwwwwww
oot oot ot oo

FROM
STEL_TRANSFERS t

WHERE
t.started_at < '$REPORT_PERIOD_END®
AND (
t.stopped_at »>= '$REPORT_PERIOD START'
OR t.stopped_at IS NULL
)

ORDER BY
t.started_at
, t.id

For alist of available reference variables, see:

* Reference: SQL Variablesfor Advanced Reports on page 159
» Reference: Database Fields for Advanced Reports on page 161,
« Creating Custom Fields on page 82

When creating advanced reports, you may specify a custom variable within the WHERE clause (for example,
$custom variable). Once declared within the SQL script text, you can to view and edit the variable by clicking
Edit Parameter s the Edit Advanced Report Template page. Y ou are prompted to enter avalue for the variable
when you run the report.

4. Optional: Add afilter in the WHERE section of your script.
For example, this example script filters out transfers that do not have a reported policy and transfers that do not
fall within the specified date range.

\HERE

ts.reported policy I'S NOT NULL
AND
ts.started_at < ' $REPORT_PERI OD_END
AND (

ts.stopped_at >= ' $REPORT_PERI OD START
OR ts.stopped_at IS NULL
)

For alist of available SQL variables you can use, Reference: SQL Variables for Advanced Reports on page
159.

5. Create your report. You can also run it at thistime.
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» Click Create: Save the report without running it. Y ou are redirected to the Manage Report Types page
where you can see the new report in the list of reports. Custom reports have edit and delete links, which
differentiate them from Consol€'s built-in reports. Both custom reports and built-in reports include a copy link
for duplicating the report and arun link to view run settings and generate the report.

« Click Create and Run: Save the report and run it. The new report is added to the Manage Report Types page,
but first, you are redirected to the New Report page where you must finalize the report run settings and click
the Run Report button to run the report.

Finalizing and Running a Report

Console requires you to finalize the report's run settings before running areport.

1

Y ou can initiate finalizing and running a report in the following ways:

» After configuring your basic or advanced report, click Create and Run.

« Goto Reports> Manage Report Types from the Console menu and clicking the run link From the Actions
column.

* GotoReports> Run a Report. Select abuilt-in or custom report from the list.

* Goto Reportsand click thererun link from the Actions column for a recently run report.

You are redirected to the New Report page.

Name the report.

Run the report now or schedule it to run later.

» Sdlect Run Now: Run this report immediately.

» Sdect Run Later: Schedule areport by setting the run date. Y ou may also select Repeat to schedule a
repeating report.

Define the report period.

Option Description
Report on Select a pre-defined time period from the drop-down list.
* last hour
o last 24 hours
o last week
* month to date
* last month
* custom
Start date Select the start date of this report. Y ou must select custom in the drop-
down menu to modify thisfield.
End date Select the end date of thisreport. Y ou must select custom in the drop-
down menu modify thisfield.
Time zone Select the time zone for this report.

Enter values for your custom SQL variables under Report Parameters. If there are no values, no custom
variables were specified for this report.

For more information on custom variables, see Editing Custom Variables on page 81.
Optional: Enter an email address and click the Add button to email arecipient a copy of this report.
After adding an email address, select whether the report is sent asan XLSX or aCSV file.

Optional: Choose additional file formats (XLSX and CSV). These files can be downloaded after the report has
been generated.

Click Run Report after finalizing your settings.
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Y our generated report is listed on the Scheduled and Recently Run Reports page. When viewing your report, you
have the following options:

» For acustom report, click Edit Report Type to configure report.
e Torunthereport again, click Rerun.
» If you chose to export your report in CSV or XLSX, click the respective button to download the files.

Editing Custom Variables

When creating advanced reports, you can specify a custom variable within the WHERE clause. For example, to create
asearch by contact, enter:

WHERE
contact = ' $CONTACT_MATCH ; # $CONTACT_MATCH is the custom vari abl e.

Once you declare the variable within the SQL script text, you can view and edit the variable on the Edit Advanced
Report Template page.

1. Toeditacustom SQL variable used in an advanced report, go to Reports and click the Manage Report Types
button. Find the advanced report and click edit. Click Edit Parameters.

2. Find the custom variable you want to configure and click edit.

3. Sdlect the desired variable type from the Type drop-down menu.

Variable Type Description

string The value of this variable must be a string.

integer The value of this variable must be an integer.

date The value of this variable must be avalid date. Click the calendar icon to select avalid
date.

ip The value of this variable must be avalid IP Address.

4. Optional: Allow the user running the report to leave the variable undefined by clearing I sfield required?. Custom
variables are required by default.

If Isfield required? is selected, a user running this report is required to enter avalue for the custom variable to

run the report.
Note: If the custom variableis not required and it is used with the AND operator, then write the report query as
follows:
WHERE
~AND (
t.status = ' $FCO
OR '"$FOO ="'
)
FaluretoincludeOR ' $FOO = "' resultsin an empty report because the dataisfiltered by t . st at us =

, whichisawaysfalse.

5. Optional: Define the variable name that is displayed when Console asks for the value of this variable.
For example, if you want to search by contacts and included a custom variable named $CONTACT _MATCH in
your SQL script, Console by default prompts the user running the report to enter avalue for "Contact Match." If
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you enter "User Name" in the Label field, Console asks for avalue called "User Name" instead and matches the
result to SCONTACT_MATCH.

6. Optional: Add ahint to remind the user the purpose of this variable.
Continuing the previous example, if your custom variable, SCONTACT_MATCH, is used to search your database
for contacts matching the value of this variable, a possible hint is: " Search by this CONTACT name."
When running the report, the user is prompted with the following:

Report Parameters

User Name
Search by this CONTACT name.

7. When finished, click Update.

Creating Custom Fields

Custom fields are used to specify rules for automatically populating fields in basic and advanced reports.

1. Goto Configuration > Custom Fields.
2. Click New Custom Field.

3. Select transfer or file from the Level drop-down list, depending on whether the new custom field stores transfer-
or file-related content.

4. Enter aname for the custom field. The name must be unique and lowercase.

The resulting SQL nameis prefixed with "cf_". For example, the field name "metadata’ appears as"cf _metadata’’.
Note: Custom fields appear in the database with the "cf_" prefix. Custom fields are utilized in the $TBL_FILES
and $TBL_TRANSFER tables.

Enter the start date (date on which to start custom field calculation).

Enter a custom field description.

Click Create.

Create and associate new rules for your custom field.

Rules are conditions that define when the custom field to comes into effect. To set up the rule's conditions,
configure the following settings:

» Sdect abuilt-in field from the drop-down list.

e Enter an operator.

e Enter an expression.

« Enter the value Console uses to populate the custom field if conditions are met.

© N o o

For alist of field names and definitions, see Reference: Built-In Fields for Custom Field Rules on page 155.

For example, to create a custom field that is popul ated with your company name, create a new custom field and
associate it with the following rule;
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Defaults Cookies Map S5H Keys Background Database Custom Fields License

= Editing Rule for Custom Field: company _name
Rule name My Comnpanmy

If the following conditions are met:

Built-in field NOT Operator Expression
Source Address v = r 10.0.0.1 remove
choose field. .. T

Then set the "company_name’ custom field value to:

Ny Company

For examples on using matchers, see Using Matchersin Custom Rules on page 157.
9. Click Create.
For each custom field, you can create multiple rules that populate with different values based on various conditions.

When multiple rules are present, Console uses thefirst rule listed (aslong as it matches the condition). To modify the
order of the custom field rules, use the drag-and-drop function to move the rulesin the list.

When creating an advanced report, you can find your available custom fields by clicking the Help link in the SQL
Script Text section.

SQL_ScnptText CREATE TABLE $FIMAL_RESULT_TABLE
| Help SELECT DISTINCT
t.name

, t.contact

.last_source_ip AS “from’
.last_dest_ip AS "to’
.started_at

.stopped_at

.s5tatus
.bytes_transferred

.files complete
.files_failed

.Tfiles _skipped

w
A

FROM
STEL_TRANSFERS t

WHERE
t.started_at < '$REPORT_PERIOD_END®
AND (
t.stopped_at »>= "$REPORT_PERIOD START'
OR t.stopped_at IS NULL

)

ORDER BY
t.started_at
, t.id
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For an example of using a custom field in a report, see Advanced Report Example: Transfer Sessions with High
Packet Loss on page 189.

Configuring SSH Keys

SSH Keys

SSH keys provide a more secure way to authenticate than using passphrases. Console generally uses SSH keys for
two purposes:

e Authentication to administer and configure a node.
* Authentication to make atransfer from one node to another.

Y ou can store keys and find alist of existing keys by navigating to the SSH Private Key pagein either of two
locations:

» Personal Preferences: Select Prefer ences from the drop-down menu next to your username in the upper right-
hand corner. Then, select the SSH K eys tab.

» Console Configuration: Go to Configuration > SSH K eys from the Console menu.
For more information on storing keys, see Storing SSH Keys on Console on page 84.

The stepsto using an SSH key differsif you are using an SSH key to make atransfer or using one to make a transfer
to nodes with endpoints that use SSH keys.

Using SSH Keys in Transfers

A user must add an SSH key in his personal preferences before he can use that key in atransfer. Even if the SSH key
is configured in Console Configuration settings, if the user did not the key in his personal preferences, the key does
not appear when he enters the credentials for a node to set up atransfer.

Making Transfers to Nodes With Endpoints that Use SSH keys

When making transfers to nodes with endpoints using SSH keys, the transfer user on the initiating node also needs
to have the private key in the .ssh folder. For awalkthrough of this process, see Transferring Files with an Endpoint
Using SSH Keys on page 85.

Storing SSH Keys on Console

Console uses a node machine's private key to authenticate into the machine using public key authentication. You
must first store in Console the private key paired with the public key on the node machine. Y ou can store private
keys privately in your user preferences or globally in Console configurations. These SSH keys can then be used to
authenticate endpoints or transfers.

1. Gotoyour private SSH keys or Console's stored SSH Keys.

« Personal Preferences. Select Preferences from the drop-down menu next to your username in the upper
right-hand corner.
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Then, click the SSH Private K eys tab.
» Console Configuration: Go to Configuration > SSH Keys.

Click New SSH Private Key.

Enter a descriptive name to represent the SSH key in Console.

Enter the filename of the key on the initiating node in the Filename on node field.

To usethiskey in atransfer, Console searches the initiating node for afile that matches the filename given.

Y ou can enter the filename with or without the full path. For example, Console accepts both my- ssh- key and
pat h/t o/ my-ssh- key.

Make sure you or the node administrator uploads the SSH key to the node or nodes from which you want to
initiate transfers.
Click Choose File to upload the same private key uploaded to the initiating nodes to Console.

If you do not have direct access to the node, you must ask the node administrator to give you the private key. This
key is used to browse and configure the node.

Enter and confirm the passphrase of the key, if any.
Click Save.

Click Test to test the new SSH private key.
Provide the following information:

« The address of the computer that has the paired public key installed in their authorized keysfile.
e The corresponding user name.

Then, click Connect with SSH Key to test against the computer.

Tip: If the connection fails, contact the node administrator to make sure the public key is properly installed in the
authorized_keysfile.

Transferring Files with an Endpoint Using SSH Keys

The objective of thisexampleisto set up two nodes in Console to transfer files from one node to the other using
public key authentication.

User A: Transfer user found on Node A.
User B: Transfer user found on Node B.
Node A: The node initiating the transfer. This node holds the private key.

Node B: The node receiving the files. This node holds the public key matching the private key in Node A. We set
up an endpoint using SSH keys for this node.

Note: For the purpose of this example, both nodes are Linux machines.

1. Generate aprivate key as User A on Node A with the following command:

# ssh-keygen -t rsa

Choose the default location to store this new private key (Default is~/ . ssh).
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2. Make sure User A hasread and write permissions for the private key file.

$ chnmod 600 ~/.ssh/id rsa
$ chnod 644 ~/.ssh/id _rsa. pub

3. Copy the SSH public key into User B'sauthorized_keysfile on Node B.

# cat ~/.ssh/id_rsa.pub >> ~./ssh/authorized_keys

4. In Console, add Node A as a managed node and Node B as an unmanaged node.

5. Goto Configuration > SSH Keys and upload the private key to Console. This key should be paired with the
public key copied to Node B.

6. Goto Nodes and edit Node B. Click Endpoints and add a new endpoint. Choose to use the SSH key that was
uploaded to Console.

7. Make atransfer from User A on Node A to the saved endpoint on Node B.

Working With SSL

Installing a Signed SSL Certificate Provided by Authorities

In adefault IBM Aspera Console installation, Apache generates and uses a self-signed SSL certificate. Install asigned
certificate provided by authoritiesto secure your server.
1. Generate your Private Key (. key) and Certificate Signing Request (CSR) (. csr ):

a) Runthefollowing openssl command, where key name is the name of the unique key that you are creating
and csr_name is the name of your CSR:

$ openssl req -new -nodes -newkey rsa: 2048 -keyout key nane. key -
out csr_nane. csr

b) Configure the certificate's X.509 attributes.

Important: The Conmon Nane field must befilled in with the fully qualified domain name of the server
to be protected by SSL. If you are generating a certificate for an organization outside of the US, see https://
www.iso.org/obp/ui/#search/code/ for alist of 2-letter, SO country codes.

For example:

Generating a 1024 bit RSA private key
++++++

You are about to be asked to enter information that will be incorporated
into your certificate request.

What you are about to enter is what is called a Distinguished Name or a
DN.

There are quite a few fields but you can | eave sone bl ank

For some fields there will be a default val ue,

If you enter '.', the field will be |left blank.

Country Nanme (2 letter code) [US]: US

State or Province Nane (full name) [Sone-State]: CA

Locality Name (eg, city) []: Emeryville

Organi zati on Name (eg, conpany) [Internet Wdgits Pty Ltd]: |BM Aspera
Organi zational Unit Nane (eg, section) []: ASP

Conmon Nane (i.e., your server's hostnanme) []: faspex.asperasoft.com


http://www.iso.org/iso/english_country_names_and_code_elements
http://www.iso.org/iso/english_country_names_and_code_elements
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Emai | Address []: faspex@sperasoft.com

¢) When prompted, you can enter extra attributes, including an optional challenge password.

Manually entering a challenge password when starting the server can be problematic in some situations (for
example, when starting the server from system boot scripts). Y ou can skip entering values for any extra
attribute by hitting the Ent er button.

Enter the following '"extra' attributes
to be sent with your certificate request
A chal | enge password []:

An optional conpany nanme []:

After finalizing the attributes, the private key and CSR are be saved to your root directory.
Important:

« |f you make a mistake when running the OpenSSL command, discard the generated files and run the command
again.

» After successfully generating your key and Certificate Signing Request, secure your private key, asit cannot
be re-generated.

. Send CSR to your signing authority.
Y ou now need to send your newly generated, unsigned CSR to a Certifying Authority (CA). Once the CSR has

been signed, you have areal certificate. Follow the key provider's instructions to generate and submit both your
private key and the Certificate Signing Request (CSR) to acquire the certificate.

Important: Some Certificate Authorities provide a Certificate Signing Request generation tool on their Website.
Check with your CA for additional information.

. If your CA returnsthe SSL certificatesto you in PFX (. pf x) format, usethe openssl command convert the
certificatesto PEM (. pen) format:

# openssl pkcsl1l2 -in path/to/pfx_cert_nanme. pfx -nocerts -out path/to/
key_nane. key -nodes

# openssl pkcsl2 -in path/to/pfx_cert_nane. pfx -nokeys -out path/to/
cert_name.crt -nodes

. Store your certificates on your server.

For example:

e ~/my_server.crt

e ~/my_server. key

Y our certificate provider may require you to also install an Intermediate CA Certificate file. Copy thefileto/
opt / asper a/ cormon/ apache/ conf/ server-ca. crt

. Install the SSL certificate with the following command:

# asctl
apache:install _ssl _cert cert file path key file path [chain _file_path]

For example:

# asctl apache:install _ssl_cert ~/ny_server.crt ~/ny_server.key /opt/
asper a/ conmon/ apache/ conf/ server-ca. crt

You can find the installed certificate and key at the following locations:

« /opt/asperal/ conmon/ apache/ conf/server.crt
e /opt/asperal conmon/ apache/ conf/server. key
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Generating and Installing a New Self-Signed SSL Certificate

Generate a self-signed certificate if you don't plan on sending your certificate to be signed by a Certified Authority
(CA), or if you want to test your SSL implementation while waiting for the CA to sign your certificate.

A self-signed certificate is atemporary certificate that is valid for 365 days. Self-signed certificates are not meant to
be used in your production environment. Users accessing your server are warned by their browser warn them that
your server isnot secure.

By default, IBM Aspera Console uses a generated, self-signed certificate as a placeholder until you caninstall a
certificate signed by authorities.

Y ou can find the installed certificates at:

» /opt/asperalcommon/conf/server.crt
» /opt/asperalcommon/conf/server.key

Generate a self-signed certificate using openssl command, where key _name is the name of the unique key that you
are creating and cert_name is the name of your certificate file:

# openssl x509 req -days 365 -in csr_nane.csr -signkey key nane. key -
out cert_name.crt

Regenerating Self-Signed SSL Certificate (Apache)

When you initially set up Console on your system a pregenerated, self-signed SSL certificate isalso installed. If you
have changed your Apache hostname, regenerate the self-signed certificate by following the instructions below.

1. Open atermina window and run the asctl command.

In atermina window, run the following command to generate a new, self-signed SSL certificate for your
installation of Aspera Console (where you will replace the HOSTNAME with your Apache server's | P address or
host name):

$ asctl apache: nake_ssl _cert HOSTNAME

Answer yes when prompted to overwrite the existing certificate.
2. Confirm that your certificates are updated.

Check the following location to confirm your self-signed SSL certificates have been updated:

« /opt/asperalcommon/apache/conf/server.crt
 /opt/asperalcommon/apache/conf/server.key

Working with Shares and Directory Services

Console and Shares on Same Machine

Important: Thistopic assumesthat you have already installed Shares. If you have not installed Shares yet, please
see the IBM Aspera Shares Administrator's Guide.

If you installed Console on the same machine as Shares, you must update the host and port settings in Shares
dat abase. yni file. Your database.yml file can be found in the following directory:

[ opt / asper a/ shar es/ u/ shar es/ confi g/ dat abase. yni

Open database.yml with atext editor and perform the following modifications:


http://downloads.asperasoft.com/en/documentation/34
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e Comment out the socket location.
e Changethe host to 127.0.0.1.
e Change the TCP port to 4406.

After performing these modifications, your dat abase. ym file should look similar to the example below.

producti on:
adapter: nysql 2
encodi ng: utf8
reconnect: false
dat abase: web_production
pool: 5
user nanme: adnin
password: v00d0O
# socket: /tnp/nysql.sock
# socket: /var/lib/mysqgl/nysql.sock
host: 127.0.0.1
port: 4406

Configuring the Directory Service

Important: You mustinstall Shareslocally or on aremote host before you can configure adirectory service. For
information on installing the latest version of Shares, please review the Administrator's Guide.

Before continuing, please ensure that the following prerequisites have been satisfied:

« Sharesisinstaled locally or on aremote host: For instructions on how to install Shares on the same machine as
Console, see Console and Shares on Same Machine on page 88.

» Consoleisinstalled on the same machine as Shares: Configure your Shares web server to use a non-standard
HTTPS port (for example, 8443, rather than 443). See the Shares Administrator's Guide (the " Setting up Shares’
topic).

» Consoleisinstalled on the same machine as Shares: Configure your Shares database with the correct host and port
settings. For more information, see Working with Shares and Directory Services on page 88.

1. Go to Accounts> Directories from the Console menu.

2. Select Remote Authentication to enable remote authentication so that Console can access the groups and users
on your Shares server.

3. Enter the base URL.
Shares users and groups are authenticated through this Node API base URL. The standard base URL is
https://shares_| P_address/api/vl.
Note: Because you must use HTTPS to connect to your Shares directory service, ensure that your Node APl base
URL usesHTTPS, rather than HTTP.

4. Enter the admin Shares user with API login capabilities. Y ou can set API login abilities for a user from the Shares
Admin page (Admin > Users > username > Security > API login).

5. Click Save and test settings.

Once the directory service is successfully connected, you can add remote users and remote groups by boing to Users
> Groups. For more information, see Adding Remote Users on page 89 and Adding Remote Groups on page
90.

Adding Remote Users

1. Go tothe Users menu. Click Add Remote User.

Note: The Add Remote User button does not appear if you have not configured the directory service.
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2. Enter thefull or partial name of an existing remote user. Click Sear ch.
3. Once your search results appear, select the remote user by clicking Add.
4. Configure the remote user's Console permissions and assign the user to a group.

Adding Remote Groups

1. Goto Groups. Click Add Remote Group.

Note: The Add Remote User button does not appear if you have not configured the directory service.

2. Enter thefull or partial name of an existing remote user. Click Sear ch.
Note: Console does not find remote groups that start with abackslash (\) or an asterisk ( * ). Avoid naming
groups that start with these characters.

3. Once your search results appear, select the remote group by clicking Add.

4. Configure the remote group's transfer paths and members.

Working with SAML

SAML and Console

IBM Aspera Consol e supports Security Assertion Markup Language (SAML) 2.0, an XML -based standard that
allows secure web domains to exchange user authentication and authorization data. With the SAML model, you

can configure IBM Aspera Console asa SAML online service provider (SP) that contacts a separate online identity
provider (1dP) to authenticate users. Authenticated users can then use IBM Aspera Console to access secure content.

With SAML enabled, IBM Aspera Console redirects a user to the IdP sign-on URL. The user signsin with the

IdP and the IdP sends a SAML assertion back to IBM Aspera Console. When a SAML user logsinto IBM

Aspera Console for the first time, IBM Aspera Console automatically creates a new user account based on the
information provided by the SAML response. Any changes subsequently made to the account on the DS server are
not automatically picked up by IBM Aspera Console. For more information about user provisioning for SAML users,
see User Accounts Provisioned by Just-In-Time (JIT) Provisioning on page 91.

IdP Requirements

To use SAML with IBM Aspera Console, you must already have an identity provider (IdP) that meets the following
requirements.

e Supports SAML 2.0

e Abletousean HTTP POST Binding.

« Ableto connect to the same directory service that IBM Aspera Console uses.

* Not configured to use pseudonyms.

e Canreturn assertionsto IBM Aspera Console that include the entire contents of the signing certificate.
e |If prompted, set to sign the SAML response. (Signing the SAML assertion is optional.)

Configure the SAML IdP

Before configuring SAML in IBM Aspera Console, make sure you configure your 1dP to send a correct SAML
response to IBM Aspera Console. For more information, see Configuring Y our Identity Provider (IdP) on page
92.

For instructions on configuring SAML, see Configuring SAML on page 92.
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SAML and Directory Services

IBM Aspera Console supports the use of both SAML and directory services. If you configure both servicesto IBM
Aspera Console, ensure the services use different Active Directory domains. Aspera advises against configuring
LDAP directly to IBM Aspera Console if the SAML IdP acts as a frontend for the same Active Directory domain.

Bypassing the Default SAML IdP

IBM Aspera Console provides a mechanism for users to bypass the SAML redirect and log in using alocal username
and password. This feature allows admins to correct server settings, including a mis-configured SAML setup, without
logging in through SAML.

To bypassthe SAML login, add | ogi n?l ocal =t r ue to the end of the login URL. For example:
https://198.51. 100. 48/ 1 ogi n?l ocal =t rue

User Accounts Provisioned by Just-In-Time (JIT) Provisioning

When a SAML user logsinto IBM Aspera Console for the first time, IBM Aspera Console automatically creates a
new user account based on the information provided by the SAML response. If the SAML response also contains
group information, and that group does not yet exist in IBM Aspera Console automatically creates anew SAML
group for each group of which the user is amember. For more information about SAML groups, see Creating SAML
Groups on page 93.

Existing Local Users and Local Groups

When a SAML user first logsin, IBM Aspera Console creates anew IBM Aspera Console SAML user account for
the SAML user. IBM Aspera Console cannot create that account if alocal user account with the same name already
exists. You must first delete the local user (so that IBM Aspera Console can create the user account) before the
SAML user canlogin.

Whenever a SAML user logsin, IBM Aspera Console updates the user's SAML group memberships:

SAML directory (IdP) IBM Aspera Console Result User allowed to log in?
groups
The SAML user isa A SAML group with the IBM Aspera Console Yes
member of a SAML group | same name does not exist | createsa SAML group with
in IBM Aspera Console the same name and adds
the associated SAML user
account to the group
The SAML user isa A SAML group with the IBM AsperaConsoleadds | Yes
member of a SAML group | same name already exists | the associated SAML user
in IBM AsperaConsole account to the IBM Aspera
Console SAML group
The SAML user isnot a The SAML user account IBM Aspera Console Yes
member of aSAML group |[inIBM AsperaConsoleis |removes the associated
part of a SAML group SAML user account from
the SAML group
The SAML user isa A local group with the IBM Aspera Console No
member of a SAML group | same name already exists | cannot create the SAML
in IBM Aspera Console group. An admin must
delete the local group or
convert the local group to
a SAML group before the
SAML user canlogin
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IdP Requirements

To use SAML with IBM Aspera Console, you must already have an identity provider (IdP) that meets the following

reguirements:
e Supports SAML 2.0

e Abletousean HTTP POST Binding.
« Ableto connect to the same directory service that IBM Aspera Console uses.
» Not configured to use pseudonyms.
e Can return assertionsto IBM Aspera Console that include the entire contents of the signing certificate.
e |If prompted, set to sign the SAML response. (Signing the SAML assertion is optional.)

IdP Metadata Formats
Y ou must configure formats to set up your 1dP to work with IBM Aspera Console:

Tag Format

Entity ID https.//server_name_or_ip/aspera/consol e/auth/saml/metadata
ACS https.//server_name_or_ip/aspera/consol e/auth/saml/callback
Base URL https://server_name _or_ip/aspera/console

If the IdP is capable of reading SAML XML metadata for a service provider, you can upload a saved XML metadata
file to configure the IdP. Y ou can retrieve the XML metadata for an existing IBM Aspera Console by going to
https://server_i pasperal/ consol e/ aut h/ sam / met adat a and saving the XML asan XML file.

SAML Assertion Requirements

IBM Aspera Console: expects assertion from an 1dP to contain the following elements:

Default Attribute

IBM Aspera Console User Field

Required

Nanel D/ SAML_SUBJECT Username Y es, with the format:
urn:oasis: names:tc: SAM.: 1.
format: unspecified

emai | Email address Yes

gi ven_nane First name Optional

sur nane Last name Optional

menber _of SAML group Necessary for SAML groups

Configuring SAML

Before following the instructions below, have the following information on hand:

e |dP Single Sign-On URL (SSO)
* |dP Certificate Fingerprint

w DN P

Go to Accounts> SAML to open the SAML Configuration page.
Select SAML Authentication.
Enter the |dP SSO Target (Redirect) URL.

1: nanei d-
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4. Allow access to Console through the redirect URL by adding the URL to the Accept edHost s listin (/ opt /
asper a/ consol e/ confi g/ consol e. ym ).

For more information, see Allowing Access to Console at Defined Hostnames on page 13.
5. Enter the certificate fingerprint.
6. Choose the certificate fingerprint algorithm that matches the certificate fingerprint.
7. Click Save.

Creating SAML Groups

Y ou can create SAML groupsin Console without waiting for a SAML user in a SAML group to log in. Console
verifies membership in the SAML group when the memberslog in with their SAML credentials.

SAML groups are created when:

* Anadmin creates a SAML group in the web application.
« Anadmin convertsalocal group into a SAML group in the web application.
e A SAML user that isamember of a SAML group logsin using SAML credentials.

After creation, you can add pre-existing SAML usersto the group.

For more information, see User Accounts Provisioned by Just-In-Time (JIT) Provisioning on page 91.

Create a New SAML Group

1. Goto Accounts> Groups.

2. Click New Group to create a SAML group.

3. Select SAML from the Directory drop-down menu.
4. Click Createto create the SAML group.

Convert an Existing Local Group to a SAML Group

1. Goto Accounts> Groups.
2. Click edit for an existing group and select SAML from the Directory drop-down menu.
3. Click Update.

Convert a SAML Group to a Local Group

1. Goto Accounts> Groups.
2. Click edit for an existing group and select L ocal from the Directory drop-down menu.
3. Click Update.

Note: If you convert aSAML group to alocal group, and a SAML user is part of a SAML group with the same
name, that SAML user cannot log into Console. For more information, see User Accounts Provisioned by Just-In-
Time (JIT) Provisioning on page 91.

Backing Up Console Database

Back Up Console with asctl

There are two different ways to back up the Console database:

1. Throughtheasct| command, which backs up only the MySQL database. Use this method before a Console
upgrade procedure, or to guard against possible database corruption.
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2. Through the Console web Ul, which backs up the MySQL database in addition to all the files required to fully
restore the Console application. Use this method for disaster recovery purposes, in order to restore Console when
the entire server islost.

Back up Consol€e's database using the following asct | command in a Terminal:
$ asctl -v consol e: backup_dat abase
This command uses mysgldump to create Console's MySQL database backup. The backup file, aspera_console.sgl,

issaved in the following directory:/ opt / asper a/ consol e/ backup/ <year - nont h- day_t i ne> For
instructions on restoring your Console database, see Restoring the Console Database on page 94.

Backing Up Console with the Web Ul

There are two different ways to back up the Console database:

1. Throughtheasct| command, which backs up only the MySQL database. Use this method before a Console
upgrade procedure, or to guard against possible database corruption.

2. Through the Console web Ul, which backs up the MySQL database in addition to all the files required to fully
restore the Consol e application. Use this method for disaster recovery purposes, in order to restore Console when
the entire server islost.

1. Select Configuration > Database from the Console menu. Click Back Up.

2. Enter the desired path of the Console machine into the Save to field. This path is the destination folder for the
console full_backup_YYYY-MM-DD_hhmmss backup file.

3. Schedule the backup to Run Now or to Run L ater.

* Click Run now: Back up the database immediately.
e Click Run later: Specify atime in the future or configure a repeating backup operation.
4. Click Back Up Now.

Once Console has been backed up, the backup file appears on the Database Backups page, where scheduled, current,
and recent backups are listed. To view details on a particular backup, click anywhere in the backup's row.

Restoring the Console Database

Y ou can restore any back up of a Console database as long as you have access to the backup file.

1. Stop Console.

$ asctl consol e: stop

2. Restore the Console database.

» If you made a back up of the Console database with the asctl command, you can restore it with the following
command:

$ asctl -v consol e:restore_database /path/to/dir
For example:

$ asctl -v consol e: restore_dat abase /opt/asperal consol e/
backup/ 2013- 1- 16 164305



| Managing the MySQL Database | 95

» |If you made a back up of the Console database with the web Ul, you can restore it with the following
command:

$ asctl -v console:restore /absolute/path/to/dir
For example:

$ asctl -v console:restore /tnp/
consol e full backup_2013-1-16 00.57.28 UTC

Important: The restore command does not support relative paths to the backup directory. The path must be
an absolute path in order for the restore command to work.

3. Start Console.

$ asctl consol e:start

Managing the MySQL Database

Configure MySQL Settings

Y ou may want to modify the MySQL settings for security or management purposes.

Change the Database root Login Password

MySQL database's root account's password is set during the setup process. For security reason, it is recommended
to update the password. Use the following command to change the password. Enter the new and old password when
prompted:

$ asctl nysql:set_root_password

Change the MySQL Port
By default, Console's MySQL uses TCP port 4406. Use the following command to change it.

$ asctl nysql:port 1234

If the MySQL's port number is changed, you will need to provide the updated Console settings to al the nodes, and
reflect the new settingsin all the nodes asper a.conf files.

Using IBM Aspera MySQL on a Separate Machine

Install the MySQL database included in the IBM Aspera Common Components on a remote server, and configure
Console to connect to the remote MySQL database.

1. On the remote server, download and install only the IBM Aspera Common Components.
Run:

$ rpm - Uvh asper a- conmon- ver si on. r pm

2. Ontheremote server, set up the MySQL database:
a) Run:

$ asctl nysql:setup
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b) Choose streamlined or detailed setup. The prompts for each setup are listed in thistable:

[tem Streamlined | Detailed
MySQ will run on this nmachine (y/n)? (default: vy) X
What port would you like MySQ to |isten on? X X
(default: 4406)

Where woul d you |ike MySQ. to store data: X

(default: C. /Programfiles/Comron Fil es/ Asperal
Conmon/ nyql / dat a)

MySQ. will need to start/restart during X X

configuration. Continue (y/n)? (Current: vy)

¢) Lastly, asetup summary shows your settings. Enter y to confirm, n to change settings, or x to quit the program
without saving.

. When finished, execute this command to give Console access to the database using the given MySQL credentials:

$ asctl
mysql : grant _renote_access consol e_server i p nysqgl _usernane nysql _password

Note: The default usernameisr oot .
. On the Console server, configure Console to use aremote MySQL database.

$ asctl consol e: setup

Answer n to the following question:
MySQL will run on this machine (y/n)? (default: y)
. On the Console server, configure Console to use the remote database.
a) Back upthe/ opt/ aspera/ cormon/ mysql / dat abase. rb. ym files.
b) Edit/ opt/asperal/ common/ nysql / dat abase. rb. ym .
Change:
* host tothelP address of the remote database.
e port tothe MySQL port (4406, by default).
e passwor d to the remote MySQL database password.
e user totheremote MySQL database user.

Note: By default, thereisno user field. Console defaultsto ther oot user. Add anew lineto configure a
different, non-root user. For example, : user: renote_consol e_user.

For example:

- host name: 54.182. 111. 111
iport: 4406
:task status:

- user: renpt e_consol e_user
s password: XRs9sJFF5j alBAd KHYLwz Q==
:setup_conpl ete: true

Save your changes.
¢) Edit/ opt/asperal/ consol e/ confi g/ dat abase. yn .
Locatethe pr oduct i on and pr oduct i on_r epor t s sections and change:
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* host tothelP address of the remote database.

e port tothe MySQL port (4406, by default).

e user nane to the remote MySQL database user.

e passwor d to the remote MySQL database password.

Note: By default, Console uses different users and passwords for the pr oduct i on and

producti on_reports environments. To follow the same design, repeat the steps to grant access
for a separate user that is dedicated to the pr oduct i on_r eport s environment (for example,
aspera_consol e_report s inthefollowing example).

For example,

producti on:
reconnect: true
encodi ng: utf8
port: 4406
adapt er: nysql
user name: renote_consol e_user
charset: utf8
dat abase: aspera_consol e
host: 127.0.0.1
collation: utf8 general ci
password: XRs9sJFF5j alBd KHYLwz Q==
production_reports:
reconnect: true
encodi ng: utf8
port: 4406
adapt er: nysql
usernane: renote_consol e_reports
charset: utf8
dat abase: aspera_consol e_reports
host: 127.0.0.1
collation: utf8_general _ci
passwor d: DDf UM 3FAdHbw Rt +BQR==

Save your changes.
6. Shut down the local MySQL database and restart all other Console services.

# asctl nysql:disable
# asctl all:restart

Connecting Console to MySQL Running on a Separate Server

1. Set up the remote database on another server.
2. On the Console server, stop Console services and back up the local database:

# asctl consol e: stop
# asctl consol e: backup_dat abase
3. Copy the generated backup to the remote server.
4. On theremote server, grant remote access privilegesto Console:

nysql > CREATE USER ' nysql _user' @onsol e_server_i p_address'
| DENTI FI ED BY ' nysql _password'; GRANT ALL PRI VILEGES ON *.* TO
"root' @consol e_server i p_address' WTH GRANT OPTI ON; FLUSH PRI VI LEGES;
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For example:

mysgl > CREATE USER 'renote _consol e _user @10. 0. 174. 47" | DENTI FI ED
BY ' XRs9sJFF5j alBA KHYLwzQ=="; GRANT ALL PRI VILEGES ON *.* TO
‘renpte_consol e_user @10. 0.174. 47" W TH GRANT OPTI ON;, FLUSH PRI VI LEGES;

5. On the remote server, migrate the Console database to the remote database using the Console backup:

# [ opt/ asperal/ comon/ nysql / bi n/ mysql -h renote_server i p_address -P port -
unmysql _username -pnysql _password < path/to/ consol e/ db/ backup

Note: The default MySQL port is 4406.

For example:

# [ opt/ asperal/ common/ nysql / bi n/ nysql -h 54.182.111. 111 -P 4406 -uroot -
pt opsecret < /opt/asperal consol e/ backup/ 2015-07-01 23458/ consol e. sql

6. On the remote server, verify that the migration was successful.
Log intothe MySQL database and view the contents of the new database:

# [ opt/ asperal/ common/ nysql / bin/nysql -h renote_server_ip_address -P port -
unmysql _user name -pnysgl _password

mysgl > use aspera_consol e;

nysql > show tabl es;

mysgl > select * fromfasp_nodes;
mysgl > use aspera_consol e reports;
mysgl > show t abl es;

7. On the Console server, configure Console to use the remote database.

a) Back upthe/ opt/ asperal/ conmon/ nysql / dat abase. rb. ym files.
b) Edit/ opt/asperal/ conmon/ nysql / dat abase. rb. yn .

Change:
* host tothelP address of the remote database.
e port tothe MySQL port (4406, by default).

e passwor d to the remote MySQL database password.
e user totheremote MySQL database user.

Note: By default, thereisno user field. Console defaultsto ther oot user. Add anew line to configure a
different, non-root user. For example, : user: renote_consol e_user.

For example:

‘host nane: 54.182.111. 111
iport: 4406
:task status:

- user: renot e_consol e_user
i password: XRs9sJFF5j alBE KHYLwz Q==
:setup_conplete: true

Save your changes.
¢) Edit/ opt/asperal/ consol e/ confi g/ dat abase. yni .

Locate thepr oduct i on and pr oduct i on_r eport s sections and change:

* host tothelP address of the remote database.



8

| Managing the MySQL Database | 99

e port tothe MySQL port (4406, by default).
e user nane to the remote MySQL database user.
e passwor d to the remote MySQL database password.

Note: By default, Console uses different users and passwords for the pr oduct i on and

producti on_reports environments. To follow the same design, repeat the steps to grant access
for a separate user that is dedicated to the pr oduct i on_r eport s environment (for example,
aspera_consol e_report s inthefollowing example).

For example,

producti on:
reconnect: true
encodi ng: utf8
port: 4406
adapt er: nysql
usernanme: renote_consol e_user
charset: utf8
dat abase: aspera_consol e
host: 127.0.0.1
collation: utf8_general _ci
password: XRs9sJFF5j alBA KHYLwz Q==
production_reports:
reconnect: true
encodi ng: utf8
port: 4406
adapt er: nysql
usernanme: renote_consol e_reports
charset: utf8
dat abase: aspera_consol e_reports
host: 127.0.0.1
collation: utf8 general ci
passwor d: DDf UM+ 3FAdHbw Rt +BQR==

Save your changes.
. Shut down the local MySQL database and restart all other Console services.

# asctl nysql:disable
# asctl all:restart

If you need to restore the original configuration to use the local MySQL database, revert the. ym files and then run:

Purg

# asctl nysql:setup

ing Data from Console Ul

Y ou can archive or purge data from Console (for example, purge all sessions before January 1, 2000) by clicking the
Pur ge button from the Database Backups page and completing the fields.

1

Schedule Console to purge the data now or at alater date.

* Run now: Purge the database immediately.

« Run later: Specify atimein the future or configure a repeating purge operation.
Select time frame of datato purge.

Choose the date by entering a number and selecting day, week, or month from the drop-down menu. Make sure
the automatically updated date displayed next to the drop-down menu is the desired day before proceeding.

Choose the type of transfersto include.
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Select All closed transfers or choose from the following list:

e All successful transfers
e All cancelled transfers
e All error transfers
e Allinactivetransfers
e All zero-byte transfers
4. Save the data being purged for archiving purposes.

Select Save data being purged? and enter the desired absolute path into the Saveto field (for example, /tmp/
data or D:\data\). The purged datawill then be stored in the file purged_data.sgl in the directory: [ absol ut e
pat h] / consol e_pur ge_YYYY- MM DD_hhnmmss/ .

Tip: Saved purged data can be restored by following the instructions in Restoring Purged Data on page 100.

5. When finished, click the Purge Now or Schedule Pur ge button (depending on whether you selected Run now or
Run later above).

Purging Data from the Command Line

Usetheasper a: db: ar chi ve command to purge data from the Console database.

Runther ake task using theasct | command:
# asctl --trace consol e:rake aspera: db: archi ve

Y ou can also use the BEFORE option to purge data from before a specific date.
For example:

# asctl --trace consol e:rake aspera: db: archi ve BEFORE=2019-07- 01

Restoring Purged Data

If you selected Save data being purged? when you purged Console data using the U, you can restore purged data
with aMySQL dataimport.

1. Stop Console services.

# asctl consol e: stop

2. Import saved datainto MySQL:

It may be necessary to provide afull path to the MySQL binary. For example, the full path to the command is/
opt / asper a/ cormon/ nysql / bi n/ mysql .

# cd /opt/asperal/ conmon/ nysql /bin
# nysql - uUSERNAME - pPASSWORD aspera_consol e < /path/to/ purged_dat a. sql

3. Start Console services.

# asct| console:start
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Updating your Console License

IBM Aspera Console requires avalid license key before you can configure users and send or receive packages. If
your Console license has expired or cannot be found, the Console login screen displays the following message:

Console license not found
Only admin logins permitted until this problem is resolved.

Aspera Console Login

Username

Password

An administrator must update the license before any other usage of Consoleisallowed for any user, including the

administrator.

The license can be updated in the Console web Ul or by running arake task on the computer where Consoleis

installed.
From the GUI:

1. Login with an administrator account and go to Configuration > License.
2. Click Upload alicensefile or paste the license text into the text window.
3. Click Save.

From the Command Line (Rake task):

1. Set thelicense text as an environment variable.

# export LI CENSE TEXT=' <ASPERA LI CENSE> <DETAI LS expiration_date=... </

KEY> </ ASPERA_ LI CENSE>'

In this example, only part of the license text is shown. Y ou must paste the entire license text for the license to be

valid.
2. Update the Asperalicense:

# asctl consol e:rake aspera:update_|icense
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Restart Console Services

If Consoleis not working properly, it is recommended you restart the Console service utilizing theasct | command,
so that Apache and MySQL continue to run uninterrupted. If the Console server's MySQL service is stopped, then
Aspera Central will need to be restarted on all nodes to re-establish a connection.

Console installs the following services on your Linux system:

Service Description

Apache HTTPD Server Apache Server for Aspera Console.
(Aspera)

Aspera Console Aspera Console main application.

MySQL Server (Aspera) MySQL Database for Aspera Console.

Right-click any of these services select Restart from the menu.

Execute the following asct | command to restart Console (while keeping Apache and MySQL running):
$ asctl console:restart

For more asctl commands, see asctl Command Reference on page 111

Resetting Console Admin Password

To reset Consol€e's administrator password, execute the following asctl command in a Terminal, replacing name with
your existing admin login, email with the current admin password, and password with the new admin password.:

$ asctl consol e: admi n_user nane enmil password

Encrypting and Decrypting Database.yml

Thedat abase. yn file contains passwords to Console components including its MySQL database. Console
automatically encrypts these passwords so that they are not stored in plain text. Console also supports two rake tasks
to encrypt or decrypt all passwordsin thefile.

If you made manual changesto the dat abase. yni file, you can run the following command to encrypt all
unencrypted passwords:

# asctl consol e:rake aspera: db: encrypt dat abase_passwor ds

If you want to see the passwords in plain text, you can run the following command to decrypt all encrypted
passwords:

# asctl consol e:rake aspera: db: decrypt _dat abase_passwor ds

Log Files

Consol€e'slog files are located in the following directories:
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OSVersion Path

Linux » Console: /opt/asperal/console/log/

e asctl: /opt/aspera/common/asctl/asctl.log

e MySQL: /opt/aspera/common/mysgl/data/mysgld.log
« Apache: /opt/asperalcommon/apache/l ogs/

In Consol€e's Apache HTTP server logs directory, you will find the following files:

e access log

e error_log

e sd_access log

e sd _eror_log

e sd request log

Important: All Apache logs are, by default, rotated by size (defaulting to 10MB files and only retaining the last 10
rotated logs).

httpd_template_linux.conf
[ opt / asper a/ conmon/ apache/ conf/ httpd_tenpl ate_|inux. conf

» ErrorLog "[${log_path} bin/asrotatelogs ${log_path} logs/error_log 10M 10"
e CustomLog "|${10g_path} bin/asrotatelogs ${log_path} logs/access log 10M 10" common

httpd-ssl_template.conf
/ opt / asper a/ conmon/ apache/ conf/extra/ htt pd-ssl _tenpl at e. conf

» ErrorLog "|${log_path} bin/asrotatelogs ${1og_path}logs/sd_error_log 10M 10"

« TransferLog "|${10g_path} bin/asrotatelogs ${log_path} logs/ss_access log 10M 10"

e CustomLog "|${ log_path} bin/asrotatel ogs ${ 1og_path} logs/ssl_request_|og 10M 10" "%t %h
%{ SSL_PROTOCOL}x %{ SSL_CIPHER} x \"%r\" %b"

Y ou can further configure Consol€'s Apache log settings by running the following commandsin a Terminal:

Setting Command

Specify an Apache log level (for
example, error level) $ asct| apache:log_|l evel error

Enable Apache log (set to notice)
$ asctl apache: enabl e_| ogs

Disable Apache log (set to emerg L
level) $ asctl apache: di sabl e_I ogs

Locate Configuration Files

Important: Asperarecommends that you DO NOT modify Console's configuration files manualy. Instead, use
theasct | command. For additional information on utilizingasct| commands, see the topic asctl Command
Reference on page 111.

Consol€'s configuration files are listed below. If you plan to modify these files, Aspera encourages backing up
Console through the GUI or by using the asctl command. The asctl command is limited to backing up the Console
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database, while the GUI backs up the database, aswell as all files required to fully restore the system. For instructions
on backing up Console through the GUI, please see Backing Up Console with the Web Ul on page 94. To back
up Consol€e's database using the asctl command, please see Back Up Console with asctl on page 93.

Component Configuration File Path

Apache /opt/asperalconsol e/config/consol e.apache.conf
MySQL /opt/asperalcommon/mysgl/my.cnf

Console /opt/asperalconsol e/config/* .yml

Appendix

Disabling SELinux
SELinux (Security-Enhanced Linux), an access-control implementation, can prevent web Ul access.
To disable SELinux:

1. Openthe SELinux configuration file: / et ¢/ sel i nux/ confi g.
2. Locatethefollowing line:

SELI NUX=enf or ci ng
3. Changethe vaueto disabled:

SEL| NUX=di sabl ed

Save your changes and close thefile.

4. Onthe next reboot, SELinux is permanently disabled. To dynamically disable it before the reboot, run the
following command:

# setenforce O

Configuring Console Defaults

The Console Defaults configuration page lets you to set up system defaults for Console, such as IP address and SSH
timeout), as well as defaults for transfers (target rate, minimum rate, bandwidth policy, and so on) and login security.
To access the Console and Transfer Defaults configuration page, select Configuration > Defaults from the Console
menu.

Console Defaults

Item Description

Console database |P Enter the Console database | P address.

address

Warn when database free | The space watcher background jobs warns you when available space drops below the
space less than set number of gigabytes. Set to zero to disable space watcher warnings.

Skip non-error transfers If asubmitted transfer doesn't start after the specified number of minutes, then flag it

older than as having an error.
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Item

Description

Mongrel Timeout

Enter the number of seconds to wait for a response when testing mongrels.

Node Polling Timeout

Enter the number of seconds the SOAP Poller background process waits for aresponse
when testing a node.

Mark Inactive Timeout

Enter the number of seconds Console waits before marking a session as inactive.

Submitted Job Timeout

Enter the number of seconds Console waits before marking a submitted Console job as
inactive.

Note: If record processing is slow, transfers can inaccurately be reported with the
error: "DB never reported session end." To work around thisissue, increase the
submitted job timeout.

File Browsing Timeout

Enter the number of seconds to wait for aresponse from a node when browsing file
lists (over and above the SSH timeout to connect).

File Browsing Max Items

Enter the maximum number of items to retrieve from a node when browsing file lists.

Default SSH Encryption

Select the default SSH encryption algorithm for non-Console nodes.

Note: Console presents this algorithm as the standard, but you can change the
algorithm when adding a new node.

Remote Login Connection
Timeout

Enter the number of seconds Console waits before timing out when establishing a
connection to aremote server.

Remote Login Response
Timeout

Enter the number of seconds Console waits before timing out when waiting for the
remote server's response.

SSH Timeout

Enter the timeout value in seconds for the SSH connection.

SSH Tunndl Start Port

Start assigning SSH tunnel ports at the specified port number.

Advanced Search Timeout

Enter the timeout value in seconds before advanced search returns current results.

Email Notification Delay

Enter the number of seconds to wait after initiating a transfer before producing
notification emails.

Total Bandwidth Graph

Select this option to track total bandwidth usage across all notes on the Dashboard
graph.

Advanced File Search

Select this option to alow users to search the entire database for filenames when using
advanced search.

Note: This may slow down Console if your database contains alarge number of files.

Email Recipients

Select this option to allow email recipients to see each other's addresses.

Session notifications

Select this option to alow non-admins to access the session notifications page.

Smart Transfer Start
Permissions

Select this option to alow users whose transfer path includes "Any" or addresses
without a username to start any matching smart transfer that is shared and uses non-
personal endpoints. For example, userA is authorized to use atransfer path that has
one endpoint set to 10.0.123.45 and the other set to "Any". If userB's shared smart
transfer is set up with non-personal endpoints on 10.0.123.45 (source) and 10.0.111.11
(destination), it will appear in userA's smart transfers list and can be started by userA.

Smart Transfer Sharing

Select this option to alow users to share smart transfers with personal logins.

Smart Transfer Editing

Select this option to alow administrators to edit each other's smart transfers.
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Item

Description

Failover / Load balancing
Behavior

Select Failover + Load balancing for Console to use the least busy node(s) first. For
more information, see Configure Failover Groups on page 61.

Watchfolders

Enable the watchfolder feature in Console.

Watchfolders per page

Configure the number of watch foldersto display per page when browsing configured
watch folders.

Transfer Defaults

Item

Description

Target Rate

Set the default target rate.

Minimum Rate

Set the minimum rate.

Bandwidth Policy

Set the default transfer policy (choose among low, high, fair, and fixed).

Max. Retry Attempts

Set the maximum retry attempts.

Retry Interval

Set the retry interval in seconds.

Transport Encryption

Select between not-encrypted or aes-128 encryption.

File Compare Type

Select afile comparison type to verify transferred files.

File Overwrite Policy

Select an overwrite policy.

Report Generation

Item

Description

Retention Period

The number of days to keep generated reports before deleting them automatically.

Maximum Email
Attachment Size

The maximum size in megabytes of CSV/XLSX filesthat may be sent by email.
(Generated files can still be downloaded from the Reports page.)

File Maximum Data
Length

The maximum size in megabytes of the result table for which CSV/XLSX files may
be generated. (CSV/XLSX files are not generated if the result table is larger than this.)
This setting is useful for preventing Console from trying to convert a giant data set
into afile and running out of disk space.

Maximum XLSfilerows

The maximum number of rows allowed for generated XL Sfiles.

Security
[tem Description
Session Timeout Sessions will timeout after the specified number of minutes of inactivity.
Deactivate Users Deactivate a Console user if there has been " X" failed login attempts within X"

minutes.

Prevent concurrent login

If this checkbox is enabled, users can only be logged in from one client at atime.

Suppress logging of
transfer tokens

Select this option to suppress tokens from being written to the database. Existing
tokens already in the database are unaffected.
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Item Description

Note: After enabling this feature, you may experience some lag before the setting
takes effect if arequest isalready in progress and the node is taking along timeto

reply.

Console Password Options

Item Description

Password Expiration Select this option to expire number of days

Password Duration Enter the number of days before passwords expire. Setting the value to O will disable
this feature.

Password Reuse Limit Enter the number of passwords users need to go through before they can reuse an old
password. Setting the value to O disables this feature.

Password Requirement Enter aregular expression to specify password requirements. Leave blank to set no

Regular Expression requirements.

Note: You can select the Restore Default link to reset the password requirement to
the following: "Passwords must be at least six characterslong, with at least one letter,
one number, and one symbol."

Password Requirement Set a message describing the password requirements for users setting a new password.
Message

Empty sessions (successfully completed with 0 bytes transferred)

A zero-byte transfer occurs when an Aspera product initiates a transfer but finds that the file already exists at
the destination and that there are no changes between the source file and the file at the destination. If Consoleis
monitoring the transfer, it marks the transfer as a success and records that zero bytes were transferred.

Nodes using hot folders regularly make these successful, zero-byte transfer sessions, and Console logs each onein

its database. One workaround isto use Aspera Watch Folders instead of hot folders. Watch Folders only attempts to
transfer afile when there is a change between the source and destination. For requirements and information on Watch
Folders, see Creating a Push Watch Folder on page 63.

Y ou can a'so configure Console to mark zero-byte transfers for deletion by the Dat abasel ngest background job.

Note: Console might still display the most recent zero-byte sessions on heavy loaded systemsif Dat abasel ngest
job backlog is high. Once the backlog is processed, Console will not display zero-byte transfers on the dashboard.

[tem Description
Leavein database Leave all zero-byte transfersin the database.
Deleteif hot folder Mark for deletion zero-byte transfers initiated from hot folder sessions, leaving all

other zero-byte transfers in the database.

Deleteall Mark for deletion all zero-byte sessions regardless of origin.

Understanding Space Watcher

Space watcher is a background process that checks the amount of free space in the database and gives warning when
space isrunning low.
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Space Watcher Functionality
Once aminute, space watcher runsal s or di r command, then writes the free space in bytes to a table named
aspera_db_disk_space free. The exact command it executesis:

df -k -P "aspera_consol e_db_directory_ path"

It only writes one record, always with "id=1". The aspera_db_disk_space free table will never have more than one
record in it. Thistable only has three fields:

Field Value
id Always equal to 1.
bytes free BIGINT, max value = 9223372036854775807, which is

approximately 8191 petabytes

last_reported at The time space watcher last stored an entry in the table.

If the process fails to figure out free space for any reason or fails to connect to MySQL, it does nothing and logs
nothing. Successful or not, it then closes its connection and then sleeps for a minute before repeating the process.

Space Watcher Messages in Console

Unless warnings have been disabled (by setting the warning threshold to zero), Console checks the
aspera_db_disk_space freetable when rendering a page. If it sees that there are no records in the table, or that it
has been longer than 10 minutes since space watcher last reported, Console displays the following message at the top
of the page: " WARNING: No recent data from database free space watcher” . If the last entry is recent (within
10 minutes) but the number of free bytesis less than the configured warning level (default: 10 gigabytes), it showsa
message such asthe following: " WARNING: Database free space low (7.5 GB remaining)”.

Working with Tags

Tagsin Aspera products are JSON (JavaScript Object Notation) strings. Console uses tags to identify transfers and to
label Console-initiated transfers. Y ou can find a specific transfer's tags by navigating to a transfer's Session Details
page and selecting the Session ID link under the Session State column.

Tags are used in the following tasks:

e Creating simple transfers.

e Creating and starting smart transfers.

» Creating advanced rulesetsto filter by tags.

» Creating custom fields with rules involving tags.
e Searching using the Advanced Search.

The JSON Match Comparison Operator

Console includes a JSON match operator in the Custom Fields and Advanced Rulesets features, which provide a
simple syntax for matching JSON formatted tags included in Asperatransfers. Below are examples of transfer tagsin
Console and Faspex transfers and instructions for matching them using the JSON match operator.

Console Transfers

A Console transfer is defined as any transfer initiated by Console using simple or smart transfers. Tags can be
specified in both simple and smart transfers. A Console transfer tag is formatted in the following way:

{"aspera":
{"consol e":
{"user_specified"
{"keyl":"val 1", ..., "key3":"val 3"}
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}
}
}

An example of a corresponding JSON match value is shown below:

[ aspera] [ consol e] [user _specified] [ keyl]val 1

Faspex Transfer
A Faspex Transfer is any transfer initiated by Faspex. A Faspex transfer tag is formatted in the following way:

{"aspera":
{"faspex":
{ "keyl":"val 1", ..., "key3":"val 3"}
}
The corresponding JSSON match value is shown below:
[aspera] [ faspex][keyl]val 1

Note: It isrecommended to use the Faspex Metadata filter for Faspex transfersinstead. See Basic Report Example:
Faspex Metadata on page 185 for more information on Faspex Metadata.

Regular Expressions in JSON Matches
Y ou can also use regular expressions in a JSON match. Define the regular expression using forward slashes (/) like
in the example below:

[ aspera] [ consol e] [user_specified]/+./
Important: Asperaadvises against using regular expressions in keys, because the result will be the first value that
matches the regular expression. In the example below, Console will return the first Faspex transfer it hits without
backtracking to check for other transfers that meet the requirements.

[aspera][faspex][/+./]/.+

Configure Background Processes

The Background Processes configuration page displays al Console processes and allows you to perform the
following tasks:

* View aprocesslog

« Edit aprocess

« Stop aprocess (although thisis not available for all processes)

* Restart aprocess (although thisis not available for all processes)

To access the Background Processes page, select Configuration > Background from the Console menu.
The following background processes can be accessed from the table:

e Controller

* Mongrel Manager

« Database Ingest

e Session Data Collector
¢ Node Info Collector

» File Data Collector
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» DataCanonicalizer

e Custom Field

« Database Utility

e Transfer Initiator

e Email

* Report

To modify the settings for a given process, click the edit link in the corresponding table row. After clicking edit, the
Editing Background Process page appears, aong with the following options:

Options Description

Startup type Select the way that the background process starts (that is, manually or automatically)
or disable the process from starting altogether.

Loglevel Select the preferred level of logging for the log file output to control the verbosity of
the log file output). Choose debug, info, warn, error or fatal.

Batch Size (Not available for all processes) Input the number of rows to process each work
interval.

Daily restart time (Not available for all processes) Input the time of day to restart the processin 24-hour

(HH:MM) time, UTC. Leave blank for no auto-restart.

Sleep Interval Input the sleep interval time in seconds.

Maximum Startup Interval | Input atime (in seconds) that must elapse before the given process is assumed to be
hanging.

Maximum Heartbeat Input atime (in seconds) that must elapse between heartbeats before the given process

Interval is assumed to be hanging.

Configure the Apache HTTP Server

Y ou may configure Console's Apache HTTP Server to use a different host name, communication port, and namespace
using asctl commands.

Change the Number of Mongrel servers
By default, Console opens four mongrel servers. To changeit, for example, from the default (4) to 10, use the
following command:
$ asctl consol e: nongrel _count 10
Update the Hostname
During the installation, you should have configured the Console's hostname. Use this command to print the current
hostname:
$ asctl apache: host nane
To change the hostname, use the following command. Replace HOSTNAM E with the new hostname:

$ asctl apache: host nane HOSTNAMVE

Important: When changing the hostname, the server's SSL certificate should be regenerated. Select (y) when
prompted to generate anew SSL certificate.

When the hostname is updated, advise your clients of the new URL. In this example, use the following address:
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http:// HOSTNAME asper a/ consol e

Change HTTP and HTTPS ports
By default, Console's web servers are running on TCP/80 (HTTP) and TCP/443 (HTTPS). Use the following
commands to update these ports (where, in this example, we TCP/7080 for HTTP and TCP/7443 for HTTPS):

Item Command

HTTP

$ asctl apache: http_port 7080

HTTPS
$ asct| apache: https_port 7443

Change Console namespace
Consol e uses the namespace /aspera/consol e by default. Use this command to print the current namespace:

$ asctl consol e: uri _namespace
To set the namespace to, for example, /console, use the following command:
$ asctl consol e: uri _namespace /consol e

When the namespace is updated, advise your client of the new URL. For example, if your Console server's addressis
10.0.0.10, use this URL:
https://10.0.0. 10/ consol e

Note: Refer to asctl Command Reference on page 111 for a complete asctl command reference.

asctl Command Reference

Youcanuseasct | commandsinaTermina window to display or modify IBM Aspera Console's component
settings. Console configuration options that can be modified using asct | are listed below. If there are modifications
that cannot be accomplished with asct | , notify Aspera Support.

Component Description

Apache Apache web server.
Console Console main application.
MySQL MySQL database.

All components commands

Important: The commands in this section control al Console components.

Task Command Description

Show config info asctl al:info Print info about all components.

Restart all components asctl all:restart Restart all components.

Setup status asctl all:setup_status Information about configuring al
components.

Start asctl all:start Start al components.
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Task Command Description
Show status asctl all:status Display the status of each
component.
Stop asctl all:stop Stop all components.
Show version asctl all:version Display the current version of each
component.
Apache
Task Command Additional Information

Create a setup file

asctl apache:create setup_filefile

Create areusable file that contains
answers to the setup questions.
Replace file with afile name.

Disable Apache

asctl apache:disable

Disable the Aspera Apache server.
When disabled, the service will not
start when rebooting computer, does
not print reminders or update its
configurations.

Disable Apache logs

asctl apache:disable logs

Set the Apache'slog level to ‘emerg'’.

Enable Apache logs

asctl apache:enable logs

Set the Apache'slog level to 'notice'.

Re-generate conf

asctl apache:generate_config

Generate the component's
configuration file using the current
settings.

Display hostname

asctl apache:hostname

Display the hostname or 1P address
of the server.

Change hostname

asctl apache:hostname host

Change the hostname or | P address
of the server. Replace host with a
new hostname or |P address.

Display HTTP port

asctl apache:http_port

Display the HTTP port the web
server listensto.

Change HTTP port

asctl apache:http_port port

Change the HTTP port the web
server listensto. Replace port with a
new port number.

Display HTTPS port

asctl apache:https port

Display the HTTPS port the web
server listensto.

Change HTTPS port

asctl apache:https port port

Change the HTTPS port the web
server listensto. Replace port with a
new port number.

Show config info

asctl apache:info

Print configuration info about
Apache.

Copy your SSL filesinto the Aspera
default location (under default
names)

asctl apacheiinstall_ssl_cert cert_file
key file [chain_fil€]

After upgrading Faspex and
Common, use this command to copy
your original SSL certificate, key
and optional chainfileto/ opt /
asper a/ conmon/ apache/ conf
and give them Aspera-standard
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Task

Command

Additional Information

names. The ht t pd- ssl . conf file
isalso re-rendered and permissions/
ownership is set for the cert files.

Set Apachelog level

asctl apache:log_level option

Specify the Apache'slog level.
Replace option with crit, error,
warn, notice, info or debug.

Create SSL certificate

asctl apache:make _ssl_cert hosthame

Create a self-signed SSL certificate
for the specified hostname. Replace
hostname with your hostname.

Restart Apache

asctl apache:restart

Configure Apache

asctl apache:setup

Configure Apache using saved file

asctl apache:setup _from_file
filename

Run setup using the answers
from afile created using the
"create_setup_file" command.

Start Apache asctl apache:start
Show Apache status asctl apache:status
Stop Apache asctl apache:stop
Upgrade Apache asctl apache:upgrade
Show Apache's version asctl apache:version
Console
Task Command Description

Create or update admin

asctl consolezadmin_user login email
[password]

Create a new admin, or update

an existing admin account.

Replace login with alogin, email
with its email. Y ou can add the
account's password in the command
([password]), or enter it when
prompted. If the login you have
entered exists, the account is updated
with new email and password.

Backup database

asctl console:backup_database dir

Backup Console database and
associate files to the specified
directory. Replace dir with a path to
store the backup.

Display base port

asctl console:base port

Display the base port of the
mongrels.

Change base port

asctl console:base_port [arg]

Change the base port of the
mongrels. Replace [arg] with the
new base port number.

Create setup file

asctl console:create setup filefile

Create areusablefile that contains
answers to the setup questions.
Replace file with afile name.
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Task Command Description

Disable Console asctl console:disable Disable Console. When disabled, the
service will not start when rebooting
computer, does not print reminders
or update its configurations.

Re-generate conf asctl console:generate_config Generate Console component's
configuration file using the current
settings.

Config info asctl consoleiinfo Print Console configuration info.

Update database asctl consolexmigrate_database Update database to the latest schema.

Display mongrel count

asctl console:mongrel_count

Display the number of mongrelsto
spawn.

Change mongrel count

asctl console:mongrel_count arg

Change the number of mongrelsto
spawn. Replace arg with a number.

Rake command

asctl consoleirake arg

Evoke arake command.

Restart Console

asctl consolerestart

Restart mongrel web serversand all
background processes.

Restore config and data

asctl consolerestore dir

Restore Console database and
configuration from a backup
directory.

Restore database

asctl consolerestore_database dir

Restore Console database from a
backup directory.

Configure Console component

asctl console:setup

Configure this component.

Configure Console using saved file

asctl console:setup_from filefile

Run setup using the answers
from afile created using the
"create_setup_file" command.

Start Console

asctl console:start

Starts mongrel web servers and all
background processes.

Show Console status

asctl console:status

Display Console status.

Stop Console asctl console:stop Stops mongrel web serversand al
background processes.

Upgrade asctl console:upgrade Upgrade Console from a previous
version.

Display namespace asctl console:uri_namespace Display Console's URL namespace.

Change namespace asctl console:uri_namespace arg Change Consol€e's URL namespace.

Replace arg with the new
namespace.

Show Consol€e's version

asctl console:version

Display the currently set up version.

Generate email templates

asctl
console:generate_email_templates

Recreate email template files.
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MySQL

Task Command Description

Create setup file asctl mysgl:create_setup _filefile Create areusable file that contains
answers to the setup questions.
Replace file with afile name.

Display database directory asctl mysql:data_dir Display the directory that the
databases are kept in.

Disable MySQL asctl mysql:disable Disable the Aspera MySQL. When
disabled, the service will not start
when rebooting computer, does
not print reminders or update its
configurations.

Grant access on MySQL-only server | asctl mysgl:grant_remote _access If MySQL server isrunning on
host mysql_user password adifferent computer, use this
command on the MySQL machine
to allow access from the specified
machine. Replace host, mysql_user
and mysgl_password with the
server's hosthame, MySQL 's user
name, and the user's password,
respectively.

Show config info asctl mysgl:info Print configuration info about
MySQL.

Show port asctl mysqgl:port Display the port the MySQL server
listens to.

Change port asctl mysqgl:port port Change the port the MySQL server
listensto. Replace port with a new
port number.

Restart MySQL asctl mysql:restart Restart the AsperaMySQL .

Set root password asctl mysqgl:set_root password Set the password for 'root' in
MySQL.

Configure MySQL-only server asctl mysql:setup If MySQL server isrunning on
adifferent computer, use this
command on the MySQL machineto
configureit.

Configure MySQL using saved file | asctl mysgl:setup_from_filefile Run setup using the answers
from afile created using the
"create_setup_file" command.

Start MySQL asctl mysqgl:start Start the AsperaMySQL.

Show MySQL status asctl mysqgl:status Display the Aspera MySQL status.

Stop MySQL asctl mysqgl:stop Stop the Aspera MySQL.

Upgrade MySQL-only server asctl mysqgl:upgrade If MySQL server isrunning on
adifferent computer, use this
command on the MySQL machineto
upgrade the database.
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Task Command Description

Show MySQL's version asctl mysgl:version Display the currently set up version.

Advanced Search

Search

Y ou can search for atransfer from any page in Console by using the search bar in the top right corner of the page. If
you want to refine your search, you can access the Advanced Search dialog by selecting the blue drop-down arrow
next to the search bar.

Advanced Search

Transfer Name:
Contact:

SSH User:
Session 1D:

File Name Start:
Source Path:

Destination Path:

Mode: =Node Name= v
Tags:

From: 102220150359 PM |
To: 102320150359 PM |1 =
Status: All v

Results: 10 v

Filter Description

Transfer Name Include transfers with this name

Contact Include transfersinitiated by this user.
SSH User Include transfers involving this SSH user.
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Filter Description
Session ID Include transfers with this unique session ID
File Name Start Include transfers with files that start with this string.
Source Path Include transfers with files that originated from this
location.
Destination Path Include transfers with files transferred to this location.
Node Include transfersinvolving this selected node or this
node | P address.
From Include transfers started from this date and onwards.
To Include transfers from this date and onwards.
Status Include transfers with the current state designated:
e Active
e Completed
e Cancelled
e Error
Results The number of results you want Console to display.

Setting Up the Console Environment

Setup Example #1: Monitoring Transfers with Another Organization

This example shows how to create a user group that can monitor all transfers between your organization and a partner
organization. The configuration in this example uses the following values:

» Partner node address: 10.0.0.0
» Console user: partner-1-staff (non-admin)

1. Add the partner's node as an unmanaged node, and add an endpoint.

To do so, go to Nodes from the Console menu, click List Unmanaged Nodes > New Unmanaged Node.
Enter the partner node's information. Y ou can add the partner's node as an unmanaged node without further

configuration.

New Unmanaged Node

= Creating New Unmanaged Node

Address 10.0.00
Name Partner #1
limit 100 characters
S5H Port 22
SSH Encryption AES256-ctr g

2. Create anew endpoint with saved login information.

List Unmanaged Nodes
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The addition of a new node creates an endpoint in Console with awildcard (* @10.0.0.0). Wildcard endpoints
reguire a user to enter login credentials every time the user usesit for atransfer. To create an endpoint with saved
login credentials, go to the Endpointstab and click Add Endpoint. Enter the login credentials for a user on the

node and click Create.

Unmanaged Nodes

Bl Partner #1 (10.0.0.0)

Details Map  Queueing
= New Endpoint

Name

Login

Password

Password confirmation

Email Notifications

Email address

EMAIL ADDRESS

Endpoints

Partner #1
descriptive name for this endpoint

partner_login

~| Use SSH Key

ON START

ON SUCCESS

List Unmanaged Nodes

ON ERROR

For more information on the actions listed in this step, see Adding Unmanaged Nodes on page 27.

3. Create agroup with permission to monitors transfers with the partner's node.

List Endpoints

Go to Groups from the Console menu and click New Group. In the Create New Group page, enter the group's

name and description. Click Create when finished.
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Users Groups  Directories SAML  Accesslog  New Group

= Creating New Group

MName Monitor transfers with Partner #1
limit 45 characters

g Permissions to monitor transfers with the
Description partner_login@10.0.0.0 endpoint.

When the group is created, select Transfer Path > Add Path. The following is an example of the Transfer Path
settings:

Users Groups Directories SAML  Access Log  New Path for 'Monitor transfers with Partner #1'

= New Transfer Path

Back to Edit Group

Endpoint 1 Partner #1 (10.0.0.0)
Direction to / from
Endpoint 2 Any

Start Simple Transfers

Start Smart Transfers

Create Smart Transfers

Share Smart Transfers

Control Transfers started by others

View Transfers started by others
Opt-in to email notifications

Description r\donitor transfers with Partner #1]
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Field Description

Endpointl Choose the Partner's node or endpoint.

Direction Set to/ from for inbound and outbound transfers.
Endpoint2 Choose Any so that users can make transfers with any node.

Group permissions

Check these options:

* View transfers started by others
» Opt-into email notifications

Click Create.

For more information on the tasks listed in this step, see Creating Console Groups on page 36.

. Create a Console user and add it to the group.

To create a user account to monitor the transfers, go to User s from the Console menu and click New User. Fill out
the form and click Create.
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Users Groups  Directories  SAML  Access Log  New User

» User Information

Login partner-1-staff
limit 40 characters
First name Partner 1
Last name Staff
Email group1@partneri.com
Time zone (GMT-08:00) Pacific Time {US & Canada) a
Set password
If unchecked, user will be sent a temporary password via email upon account creation
Password
Confirm Password

= Permissions

Active (allow user to login)
Reports Allowed

Console Administrator

5. Assign the user to the group.
In the User Maintenance page's Groups tab, select the group from the drop menu and click Add.

Users  Groups Directories =~ SAML  Access Log  Permissions for Partner 1 Staff (partner-1-staff)

= Group Memberships

Monitor transfers with Partner #1 a Add

NAME DESCRIPTION DIRECTORY ACTIONS

When logging into Console with this user account, you can monitor al the transfers with the partner's node.
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For more information on the tasks listed in this step, see Creating Console Users on page 38.

Setup Example #2: Managing Aspera Faspex Transfers

This example shows how to monitor and control transfers on a node running Faspex, a file exchange application built
upon IBM Aspera High-Speed Transfer Server for a centralized transfer solution. The configuration in this exampleis
asfollow:

» Faspex node address: 10.0.0.0
* Console user: faspex-monitor-1
1. Add Faspex as a managed node, and create an endpoint.

Go to Nodes from the Console menu and click New M anaged Node. Enter the Faspex node information and click
Create.

» Creating New Node

IP Address 10.0.0.0
cannot be a domain name

Name Faspex Server
limit 100 characters

Communication

SSH Port 22
SSH Encryption AES256-ctr Ky
Node API Port 9092

Default: 9081 for hitp, 9092 for https
B Use HTTPS to connect to node (recommended)

Require signed SSL certificate

Failover
Enable failover and load balancing for Console-initiated transfers on this node
All nodes with the same failover group name must have the same user accounts and docroot paths
Failover Group Name (none)
Other

Create default Console groups

Important: If you wish to configure the Faspex node transfer settings using Console, go to the Node
Maintenance page, select the Credentials tab, and enter the SSH login.

When the node is added, go to the Endpoints tab and click Add Endpoint. Enter Faspex in the Login field, leave
password fields blank. When finished, click Create.
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« New Endpoint

Name Faspex
descriptive name for this endpoint

Login faspex_server

| Use SSH Key

Password

Password confirmation

Email Notifications

Email address m
EMAIL ADDRESS ON START ON SUCCESS ON ERROR

For more information on the tasks listed in this step, see xfer_user/projectlsvcAspera.
2. Create agroup with the proper permissions.

Go to Groups from the Console menu and click New Group. Enter the group's information and click Create.

Users  Groups Directories  SAML  Access Log MNew Group

= Creating New Group

Name Faspex Monitors
limit 45 characters

Description [T ST BRI TETRIETS H TR LaekEn
erver|

When the group is created in the Group Maintenance page, go to the Transfer Pathstab and click Add Path. Use
the following settings for this Transfer Path (change the Faspex node address to match yours):
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Users Groups Directories SAML Access Log New Path for 'Faspex Monitors'

= New Transfer Path

Back to Edit Group

Endpoint 1 faspex_server (10.0.0.0) u
Direction to /from §g
Endpoint 2 Any [

Group permissions Select all

Start Simple Transfers

(< <]

Start Smart Transfers

<]

Create Smart Transfers

(<]

Share Smart Transfers

<]

Control Transfers started by others

a

View Transfers started by others

<]

Opt-in to email notifications

Description onitor and control transfers on Faspex
erver.

Item Description

Endpoint1 faspex@22.33.44.55

Direction to/ from

Endpoint2 Any

Options Check these options:
* View Transfers started by others
e Opt-into email notifications

For more information on the tasks listed in this step, see Creating Console Groups on page 36.
3. Add usersto the group.

In the Group Maintenance page, go to the Members tab, select the Console user from the menu and click Add.
When added, the Console user can monitor and control transfers on the Faspex node through Console.



| Appendix | 125

Users Groups Directories SAML Access Log Edit Group 'Faspex Monitors'

= Editing Group Details

Name Faspex Monitors
limit 45 characters

Monitor and control transfers on the Faspex

Description
server.

= Transfer Paths

TRANSFER PATH USER PERMISSIONS OTHER PERMISSIONS
START START CREATE SHARE
ENDPOINT DIRECTION ENDPOINT SMART SIMPLE SMART SMART CONTROL VIEW EMAIL ACTIONS
faspex_server (10.0.0.0) - Any o o o o o o "y edit delete

= Members
-- Select User -- d Add
LOGIN NAME ACTIONS
faspex-maonitor-1 delete

For more information on the tasks listed in this step, see Creating Console Users on page 38.

Setup Example #3: Create Groups of Different Permissions

This example shows how to assign different permissionsto different project members. The configuration in this
exampleisasfollows:

e Endpointl: project@1.2.3.4

e Endpoint2: project@5.6.7.8

e Userl (Project admin): adminl

e User2 (Project member): memberl

e Group - Project admin: All permissions between Endpoint1 and Endpoint2

e Group - Project member: Limited permissions between Endpoint1 and Endpoint2

1. Prepare the nodes, endpoints and the Console user accounts.

+ Add amanaged or unmanaged node with an endpoint for transfer: project@1.2.3.4
* Add amanaged or unmanaged node with an endpoint for transfer: project@5.6.7.8
* Add aConsole user: adminl

* Add aConsole user: memberl

For more information on the tasks listed in this step, see xfer_user/projectlsvcAspera, Adding Unmanaged Nodes
on page 27, and Creating Console Users on page 38.

2. Create agroup for the project administrator.

Go to Groups from the Console menu and click New Group. Enter the group's information and click Create.
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= Creating New Group

Name Project admin
limit 45 characters

All permission between Endpoint1 and

Description Endpoint2.

In the Group Maintenance page, click the Transfer Paths tab. Enter the following information:
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Accounts

Users Groups Directories  Access Log Mew Path for 'Project admin'

= New Transfer Path

Endpoint 1 project@1.2.3.4 -
Direction to /from -
Endpoint 2 projecti@s.6.7.8 -

Group permissions Select all Deselect all

Start Simple Transfers

Start Smart Transfers

Create Smart Transfers

Share Smart Transfers

Control Transfers started by others
View Transfers started by others

Opt-in to email notifications

Description
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Item Description

Endpointl project@1.2.3.4

Direction to/ from

Endpoint2 project@5.6.7.8

Options Select All.
Click Create.

In the Group Maintenance page, go to the M ember s tab and add the user admin1 into this group.

Users  Groups  Directories  Access Log  Members for Group 'Project admin'

= Members of this Group

admin 1 (admin1) -

For more information on the tasks listed in this step, see Creating Console Groups on page 36.
3. Create agroup for the project members.

Go to Groups from the Console menu and click New Group. Enter the group's information and click Create.

= Creating New Group

MName Project member
limit 45 characters

Restricted permission between Endpoint1

Description and Endpoint2.

In the Group Maintenance page, click the Transfer Pathstab. Enter the following information:

[tem Description

Endpointl project@1.2.3.4

Direction to/ from
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Item Description
Endpoint2 project@5.6.7.8
Options Check these options:

o Start Smart Transfers
* View Transfers started by others
» Opt-into email notifications

When finished, click Create.

In the Group Maintenance page, go to the Member stab and add the user member 1 into this group.

Users  Groups  Directories  Access Log  Members for Group 'Project member'

= Members of this Group

member 1 (memberl) -

For more information on the tasks listed in this step, see Creating Console Groups on page 36.
4. Create a Smart Transfer template with the project admin account.

At this point, both Console users should have the proper permissions. Use the project admin account (adminl) to
create a Smart Transfer template.

New Smart Transfer

Description

Transfer name
Endpoint1 -> Endpoint2

41 Share this smart transfer

Allow changes to transfer settings at submit time

When the user adminl creates and share a Smart Transfer template, member 1 will be able to execute the Smart
Transfer template.
For more information on the tasks listed in this step, see Sharing a Smart Transfer on page 57
5. Execute the Smart Transfer with the project member account.
The Project member group, which has the same Transfer Path as the Project admin group, has access to the

shared Smart Transfer templates. Go to Transfer from the Console menu, the Project member will see the Smart
Transfer template listed in the Saved Smart Transferstable.
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Email Template Examples

Email Template Example: Creating a Simple Notification for a Successful Transfer

The following example shows how to create an email template that notifies a user of a successful transfer with
minimal information.

1. Select Create new transfer success email template and then edit.

2. Name your template "Client Success Email".

3. Enter aFrom Name and Reply-to Addressif you don't want the notification to come from the default email
address.

4. Enter anew email subject: "Client Transfer Notification - Success".

5. Click Edit Plain Template and make remove variables to limit information provided to the recipient.
For example:

Client Transfer Notification

Description of the Transfer: DESCRI PTI ON
Client Nane: CONTACT

Total Bytes Transferred: BYTES_TRANSFERRED
Total Tine for Transfer: ELAPSED TI ME

Aver age Transfer Rate: AVERAGE RATE

You are receiving this nmessage because your Aspera Consol e preferences
are set to receive these notifications or sonmeone el se thought you
shoul d know about this particular transfer.

The end result should look like the following:

Client #1 Transfer Notification

Description of the Transfer: TEMPLATE TEST: File from Sydney to LA
Client Name: econl (ssh)

Total Bytes Transferred: O Bytes

Total Time for Transfer: 44s

Average Transfer Rate:

You are receiving this message because your Aspera Console preferences
are set to receive these notifications or someone else thought you
should know about this particular transfer.

6. Edit HTML Template to match the information in the basic template.
The end result should look like the following:
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Client #1 Transfer Notification

Description of the Transfer: TEMPLATE
TEST: File from
Sydney to LA

Client Name: econl (ssh)

Total Bytes Transferred: 0 Bytes

Total Time for Transfer: 445

Average Transfer Rate:

You are receiving this message because your Aspera Console preferences
are set to receive these notifications or someone else thought you should
know about this particular transfer.

7. Click the Send Test Email button to test the new email template.

Email Template Example: Adding Company Branding to Your Template

The following example shows how to create an email template that shows company branding when opened in HTML
format.

1. Onthe Template preview screen, click the Edit HTML Template button to modify the template's HTML code.
2. Locate the URL of your company logo. Y our image must be hosted on a server that is accessible to the recipient.
3. Openthe HTML Template and insert the following code in the desired location.

<I MG SRC="ht t p: // <l MAGE_URL>">

In this example, we've inserted the logo into the header.

The result may look like the following:



| Appendix | 132

Aspera Console Transfer Notification

aspera

Description: TEMPLATE TEST: File from Sydney to LA
Started by: econl (ssh)
Started at: 2009-03-30 13:50:03 Pacific Time (US & Canada)
Source: Sydney (10.0.75.201)
First 5 Source Paths: C:/demo files/test
C:/demo files
Destination: LA (10.0.85.108)

/home/econl/uploads

Node References

Node-Level Configuration Options

To start node configuration, go to Nodes in the Console menu. Click edit for an existing node that you wish
to configure. The server's admin credentials are required for the configuration. See Updating a Node's Admin
Credentials on page 26.

The node configuration options can be found in the Configuration tab. The following is a summarized chart for
navigating and changing values when you click on an individual section. Click Save changes when finished:

Note: Configuration at the node level will affect all user accounts and group accounts on that node performing

Asperatransfers.
Section Configuration Details
Database Configuring policy and logging level settings.
Transfer Server Setting transfer server |P address and port.
HTTP Fallback Server Enable and configure HTTP/ HTTPS fallback server.
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Section

Configuration Details

Docroot

Setting document root and its access permissions.

Authorization

reguirements.

Connection permissions, token key, and encryption

Bandwidth

settings.

Incoming and outgoing transfer bandwidth and policy

Advanced File Handling

rules, and exclude pattern.

File handling settings, such asfile block size, overwrite

Advanced Network Options

Network | P address, port, and socket buffer settings.

Database

# Field Description Values Default

1 Host IP Enter the Aspera Console server's | P address, valid IPv4 127.0.0.1
default 127.0.0.1 address

2 Port The default value for an Aspera Console Integer 4406
installation is 4406. Valid port numbers range between 1 and
between 1 and 65535. 65535

3 User User login for the database server. text string blank

4 Database Name Name of the database used to store Asperatransfer | text string blank
data.

5 Threads The number of parallel connections used for Integer 10
database logging. A higher value may be useful between 1 and
when alarge number of files are being transferred |40
within agiven time frame.

6 Stop Transferson Quitsal ongoing transfersand no new transfers . re fase

Database Error are permitted when a database error prevents . fase

data from being written to the database. Set this
to trueif all transfers must be logged by your
organization.

7 Session Progress Setting this value to true will log transfer status |+ trye true
such as number of files transferred, and bytes . fase
transferred, at a given interval.

8 Session Progress The frequency at which an Aspera node logs Positive integer | 1

Interval transfer session information, up to 65535 seconds.

9 File Events Setting this value to true enables the logging of . true true
complete file paths and file names. Performance |, false
may be improved when transferring datasets
containing thousands of files. Also see File Per
Session for setting athreshold for the number of
filesto log per session.

10 File Progress Setting this value to true will log file statussuch . e true
as bytestransferred at agiven interval. . fase
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Field

Description

Values

Default

11

File Progress Interval

The frequency at which an Asperanode logsfile
transfer information, up to 65535 seconds. The

default setting of 1 logging sessions every second.

Integer

65535

between 1 and

1

12

Files Per Session

The value is the cut-off point for file names
logged in a given session. For example, if the
valueis set to 50, the first 50 file names will be
recorded for any session. The session will still
record the number of files transferred along with
the number of files completed, failed, or skipped.
The default setting of 0 will log al file names for
agiven session.

or zero

Positive integer | O

13

Ignore Empty Files

byte files.

Setting thisto true will block the logging of zero-

e true
o fase

false

14

Ignore No-transfer Files

Setting thisto true will block the logging of files
that have not been transferred because they exist
at the destination at the time the transfer started.

e true
o« fase

false

15

Rate Events

Setting thisto true will log changes made to
the Target Rate, Minimum Rate, and Transfer
Policy of atransfer by any user or Aspera node
administrator during atransfer.

e true
« fase

true

Transfer Server

#

Field

Description Values

Default

Bind Address

default value 127.0.0.1 enables the transfer
server to accept transfer requests from
thelocal computer. Setting the value to
0.0.0.0 alowsthe Asperatransfer server
to accept transfer requests on all network
interfaces for this node. Alternatively, a
specific network interface address may be
specified.

Thisisthe network interface address on Valid IPv4
which the transfer server listens. The address

127.0.0.1

Bind Port

The port at which the transfer server will Integer between
accept transfer requests. 1 and 65535

40001

HTTP Fallback Server

Note: While Console can change a node's settings for HT TP fallback, Console does not support HTTP fallback for
transfersit initiates.

#

Field

Description

Values

Default

Cert File

The absolute path to an SSL certificatefile. If left
blank, the default certificate file that came with
your HST Server will be used.

file path

blank




| Appendix | 135

# Field Description Values Default
2 Key File The absolute path to an SSL key file. If |eft blank, | file path blank
the default certificate file that came with your
HST Server will be used.
3 Bind Address Thisisthe network interface address on which valid IPv4 0.0.0.0
the HTTP Fallback Server listens. The default address
value 0.0.0.0 allows the Aspera HTTP Fallback
Server to accept transfer requests on all network
interfaces for this node. Alternatively, a specific
network interface address may be specified.
4 Restartable Transfers | Setting thisto true allows interrupted transfersto | e true
resume at the point of interruption. . fase
5 Session Activity Any value greater than 0 sets the amount of Positiveinteger |0
Timeout time, in seconds, that the HTTP Fallback Server
will wait without any transfer activity before
canceling the transfer. Notice that this option
cannot be left at 0, otherwise interrupted HTTP
Fallback sessionswill get stuck until server or
asperacentral is restarted.
6 Enable HTTP Enables the HTTP Fallback Server that allows . true false
failed UDP transfersto continue over HTTP. . fase
7 HTTP Port The port on which the HTTP server listens. Valid | positiveinteger | 8080
port numbers range between 1 and 65535.
8 Enable HTTPS Enables the HTTPS Fallback Server that allows |+ {rye fase
failed UDP transfersto continue over HTTPS. . fase
9 HTTPS Port The port on which the HTTPS server listens. positiveinteger | 8443
Valid port numbers range between 1 and 65535.
Docroot
# | Field Description Values Default
Absolute Path The Absolute Path describes the area of the file file path N/A
system that is accessible by Asperausers. The
default empty value gives users access to the entire
file system.
2 | Read Allowed Setting thisto true allows users to transfer fromthe . e N/A
designated area of the file system as specified by the |, false
Absolute Path value.
3 | Write Allowed Setting this to true allows users to transfer to the . true N/A
designated area of thefile system as specified by the |, o0
Absolute Path value.
4 | Browse Allowed Setting this to true allows users to browse the . true N/A
directory. . fase
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#

Field

Description

Values

Default

Incoming Transfers

The default setting of allow allows users to transfer
to this computer. Setting thisto deny will prevent
transfers to this computer. When set to require
token, only transfersinitiated with valid tokens will
be allowed to transfer to this computer. Token-based
transfers are typically employed by web applications
such as Faspex and require a Token Encryption Key.

+ dlow

o deny

* require
token

dlow

Incoming External
Provider URL

The value entered should be the URL of the

external authorization provider for incoming
transfers. The default empty setting disables external
authorization. Aspera servers can be configured to
check with an external authorization provider. This
SOAP authorization mechanism can be useful to
organi zations requiring custom authorization rules.

HTTP URL

blank

Incoming External
Provider SOAP Action

The SOAP action required by the external
authorization provider for incoming transfers.
Required if External Authorization is enabled.

text string

blank

Outgoing Transfers

The default setting of allow allows users to transfer
from this computer. Setting thisto deny will prevent
transfers from this computer. When set to require
token, only transfersinitiated with valid tokens will
be allowed to transfer from this computer. Token-
based transfers are typically employed by web
applications such as Faspex and require a Token
Encryption Key.

« dlow

e deny

* require
token

alow

Outgoing External
Provider URL

The va ue entered should be the URL of the

external authorization provider for outgoing
transfers. The default empty setting disables external
authorization. Aspera servers can be configured to
check with an external authorization provider. This
SOAP authorization mechanism can be useful to
organi zations requiring custom authorization rules.

HTTPURL,
default blank

Outgoing External
Provider Soap Action

The SOAP action required by the external
authorization provider for outgoing transfers.
Required if External Authorization is enabled.

Text string

blank

Token Encryption Cipher

The cipher used to generate encrypted authorization
tokens.

e aes128
e aes-192
e aes-256

aes-128

Token Encryption Key

Thisisthe secret token that will be used to authorize
those transfers configured to require token. Token
generation is part of the Aspera SDK. See the
Aspera Developer's Network (Token-based
Authorization Topic) for more information.

Text string

blank

Token Life (seconds)

Sets token expiration for users of web-based transfer
applications.

Positive integer

1200

10

Encryption Allowed

Describes the type of transfer encryption accepted
by this computer. When set to any the computer

. any

any
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Field

Description

Values

Default

allows both encrypted and non-encrypted transfers.
When set to none the computer restricts transfers

to non-encrypted transfers only. When set to
aes-128 the computer restricts transfers to encrypted
transfersonly.

* none
e aes128

Bandwidth

Field

Description

Values

Default

Incoming Vlink ID

The value setsthe VIink ID for incoming transfers.
Vlinks are a mechanism to define aggregate transfer
policies. The default setting of O disables VIinks.
One Vlink—the virtual equivalent of a network
trunk—represents a bandwidth allowance that may
be allocated to anode, group, or user. VIink ID are
defined in each Vlink created in Aspera Console.
The VIink ID isaunique numeric identifier. See
Configuring Virtual Links on page 32

Pre-defined
value

0

Incoming Target Rate
Cap (Kbps)

The value sets the Target Rate Cap for incoming
transfers. The Target Rate Cap is the maximum
target rate that atransfer can request, in kilobits

per second. No transfer may be adjusted above this
setting, at any time. The default setting of Unlimited
signifies no Target Rate Cap. Clients requesting
transfers with initial rates above the Target Rate Cap
will be denied.

Positive integer

Unlimited

Incoming Target Rate
Default (Kbps)

This value represents the initia rate for incoming
transfers, in kilobits per second. Users may be
able to modify thisratein real time as allowed by
the software in use. This setting is not relevant to
transfers with a Fixed policy.

Positive integer

10000

Incoming Target Rate
Lock

After an incoming transfer is started, its target
rate may be modified in real time. The default
setting fal se gives users the ability to adjust the
transfer rate. A setting of true prevents real-time
modification of the transfer rate.

e true
o fdse

false

Incoming Minimum Rate
Cap (Kbps)

The value sets the Minimum Rate Cap for incoming
transfers. The Minimum Rate Cap isalevel
specified in kilobits per second, below which an
incoming transfer will not slow, despite network
congestion or physical network availability. The
default value of Unlimited effectively turns off the
Minimum Rate Cap.

Positive integer

Unlimited

Incoming Minimum Rate
Default (Kbps)

This value represents the initial minimum rate for
incoming transfers, in kilobits per second. Users
may be able to modify thisrate in real time as
allowed by the software in use. This setting is not
relevant to transfers with a Fixed policy.

Positive integer

Incoming Minimum Rate
Lock

After an incoming transfer is started, its minimum
rate may be modified in real time. The default

e true

false
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Field

Description

Values

Default

setting of false gives users the ability to adjust the
transfer's minimum rate. A setting of true prevents
real-time modification of the transfer rate. This
setting is not relevant to transfers with a Fixed

policy.

o fdse

Incoming Bandwidth
Policy Default

The value chosen sets the default Bandwidth Policy
for incoming transfers. The default policy value
may be overridden by client applicationsinitiating
transfers.

o fixed
* high
o fair
e low

fair

Incoming Bandwidth
Policy Allowed

The value chosen sets the allowed Bandwidth
Policy for incoming transfers. Asperatransfers use
fixed, high, fair and low policiesto accommodate
network-sharing requirements. When set to any, the
server will not deny any transfer based on policy
setting. When set to high, transfers with a Policy of
high and less aggressive transfer policies (such as,
fair or low) will be permitted. Fixed transfers will
be denied. When set to low, only transfers with a
Bandwidth Policy of low will be allowed.

o fixed
* high
« fair
e low

fair

10

Incoming Bandwidth
Policy Lock

After an incoming transfer is started, its Policy may

be modified in real time. The default setting of false
gives users the ability to adjust the transfer's Policy.

A setting of true prevents real-time modification of

the Palicy.

o true
o fdse

false

11

Outgoing Vlink ID

The value setsthe Vlink ID for outgoing transfers.
Vlinks are a mechanism to define aggregate transfer
policies. The default setting of 0 disables VIinks.
One Vlink—the virtual equivalent of a network
trunk—represents a bandwidth allowance that may
be allocated to anode, group, or user. VIink ID are
defined in each Vlink created in Aspera Console.
The Vlink ID isaunique numeric identifier. See
Configuring Virtua Links on page 32

Pre-defined
value

12

Outgoing Target Rate
Cap (Kbps)

The value sets the Target Rate Cap for outgoing
transfers. The Target Rate Cap is the maximum
target rate that atransfer can request, in kilobits

per second. No transfer may be adjusted above this
setting, at any time. The default setting of Unlimited
signifies no Target Rate Cap. Clients requesting
transferswith initial rates above the Target Rate Cap
will be denied.

Positive integer

Unlimited

13

Outgoing Target Rate
Default (Kbps)

This value represents the initial rate for outgoing
transfers, in kilobits per second. Users may be
able to modify thisratein real time as allowed by
the software in use. This setting is not relevant to
transfers with a Fixed policy.

Positive integer

10000

14

Outgoing Target Rate
Lock

After an outgoing transfer is started, its target
rate may be modified in real time. The default
setting of false gives users the ability to adjust the

e true
+ fase

false
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Field

Description

Values

Default

transfer rate. A setting of true prevents real-time
modification of the transfer rate.

15

Outgoing Minimum Rate
Cap (Kbps)

The va ue sets the Minimum Rate Cap for outgoing
transfers. The Minimum Rate Cap isalevel
specified in kilobits per second, below which an
incoming transfer will not slow, despite network
congestion or physical network availability. The
default value of Unlimited effectively turns off the
Minimum Rate Cap.

Positive integer

Unlimited

16

Outgoing Minimum Rate
Default

This value represents the initial minimum rate for
outgoing transfers, in kilobits per second. Users may
be able to modify thisrate in real time as allowed

by the software in use. This setting is not relevant to
transfers with a Fixed policy.

Positive integer

17

Outgoing Minimum Rate
Lock

After an outgoing transfer is started, its minimum
rate may be modified in real time. The default
setting of false gives users the ability to adjust the
transfer's minimum rate. A setting of true prevents
real-time modification of the transfer rate. This
setting is not relevant to transfers with a Fixed

policy.

o true
o fdse

false

18

Outgoing Bandwidth
Policy Default

The value chosen sets the default Bandwidth Policy
for outgoing transfers. The default policy value
may be overridden by client applications initiating
transfers.

o fixed
e high
o fair
* low

far

19

Outgoing Bandwidth
Policy Allowed

The value chosen sets the allowed Bandwidth
Policy for outgoing transfers. Asperatransfers use
fixed, high, fair and low policiesto accommodate
network-sharing requirements. When set to any, the
server will not deny any transfer based on policy
setting. When set to high, transfers with a Policy
of high and less aggressive transfer policies (for
example, fair or low) will be permitted. Fixed
transfers will be denied. When set to low, only
transfers with a Bandwidth Policy of low will be
allowed.

e any
* high
o fair

* low

any

20

Outgoing Bandwidth
Policy Lock

After an outgoing transfer is started, its Policy may
be modified in real time. The default setting of false
gives users the ability to adjust the transfer's Policy.
A setting of true prevents real-time modification of
the Policy.

e true
o fdse

false

Advanced File Handling

#

Field

Description

Values

Default

File Create Mode

Specify file creation mode (permissions). If
specified, create files with these permissions (for
example 0755), irrespective of File Create Grant
Mask and permissions of the file on the source

Positive integer
(octal)

undefined
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Field

Description

Values

Default

computer. Only takes effect when the server isa
non-Windows receiver.

File Create Grant Mask

Used to determine mode for newly created files

if File Create Mode is not specified. If specified,
file modes will be set to their original modes plus
the Grant Mask values. Only takes effect when the
server is anon-Windows receiver and when File
Create Mode is not specified.

Positive integer
(octal)

0644

Directory Create Mode

Specify directory creation mode (permissions). If
specified, create directories with these permissions
irrespective of Directory Create Grant Mask and
permissions of the directory on the source computer.
Only takes effect when the server is a non-Windows
receiver.

Positive integer
(octal)

undefined

Directory Create Grant
Mask

Used to determine mode for newly created
directoriesif Directory Create Mode is not
specified. If specified, directory modes will be set
to their original modes plus the Grant Mask values.
Only takes effect when the server is a non-Windows
receiver and when Directory Create Mode is not
specified.

Positive integer
(octal)

0755

Read Block Size (bytes)

Thisis a performance tuning parameter for an
Aspera sender. It represents the number of bytes an
Aspera sender reads at atime from the source disk
drive. Only takes effect when server is sender. The
default of O will cause the Aspera sender to useits
default internal buffer size, which may be different
for different operating systems.

Positive integer

Write Block Size (bytes)

Thisis a performance tuning parameter for an
Asperareceiver. Number of bytes an ascp receiver
writes data at atime onto disk drive. Only takes
effect when server is receiver. The default of O will
cause the Aspera sender to use its default internal
buffer size, which may be different for different
operating systems.

Positive integer

Use File Cache

Thisis a performance tuning parameter for an
Asperareceiver. Enable or disable per-file memory
caching at the datareceiver. File level memory
caching improves data write speed on Windows
platformsin particular, but will use more memory.
We suggest using afile cache on systems that are
transferring data at speeds close to the performance
of their storage device, and disable it for systems
with very high concurrency (because memory
utilization will grow with the number of concurrent
transfers).

e true
false

true

Max File Cache Buffer
(bytes)

Thisis a performance tuning parameter for an
Asperareceiver. This value corresponds to the
maximal size allocated for per-file memory cache
(see Use File Cache). Unit is bytes. The default of

Positive integer
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Field

Description

Values

Default

O will cause the Asperareceiver to use itsinternal
buffer size, which may be different for different
operating systems.

Resume Suffix

Extension name of a class of special files holding
metadata information of regular data files. Useful

in the context of resuming partially completed
transfers. During resume mode (-k1/2/3), each data
file has a corresponding metadata file with the same
name and the pre-specified resume suffix.

text string

aspx

10

Preserve Attributes

Configure file creation policy. When set to none, do
not preserve the timestamp of source files. When set
to times, preserve the timestamp of the source files
at destination.

none/ times

undefined

11

Overwrite

Overwrite is an Aspera server setting that
determines whether Asperaclients are allowed to
overwrite files on the server. By default itis set to
allow, meaning that clients uploading filesto the
servers will be allowed to overwrite existing files as
long asfile permissions allow that action. If set to
deny, clients uploading files to the server will not
be able to overwrite existing files, regardless of file
permissions.

o alow
e deny

alow

12

File Manifest

When set to text atext file "receipt” of all files
within each transfer session is generated. If set to
disable no File Manifest is created. The file manifest
isafile containing alist of everything that was
transferred in a given transfer session. The filename
of the File Manifest itself is automatically generated
based on the transfer session's unique ID. The
location where each manifest iswritten is specified
by the File Manifest Path value. If no File Manifest
Path is specified, the file will be generated under the
destination path at the receiver, and under the first
source path at the sender.

» text
» disable

none

13

File Manifest Path

Specify the location to store manifest files. Can be
an absolute path or a path relative to the transfer
user's home.

text string

blank

14

Pre-Calculate Job Size

Configure the policy of calculating total job size
before data transfer. If set to any, follow client
configurations (-o PreCal culateJobSize={ yes|no} ).
If set to no, disable calculating job size before
transferring. If set to yes, enable calculating job size
before transferring.

any

15

Storage Rate Control

Enable/Disable disk rate control. When enabled,
adjust transfer rate according to the speed of
receiving |I/O storage, if it becomes a bottleneck.

o true
o fdse

false

16

File checksum method

Specify the type of checksum to calculate for
transferred files. The content of transfers can be

[ any
e md5

any
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# |Field Description Values Default
verified by comparing the checksum value at the
destination with the value read at the source.
16 | Partia Suffix Set the file suffix for partially downloaded files. .aspx
Advanced Network Options
# | Field Description Values Default
Bind IP Address Specify an |P address for server-side ascp to bind Vaid IPv4 blank
its UDP connection. If avalid IP addressis given, address
ascp sends and receives UDP packets ONLY on the
interface corresponding to that | P address.
2 | Bind UDP Port Specify a port number for server-side ascp to bind Positive integer | 33001
its UDP connection. This also prevents client ascp
processes from binding to same UDP port. Valid
port numbers range between 1 and 65535.
3 | Disable Packet Batching | When set to true, send data packets back to back . true false
(no sending a batch of packets). Thisresultsin . fase
smoother datatraffic at a cost of higher CPU usage.
4 [ Maximum Socket Buffer | Upper bound the UDP socket buffer of an ascp Positiveinteger |0
(bytes) on below the input value. The default of O will
cause the Aspera sender to use its default internal
buffer size, which may be different for different
operating systems.
5 | Minimum socket buffer | Set the minimum UDP socket buffer size for an ascp | Positive integer |0
(bytes) session.

Node Account-Level Configuration Options

When configuring users and groups on a hode from Console, both group-level and user-level settings share the same
configuration options. This topic covers the following configuration sections:

Section

Configuration Details

Docroot

Setting document root and its access permissions.

Authorization

Connection permissions, token key, and encryption requirements.

Bandwidth

Incoming and outgoing transfer bandwidth and policy settings.

Advanced File Handling

File handling settings, such asfile block size, overwrite rules, and exclude pattern.

Advanced Network Network IP, port, and socket buffer settings.

Options

Docroot

# |Field Description Values Default
Absolute Path The Absolute Path describes the area of thefile file path N/A

system that is accessible by Aspera users. The
default empty value gives users access to the entire
file system.
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Required if External Authorization is enabled.

Field Description Values Default
Read Allowed Setting thisto true allows usersto transfer fromthe . e N/A
designated area of the file system as specified by the | , false
Absolute Path value.
Write Allowed Setting this to true allows users to transfer to the . true N/A
designated area of the file system as specified by the | , false
Absolute Path value.
Browse Allowed Setting this to true allows users to browse the . true N/A
directory. . fase
Authorization
Field Description Values Default
Incoming Transfers The default setting of allow alows usersto transfer .  gjjow alow
to this computer. Setting thisto deny will prevent . deny
transfers to this computer. When set to require . require
token, only transfers initiated with valid tokens will token
be allowed to transfer to this computer. Token-based
transfers are typically employed by web applications
such as Faspex and require a Token Encryption Key.
Incoming External The value entered should be the URL of the HTTP URL blank
Provider URL external authorization provider for incoming
transfers. The default empty setting disables external
authorization. Aspera servers can be configured to
check with an external authorization provider. This
SOAP authorization mechanism can be useful to
organi zations requiring custom authorization rules.
Incoming External The SOAP action required by the external text string blank
Provider SOAP Action | authorization provider for incoming transfers.
Required if External Authorization is enabled.
Outgoing Transfers The default setting of allow allows usersto transfer .  gjjow alow
from this computer. Setting this to deny will prevent |, deny
transfers from this computer. When set torequire | | require
token, only transfers initiated with valid tokens will toKen
be allowed to transfer from this computer. Token-
based transfers are typically employed by web
applications such as Faspex and require a Token
Encryption Key.
Outgoing External The value entered should be the URL of the HTTP URL,
Provider URL external authorization provider for outgoing default blank
transfers. The default empty setting disables external
authorization. Aspera servers can be configured to
check with an external authorization provider. This
SOAP authorization mechanism can be useful to
organi zations requiring custom authorization rules.
Outgoing External The SOAP action required by the external Text string blank
Provider Soap Action authorization provider for outgoing transfers.
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Field

Description

Values

Default

Token Encryption Cipher

The cipher used to generate encrypted authorization
tokens.

e aes128
e aes192
e aes-256

aes-128

Token Encryption Key

Thisisthe secret token that will be used to authorize
those transfers configured to require token. Token
generation is part of the Aspera SDK. See the
Aspera Developer's Network (Token-based
Authorization Topic) for more information.

Text string

blank

Token Life (seconds)

Sets token expiration for users of web-based transfer
applications.

Positive integer

1200

10

Encryption Allowed

Describes the type of transfer encryption accepted
by this computer. When set to any the computer
allows both encrypted and non-encrypted transfers.
When set to none the computer restricts transfers

to non-encrypted transfers only. When set to
aes-128 the computer restricts transfers to encrypted
transfers only.

] any
* none
e aes128

any

Bandwidth

#

Field

Description

Values

Default

Incoming Vlink ID

The value setsthe V1ink ID for incoming transfers.
Vlinks are a mechanism to define aggregate transfer
policies. The default setting of 0 disables VIinks.
One Vlink—the virtual equivalent of a network
trunk—represents a bandwidth allowance that may
be allocated to anode, group, or user. VIink ID are
defined in each Vlink created in Aspera Console.
The Vlink ID is aunique numeric identifier. See
Configuring Virtual Links on page 32

Pre-defined
vaue

Incoming Target Rate
Cap (Kbps)

The value sets the Target Rate Cap for incoming
transfers. The Target Rate Cap is the maximum
target rate that a transfer can request, in kilobits

per second. No transfer may be adjusted above this
setting, at any time. The default setting of Unlimited
signifies no Target Rate Cap. Clients requesting
transfers with initial rates above the Target Rate Cap
will be denied.

Positive integer

Unlimited

Incoming Target Rate
Default (Kbps)

This value represents the initial rate for incoming
transfers, in kilobits per second. Users may be
able to modify this ratein real time as allowed by
the software in use. This setting is not relevant to
transfers with a Fixed policy.

Positive integer

10000

Incoming Target Rate
Lock

After an incoming transfer is started, its target
rate may be modified in real time. The default
setting false gives users the ability to adjust the
transfer rate. A setting of true prevents rea-time
modification of the transfer rate.

o true
false

false
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Field

Description

Values

Default

Incoming Minimum Rate
Cap (Kbps)

The value sets the Minimum Rate Cap for incoming
transfers. The Minimum Rate Cap isalevel
specified in kilobits per second, below which an
incoming transfer will not slow, despite network
congestion or physical network availability. The
default value of Unlimited effectively turns off the
Minimum Rate Cap.

Positive integer

Unlimited

Incoming Minimum Rate
Default (Kbps)

This value represents the initial minimum rate for
incoming transfers, in kilobits per second. Users
may be able to modify thisratein real time as
allowed by the software in use. This setting is not
relevant to transfers with a Fixed policy.

Positive integer

Incoming Minimum Rate
Lock

After an incoming transfer is started, its minimum
rate may be modified in real time. The default
setting of false gives users the ability to adjust the
transfer's minimum rate. A setting of true prevents
real-time modification of the transfer rate. This
setting is not relevant to transfers with a Fixed

policy.

e true
+ fase

false

Incoming Bandwidth
Policy Default

The value chosen sets the default Bandwidth Policy
for incoming transfers. The default policy value
may be overridden by client applicationsinitiating
transfers.

o fixed
* high
« fair
* low

fair

Incoming Bandwidth
Policy Allowed

The value chosen sets the allowed Bandwidth
Palicy for incoming transfers. Asperatransfers use
fixed, high, fair and low policiesto accommodate
network-sharing requirements. When set to any, the
server will not deny any transfer based on policy
setting. When set to high, transfers with a Policy of
high and less aggressive transfer policies (such as,
fair or low) will be permitted. Fixed transfers will
be denied. When set to low, only transfers with a
Bandwidth Policy of low will be allowed.

« fixed
* high
« fair
* low

fair

10

Incoming Bandwidth
Policy Lock

After anincoming transfer is started, its Policy may

be modified in real time. The default setting of false
gives users the ability to adjust the transfer's Palicy.

A setting of true prevents real-time modification of

the Palicy.

e true
o fase

false

11

Outgoing Vlink ID

The value setsthe Vlink ID for outgoing transfers.
Vlinks are a mechanism to define aggregate transfer
policies. The default setting of O disables VIinks.
One Vlink—the virtual equivalent of a network
trunk—represents a bandwidth allowance that may
be allocated to a node, group, or user. VIink ID are
defined in each Vlink created in Aspera Console.
The VIink ID isaunique numeric identifier. See
Configuring Virtual Links on page 32

Pre-defined
value

12

Outgoing Target Rate
Cap (Kbps)

The value sets the Target Rate Cap for outgoing
transfers. The Target Rate Cap is the maximum

Positive integer

Unlimited
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Field

Description

Values

Default

target rate that a transfer can request, in kilobits

per second. No transfer may be adjusted above this
setting, at any time. The default setting of Unlimited
signifies no Target Rate Cap. Clients requesting
transfers with initial rates above the Target Rate Cap
will be denied.

13

Outgoing Target Rate
Default (Kbps)

This value representsthe initia rate for outgoing
transfers, in kilobits per second. Users may be
able to modify thisratein real time as allowed by
the software in use. This setting is not relevant to
transfers with a Fixed policy.

Positive integer

10000

14

Outgoing Target Rate
Lock

After an outgoing transfer is started, its target

rate may be modified in real time. The default
setting of false gives users the ability to adjust the
transfer rate. A setting of true preventsreal-time
modification of the transfer rate.

o true
o fdse

false

15

Outgoing Minimum Rate
Cap (Kbps)

The value sets the Minimum Rate Cap for outgoing
transfers. The Minimum Rate Cap isalevel
specified in kilobits per second, below which an
incoming transfer will not slow, despite network
congestion or physical network availability. The
default value of Unlimited effectively turns off the
Minimum Rate Cap.

Positive integer

Unlimited

16

Outgoing Minimum Rate
Default

This value represents the initial minimum rate for
outgoing transfers, in kilobits per second. Users may
be able to modify thisrate in real time as allowed

by the software in use. This setting is not relevant to
transfers with a Fixed policy.

Positive integer

17

Outgoing Minimum Rate
Lock

After an outgoing transfer is started, its minimum
rate may be modified in real time. The default
setting of false gives users the ability to adjust the
transfer's minimum rate. A setting of true prevents
real-time modification of the transfer rate. This
setting is not relevant to transfers with a Fixed

policy.

e true
+ fase

fase

18

Outgoing Bandwidth
Policy Default

The value chosen sets the default Bandwidth Policy
for outgoing transfers. The default policy value
may be overridden by client applicationsinitiating
transfers.

o fixed
* high
« fair
* low

fair

19

Outgoing Bandwidth
Policy Allowed

The value chosen sets the allowed Bandwidth
Palicy for outgoing transfers. Aspera transfers use
fixed, high, fair and low policiesto accommodate
network-sharing requirements. When set to any, the
server will not deny any transfer based on policy
setting. When set to high, transfers with a Policy

of high and less aggressive transfer policies (for
example, fair or low) will be permitted. Fixed
transfers will be denied. When set to low, only

L] any
* high
o fair
e low

any
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Field

Description

Values

Default

transfers with a Bandwidth Policy of low will be
allowed.

20

Outgoing Bandwidth
Policy Lock

After an outgoing transfer is started, its Policy may
be modified in real time. The default setting of false
gives users the ability to adjust the transfer's Palicy.
A setting of true prevents real-time modification of
the Policy.

o true
o fdse

false

Advanced File Handling

Field

Description

Values

Default

File Create Mode

Specify file creation mode (permissions). If
specified, create files with these permissions (for
example 0755), irrespective of File Create Grant
Mask and permissions of the file on the source
computer. Only takes effect when the server isa
non-Windows receiver.

Positive integer
(octal)

undefined

File Create Grant Mask

Used to determine mode for newly created files

if File Create Mode is not specified. If specified,
file modes will be set to their original modes plus
the Grant Mask values. Only takes effect when the
server is anon-Windows receiver and when File
Create Mode is not specified.

Positive integer
(octal)

0644

Directory Create Mode

Specify directory creation mode (permissions). If
specified, create directories with these permissions
irrespective of Directory Create Grant Mask and
permissions of the directory on the source computer.
Only takes effect when the server is a non-Windows
receiver.

Positive integer
(octal)

undefined

Directory Create Grant
Mask

Used to determine mode for newly created
directoriesif Directory Create Mode is not
specified. If specified, directory modes will be set
to their original modes plus the Grant Mask values.
Only takes effect when the server is a non-Windows
receiver and when Directory Create Mode is not
specified.

Positive integer
(octal)

0755

Read Block Size (bytes)

Thisis a performance tuning parameter for an
Aspera sender. It represents the number of bytes an
Aspera sender reads at atime from the source disk
drive. Only takes effect when server is sender. The
default of O will cause the Aspera sender to useits
default internal buffer size, which may be different
for different operating systems.

Positive integer

Write Block Size (bytes)

Thisis a performance tuning parameter for an
Asperareceiver. Number of bytes an ascp receiver
writes data at atime onto disk drive. Only takes
effect when server is receiver. The default of O will
cause the Aspera sender to use its default internal
buffer size, which may be different for different
operating systems.

Positive integer
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Field

Description

Values

Default

Use File Cache

Thisis a performance tuning parameter for an
Asperareceiver. Enable or disable per-file memory
caching at the datareceiver. File level memory
caching improves data write speed on Windows
platformsin particular, but will use more memory.
We suggest using afile cache on systemsthat are
transferring data at speeds close to the performance
of their storage device, and disable it for systems
with very high concurrency (because memory
utilization will grow with the number of concurrent
transfers).

o true
false

true

Max File Cache Buffer
(bytes)

Thisis a performance tuning parameter for an
Asperareceiver. This value corresponds to the
maximal size allocated for per-file memory cache
(see Use File Cache). Unit is bytes. The default of
0 will cause the Asperareceiver to use itsinternal
buffer size, which may be different for different
operating systems.

Positive integer

Resume Suffix

Extension name of a class of special files holding
metadata information of regular datafiles. Useful

in the context of resuming partially completed
transfers. During resume mode (-k1/2/3), each data
file has a corresponding metadata file with the same
name and the pre-specified resume suffix.

text string

aspx

10

Preserve Attributes

Configure file creation policy. When set to none, do
not preserve the timestamp of source files. When set
to times, preserve the timestamp of the sourcefiles
at destination.

none/ times

undefined

11

Overwrite

Overwriteis an Aspera server setting that
determines whether Asperaclients are allowed to
overwrite files on the server. By default it is set to
allow, meaning that clients uploading filesto the
servers will be allowed to overwrite existing files as
long asfile permissions allow that action. If set to
deny, clients uploading files to the server will not
be able to overwrite existing files, regardless of file
permissions.

o dlow
e deny

alow

12

File Manifest

When set to text atext file "receipt” of al files
within each transfer session is generated. If set to
disable no File Manifest is created. The file manifest
isafilecontaining alist of everything that was
transferred in a given transfer session. The filename
of the File Manifest itself is automatically generated
based on the transfer session's unique ID. The
location where each manifest iswritten is specified
by the File Manifest Path value. If no File Manifest
Path is specified, the file will be generated under the
destination path at the receiver, and under the first
source path at the sender.

* text
+ disable

none
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(bytes)

session.

# |Field Description Values Default
13 | File Manifest Path Specify the location to store manifest files. Canbe | text string blank
an absolute path or a path relative to the transfer
user's home.
14 | Pre-Calculate Job Size | Configure the policy of calculating total job size . any any
before data transfer. If set to any, follow client . vyes
configurations (-o PreCalculateJobSize={yesno}). |, no
If set to no, disable calculating job size before
transferring. If set to yes, enable calculating job size
before transferring.
15 | Storage Rate Control Enable/Disable disk rate control. When enabled, . true false
adjust transfer rate according to the speed of . fase
receiving 1/O storage, if it becomes a bottleneck.
16 | File checksum method Specify the type of checksum to calculate for . any any
transferred files. The content of transfers can be e mds
verified by comparing the checksum value at the . <hal
destination with the value read at the source.
16 | Partia Suffix Set the file suffix for partially downloaded files. .aspx
Advanced Network Options
# | Field Description Values Default
1 |[BindIP Address Specify an |P address for server-side ascp to bind Valid IPv4 blank
its UDP connection. If avalid IP addressis given, address
ascp sends and receives UDP packets ONLY on the
interface corresponding to that 1P address.
2 | Bind UDP Port Specify a port number for server-side ascp to bind Positive integer | 33001
its UDP connection. This also prevents client ascp
processes from binding to same UDP port. Valid
port numbers range between 1 and 65535.
3 | Disable Packet Batching | When set to true, send data packets back to back . true false
(no sending a batch of packets). Thisresultsin . fase
smoother datatraffic at a cost of higher CPU usage.
4 [ Maximum Socket Buffer | Upper bound the UDP socket buffer of an ascp Positiveinteger |0
(bytes) on below the input value. The default of O will
cause the Aspera sender to use its default internal
buffer size, which may be different for different
operating systems.
5 | Minimum socket buffer | Set the minimum UDP socket buffer size for an ascp | Positiveinteger O

Transfer References

Simple Transfer Options

The following tables provide information on additional configurable settings that are available when creating simple
transfers.



| Appendix | 150

Connection

Fasp Port (UDP) Specify the UDP port for FASP file transfers.

Fasp proxy Enable transferring through a FASP proxy server, and specify the proxy host address, port,
username, and password. This feature enables the source node to bypass restrictionsto the
destination node for this specific transfer by using a proxy.

Security
Content protection Check the option to enable the content protection that encrypts the files on destination, using

the entered password.

Transport encryption

Select aes-128 to transfer with this encryption method.

Transfer

Target rate

Specify the transfer target rate.

Minimum rate

Set the transfer minimum rate

Bandwidth policy

Choose atransfer policy among fixed/high/fair/low.

Retry policy

Check the option to enable the retry policy, aswell as specify the number of attempts and
the duration.

Notifications

Email address To send status notifications for transfer events (start, success, or error), enter an email
address and click Add. When the email address appearsin the table, specify which email
template to use for each transfer event.

File Handling

Timestamp Filtering

Select this option to exclude files modified in the designated number of seconds.

Resume policy

Specify aresume policy and the overwrite rule when the file exists on the destination.

File attributes

Check the option to preserve the file permissions on the destination.

Symlinks

Specify how to deal with symbolic links: follow, copy, copy and force, or skip. Leave this
option blank if the sourceis on Windows. For all others, leaving it blank is the same as
choosing "follow".

Source Archiving

Move source files to adesignated directory after completing atransfer. The transfer's session
details page will display the archive directory's filepath as the After transfer path. For more
information on session details, see Transfer Details on page 42.

Note: The After transfer path will only be visible in the session details of the Console that
initiated the transfer. Another Console monitoring the same managed nodes will not have
access to the After transfer path.

Note: Rerunning the transfer may generate a"No such file or directory" error since the
source files were moved to the archive directory.

Delete empty source
subdirectories

This option becomes available if you selected Source Archiving. Select this option to delete
any subdirectory that is emptied by the source archiving.

Note: Console does not delete the top-most directory in the source path.
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Check the option to delete the transferred files from the source computer.

Exclude filter

Enter file-name pattern Console uses to determine what files to exclude from the transfer.
Y ou can use the following two symbols in the pattern:

e *: Matcherszero to many charactersin astring. For example, the* . t np pattern
matches. t mp and abcde. t np.

e ?:Matches any one character except a/ or . when preceded immediately by a/
character. For example, thet ?p pattern matchest np, but not t enp; and the ?exe
pattern matchesf i | e. exe but not . exe. fi | e, because the filepath would be
/.exe.file.

Include filter

Enter file-name pattern Console uses to determine what files to include in the transfer. Only
files matching thefilter are transferred.

Y ou can use the following two symbols in the pattern:

e *:Matcherszero to many charactersin a string. For example, the* . t np pattern
matches. t mp and abcde. t np.

e ?: Matches any one character except a/ or . when preceded immediately by a/
character. For example, thet ?p pattern matchest np, but not t enp; and the ?exe
pattern matchesf i | e. exe butnot . exe. fil e.

Advanced

Initiator

Check this option to initiate transfers from the destination node (if possible). Console
normally initiates transfers from the source node unless the source is an unmanaged node.

ascp version

Select the option to use ascp4 for thistransfer. Theinitiating node must have ascp4
available,

Note: Both nodes need to be running the same version of HST Server to useascp4. Also,
theappl y_| ocal _docr oot parameter inasper a. conf isnot currently supported.

Note: ascp4 isonly available for HST Server 3.8 and later.

fasp datagram size
(MTU)

Select the option and enter the datagram size in bytes.

Read block size

Check the option and enter the read block size in bytes.

Write block size

Check the option and enter the write block size in bytes.

Transfer Time

Transfer

Specify when to submit the transfer.

Note: You can cancel scheduled simple transfers by going to Activity > Transfers. Click
the Scheduled drop-down menu and select All. In the row for the transfer, click Cancel.
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Transfers
Scheduled: | All r
= Future
NAME DETAILS SCHEDULED

Cancel Scheduled Transfer admin (console), Node 1 fo Mode 1 4:39pm 30-Oct

ACTIONS

o

art

lx]

[k}

Smart Transfer Options

The following tables provide information on additional configurable settings that are available when creating smart

transfers.
Connection

Fasp Port (UDP) Specify the UDP port for FASP file transfers.

Fasp proxy Enable transferring through a FASP proxy server, and specify the proxy host address, port,
username, and password. This feature enables the source node to bypass restrictions to the
destination node for this specific transfer by using a proxy.

Security
Content protection Check the option to enable the content protection that encrypts the files on destination, using

the entered password.

Transport encryption

Select aes-128 to transfer with this encryption method.

Transfer

Target rate

Specify the transfer target rate.

Minimum rate

Set the transfer minimum rate

Bandwidth policy

Choose atransfer policy among fixed/high/fair/low.

Retry policy

Check the option to enable the retry policy, as well as specify the number of attempts and
the duration.

Notifications

Email address To send status notifications for transfer events (start, success, or error), enter an email
address and click Add. When the email address appearsin the table, specify which email
template to use for each transfer event.

File Handling

Timestamp Filtering

Select this option to exclude files modified in the designated number of seconds.

Resume policy

Specify aresume policy and the overwrite rule when the file exists on the destination.
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File attributes Check the option to preserve the file permissions on the destination.

Symlinks Specify how to deal with symbolic links: follow, copy, copy and force, or skip. Leave this
option blank if the source is on Windows. For all others, leaving it blank is the same as
choosing "follow".

Source Archiving Move source files to a designated directory after completing atransfer. The transfer's session
details page will display the archive directory's filepath as the After transfer path. For more
information on session details, see Transfer Details on page 42.

Note: The After transfer path will only be visible in the session details of the Console that
initiated the transfer. Another Console monitoring the same managed nodes will not have
access to the After transfer path.

Note: Rerunning the transfer may generate a"No such file or directory" error since the
source files were moved to the archive directory.

Delete empty source | This option becomes available if you selected Source Archiving. Select this option to delete
subdirectories any subdirectory that is emptied by the source archiving.

Note: Console does not delete the top-most directory in the source path.

Source Deletion Check the option to delete the transferred files from the source computer.

Excludefilter Enter file-name pattern Console uses to determine what files to exclude from the transfer.
Y ou can use the following two symbols in the pattern:

e *:Matcherszero to many charactersin astring. For example, the* . t np pattern
matches. t mp and abcde. t np.

e ?: Matches any one character except a/ or . when preceded immediately by a/
character. For example, thet ?p pattern matchest np, but not t enp; and the ?exe
pattern matchesf i | e. exe but not . exe. fi | e, because the filepath would be
/.exe.file.

Include filter Enter file-name pattern Console uses to determine what files to include in the transfer. Only
files matching thefilter are transferred.

Y ou can use the following two symbols in the pattern:

e *:Matcherszero to many charactersin astring. For example, the* . t np pattern
matches. t mp and abcde. t np.

e ?:Matches any one character except a/ or . when preceded immediately by a/
character. For example, thet ?p pattern matchest np, but not t enp; and the ?exe
pattern matchesfi | e. exe butnot . exe. fil e.

Advanced
Initiator Check this option to initiate transfers from the destination node (if possible). Console
normally initiates transfers from the source node unless the source is an unmanaged node.
ascp version Select the option to use ascp4 for thistransfer. Theinitiating node must have ascp4

available.

Note: Both nodes need to be running the same version of HST Server to use ascp4. Also,
theappl y_| ocal _docr oot parameterinasper a. conf isnot currently supported.

Note: ascp4 isonly available for HST Server 3.8 and later.

fasp datagram size Select the option and enter the datagram size in bytes.
(MTU)
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Read block size Check the option and enter the read block sizein bytes.

Write block size Check the option and enter the write block size in bytes.
Scheduling

Start Click the calendar icon to select a date and time that serves as the starting basis for your

recurring smart transfers. Based on the "Start" entry, Console will calculate the run time for
the next occurrence (that matches the repeat rules). For example, if your start date is Friday,
April 8, but your transfer is scheduled to run on Saturdays, then the first transfer will occur

on Saturday, April 9.

Repeat every Select the number of minutes, hours, days, weeks, or monthsto repeat this transfer. When
weeks is selected, you can enable the requisite days of the week. When months is sel ected,
you can specify whether to perform the transfer on a specific day of the month or on the "nth
____day" of the month (for example, 1st Sunday).

Until Click the calendar icon to select a"do not go beyond" date and time. Y our smart transfer
will not repeat beyond this entry.

Time zone Select your timezone from the drop-down list.

Important: When you have more than one destination, you can override the default smart transfer settings (with the
exception of scheduling) shown in the More Options panel for each individual destination.

Specify Base for Source Path

When selecting the source for a simple or smart transfer, you have the option to select Specify base for source
path(s) to specify a portion of the source path to remove to place the transferred files directly into the destination
folder without its hierarchy of directories.

For example, a source computer has a sent_files/project directory containing the following folders and files:

« /shared_files/project/presentation

« /shared_files/project/video footage/takel
» /shared_files/project/video footage/take?
» /shared_files/project/video footage/take3

If your select the shared_files/project directory as the source, by default, the transfer includesthesent _fi | es
directory and the entirety of its contents, including its hierarchy of directories. If the destination directory is specified
as/incoming, your transferred files appear as follows on the destination computer:

docroot/inconi ng/ shared _fil es/ project/presentation

docroot/inconi ng/ shared fil es/project/video footage/takel
docroot/inconi ng/ shared fil es/project/video footage/take2
docroot/inconi ng/ shared_fil es/ project/video_footage/take3

By selecting Specify base for sour ce paths(s), the project folder can be excluded. Entering "/shared_files/project”
in the field removes that part of the source path. Only the presentation and video_footage directories are transferred.
The transferred files appear as follows on the destination computer:

docr oot /i nconi ng/ presentati on

docroot /i nconi ng/ vi deo_f oot age/ t akel
docroot /i nconi ng/ vi deo_f oot age/ t ake2
docroot /i nconi ng/ vi deo_f oot age/ t ake3

If any files or folders selected for transfer fall outside the specified base path, they are omitted from the transfer.
For example, if the specified path is/shared_files/project/video_footage, then presentation is not transferred at
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all becauseitisnot in video_footage. Only takel, take2, and take3 are transferred. The transferred files appear as
follows on the destination computer:

docroot/inconi ng/takel
docroot/inconi ng/take2
docroot/inconi ng/take3

Tip: Specify base for source paths(s) can also be used to include more path depth than the default. If the source-
base path is specified as/shared_files, then project and al filesand foldersin its folder hierarchy are included.
Similarly, if the source-base path is specified as/, the entire source path and al fields and foldersin its folder
hierarchy are transferred.

Report References

Reference: Basic Report Organization Options

Field Description

Client Address Organize / summarize report by Client IP Address (client
= initiator of the transfer)

Contact Organize by the 'Contact’ shown for atransfer. This
might be a Console user name, a Faspex Server user
name, SSH account, or customized value obtained from

atransfer cookie. Examples: "admin (console)", "aspera
(ssh)", "aspera (faspex)”.

File Display adetail row for every filein every transfer.

File Extension Organize / summarize report by file extension.

Server Address Organize / summarize report by Server IP Address.

Session Display arow for every transfer session. A transfer
session represents one attempt to transfer.

Transfer Display arow for every transfer. A transfer may have

multiple sessionsiif it took multiple attemptsto finish.

Reference: Built-In Fields for Custom Field Rules

Built-In Fields Available for Creating Custom Field Rules (for Transfer-Level Fields)

Transfer Field Description
Client Address IP address of transfer initiator.
Client User Client-side username. Null for all transfers, except for

transfersinitiated by the Console.

Contact Contact assigned by Console. This can be a Console
user name, a Faspex Server user name, SSH account,
or customized value obtained from a transfer cookie.

Examples: "admin console", "asperassh”, "aspera
faspex".
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Transfer Field Description

Cookie Custom identifying text attached to a transfer session.
Thistext is used by the Console to identify and name
transfers.

Destination Address IP address of transfer destination (use for general
purpose).

Destination Path Thefile path on the destination machine.

Destination User If upload, dest_user is the server user. If download,

dest_user isclient user (NULL, unlessinitiated from
Console). For everyday purposes, recommend using
contact field instead.

Direction The direction of the transfer from the perspective of the
client. "Upload" if the transfer is a push; "Download" if
the transfer isa pull.

Meta-tags JSON hash used to tag transfers with additional data.

Faspex Metadata Information provided by Faspex, encoded in the transfer
cookie. See Basic Report Example: Faspex Metadata on
page 185.

Server Address IP address of the server.

Server User SSH account specified when the transfer starts (should
aways be displayed).

Source Address IP address of transfer source.

Source Paths File paths on the source machine.

Source User If upload, source_user isthe client user. If download,

SOuUrce User is server user.

Started Via The name of the application (Aspera or custom) that
isresponsible for initiating the transfer (for example,

aspera.scp, aspera.sync, €tc.).

Token Security token used for the transfer (note that this
depends on whether or not the application that started the
transfer is configured to use tokens).

Transfer Name Human-readable name assigned to atransfer. This name
may have been keyed in by the user or automatically set
by an application.

Built-In Fields Available for Creating Custom Field Rules (for File-Level Fields)

Note: Setting up file-level custom fieldsis NOT recommended for customers that transfer many small files, asthis
will result in scaling issues.

File Field Name Description

File Bytes Transferred Total bytes successfully received over the network.
File Error Desc Error message for thefile, if any.

File Extension Portion of the filename after the last period (.)
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File Field Name Description

File Full Destination Path File'sfull path from the destination's point-of-view.

File Full Source Path File'sfull path from the source's point-of-view.

File Name Name of the file, without its path (for example,
"ny_file.txt" ratherthan/tmp/my_file.txt)

File Size Size of thefile in bytes.

File Status Status of transfer or file (for example, "running,"

"completed,” "canceled" or "error").

Using Matchers in Custom Rules

Y ou can use regular expression (Regex) and JSON matchers (except in fields that expect anumber) to trigger arule
based on a particular phrase.

For example, you can use a Regex matcher to set a custom field named "engagement_id" to text the ID from an URL
in acookie:

e Built-in field: Cooki e

e Operator: mat chi ng regul ar expression

» Expression:. *engagenent\/ (?<text>.+?)\/transferid
e "engagement_id" custom field value: <t ext >.

In other words, if the cookie matches the regular expression, then set the custom field value to the value of <t ext >.
So, if the cookie hasthe URL: ht t ps: / / exanpl e. coni cust oner _engagenent/ 1234/ transferi d, the
"engagement_id" custom field valueis 1234.

Another exampleis using JSON matching to set a custom field (for example, "faspex_event") to the event namein
Faspex metadata:

e Built-in field: Faspex Met adat a

e Operator: JSON mat ch

e Expression:\{.*"Event":"(?<event>. +?)".*\)

« "faspex_event" custom field value: <event >.

In other words, if the Faspex Metadata JSON matches the expression, then set
the custom field value to the value of <event >. So, if the Faspex metadatais

{"EBEvent": " Sunmmer"," _pkg_uui d":"abde20e28db24bf db513c0a3de3bb8ff",
"pkg_name":"test"...},the"faspex_event" custom field'svalueis Summrer .

The expression isinterpreted as follows:

Expression I nterpretation Characters matched in the
example

\ { Finds aleft curly bracket character {

VX Followed by 0 or more characters
until the next piece of the expression
("EBEvent":")

"Event":" Followed by the first match of the "EVENT":"
exacttext" Event " : "

(?<event >. +?) Followed by at least 1 Sunmer
character" (save these characters and
call them <event >)
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Expression Interpretation Characters matched in the
example
" Followed by a quotation mark "
* Followed by O or more characters , " _pkg_uui d":"abde20e28db?

until the next piece of the expression |" pkg_nane":"test". ..
(30)

\} Followed by aright curly bracket }
character

Reference: Reporting Filters

Console provides built-in filters that allow you to specify conditions for limiting the data included in your report.

Column Heading Description
Filter By Select from alist of parameter names.
NOT Appears as a checkbox, where unchecked represents "is" and checked represents"is
not" (for example, file extension is not equal to tmp)
Comparison Select from alist of operators (for example,, equal to, greater than, etc.).
Value Input a parameter value to complete the filter expression.
Filters
Filter by NOT Comparison Value
File Extension - < equal to * mp3 remave
File Size - greater than ~ 10000 remave

select...

-

Important: Once you have added afilter, you may remove it by clicking the Remove hyperlink.

Thefollowing filter parameters are available within the Filter By drop-down list:

4bf db513c

Parameter Name

Parameter Description

{ Custom Field Names}

Displays custom fields that you have configured for the SQL database.

File Bytes Transferred

File bytes successfully received over the network by the destination.

File Bytes Written

Files bytes successfully received over the network by the destination, plus bytes
skipped for data already present at the destination.

File Error Description

File's error message, if any.

File Extension

Portion of the filename after the last period (.)

File Fullpath

File's directory tree hierarchy.

File Name

Name of the file, without its path (for example, "my_file.txt," rather than "C:\temp
\my_file.txt").

File Session Status

Status of file session (for example, "running,”" "completed," "canceled" or "error"),

where afile session isonefilein atransfer session. A file record may group together
more than one file session record if, during atransfer session, one of the files fails or
isinterrupted. In the next transfer session (when the transfer is retried or a hot folder
handles the next batch of filesto arrive), then that particular file may be retried. This

will result in another file session record being created.
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Parameter Name

Parameter Description

File Size Size of thefilein bytes.

File Status Thefile status will be the status of the last/most recent file session for the file (for
example, "running,” "completed,” "canceled" or "error").

SSH Account SSH account specified when the transfer starts.

Transfer Average Rate Average transfer rate in bits per second.

Transfer Bytes Lost

Number of bytes sent by source for a particular file, but never received by destination,
or never written to disk.

Transfer Bytes Transferred

Total bytes successfully received over the network by the destination.

Transfer Bytes Written

Total bytes successfully received over the network by the destination, plus bytes
skipped for data already present at the destination.

Transfer Client Address

IP address of transfer initiator.

Transfer Contact

Contact assigned by Console. This can be a Console user name, a Faspex user name,
SSH account, or customized value obtained from atransfer cookie. Examples: "admin

(console)", " michael (faspex)"

aspera (ssh)",

Transfer Cookie

Custom identifying text attached to atransfer session. Thistext is used by the Console
to identify and name transfers.

Transfer Destination
Address

IP address of transfer destination.

Transfer Destination Path

The file path on the destination machine.

Transfer Error Description

Error message for transfer or file, if any.

Transfer Files Completed

Number of files successfully verified at destination (i.e., the number of files actualy
transferred plus the number of files that were already at destination).

Transfer Files Failed

Number of files that failed to transfer.

Transfer Name

Human-readable name assigned to a transfer. This name may have been keyed in by
the user or automatically set by an application.

Transfer Server Address

IP address of transfer server.

Transfer Session Status

Indicates status of transfer session (for example, "running," "completed," "canceled”
or "error"), where the transfer session represents one execution of ascp (i.e., one
attempt to transfer).

Note: When atransfer session isinterrupted or fails and is configured to retry, a
second transfer session will begin after the configured retry interval has elapsed.

Transfer Source Address

IP address of transfer source.

Transfer Source Paths

File paths on the source machine.

Transfer Status

A transfer will group together transfer sessions into a singleitem. The transfer status
will be the status of the last/most recent transfer session for the transfer (for example,
"running," "completed,” "canceled" or "error").

Reference: SQL Variables for Advanced Reports

When creating your advanced report, you may utilize the SQL variableslisted below. These variables also appear
within Console's built-in, SQL script text help.
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SQL Variable Description

$TBL_FILES Files table. One record in this table represents one file. At run time, this
variable gets replaced with the SQL name of the table containing the file
data (currently 'rpt_transfer_files'). Please note the following distinction:

e A FILE record can have multiple associated TRANSFER SESSION
FILE records (if afile took more than one attempt to transfer).

* A FILE record has one and only one associated TRANSFER record
($TBL_TRANSFER_FILES.transfer_id = $TBL_TRANSFERS.id).

$TBL_TRANSFER_SESSIONS Transfer sessions table. One record in this table represents one attempt

to transfer data. If you start atransfer and it fails, then automatically
retries and succeeds, there will be two recordsin thistable, one for the
initial attempt and one for the automatic retry. For hot folder transfers,
each session represents one attempt to transfer a batch of filesthat are
currently available. If new files become available while the first batch isin
progress, these may be transferred in a subsequent session, resulting in an
additional record in thistable. At run time, this variable gets replaced with
the SQL name of the table containing the transfer session data (currently
'rpt_transfer_sessions). Please note the following distinction:

e A TRANSFER SESSION record can have multiple TRANSFER
SESSION FILE records (if the session attempted to transfer more than
onefile).

¢ A TRANSFER SESSION record has one and only one associated
TRANSFER record ($TBL_TRANSFER_SESSIONS.transfer_id =
$TBL_TRANSFERS.id).

$TBL_TRANSFER_SESSION_FILES | Fileswithin atransfer session. One record in this table represents one
attempt to transfer afile. At run time, this variable gets replaced with
the SQL name of the table containing the file session data (currently
'rpt_transfer_session_files). Please note the following distinction:

e A TRANSFER SESSION FILE record has
one and only one associated FILE RECORD
($TBL_TRANSFER_SESSION_FILES.transfer_file_id =
$TBL_FILES.id).

¢ A TRANSFER SESSION FILE record has one and
only one associated TRANSFER SESSION record
($TBL_TRANSFER_SESSION_FILES.transfer_session_id =
$TBL_TRANSFER_SESSIONS.id).

$TBL_NODES A table containing one record for each node, whether managed or
unmanaged. At run time, this variable gets replaced with the SQL name of
the table containing the node data (currently 'rpt_transfer_nodes).

$TBL_TRANSFERS A TRANSFER groups together TRANSFER SESSIONS to tie together
retry attempts and hot folder file batches. Related TRANSFER
SESSIONS are grouped together so that no matter how many times the
session was interrupted and retried, only asingle record will be present in
thistable. At run time, this variable gets replaced with the SQL name of
the table containing the transfer data (currently 'rpt_transfers’). Please note
the following distinction:

e A TRANSFER record can have multiple TRANSFER SESSION
records (if multiple attempts or batches were required to transfer all the
data).
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SQL Variable

Description

* A TRANSFER record can have multiple FILE records (if the transfer
consisted of more than onefile).

$FINAL_RESULT_TABLE

'report_100_results).

Thisisthe table where you place your final results. The data displayed
on reports comes directly from this table. At run time, this variable gets
replaced with a name based on an auto-generated numeric id (for example,

$TMP_TABLENAME

If you need any temporary tables for intermediate record

processing, give them names starting with "$STMP_" (for example,
$TMP_UNIQUE_IP_ADDRESSES). At run time, these variables get
replaced with a name based on an auto-generated numeric id (for example,
'report_100_temp_unique_ip_addresses)).

$USER_ID

Thisistheloginid of user requesting report. At run time, this variable gets
replaced with the numeric id of the user requesting the report.

$REPORT_PERIOD_START

Report period start. The user running this report will be prompted for a
value at request time. (Vaueis converted to UTC before substitution).

$REPORT_PERIOD_END

Report period end. The user running this report will be prompted for a
value at request time. (Vaueis converted to UTC before substitution).

$ANYTHING_ELSE

Any $NAME that does not match one of the variablesis presumed to be a
custom variable whose value will be provided by the report requester. See
Editing Custom Variables on page 81 for instructions on how to create
and configure a custom variable.

Reference: Database Fields for Advanced Reports

When creating your advanced report, you may utilize the database fields listed below. These fields (and
corresponding descriptions) also appear within Console's built-in, SQL script text help.

Note: Theterm "client" refers to the machine initiating atransfer request. The term "server" refers to the machine
receiving the request. These terms do not describe the direction of the file transfer. Aslong as amachineisthe
transfer initiator, it does not matter whether the machineis sending afile or receiving afile.

Database Field Description Table

args _attempted Number of items specifically selected | $TBL_TRANSFER_SESSIONS
by the user (either in GUI or command
line).

args_completed Out of the number of arguments $TBL_TRANSFER_SESSIONS

attempted, the number completed
successfully.

aspera_version

Aspera product version for the node
machine.

$TBL_NODES

avg_loss pct Average packet loss over the network, | $TBL_TRANSFER_SESSIONS
which is calculated as a percentage.
avg_rate Average transfer rate in bits per $TBL_TRANSFERS,
second. $TBL_TRANSFER_SESSIONS
bytes config The number of contiguous bytes $TBL_TRANSFER_SESSION_FILES,

that have been transferred to the
destination.

$TBL_FILES
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Database Field Description Table
bytes lost Number of bytes sent by sourcefora | $TBL_TRANSFERS,
particular file, but never received by $TBL_TRANSFER_SESSIONS,
destination, or never written to disk. $TBL_TRANSFER_SESSION_FILES,
$TBL_FILES
bytes pretransfer If the server is configured to do so, $TBL_TRANSFERS,

calculates size of the transfer before
the transfer starts. On the server, this
corresponds to the "pre-calculate job
Size" setting.

$TBL_TRANSFER_SESSIONS

bytes remaining

Total bytes waiting to be sent over the
network to the destination.

$TBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS

bytes transferred

Total bytes successfully received over
the network by the destination.

$TBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS,
$TBL_TRANSFER_SESSION_FILES,
$TBL_FILES

bytes written Total bytes successfully received over | $TBL_TRANSFERS,
the network by the destination, plus $TBL_TRANSFER_SESSIONS,
bytes skipped for data already present | $TBL_TRANSFER_SESSION_FILES,
at the destination. $TBL_FILES

cipher Encryption algorithm. $TBL_TRANSFERS,

$TBL_TRANSFER_SESSIONS

client_console ip

The client's |P address from the
perspective of the Aspera Console
application (advanced / debugging
field).

$TBL_TRANSFER_SESSIONS

client_err_code

Error code reported by the client.

$TBL_TRANSFER_SESSION_FILES,
$TBL_TRANSFER_SESSIONS

client_err_desc

Error code description reported by the
client.

$TBL_TRANSFER_SESSION_FILES,
$TBL_TRANSFER_SESSIONS

client_external_fasp port

The client's UDP port from the
perspective of the server (advanced /
debugging field).

$TBL_TRANSFER_SESSIONS

client_externa_ip

The client's | P address from the
perspective of the server (advanced /
debugging field).

Note: If the client is a managed node
and the server is not, then thisfield is
null.

$TBL_TRANSFER_SESSIONS

client_file _basename

File's basename from client's point-of-
view.

$TBL_TRANSFER_SESSION_FILES,
$TBL_FILES

client_file_extension

File's extension from client's point-of-
view.

$TBL_TRANSFER_SESSION_FILES,
$TBL_FILES

client_file_fullpath

File'sfull path from the client's point-
of-view.

$TBL_TRANSFER_SESSION_FILES,
$TBL_FILES
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Database Field

Description

Table

client_file index

Arbitrary, unique number assigned to
each file within atransfer session (on
the client).

$TBL_TRANSFER_SESSION_FILES

client_ip

IP address of the transfer initiator (use
for general purpose).

$TBL_TRANSFER_SESSIONS

client_node id

ID number assigned to the client node.

$TBL_TRANSFER_SESSIONS

client_node_uuid

Universaly, unique ID number
assigned to the client node.

$TBL_TRANSFER_SESSIONS

client_status

Either the file status (running,
completed, error) or the session status
reported by the client.

Note: In some cases, client and server
can see different statuses (for example,
canceled versus error).

$TBL_TRANSFER_SESSION_FILES,
$TBL_TRANSFER_SESSIONS

client_user

Client-side username. Null for all
transfers, except for transfers initiated
by the Console.

$TBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS

contact

Contact assigned by Console. This can
be a Console user name, a Faspex user
name, SSH account, or customized
value obtained from atransfer cookie.

Examples: "admin (console)", "aspera
(sshy", "michael (faspex)"

$TBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS

cookie

Custom identifying text attached to
atransfer session. Thistext isused
by the Console to identify and name
transfers.

$TBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS

dest_endpoint _id

ID number assigned to the destination
endpoint.

$TBL_TRANSFER_SESSIONS

dest_file basename File's basename from destination's $TBL_FILES
point-of-view.

dest_file_extension File's extension from destination's $TBL_FILES
point-of-view.

dest_file fullpath File'sfull path from the destination's | $TBL_FILES

point-of-view.

dest_ip IP address of transfer destination (use | $TBL_TRANSFER_SESSIONS
for general purpose).

dest_node id ID number assigned to the destination | $TBL_TRANSFER_SESSIONS
node.

dest_path The file path on the destination $TBL_TRANSFERS,
machine. $TBL_TRANSFER_SESSIONS

dest_user If upload, dest_user isthe server $TBL_TRANSFERS,

user. If download, dest_user isclient
user (NULL, unlessinitiated from

$TBL_TRANSFER_SESSIONS
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Database Field

Description

Table

Console). For everyday purposes,

recommend using contact field instead.

dirs_pretransfer

If the server is configured to do so,
calculates number of directoriesto be
transferred. Only calculated if "pre-
calculate job size" setting isturned on.

$TBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS

dirscans_completed

Number of directory scans completed.

$TBL_TRANSFER_SESSIONS

err_desc

Error message for transfer or file, if
any.

$TBL_TRANSFER_SESSION_FILES,
$TBL_TRANSFER_SESSIONS

fallback_protocol

If the transfer has been configured
to retry using the HTTP fallback
protocol, then this field will report
"http." If not, will be NULL.

$TBL_TRANSFER_SESSIONS

file_basename

Name of the file, without its path (for
example, "my_file.txt," rather than "C:
\temp\my_file.txt")

$TBL_TRANSFER_SESSION_FILES,
$TBL_FILES

file_extension Portion of the filename after the last $TBL_TRANSFER_SESSION_FILES,
period (.) $TBL_FILES
file fullpath Full path to thefile. $TBL_TRANSFER_SESSION_FILES,
$TBL_FILES
files_attempted Number of filesattemptedtobesent | $TBL_TRANSFERS,

over the network.

$TBL_TRANSFER_SESSIONS

files_ complete

Number of files successfully verified
a destination, that is, the number of

files actually transferred + number of
files that were already at destination.

$TBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS

files failed

Number of files that failed to transfer.

$TBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS

files_pretransfer

If the server is configured to do

so, calculates number of filesto be
transferred. Only calculated if "pre-
calculate job size" setting is turned on.

$TBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS

files_skipped

Number of files skipped.

$TBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS

filescans_completed

The number of file scans compl eted.

$TBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS

hostname

The local name of the node machine
(whichisonly filled in for managed
nodes). Note that a node machine will
be called "localhost" if it hasn't been
previously named.

$TBL_NODES

Unique integer 1D assigned by the
Console (used as an internal field).

$TBL_NODES, $TBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS,
$TBL_TRANSFER_SESSION_FILES,
$TBL_FILES
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Database Field

Description

Table

initiated_by source

Identifiesan "upload." If thisfield is
equal to 1, then whoever started the
transfer is uploading.

$TBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS,
$TBL_TRANSFER_SESSION_FILES,
$TBL_FILES

last_client_ip

The client's P address from the last
session of amultiple session transfer.

$TBL_TRANSFERS

last_client_node id

ID number assigned to the client node
during the last session of amultiple
session transfer.

$TBL_TRANSFERS

last_dest_ip

The destination's | P address from
the last session of a multiple session
transfer.

$TBL_TRANSFERS

last_dest node id

ID number assigned to the destination
node during the last session of a
multiple session transfer.

$TBL_TRANSFERS

last_err_desc

Error description from the last session
of amultiple session transfer.

$TBL_TRANSFERS, $TBL_FILES

last_network_delay

Thelag on the network (RTT,
measured in milliseconds) from the
last session of amultiple session
transfer.

$TBL_TRANSFERS

last_restarted at

The last date/time that the node
machine was restarted (for managed
node's only).

$TBL_NODES

last_retry_timeout

The number of seconds that the server
waited to try again (after afailure),
during the last session of amultiple
transfer on.

$TBL_TRANSFERS

last_server_ip

The server's | P address from the last
session of amultiple session transfer.

$TBL_TRANSFERS

last_server_node id

ID number assigned to the server node
during the last session of amultiple
session transfer.

$TBL_TRANSFERS

last_source_ip

The source's IP address from the last
session of amultiple session transfer.

$TBL_TRANSFERS

last_source node id

ID number assigned to the source node
during the last session of amultiple
session transfer.

$TBL_TRANSFERS

last_transfer_session file id

ID number assigned to the file during
the last transfer session.

$TBL_FILES

last_transport

Transport mechanism (“fasp2" for
Aspera protocol, "http" for fallback
protocol) from the last session of a
multiple session transfer.

$TBL_TRANSFERS
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Database Field Description Table

max_rate Maximum transfer rate. $TBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS

min_rate Minimum transfer rate. $TBL_TRANSFERS,

$TBL_TRANSFER_SESSIONS

mkdirs_attempted

Number of directories that were

$TBL_TRANSFER_SESSIONS

attempted to be created at the
destination.

mkdirs failed Number of directoriesthat failed tobe | $TBL_TRANSFER_SESSIONS
created at the destination.

mkdirs_passed Number of directories that were $TBL_TRANSFER _SESSIONS
created successfully at the destination.

name cf Human-readable name assignedtoa | $TBL_NODES, $TBL_TRANSFERS,
transfer. This name may have been $TBL_TRANSFER_SESSIONS
keyed in by the user or automatically
set by an application.

network_delay Lag on the network (RTT), whichis | $TBL_TRANSFER_SESSIONS
measured in milliseconds.

operation Either upload or download from the $TBL_TRANSFERS,
perspective of the client (theinitiator). | $TBL_TRANSFER_SESSIONS
Upload if pushing; download if
pulling.

0S The node machine's Operating System. | $TBL_NODES

0S _version The version of the node machine's $TBL_NODES

Operating System.

paths attempted

The total number of files and
directories attempted.

$TBL_TRANSFER_SESSIONS

paths_excluded

The number of files and directories
that were not transferred because of an
exclusion rules.

$TBL_TRANSFER_SESSIONS

paths failed

The number of files and directories
that failed to transfer. A failureis
counted if the sender was unable to
read a source file or the destination
was unable to write thefile.

$TBL_TRANSFER_SESSIONS

paths irreg

Thisisthe total number of special files
(for example, nodes, pipes, memory
mapped files, page files or /proc files).
These files are never transferred.

$TBL_TRANSFER_SESSIONS

pct_complete

Percent (%) of transfer that has been
completed. NULL if the node is server
is not configured to pre-calculate job
size.

$TBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS

pretransfer_stats changed

Between one attempt to the next
(retries and sync), whether or not the

$TBL_TRANSFERS
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Database Field Description Table
size of the transfer has changed (grew
or reduced in size).
primary_address The node's actual | P address (which $TBL_NODES

has been keyed into the Console
interface).

priority

Normal or high (only valid when the
policy if adaptive).

$TBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS

reported by both sides

Database logger added information
to the Console from both ends of the
transfer (both source and destination
are managed nodes and both are
sending data back to the database).

$TBL_TRANSFERS

reported by server

If thisfield is equal to 1, then Console
received data from the server node. If
thisfield is equal to O, then the server
was not a managed node or failed to

log.

$TBL_TRANSFER_SESSION_FILES,
$TBL_FILES

reported_policy High, fixed, adaptive or trickle. $TBL_TRANSFER_SESSIONS

reported_priority Normal or high (only valid whenthe | $TBL_TRANSFER_SESSIONS
policy if adaptive).

retry_timeout After atransfer fails, the number of $TBL_TRANSFER_SESSIONS

seconds the server will wait before
trying again.

seconds _remaining

Seconds remaining for the file transfer.

$TBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS

server_console ip

Internal |P address of the server
(inputted into the nodes page inside
Console). Note that thisfield is
primarily used for testing.

$TBL_TRANSFER_SESSIONS

server_err_code

Error code reported by the server.

$TBL_TRANSFER_SESSION_FILES,
$TBL_TRANSFER_SESSIONS

server_err_desc

Error code description reported by the
server.

$TBL_TRANSFER_SESSION_FILES,
$TBL_TRANSFER_SESSIONS

server_externa_fasp_port

External fasp (UDP) port of the server.
Note that thisfield is primarily used
for testing.

$TBL_TRANSFER_SESSIONS

server_externa _ip

External |P address of the server. Note
that thisfield is primarily used for
testing.

$TBL_TRANSFER_SESSIONS

server_file basename

File's basename from server's point-of-
view.

$TBL_TRANSFER_SESSION_FILES,
$TBL_FILES

server_file extension

File's extension from server's point-of-
view.

$TBL_TRANSFER_SESSION_FILES,
$TBL_FILES

server_file fullpath

File'sfull path from the server's point-
of-view.

$TBL_TRANSFER_SESSION_FILES,
$TBL_FILES
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Database Field

Description

Table

server_file index

Arbitrary, unique number assigned to
each file within atransfer session (on
the server)

$TBL_TRANSFER_SESSION_FILES

server_ip

|P address of transfer server.

$TBL_TRANSFER_SESSIONS

server_node id

ID assigned to the server node.

$TBL_TRANSFER_SESSIONS

server_node_uuid

Universaly, unique ID assigned to the
server node.

$TBL_TRANSFER_SESSIONS

server_status

Either the file status (running,
completed, error) or the session status
reported by the server. Note that in
some cases, client and server can

see different statuses (for example,
canceled versus error).

$TBL_TRANSFER_SESSION_FILES,
$TBL_TRANSFER_SESSIONS

server_user

SSH account specified when the
transfer starts (should always be

displayed).

$TBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS

session_count

Number of sessions required for the
transfer.

Note: Hot folders can span many
sessions.

$TBL_TRANSFERS

session_file_count

Number of sessions required to send a
particular file.

$TBL_FILES

session _id ID assigned to transfer session. $TBL_TRANSFER_SESSION_FILES,
$TBL_TRANSFER_SESSIONS
size Size of thefilein bytes. $TBL_TRANSFER_SESSION_FILES,
$TBL_FILES
size _changed The change in file size from one $TBL_FILES
transfer attempt to another.
soap_active_sessions Number of transfer sessions running $TBL_NODES

on the node.

source_endpoint_id

ID assigned to the source endpoint.

$TBL_TRANSFER_SESSIONS

source file_basename

File's basename from source's point-of-
view.

$TBL_FILES

source file_extension File's extension from source's point-of- | $TBL_FILES
view.
source file fullpath File'sfull path from the source's point- | $TBL_FILES

of-view.

source_ip

IP address of transfer source.

$TBL_TRANSFER_SESSIONS

source node id

ID assigned to the source node.

$TBL_TRANSFER_SESSIONS

source_paths

File paths on the source machine.

$TBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS
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Database Field

Description

Table

source paths changed

Between one transfer attempt to the
next, whether or not the file source

$TBL_TRANSFERS

paths have changed.

source_user If upload, source_user isthe client $TBL_TRANSFERS,
user. If download, source user is $TBL_TRANSFER_SESSIONS
Server user.

ssh_port Node machine's SSH port. $TBL_NODES

ssh_tunnel_port Node machine's SSH tunnel port. $TBL_NODES

start_byte Displaysthe point at which datafrom | $TBL_TRANSFER_SESSION_FILES,
the file started transferring to the $TBL_FILES
destination (relevant if some of thefile
has aready been transferred). If the
file has already been transferred to the
destination, then the start byte equals
thetotal file size.
started _at Date and time that atransfer or file $TBL_TRANSFERS,
started. $TBL_TRANSFER_SESSIONS,
$TBL_TRANSFER_SESSION_FILES,
$TBL_FILES
started_via The name of the application (Aspera | $TBL_TRANSFERS,
or custom) that is responsible for $TBL_TRANSFER_SESSIONS
initiating the transfer (for example,
aspera.scp, aspera.sync, etc.).
status Status of transfer or file (for example, | $TBL_TRANSFERS,
"running,” "completed,” "canceled" or | $TBL_TRANSFER_SESSIONS,
"error'). $TBL_TRANSFER_SESSION_FILES,
$TBL_FILES
stopped_at Date and time that atransfer or file $TBL_TRANSFERS,
stopped (value is blank if transfer or $TBL_TRANSFER_SESSIONS,
fileisstill active). $TBL_TRANSFER_SESSION_FILES,
$TBL_FILES
target_rate Target transfer rate. $TBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS
tmp_actual_rate Reserved for future use. $TBL_TRANSFERS,

$TBL_TRANSFER_SESSIONS

tmp_actual_rate calculated at

Reserved for future use.

$TBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS

tmp_loss pct

Reserved for future use.

$TBL_TRANSFER_SESSIONS

token

Security token used for the transfer
(note that this depends on whether
or not the application that started the
transfer is configured to use tokens).

$TBL_TRANSFERS,
$TBL_TRANSFER_SESSIONS

transfer_file id

Correspondsto thefile ID field

$TBL_TRANSFER_SESSION_FILES

transfer_id

Correspondsto ID field.

$TBL_TRANSFER_SESSIONS,
$TBL_FILES
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Database Field Description Table

transfer_session_id Corresponds to transfer session 1D $TBL_TRANSFER_SESSION_FILES
field

transfer_uuid Universally, unique ID that is used $TBL_TRANSFERS,
to identify the transfer as awhole. $TBL_TRANSFER_SESSIONS
May contain multiple sessionsand is
generated by application that started
the transfer. Generally only populated
by transfers started by Console.

transport fasp2 for Aspera protocol, "http" for $TBL_TRANSFER_SESSIONS
fallback protocol

type Managed or unmanaged node. $TBL_NODES

udp_port Node machine's UDP port. $TBL_NODES

use_ssh_tunnel Set up an SSH tunnel for database $TBL_NODES
logging (for managed nodes only).

USecs Length of the transfer session (in $TBL_TRANSFERS,
milliseconds). Not authoritative $TBL_TRANSFER_SESSIONS,
(use only for transfer sessions and $TBL_TRANSFER_SESSION_FILES,
transfers). $TBL_FILES

uuid Universally, unique identifier that is $TBL_NODES
generated on the node when installing
Aspera software (for managed nodes
only)

Important: If you have configured custom fields, they will be prefixed with "cf_". Custom fields are utilized in
the $TBL_FILES and $TBL_TRANSFER tables. Please note that if you would like to add additional custom fields,
you may do so viathe Configuration > Custom Fields. For instructions on setting up a custom field, see Creating

Custom Fields on page 82.

Advanced Report Usage Notes

Advanced Report Usage Notes: Avoid Duplicating Identical Records

Consol€'s security filtering prioritizes speed over the cost of potentially returning duplicate records. It is up to the
report writer to remove duplicate records returned when querying report tables directly.

For example, a user unaware of Console internals might expect the following to aways return no more than asingle

record:

SELECT ts.*
FROM

$TBL_TRANSFER _SESSI ONS ts

VWHERE

ts.session_id=' ed0a9b4039bb40df a86690f f 7elf 6f a2’

However, depending on the user's group memberships and permissions, the above could return multiple identical
records. To correct this, use SELECT DISTINCT. For example:

SELECT DI STINCT ts.*
FROM
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$TBL_TRANSFER SESSI ONS ts
VWHERE
ts.session_id='ed0a9bh4039bb40df a86690f f 7elf 6f a2’

Be aware that this means you cannot directly perform aggregate computations--such as SUM, AVERAGE, or
COUNT--on the reporting tables. For example, in the following, total_bytes transferred could count some sessions
multiple times:

SELECT DI STI NCT

ts. contact

, SUMts. bytes transferred) AS total bytes transferred
FROM

$TBL_TRANSFER_SESSI ONS t s
V\HERE

Instead, first extract just the data of interest to atemporary table, then summarize from there:

# Create holding table for filtered raw data
CREATE TABLE $TMP_FI LTERED TRANSFER SESSI ONS (
“id INT(11) NOT NULL AUTO | NCREMENT PRI MARY KEY
, ~contact® VARCHAR(255)
, bytes transferred’ BI G NT(20)

# Extract relevant data (very inportant to include ts.id)
| NSERT | NTO $TMP_FI LTERED TRANSFER_SESSI ONS
SELECT DI STI NCT

ts.id

, ts.contact

, ts.bytes transferred
FROM $TBL_TRANSFER SESSIONS ts
VHERE

ts.started_at < ' $REPORT_PERI OD_END

AND (

ts.stopped_at >= ' $REPORT_PERI OD START'

OR ts.stopped_at IS NULL

);

# Sunmmari ze by contact
CREATE TABLE $FI NAL_RESULT_TABLE
SELECT

fts.contact

, SUMfts.bytes transferred) AS total bytes transferred
FROM

$TMP_FI LTERED_TRANSFER SESSI ONS fts
GROUP BY

fts.contact
ORDER BY

fts.contact

Advanced Report Usage Notes: Avoid Duplicating Redundant Records

Transfers between two managed nodes create two records per file, onein $TBL_TRANSFER_SESSION_FILES
andonein $TBL_FILES.

If both source and destination are managed nodes, then both sides log to the database. These records will not be
identical--the record logged by the server reports the server-side path, while the record logged by the client reports the
client-side path. Sometimes other fields, such as err_desc, may differ aswell.
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There are several fieldsin the canonical tables supplied specifically to address this issue:

Field Name Description Tables
reported_by both_sides | 0if transfer was only logged by | $TBL_TRANSFERS
oneside.

1if transfer was logged by both
server and client.

reported by server 0if thefilerecord waslogged |$TBL_FILES
by the client. $TBL_TRANSFER_SESSION_FILES
1if thefile record was logged
by the server.
initiated_by_source Oif transfer isapull (clientis |$TBL_TRANSFERS
the destination). $TBL_TRANSFER_SESSIONS$TBL_FILES

1 if trangfer isapush (dlientis | $TBL_TRANSFER_SESSION_FILES

the source).

To ensure that each fileis present only once in aresult set, we need to use the above fields to give precedence to the
record from one side or the other.

Note: The previous caveat about record duplication (Advanced Report Usage Notes: Avoid Duplicating Identical
Records on page 170) also applies (i.e. the file record reported by the server node could itself be returned multiple
times, as well as the record reported by the client node).

Note: Certain edge cases cause a problem even when using the above filter. For example, if both nodes start
reporting a transfer session and one node loses its connection to the database, then reported_by both_sides will
equal 1, but not all of the file records will have two records in the file tables.

The following SQL example, taken from the built-in Activity Summary By Contact report, gives the destination-
sidefile record precedence in cases where both sides logged the transfer.

#
# Set variables to hold report datetime paraneters
# (all datetines are converted to UTC)

i

7
SET @eport_period_start = '$REPORT_PERI OD_START' ;
SET @eport_period_end = ' $REPORT_PERI OD_END ;

H

# PRE- FI LTER RECORD | DS

# Initially retrieve just the id colums from
# base tables (inproves performance by avoidi ng
# queries with nore than one join)

H

H H
()
Q
—
()
—
Q
=
D
(%]
—
o
>
2
o
—
>
D
o)
=
D
—
—
(0]
=
D
o
=
(1)
(@]
o
=
o

CREATE TABLE $TMP_TRANSFER | DS (
id INT NOT NULL PRI MARY KEY
, reported_by both_sides TINYINT(1) NOT NULL DEFAULT O

) il
CREATE TABLE $TMP_TRANSFER_SESSI ON_I DS (
id INT NOT NULL PRI MARY KEY
, reported_by both_sides TINYINT(1) NOT NULL DEFAULT O

I

CREATE TABLE $TMP_FI LE _SESSI ON I DS (
id INT NOT NULL PRI MARY KEY

, transfer_session_id | NT NOT NULL

);
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| NSERT | NTO $TMP_TRANSFER_| DS
SELECT DI STI NCT

t.id

, t.reported by both_sides
FROM $TBL_TRANSFERS t
V\HERE

(t.started_at < @eport_period_end

AND (t.stopped_at >= @eport_period _start
OR t.stopped_at IS NULL

# Transfer Sessions
# (copy over 'reported by both_sides'
# fromtransfers)

| NSERT | NTO $TMP_TRANSFER SESSI ON_| DS
SELECT DI STI NCT
ts.id
, t.reported by both_sides
FROM $TBL_TRANSFER _SESSI ONS ts
JO N $TMP_TRANSFER | DS t
ON ts.transfer_id =t.id
VWHERE
(ts.started at < @eport_period_end
AND (ts.stopped _at >= @eport_period start
OR ts.stopped_at IS NULL

# Fil e Sessions (choose destination-side
# info if both sides | ogged to db)

| NSERT | NTO $TMP_FI LE_SESSI ON_| DS
SELECT DI STI NCT
fs.id
, fs.transfer_session_id
FROM $TBL_TRANSFER_SESSI ON_FI LES fs
JO N $TMP_TRANSFER SESSI ON_IDS ts
ON fs.transfer_session_id =ts.id
VWHERE
(fs.started at < @eport_period_end
AND (fs.stopped at >= @eport_period _start
OR fs.stopped_at IS NULL)

)
AND (ts.reported_by both_sides=0
OR (
(fs.reported by server=1
AND fs.initiated by source=1)
OR (fs.reported_by server=0
AND fs.initiated_by source=0)

)
)

bREATE I NDEX i dx_transfer_session_id
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ON $TMP_FI LE SESSI ON I DS (transfer_session_id);

Advanced Report Usage Notes: Filter on Raw Values

Filtering on computed values in most cases prevents MySQL from being able to take advantage of indexes. For
example, the following will force a scan of every recordin TBL_TRANSFER_SESSIONS, because MySQL hasto
perform the CONVERT( ) on ts.started_at for every record:

SELECT DI STINCT ts.*
FROM
$TBL_TRANSFER _SESSI ONS t's
VHERE
CONVERT(ts.started_at, DATE) = DATE(NOW))

Instead, compute the correct criteriato compare the raw value against:

SET @ odays_date = DATE(NOW));

SET @onorrows_date = DATE ADD( @ odays_date, | NTERVAL 1 DAY);
SELECT DI STINCT ts.*

FROM

$TBL_TRANSFER _SESSI ONS ts

VWHERE

ts.started_at >= @odays_date

AND ts.started at < @onorrows_date

Note: Even the above will only give expected resultsif you arein GMT time zone, as NOW( ) will return UTC time.

The builtin report variables SREPORT_PERIOD_START and $REPORT_PERIOD_END contain datetimes
converted from local time zone of input into UTC and are usually a better choice for date filtering (unless recipient is
fine with UTC-based filtering).

Advanced Report Usage Notes: Filter Strings by Using "Begins With"

If possible, filter strings by matching “begins with” rather than “contains’ or “ends with”. If that's not possible,
consider creating a custom field. For example, the following will not be able to use the index on ts.contact:

SELECT DI STINCT ts.*
FROM
$TBL_TRANSFER SESSI ONS ts
VWHERE
ts.contact LIKE '%uro2012 Li vex%

If you know all the possible ways the string could begin, you could enumerate them like this:

SELECT DI STINCT ts.*
FROM
$TBL_TRANSFER SESSI ONS ts
VWHERE
ts.contact LIKE 'AA Euro02012 Livex%
OR ts.contact LIKE ' BB Euro02012 Livex%
OR ts.contact LIKE ' CC Euro2012 Livex%

If the report is only to be run for asmall date range and there are few transfer sessions then you may not need to
worry about this. If you expect to be running over large date ranges and large numbers of sessions, then you should
create a custom field that detects the presence of the match string and then copiesit to the custom field -- you could
then filter on the custom field instead.
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Advanced Report Usage Notes: Always Include a Date Filter

To avoid creating areport that might try to work on the entire database you should always include some kind of date
filter.

The recommended option is to use the built-in report variables SREPORT_PERIOD_START and
$REPORT_PERIOD_END tofilter data. If an advanced report contains these variables, the web Ul will include
date pickers when the user runsthe report. A standard filter to find all transfers that were active at any time during the
report period would look like the following:

SELECT DI STI NCT

ts.id

, ts.contact

, ts.bytes transferred

FROM
$TBL_TRANSFER SESSI ONS t s

VHERE
ts.started_at < ' $REPORT_PERI OD_END
AND (
ts.stopped_at >= ' $REPORT_PERI OD START
OR ts.stopped_at |I'S NULL

);

Notetheclause OR ts. st opped_at | S NULL. Without this, the report would exclude any transfers that
were still running at the time the report was run. Depending on the intended purpose of the report, you might need
to prorate data for transfers that were active for only part of the reporting period, such ascases 2, 3, and 4 in the

following:
report report
start end
! case 1 » ‘
case2 »

GEE‘;ES >

case 4 : >

As an alternative, you can avoid the use of SREPORT_PERIOD_START and $REPORT_PERIOD_END if you
are creating a report that always looks at the last X hours:

SET @rin_start = DATE_SUB(NOW ), |NTERVAL 24 HOUR);
CREATE TABLE $FI NAL_RESULT_TABLE

SELECT DI STINCT ts.*

FROM

$TBL_TRANSFER SESSI ONS ts

VWHERE

ts.started _at >= @rin_start
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Note: Asof Console 1.6 there is abug in the report engine that causes the creation of Excel/CSV filesto fail if
you do not reference $SREPORT_PERIOD_START and $REPORT_PERIOD_END at al. To work around this,
include adummy reference in the report SQL. For example:

SET @umy = ' $REPORT_PERI OD_START' ;

When running the report, users are then asked for report period dates, but they will be ignored.

Advanced Report Usage Notes: Always Name Your Computed or Aggregated Columns

Always name your computed or aggregate columns, and avoid names that might be reserved words. In particular, do

not cal afinal result column "name", "count", "id", and so on.

INCORRECT:

CREATE TABLE $FI NAL_RESULT _TABLE
SELECT

fts.contact

, COUNT(*)

, SUMfts.bytes transferred)

CORRECT:

CREATE TABLE $FI NAL_RESULT_TABLE
SELECT

fts.contact

, COUNT(*) AS session_count

, SUMfts.bytes transferred) AS total bytes transferred

Advanced Report Usage Notes: Avoid Joining Reporting Views

MySQL often mis-optimizes queries that join reporting views directly to each other. The fact that the views can show
the same record multiple times can cause a geometric explosion in the number of temporary records inspected.

EXAMPLE:

# Find all sessions that contained file "foo.txt"
# List both session info and file info
# ASSUVMES NO SESSI ONS WERE BETWEEN TWO MANAGED NODES
SET @eport_period_start = '$REPORT_PERI OD_START'
SET @eport_period_end = ' $REPORT_PERI OD_END ;
CREATE TABLE $FI NAL_RESULT_TABLE
SELECT DI STI NCT

ts.session_id

, ts.source_ip

, ts.dest _ip

, ts.started at

, ts.stopped_at

, ts.status

, tsf.file_fullpath

, tsf.size
, tsf.started at AS file_started at
, tsf.stopped_at AS file_stopped_at
, tsf.status AS file_status
FROM



| Appendix | 177

$TBL_TRANSFER SESSI ONS ts

JO N $TBL_TRANSFER SESSI ON_FI LES t sf
ONts.id = tsf.transfer_session_id

VHERE

tsf.started_at < @eport_period_end

AND (
tsf.stopped_at >= @eport_period_start
OR tsf.stopped_at IS NULL

AND tsf.file basenane = "foo.txt"
ORDER BY

ts.started at

, tsf.started at

Although the above report uses SELECT DISTINCT, contains no aggregate functions such as COUNT and SUM,
and generates a correct final result (unless any of the transfer sessions were between two managed nodes), it is
potentially slow. For greater speed (and to prevent query misoptimization from MySQL), it is better to decompose the
above query into smaller steps, and join your temporary tables to the report views instead of joining the report views
together directly.

Note: In order to avoid complexity in the SQL, the example below assumes no sessions were between two managed
nodes. Therefore, the code for dealing with this has been left out (see Advanced Report Usage Notes: Avoid
Duplicating Redundant Records on page 171).

EXAMPLE

SET @eport_period_start = '$REPORT_PERI OD_START' ;
SET @eport_period_end = ' $REPORT_PERI OD_END ;

CREATE TABLE $TMP_TRANSFER_SESSI ON | DS (
id INT NOT NULL PRI MARY KEY

)

CREATE TABLE $TMP_TRANSFER_SESSI ON_FI LE_| DS (
id INT NOT NULL PRI MARY KEY

, transfer _session_id I NT NOT NULL

);

# Create table to hold all desired fields from
# transfer_sessions

CREATE TABLE $TMP_TRANSFER SESSI ON DATA (
“id INT(11) NOT NULL AUTO_| NCREMENT PRI MARY KEY
“session_id VARCHAR(36)
“source_i p° VARCHAR( 255)
“dest _i p° VARCHAR( 255)
“started_at® DATETI ME
“stopped_at® DATETI ME
“status® VARCHAR(255)

# Create table to hold all desired fields from
# transfer_session _files
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CREATE TABLE $TMP_TRANSFER_SESSI ON_FI LE_DATA (
“id INT(11) NOT NULL AUTO | NCREMENT PRI MARY KEY
, transfer_session_id |NT(11)

, started_at”™ DATETI ME
, stopped_at™ DATETI ME
, status’ VARCHAR(255)
, file fullpath® TEXT
, Size  BIGd NT(20)

)

PRE- FI LTER BASE TABLE | DS

HHH

For this report, we know we are
filtering on file name and can use
the index on that colum, so it is
faster to find the records from
transfer_session_files first

HFHEHFEHFEHHH

| NSERT | NTO $TMP_TRANSFER_SESSI ON_FI LE | DS
SELECT DI STI NCT
tsf.id
, tsf.transfer _session_id
FROM $TBL_TRANSFER SESSI ON_FI LES t sf
VWHERE
tsf.started at < @eport_period_end
AND (
tsf.stopped_at >= @eport_period_start
OR tsf.stopped_at IS NULL

AND tsf.fil e_basename = "foo.txt"

# Create an index on the join field -

# for speed, we wait until table is

# popul ated i nstead of defining the index
# during initial creation of table

CREATE | NDEX i dx_transfer_session_id ON
$TMP_TRANSFER SESSI ON FI LE I DS (transfer_session_id);

| NSERT | NTO $TMP_TRANSFER SESSI ON_| DS
SELECT DI STINCT ts.id
FROM $TBL_TRANSFER _SESSI ONS t s
JO N $TMP_TRANSFER _SESSI ON_FI LE I DS t sf
ONts.id = tsf.transfer_session_id
VHERE
ts.started_at < @eport_period_end
AND (
ts.stopped_at >= @eport_period_start
OR ts.stopped_at |I'S NULL



#

# Renmove transfer file sessions that don't have an
# associ ated transfer_session record

# (normally not supposed to happen, but we want

# to protect against bad data that night be

# caused by system crash, |ogger errors, console

# purge errors, Canonicalizer shutdown, etc.)

# For this particular report, this is not needed

# since the final join will weed out such records,
# but it is a good habit to maintain, this report
# could be nodified later into one where

# it would make a difference.

#

DELETE tsf.*

FROM $TMP_TRANSFER _SESSI ON FI LE I DS t sf
LEFT JO N $TMP_TRANSFER SESSION IDS ts
ON tsf.transfer_session_id = id

WHERE ts.id IS NULL;

ts.

Il

H
# CGet all desired fields
"
S
# transfer_session files
B oo e e eee e

| NSERT | NTO $TMP_TRANSFER SESSI ON_FI LE_DATA (
id
, transfer_session_id
, started at’
, stopped_at’
, status’
, file_fullpath
, Size
)
SELECT DI STI NCT
tsf.id
, tsf.transfer_session_id
, tsf.started at
, tsf.stopped_at
, tsf.status
, tsf.file_fullpath
, tsf.size
FROM
$TMP_TRANSFER_SESSI ON_FI LE_I DS tsf _ids
STRAI GHT_JO N $TBL_TRANSFER SESSI ON_FI LES t sf
ON tsf _ids.id = tsf.id

CREATE | NDEX i dx_transfer _session_id ON

$TMP_TRANSFER SESSI ON_FI LE_DATA (“transfer_session_id');

# transfer_sessions
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| NSERT | NTO $TMP_TRANSFER_SESSI ON_DATA (
id
, ~session_id
, ~source_ip
, dest_ip’
, started_at"”
, stopped_at"
, Status’
)
SELECT DI STI NCT
ts.id
, ts.session_id
, ts.source_ip
, ts.dest _ip
, ts.started_at
, ts.stopped_at
, ts.status
FROM
$TMP_TRANSFER _SESSI ON_I DS ts_i ds
STRAI GHT_JO N $TBL_TRANSFER SESSI ONS t s
ONts ids.id =ts.id

Create final result table

HH* H

CREATE TABLE $FI NAL_RESULT_ TABLE
SELECT
ts.session_id
, ts.source_ip
, ts.dest _ip
, ts.started_at
, ts.stopped_at
, ts.status
, tsf.file_fullpath
, tsf.size
, tsf.started at AS file started at
, tsf.stopped_at AS file_stopped_at
, tsf.status AS file_status
FROM
$TMP_TRANSFER SESSI ON_DATA ts
JO N $TMP_TRANSFER_SESSI| ON_FI LE_DATA t sf
ON ts.id = tsf.transfer_session_id
ORDER BY
ts.started at
, tsf.started at

Example Reports

Basic Report Example: Faspex User Activity

The following example demonstrates the process of creating a new, basic report (following the instructions described
in Creating a Basic Report on page 77) for Faspex users. In our example, we will generate areport that displays
transfer activity by Faspex users only. The example report, once generated, will display total bytes transferred by
each Faspex Server user, along with file and transfer-level detail (where atransfer groups together transfer sessions
into asingleitem).
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1. Go to the Manage Report Types page.

Select Reports from the Console menu, and then click the Manage Report Types button. On the Manage Report
Types screen, click the New Basic button.

2. Configure your basic report to display file- and transfer-level details, organized by Faspex Users.
On the Create New Report Type page (for basic reports), enter the following information:

Dashboard Activity Nodes Accounts Transfer Reports Notifications

Reports

= Create New Basic Report Type

Mame
limit 75 characters

Description

= How would you like to organize this report?

select v
Field Description
Name Basic Faspex User Report
Description Basic Faspex Server User report, which includes total bytes per Faspex User, as

well asfile- and transfer-level details.

How would you liketo Select "Contact," "Transfer," and "Fil€" as the fields by which to organize this
organize this report? report. In doing so, the report will be grouped by the following fields:

» Contact (Contact assigned by Console. This can be a Console user name, a
Faspex Server user name, SSH account, or customized value obtained from
atransfer cookie. Examples: "admin (console)", "aspera (ssh)", "michael
(faspex)™.)

e Transfer (Human-readable name assigned to atransfer. A transfer represents
one or multiple executions of ascp (that is, one or multiple attempts to transfer).)

* File(Fileésname)

Columnsto include Select the following basic fields to include as columns:

e bytestransferred




| Appendix | 182

Field

Description

e averagerate

e files completed

o filesfailed

o dtarted at

e stopped at

e status

» error description

e source address

e destination address

Note: When you select afield, its definition will appear in the box below.

Select the following fields to sort data inside your groups:

+ Sort your contact groups by contact name.
e Sort your transfer groups by the time that the transfer started.
e Sort your file groups by file name.

Select ascending order for all fields.

Filters

To narrow down the report so that only Faspex Users are displayed, specify the
Transfer Contact field as ending with the value (faspex).

3. Save, finalize run settings, and run your report.
Next, click the Create and Run button. Confirm the following settings on next page:

» Titleisasdescribed above.

* Report is scheduled to Run Now.

* Report period is Month to date and time zone is Pacific.
« Sorting is as described above.

 Filter isas described above.

e XLSX fileformat is checked.

Once confirmed, click the Run Report button.

View your Web and XLSX reports.

After clicking the Run Report button, the page updates to display the report queuing and then running. Once
generated, the Web version of your basic report appears as shown below.
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Edit Report Type m Back to List

As of 2013-06-12 11:45:09 (GMT-08:00) Pacific Time (US & Canada)

06/01/2013 12:00 AM - 06/12/2013 11:45 AM (PDT)
Transfer Contact ending with (faspex)

Bytes Transferred Average Rate Files Completed Files Failed Started At
- TOTAL: 118,168,806 0,453,504 10 0
~ admin {faspex) 104,969,480 9,330,620 5 0
v test package (upload) 47,898 383,184 2 0 2013-06-12 11:19:21
o device.txt 488 3,004 1 0 2013-06-12 11:19:22
o logeat.txt 47,410 379,280 1 0 2013-06-12 11:19:22
- test 4 (upload) 104,857,600 0,320,676 1 0 2013-06-12 11:41:54
o 100MB 104,857,600 0,320,676 1 0 2013-06-12 11:41:55
» test 5 (upload) 63,082 511,856 2 0 2013-06-12 11:44:47
~ user] (faspex) 13,199,326 10,550,461 5 0
» test 2 {upload) 11,072,036 11,072,036 4 0 2013-06-12 11:40:26
- test 3 (upload) 2,126,390 8,505,560 1 0 2013-06-12 11:41:00
© Snow jpg 2,126,300 2,505,560 1 0 2013-06-12 11:41:01

2013-06-12 11:
2013-06-12 11:
2013-06-12 11:

Stopped At

19:23
19:22
19:22

2013-06-12 11:43:25

2013-06-12 11:43:25

2013-06-12 11:44:48

2013-06-12 11:40:30

2013-06-12 11:41:03

2013-06-12 11:41:03

SX

Status  Error Source Address
completed 10.0.200.82
completed 10.0.200.82
completed 10.0.200.82
completed 10.0.200.8
completed 10.0.200.8
completed 10.0.200.82
completed 10.0.200.8
completed 10.0.200.8

10.0.200.8

completed

m

View SQL

Asyou can see, the report's data is grouped and sorted in the following manner:

Faspex Users
Transfers (per Faspex User), which are sorted by the time they started
File name (per Transfer)

In addition, all data columns appear as selected on the Create Advanced Report Type page. To download the Excel

version of the report for use in other applications, click the XL SX button.

Basic Report Example: Hot Folder Activity

The following example demonstrates the process of creating a new, basic report (following the instructions described
in the topic Creating a Basic Report on page 77) for Hot Folder transfers. In our example, we will generate a
report that displays transfer activity for Hot Folders that have been set up within HST Server, Point_to_Point and

B [ C [ p] [ E [ F [ G H | I [

[Dasi-aspexlserReport1_2013-06-12_184513_UTC.xls
2 |Basic Faspex User Report
3 |Generated By: cheng
4 |Generated At: 2013/06/12 11:45:09 (GMT-08:00) Pacific Time (US & Canada)
5 |Report Period Start: 06/01/2013 12:00 AM
6 |Report Period End: 06/12/2013 11:45 AM
7 |Report Time Zone® Pacific Time (US & Canada)
8
9 |Level Row Type Heading Bytes Transferred  Average Rate Files Completed Files Failed  Started At Stopped At Status Error’
10 0 Grand Total TOTAL: 118,168,806 9,453,504 10 0
1 1 Contact admin (faspex) 104,969,480 9,330,620 5 0
12 2 Transfer test package (upload) 47,898 383,184 2 0 2013/06M12 11:19:21  2013/06/12 11:19:23 completed
13 3 [File device.txt 488 3,904 1 0 2013/06/12 11:19:22  2013/06/12 11:19:22 completed
14 3 File logcat.txt 47,410 379.280 1 0 2013/06M12 11:19:22 2013/06/12 11:19:22 completed
15 2 Transfer test 4 (upload) 104,857,600 9,320,676 1 0 2013/06/12 11:41:54  2013/06/12 11:43:25 completed
16 3 [File 100MB 104,857,600 9,320,676 1 0 2013/06/12 11:41:55  2013/06/12 11:43:25 completed
17 2 |Transfer test & (upload) 63,962 511,856 2 0 2013/06M12 11:44:47  2013/06/12 11:44:48 completed
18 3 [File China 1.PNG 31,464 251,712 1 0 2013/06/12 11:44:48  2013/06/12 11:44:48 completed
19 3 File China 2.PNG 32,518 260,144 1 0 2013/06/12 11:44:48  2013/06/12 11:44:48 completed
20 1 Contact user] (faspex) 13,199,326 = 10,559,461 5 0
il 2 Transfer test 2 (upload) 11,072,936 | 11.072,936 4 0 2013/06/12 11:40:26  2013/06/12 11:40:36 completed
22 3 File Blue Pond.jpg 3,864,665 7.729,330 1 0| 2013/06/12 11:40:26  2013/06/12 11:40:30 completed
3 3 File Bristle Grass jpg 1,889,288 | 15,114,304 1 0 2013/06/12 11:40:31  2013/06/12 11:40:31 completed
24 3 File Lake.Jpg 913,673 7,309,384 1 0 2013/06/12 11:40:32  2013/06/12 11:40:32 completed
25 3 [File Lion_jpg 4,405,310 8,810,620 1 0 2013/06/12 11:40:32  2013/06/12 11:40:36 completed
26 2 |Transfer test 3 (upload) 2,126,390 8,505,560 1 0 2013/06/12 11:41:00 2013/06/12 11:41:03 completed
= TR, el e arnr ren 4 B e e e

m
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Client. The example report, once generated, will display Hot Folder transfer start time, end time and the number of
filestransferred.

1. Go to the Manage Report Types page

Select Reports from the Console menu, and then click the Manage Report Types button. On the Manage Report
Types screen, click the New Basic button.

2. Configure your basic report to display file- and transfer-level details, organized by Faspex Users
On the Create New Report Type page (for basic reports), enter the following information:

Dashboard Activity Nodes Accounts Transfer Reports Notifications

Reports

= Create New Basic Report Type

Mame
limit 75 characters

Description

= How would you like to organize this report?

select v
Field Description
Name Basic Hot Folder Transfer Report
Description Basic Hot Folder Transfer report, which includes start time, stop time and the

number of files that were transferred.

How would you liketo Select "Transfer" as the field by which to organize this report. In doing so, the
organize this report? report will be grouped the human-readable name that has been assigned to each hot
folder transfer. A transfer represents one or multiple executions of ascp (that is.,
one or multiple attempts to transfer).

Columnsto include Select the following basic fields to include as columns:

e Started at
e stopped at
e files completed
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Field Description

» averagerate

Note: When you select afield, its definition appearsin the box below.

Sort Select the "transfer name" field (in ascending order) to sort data inside your group.

Filters In this example, we must set afilter that checks the value of the transfer cookie.
When files are transferred using Hot Folders, the transfer cookie contains the
following information:

aspera. sync2:

Thus, the filter must be set to only include transfers that have atransfer cookie
starting with the value aspera.sync2:.

3. Save, finalize run settings, and run your report.
Next, click the Create and Run button. Confirm the following settings on next page:

« Titleisas described above
* Report is scheduled to Run Now
* Report period is Month to date and time zone is Pacific
e Sorting is as described above
» Filter isas described above
Once confirmed, click the Run Report button.
4. View your Web report.

After clicking the Run Report button, the page will update to display the report queuing and then running. Once
generated, the Web version of your basic report appears as shown below.

Report: Basic Hot Folder Transfer Report

As of 2013-06-12 14:00:50 (GMT-08:00) Pacific Time (US & Canada)

06/01/2013 12:00 AM - 06/12/2013 02:00 PM (PDT)
Transfer Cookie starting with aspera.sync2:

Started At Stopped At Files Completed Awverage Rate

~ TOTAL: 13 7,697,113
o New folder 2013-00-12 13:47:15 2013-00-12 13:47:52 2 724

o Mew folder 2013-06-12 13:47:55 2013-06-12 13:47:57 10 43,844

o New folder 2013-06-12 13:58:00 2013-06-12 13:59:19 1 11,983,726

View SQL

Basic Report Example: Faspex Metadata

The following example demonstrates the process of creating a new, basic report (following the instructions described
in the topic Creating a Basic Report on page 77) for Faspex metadata. In our example, we will generate a report

that displays the metadata that is entered into a " Create New Package" form within Faspex, which is accomplished by
creating a new, custom field called "Event" within Console.



| Appendix | 186

Note: This example assumes that the "event" (metadata) field has already been set up on the Faspex node. When
creating a new Faspex package, Faspex users can select from a predefined (drop-down) list of events, which populates

the database for this custom field.

The example report, once generated, will display the purpose (or "Event") of the Faspex package, as well asfile-level
detail, transfer-level detail (where atransfer groups together transfer sessionsinto asingle item), and which Faspex

user sent the package.

1. Set up a Console database custom field for the metadata.

Within Console, select Configuration from the main menu, and then the Custom Fields tab. Create a new,
custom field with the following attributes:

* Level: Select "transfer"
* Name: Enter the name "event"
* Start Date: Enter "2011-01-01"

e Description: Sincethis custom field is for the metadata report, enter the description "Faspex Metadata report

demo"

For more information on custom fields, see Creating Custom Fields on page 82.

2. On the next page, click the Back to Custom Fields tab or the Custom Fieldstab. Locate the entry for the field
you just created ("event” in this case), and click recalculate

3. Create acustom rule for the Faspex M etadata transfer field.

e Built-in field: Faspex Met adat a

e Operator: JSON mat ch

o Expression:\{.*"Event":"(?<event>. +?)".*\)
- "faspex_event" custom field value: <event >.

In other words, if the Faspex Metadata JSON matches the expression, then set

the custom field value to the value of <event >. So, if the Faspex metadatais
{"EBvent":"Sumer"," pkg_uui d":"abde20e28db24bf db513c0a3de3bb8f f",
"pkg_name":"test"...},the"faspex_event" custom field'svalueis Sunmer .

The expression isinterpreted as follows:

Expression

I nterpretation

Charactersmatched in the
example

\{

Finds aleft curly bracket character

{

*

Followed by 0 or more characters
until the next piece of the
expression (" Event": ")

"Event":"

Followed by the first match of the
exacttext" Event " : "

"EVENT": "

(?<event>. +7?)

Followed by at least 1
character" (save these characters
and call them <event >)

Sunmer

Followed by a quotation mark

Followed by O or more characters
until the next piece of the
expression (\ {)

, " _pkg_uui d": "abde20e28db
"pkg_nanme":"test"...

24bf db513¢

V)

Followed by aright curly bracket
character

4. Go to the Manage Report Types page.
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Select Reports from the Console menu, and then click the Manage Report Types button. On the Manage Report
Types screen, click the New Basic button.

5. Configure your basic report to display contact, file-level, and transfer-level details, organized by Faspex metadata

(the "event").

On the Create New Report Type page (for basic reports), enter the following information:

Dashboard

Activity Nodes Accounts Transfer Reports MNotific ations

Reports

= Create New Basic Report Type

Mame

Description

limit 75 characters

= How would you like to organize this report?

select v
Field Description
Name Faspex meta data report
Description Based on the custom field "event." Includes metadata, contact, file-level, and

transfer-level details.

How would you liketo
organize this report?

Select "Event" (which isacustom field), "Contact,” "Transfer" and "File" asthe
fields by which to organize this report. In doing so, the report will be grouped by
the following:

« Event (Based on atransfer-level rule that states if the conditions match the
regular expression, then set the "event" custom field value to the Faspex
metadata value.)

¢ Contact (Contact assigned by Console. This can be a Console user name, a
Faspex Server user name, SSH account, or customized value obtained from
atransfer cookie. Examples: "admin (console)", "aspera (ssh)", "michael

(faspex)”.)
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Field Description

e Transfer (Human-readable name assigned to atransfer. A transfer represents
one or multiple executions of ascp (i.e., one or multiple attempts to transfer).)
* File(Fileésname)

Columnsto include Select the following basic fields to include as columns:

o dtarted at

e stopped at

e bytestransferred
e gtatus

* averagerate

e cookie

Note: When you select afield, its definition will appear in the box below.

Sort Select the following fields to sort datainside your groups:

« Sort your metadata groups by event/metadata name
» Sort your contact groups by contact name

< Sort your transfer groups by transfer name

e Sort your file groups by file name

Select ascending order for all fields.

Filters Filter the report so that only fields with metadata appear (that is, event is not
NULL) and only data from Faspex Usersis displayed (that is, transfer contact
contains the value faspex).

6. Save, finalize run settings and run your report.
Next, click the Create and Run button. Confirm the following settings on next page:

» Titleisasdescribed above.

* Report is scheduled to Run Now.

* Report period is Month to date and time zone is Pacific.
» Sorting is as described above.

 Filter isas described above.

Once confirmed, click the Run Report button.
7. View your Web report.

After clicking the Run Report button, the page will update to display the report queuing and then running. Once
generated, the Web version of your basic report will appear as shown below.



Report: Faspex meta data report

As of 2013-06-13 17:40:01 (GMT-08:00) Pacific Time (US & Canada)

06/01/2013 12:00 AM - 06/13/2013 05:39 PM (PDT)
Transfer Contact containing faspex, Event NOT NULL
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Edit Report Type Back to List

Started At Stopped At Bytes Transferred Status Average Rate Cookie

~ TOTAL: 44,397:720' ' 7,?21:343'
+ Autumn Trip 26,246,026 7,408,865
= admin (faspex) 26,246,026 7,408,865

+ video (upload) 2013-08-13 17:33:07 2013-06-13 17:33:30 26,240,026 com pleted 7,408,865 aspera_faspex20:u:f47697ae-c729-404c-beo

o Wildlife.wmv 2013-06-13 17:33:08 2013-08-13 17:33:36 26,246,026 completed 7,408,805 aspera.-faspex20:u:f47697ae-c729-404c-bco]
+ Spring Trip 2,184,528 5,825,408
- admin (faspex) 2,184,528 5,825,408

»+ photos {upload) 2013-06-13 17:34:31 2013-06-13 17:34:33 2,061,558 com pleted 8,246,232 asperafaspex20:usedc7b031-cc60-4010-b71

- test 2 {upload) 2013-06-13 17:32:13 2013-06-13 17:32:189 58,988 completed 471,904 asperafaspex20:u:b5a46448-¢103-4927-aet

© Japan 1.PNG 2013-06-1317:32:18 | 2013-06-13 17:32:10 20,029 completed 232,232 asperafaspex20:u:b5a46448-c103-4927-ael

© Japan 2.PNG 2013-06-13 17:32:1¢ | 2013-06-13 17:32:1¢ 20,959 completed 230,672 aspera faspex20iub5a46448-c103-4027-ael

v test] {upload) 2013-06-13 17:31:43 2013-06-13 17:31:45 63,982 completed 511,856 aspera.faspex20:u:8c4b05ba-cc73-404d-9¢c0
¥ Summer 163,248 1,305,984
» Winter 15,760,522 0,608,783
» Winter Trip 43,306 347,168

4 | 1 3

View SaQL

Asyou can see, the report's data is grouped and sorted in the following manner:

* Metadata

» Faspex Usersthat selected the corresponding event/metadata

* Transfers (per Faspex User), which are sorted by the time they started
e File name (per Transfer)

In addition, all data columns appear as selected on the Create Basic Report Type page.

Advanced Report Example: Transfer Sessions with High Packet Loss

The following example demonstrates the process of creating a new, advanced report (following the instructions
described in the topic Creating an Advanced Report on page 78) for transfers with high packet loss. In our

example, we will generate areport that displays alist of al transfers that have high packet loss, where high lossis
user specified. The report includes transfers that started before the report period start, as well as ones that ended after
the report period end, as long as part of the transfer fell within the reporting period. Note that the datais not prorated,
meaning that the "bytes transferred,” "files complete" and other values show totals for the entire transfer, even if part
of the transfer took place outside the reporting period.

1. Go to the Manage Report Types page.

Select Reports from the Console menu, and then click the Manage Report Types button. On the Manage Report
Types screen, click the New Advanced button.

2. Input your advanced report's name and description.

On the Create New Advanced Report Type page, enter the following information:;

Field Description

Name Transfer Sessions with High Packet loss
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Field Description

Description Displaysalist of al transfersthat have high packet loss.

3. Create your SQL script.

Important: For assistance on SQL variables and afields reference guide, please click the Help link.

CREATE TABLE $FI NAL_RESULT_TABLE

SELECT DI STINCT -- prevents duplicate rows (that is, overlapping
per nm ssi ons)
ts. nane
, ts.contact
, ts.bytes transferred
, ts.bytes | ost
, TRUNCATE((ts.bytes |ost)*100/(ts.bytes transferred + ts. bytes |ost),
1) AS "packet loss %
, ts.source_ip AS “from
, ts.dest _ip AS "to
, ts.started at
, ts.stopped_at
, ts.status
, ts.files_conplete
, ts.files failed
, ts.files_skipped

FROM
$TBL_TRANSFER _SESSI ONS t's

VWHERE
((ts.bytes lost * 100) /(ts.bytes lost + ts.bytes transferred)) >=
$PACKET _LOSS /* Customl configurable variable */
AND
ts.started_at < ' $REPORT_PERI OD_END
AND (
ts.stopped_at >= ' $REPORT_PERI OD_START'
OR ts.stopped_at IS NULL

)

ORDER BY
5 DESC
, 8

Important: For demonstration purposes, we have created a configurable/custom variable called
$PACKET_LOSS in the SQL script text above. You may, alternatively, utilize the built-in SQL database field
avg_loss pct, to display the average packet loss over the network (as a percentage). Please see the Help link in the
application for details.

4. Save, finalize run settings and run your report.
Next, click the Create and Run button. Confirm the following settings on next page:

» Titleisasdescribed above.
* Report is scheduled to Run Now.
* Report period is Last 24 hours and time zone is Pacific.
Once confirmed, click the Run Report button.
5. View your Web report.
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After clicking the Run Report button, the page will update to display the report queuing and then running. Once
generated, the Web version of your basic report will appear as shown below.

Report: Transfer Sessions with High Packet loss

As of 2013-06-12 15:10:12 (GMT-08:00) Pacific Time (US & Canada)

06/11/2013 03:10 PM - 06/12/2013 03:10 PM (PDT)
Packet Loss: 10

Name Contact Bytes Transferred Bytes Lost Packet Loss % From To Started At Stopped At Status
Windows to Linux admin (console) 104,857,600 99,175,904 45.6 10.0.203.82 |10.0.203.250 |2013/06/12 14:59:11 2013/06/12 15:03:49 | completed
Windows to Linux admin (console) 17,790,056 15,963,040 47.2 10.0.203.82 |10.0.203.250 |2013/06/12 14:57:08 |2013/06/12 14:58:11 com pleted
Windows to Linux admin (console) 33,373,320 24,377,456 42.2 10.0.203.82 |10.0.203.250 |2013/06/12 15:04:11 2013/06/12 15:08:49 | completed
New folder root {ssh) 104,857,600 18,874,545 15.2 10.0.203.82 |10.0.203.229 |2013/06/12 13:58:09 |2013/06/1213:58:19 |completed

Aspera Ecosystem Security Best Practices

Y our Aspera applications can be configured to maximize system and content security. The following sections
describe the recommended settings and practices that best protect your content when using IBM Aspera High-Speed
Transfer Server and IBM aspera High-Speed Transfer Endpoint, IBM Aspera Faspex,|BM Aspera Shares, and IBM
Aspera Console.

Contents

Securing the Systems that Run Aspera Software
Securing the Aspera Application

Securing Content in your Workflow

Securing the Systems that Run Aspera Software

The systems that run Aspera software can be secured by keeping them up to date, by applying security fixes, and by
configuring them using the recommended settings.

Updates

Aspera continually improves the built-in security of its products, as do the producers of third-party components used
by Aspera, such as Apache, Nginx, and OpenSSH. One of the first lines of defense is keeping your products up to
date to ensure that you are using versions with the latest security upgrades:

» Keep your operating system up to date.
» Keep your Aspera products up to date.

e |f using, keep OpenSSH up to date. The server security instructions require that OpenSSH 4.4 or newer (Aspera
recommends 5.2 or newer) isinstalled on your system in order to use the Mat ch directive. Mat ch allows you
to selectively override certain configuration options when specific criteria (based on user, group, hostname, or
address) are met.

e |f you are using the HSTS web Ul, keep Apache server up to date.
Security Fixes

Rarely, security vulnerabilities are detected in the operating systems and third-party components that are used by
Aspera. Aspera publishes security bulletins immediately that describe the affected products and recommended
remediation steps.

Security Configuration
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Recommended security settings vary depending on the products you are using and how they interact. See the
following subsections for your Aspera products.

HSTS

1. Configureyour SSH Server.
Aspera recommends that you:

e Open TCP/33001 and keep TCP/22 open until users are notified that they should switch to TCP/33001.
* Once users are notified, block TCP/22 and allow traffic only on TCP/33001.

The following steps open TCP/33001 and block TCP/22.
a) Open the SSH configuration file.

[ etc/ssh/sshd _config

If you do not have an existing configuration for OpenSSH, or need to update an existing one, Aspera
recommends the following reference: https://wiki.mozilla.org/Security/Guidelines'OpenSSH.

b) Change the SSH port from TCP/22 to TCP/33001.
Add TCP/33001 and comment out TCP/22 to match the following example:

#Port 22
Port 33001

HSTS admins must also update the SshPor t valueinthe <VEB. . . > section of asper a. conf.

Once this setting takes effect:

« Asperaclients must set the TCP port to 33001 when creating connections in the GUI or specify - P
33001 for command line transfers.
e Server administrators should usessh - p 33001 to access the server through SSH.
¢) Disable non-admin SSH tunneling.
SSH tunneling can be used to circumvent firewalls and access sensitive areas of your company's network.
Add the following linesto the end of sshd_conf i g (or modify them if they already exist) to disable SSH
tunneling:

Al | owTcpForwar di ng no
Mat ch G oup root
Al | owTcpForwar di ng yes

Depending on your sshd_conf i g file, you might have additional instances of Al | owTCPFor war di ng
that are set to the default Yes. Review your sshd_conf i g filefor other instances and disable if necessary.

Disabling TCP forwarding does not improve security unless users are a so denied shell access, because
with shell access they can still install their own forwarders. Aspera recommends assigning users to aspshell,
described in the following section.

d) Disable password authentication and enable public key authentication.
Public key authentication provides a stronger authentication method than passwords, and can prevent brute-
force SSH attacks if all password-based authentication methods are disabled.

Important: Before proceeding:

* Createapublic key and associate it with atransfer user, otherwise clients have no way of connecting to the
server.

» Configure at least one non-root, non-transfer user with a public key to use to manage the server. Thisis
because in the following steps, root login is disabled and transfer users are restricted to aspshell, which
does not alow interactive login. This user and public key iswhat you use to access and manage the server
as an administrator.


https://wiki.mozilla.org/Security/Guidelines/OpenSSH
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Add or uncomment PubkeyAut hent i cati on yes and comment out Passwor dAut henti cati on
yes:

PubkeyAut henti cati on yes
#Passwor dAut henti cati on yes
Passwor dAut henti cati on no

Note: If you choose to leave password authentication enabled, be sure to advise account creators to use strong
passwords and set Per mi t Enpt yPasswor ds to "no".

Per m t Enpt yPasswor ds no
€) Disableroot login.

~ CAUTION: This step disables root access. Make sure that you have at |east one user account with
£ '_1 sudo privileges before continuing, otherwise you may not have access to administer your server.
Comment out Per mi t Root Logi n yes and add Per mi t Root Logi n No:

#Per m t Root Logi n yes
Per m t Root Logi n no

f) Restart the SSH server to apply new settings. Restarting your SSH server does not affect currently connected
users.

# systenttl restart sshd. service
or for Linux systemsthat usei ni t . d:

# service sshd restart

g) Review your logs periodically for attacks.

For information on identifying attacks, see IBM Aspera|BM Aspera High-Speed Transfer Server Admin
Guide: Securing Your SSH Server.

. Configure your server's firewall to permit inbound access to only Aspera-required ports.
Asperarequires inbound access on the following ports:

« For SSH connections that are used to set up connections, TCP/33001.

* For FASP transfers, UDP/33001.

o If youuse HTTP and HTTPS fallback with HSTS, TCP/8080 and TCP/8443. If you only use HTTPS, only
open TCP/8443.

e |If your clients access the HSTS web Ul, TCP/80 (for HTTP) or TCP/443 (for HTTPS).

. For HSTS, require strong TL S connections to the web server.

TLS1.0and TLS 1.1 are vulnerable to attack. Run the following command to require that the client's SSL security
protocol be TLS version 1.2 or higher:

# [ opt/asperal bin/asconfigurator -x "set _server_data;ssl_protocol,tlsvl. 2"

. If asperanoded is exposed to internet traffic, run it behind a reverse proxy.

If your Aspera server must expose asperanoded to the internet, such as when setting it up asalBM Asperaon
Cloud (AoC) node, Aspera strongly recommends protecting it with areverse proxy. Normally, asperanoded runs
on port 9092, but nodes that are added to AoC must have asperanoded run on port 443, the standard HTTPS port
for secure browser access. Configuring areverse proxy in front of asperanoded provides additional protection
(such as against DOS attacks) and resource handling for requests to the node's 443 port.

The following instructions describe how to set up Nginx as areverse proxy and require that you have valid, CA-
signed SSL certificatesin . pemformat for the server. Other reverse proxies might be supported on your server.


https://downloads.asperasoft.com/en/documentation/4
https://downloads.asperasoft.com/en/documentation/4
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a) Set up asystem user with Node API credentials on your server.
b) Download and install Nginx.
¢) Configurethe HTTPS port for asperanoded.

# asconfigurator -x "set _server_data; https_port, 9092"

d) Open the Nginx configuration filein atext editor.

Open/ et ¢/ ngi nx/ ngi nx. conf and ensure thefollowingi ncl ude directiveispresentinthehtt p
section. If it isnot present, add it to thefile:

http {

i“hcl ude /etc/ngi nx/conf.d/*.conf;
}
e) Createafilenamed asper a_node_pr oxy. conf and saveit in the following location:
[ et ¢/ ngi nx/ conf. d/ aspera_node_proxy. conf
f) Pastethefollowing content into asper a_node_pr oxy. conf :

#
# Aspera configuration - reverse proxy for asperanoded
#
server {
listen 443;
server_name your.servername. com
ssl _certificate /opt/asperaletc/aspera_server_cert.pem
ssl _certificate_key /opt/asperaletc/aspera_server_key. pem
ssl on;
ssl _session_cache builtin: 1000 shared: SSL: 10m
ssl _protocols TLSv1. 2;
ssl _ci phers EECDH+AESGCM EDH+AESGCM AES256+EECDH: AES256+EDH;
ssl _prefer_server_ci phers on;
access_| og / var /| og/ ngi nx/ node- api . access. | og;
location / {
proxy_pass https://127.0.0. 1: 9092;
proxy_read_ti neout 60;
proxy _redirect https://2127.0.0.1:9092 https://your.servernanme. com
proxy_set header Host $host : $server _port;
proxy_set header X-Real -1P $renot e_addr;
proxy_set _header X-Forwarded- For $proxy_add_x_f orwarded_for;
proxy_set _header X-Forwarded-Proto $scheng;
}
}

Note: Configure SSL ciphers as required. The preceding sampleis not configured for backwards
compatihility, and the recommended list of secure ciphers might change. Aspera recommends reviewing and
staying current with the list provided in https://cipherli.st/.

In this configuration, Nginx listens externally on port 443, not 9092. Replace your .servername.com with your
server'sdomain name.

0) Restart asperanoded.
# systenct!| restart asperanoded
or for Linux systemsthat usei ni t . d:

# service asperanoded restart

h) Restart Nginx.

# service nginx restart


https://cipherli.st/
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5. Install AsperaFASP Proxy in a DMZ to isolate your HSTS from the I nternet.
For more information, see IBM Aspera FASP Proxy Admin Guide

Faspex and Shares
1. Configure your Faspex or Shares server firewall to allow inbound access to TCP/443, the default HTTPS port.
2. Faspex and Shares transfer nodes should be configured as described for HSTS.

The transfer user that is used by Faspex and Shares (usually xf er ) must be configured on the node to only allow
transfers with a token:

# asconfigurator -x

"set _user_dat a;user_nane, xfer;authorization_transfer_in_val ue, t oken"
# asconfigurator -x

"set _user _dat a;user _nane, xfer; aut hori zati on_transfer_out val ue, t oken”

Set the token encryption key to a string of at least 20 characters:

# asconfigurator -x
"set _user_dat a; user _nane, xf er; t oken_encrypti on_key, t oken_stri ng"

Do not use UUIDs for this key because they might not be generated using cryptographically secure methods.

Console

Configure the firewall of the computer on which Consoleisinstalled to only allow Aspera-required connections to the
following ports:

» For HTTP or HTTPS access for the web Ul, inbound TCP/80 or TCP/443.
e For SSH connections, outbound TCP/33001 to managed nodes.
» For Node API connections, outbound TCP/9092 to managed nodes.

« For connections to legacy nodes (those running HSTS older than 3.4.6), outbound TCP/40001 and inbound
TCP/4406. For security and reliability, Asepra strongly recommends upgrading all nodes to the latest version.

Securing the Aspera Applications

Y our Aspera products can be configured to limit the extent to which users can connect and interact with the servers.
Theinstructions for Shares 1.9.x and Shares 2.x are dlightly different; see the section for your version.

HSTS

1. Restrict user permissionswith aspshel | .

By default, all system users can establish a FASP connection and are only restricted by file permissions. Restrict
the user's file operations by assigning them to use aspshel | , which permits only the following operations:

* Running Aspera uploads and downloads to or from this computer.
» Establishing connections between Aspera clients and servers.
« Browsing, listing, creating, renaming, or deleting contents.

These instructions explain one way to change a user account or active directory user account so that it usesthe
aspshel | ; there may be other waysto do so on your system.

Run the following command to change the user login shell to aspshel | :
# sudo usernod -s /bin/aspshell usernane

Confirm that the user's shell updated by running the following command and looking for / bi n/ aspshel | at
the end of the output:

# grep usernane /etc/passwd


http://downloads.asperasoft.com/en/documentation/42
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Note: If you use OpenSSH, sssd, and Active Directory for authentication: To makeaspshel | the default
shell for all domain users, first set up alocal account for server administration because this change affects all
domain users. Then open/ et ¢/ sssd/ sssd. conf and changedef aul t _shel | from/ bi n/ bashto/
bi n/ aspshel I .

2. Restrict Asperatransfer usersto alimited part of the server's file system or bucket in object storage.

a) For on-premises servers, set a default docroot to an empty folder, then set a docroot for each user:

# asconfigurator -x "set _node_dat a; absol ut e, docroot"
# asconfigurator -x "set user_dat a;user_nane, user nane; absol ut e, docr oot "

Replace username with the username and docroot with the directory path to which the user should have
access.
b) For cloud-based servers, set a default restriction to an empty folder, then set arestriction for each user:

# asconfigurator -x "set_node_data;file_restriction,|storage_path"
# asconfigurator -x
"set _user_dat a;user_nane, usernane;file restriction,|storage_path"

Replace username with the username and storage_path with the path to which the user has access. Restriction
syntax is specific to the storage:

Storage Type Format Example
local storage file://1//]*

S3 and IBM Cloud Object Storage s3:/1*

Swift storage swift//*

Azure storage azu://*

Azure Files azure-files://*
Google Cloud Storage gs://*

Hadoop (HDFS) hdfs: //*

The"|" isadelimiter, and you can add additional restrictions. For example, to restrict the system user xf er
tos3://s3. anazonaws. conf bucket xyz/f ol der _a/* and not allow accessto key files, run the
following command:

# asconfigurator -x "set_user_data; user_name, xfer;file_restriction,|
s3://s3. amazonaws. conif bucket xyz/fol der_a/*|!*. key"

3. Restrict users read, write, and browse permissions.

Users are given read, write, and browse permissions to their docroot by default. Change the global default to deny
these permissions:

# asconfigurator -x
"set _node_data;read_al |l owed, fal se;wite_allowed, fal se;dir_all owed, fal se"

Run the following commands to enable permissions per user, as required:
# asconfigurator -x "set user_data;user_nane, user nane; read_al | owed, f al se"
# asconfigurator -x "set user_data;user_nane, usernanme; wite_all owed, fal se"
# asconfigurator -x "set user_data;user_nane, user nane; dir_al | oned, fal se"

4. Limit transfer permissionsto certain users.
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Set the default transfer permissions for all usersto deny:

# asconfigurator -x "set_node_dat a; aut hori zati on_transfer_in_val ue, deny"
# asconfigurator -x "set_node_dat a;aut horization_transfer_out_ val ue, deny"

Allow transfers for specific users by running the following commands for each user:

# asconfigurator -x

"set _user _dat a; user _nane, user nane; aut hori zati on_transfer_in_val ue, al | ow'
# asconfigurator -Xx

"set user _dat a;user nane, user nane; aut hori zati on_transfer_out val ue, al | ow'

Note: For auser that is used by Shares or Faspex (usually xf er ), allow transfers only with a token by setting
aut hori zation_transfer_{in|out} val uetot oken.

. Encrypt transfer authorization tokens.

When aclient requests a transfer from a server through an Aspera web application, an authorization token is
generated. Set the encryption key of the token for each user or group on the server:

# asconfigurator -x
"set _user_dat a; user _nane, user nanme; t oken_encrypti on_key, t oken_stri ng"
# asconfigurator -x
"set _group_dat a; group_nane, gr oupnane; t oken_encrypti on_key, t oken_stri ng"

The token string should be at least 20 random characters.

Note: Thisisnot used to encrypt transfer data, only the authorization token.
. Require encryption of content in transit.

Y our server can be configured to reject transfers that are not encrypted, or that are not encrypted with a strong
enough cipher. Asperarecommends setting an encryption cipher of at least AES-128. AES-192 and AES-256 are
also supported but result in slower transfers. Run the following command to require encryption:

# asconfigurator -Xx
"set _node_dat a;transfer_encryption_al |l owed_ci pher, aes- 128"

By default, your server is configured to transfer (as a client) using AES-128 encryption. If you require higher
encryption, change this value by running the following command:

# asconfigurator -x "set_client _data;transport_ci pher, val ue"

Y ou can aso specify the encryption level in the command line by using - ¢ ci pher withascp andasync
transfers. ascp4 transfers use AES-128 encryption.

. Configure SSH fingerprinting for HSTS.

For transfers initiated by aweb application (such as Faspex, Shares, or Console), the client browser sends the
transfer request to the web application server over an HTTPS connection. The web application requests a transfer
token from the target server. The transfer is executed over a UDP connection directly between the client and the
target server and is authorized by the transfer token. Prior to initiating the transfer, the client can verify the server's
authenticity to prevent server impersonation and man-in-the-middle (MITM) attacks.

To verify the authenticity of the transfer server, the web application passes the client atrusted SSH host key
fingerprint of the transfer server. The client confirms the server's authenticity by comparing the server's fingerprint
with the trusted fingerprint. In order to do this, the host key fingerprint or path must be set in the server's

asper a. conf.

Note: Server SSL certificate validation (HTTPS) isenforced if afingerprint is specified in asper a. conf
and HTTP fallback is enabled. If the transfer "falls back” to HTTP and the server has a self-signed certificate,
validation fails. The client requires a properly signed certificate.
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If you set the host key path, the fingerprint is automatically extracted from the key file and you do not extract it
manually.

Retreiving and setting the host key fingerprint:
a) Retrieve the server's SHA-1 fingerprint.

# cat /etc/ssh/ssh_host _rsa key.pub | awk '{print $2}' | base64 -d |
shalsum

b) Set the SSH host key fingerprint in asper a. conf . (Go to the next step to set the host key path instead).

# asconfigurator -x
"set _server_data; ssh_host _key fingerprint,fingerprint”

This command creates aline similar to the following example of the <ser ver > section of asper a. conf :

<ssh_host _key_fi nger pri nt >7qdOwebGGeDeN7/W +2dP3HMAN P3
</ ssh_host _key_fingerprint>

¢) Restart the node service to activate your changes.

Run the following commands to restart asper anoded:
# systentt!| restart asperanoded

or for Linux systemsthat usei ni t . d:
# service asperanoded restart

Setting the host key path: To set the SSH host key path instead of the fingerprint, from which the fingerprint will
be extracted automatically, run the following command:

# asconfigurator -x "set_server_data; ssh_host _key path, ssh_key filepath"
This command creates aline similar to the following in the <ser ver > section of asper a. conf :

<ssh_host _key pat h>/etc/ssh/ssh_host _rsa_key. pub
</ ssh_host _key_pat h>

Restart the node service to activate your changes, as described for "Retreiving and setting the host key
fingerprint".
8. Install properly signed SSL certificates.

Though your Aspera server automatically generates self-signed certificates, Asperarecommendsinstalling valid,
signed certificates. These are required for some applications.

Faspex

Many of the settings for Faspex are the same asfor HSTS, including SSH server configuration, firewall settings,
and signed SSL certificate installation. The following recommendations augment or are additional to the
recommendations described for HSTS.

1. Redtrict transfers by all users except "faspex”.

If your system is adedicated Faspex server - the HSTS installed as part of your Faspex installation is used only for
Faspex transfers - prohibit transfers by all users except "faspex". If you have not already, deny transfers globally
by default:

# asconfigurator -x "set _node_dat a; aut hori zation_transfer_in_val ue, deny"
# asconfigurator -x "set_node_dat a; aut horization_transfer_out_val ue, deny"
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Allow transfers for "faspex" by running the following commands:

# asconfigurator -x

"set _user _dat a; user _nane, f aspex; aut hori zati on_transfer _in_val ue, t oken"
# asconfigurator -x

"set _user_dat a; user_nane, f aspex; aut hori zati on_transfer_out val ue, t oken"

. Configure the Nginx server to allow only strong TLS.

The default configuration of Faspex has TLS 1.0, 1.1 and 1.2 enabled. Older browsers require the older and less
secure versions (TLS 1.0 and 1.1). Y ou can disable support for older browsers by removing TLS1.0and TLS 1.1
from the configuration.
a) Open the Nginx configuration file on the Shares server for editing:

/ opt / asper a/ conmon/ apache/ conf/ extral/ htt pd-ssl. conf
b) Locate the following line:

SSLProtocol ALL -SSLv2 -SSLv3

¢) Replace the line with the following and save your change:

SSLProt ocol TLSv1. 2
d) Restart Apache to activate your change:

# asctl apache:restart

. Limit admin logins to those from known | P addresses.

Faspex admins have the ability to execute post-processing scripts on the server. If an admin account is
compromised, this capability can be a serious threat to your server's security. You can add additional protection by
allowing admin logins from only specific |P addresses.

a) Inthe Faspex Ul, go to Accounts and select the admin account.

b) Inthe Permissions section, locate the Allowed | P addresses for login field and enter the |P addresses or |P
address range to allow.

¢) Click Saveto activate your changes.

. Configure Faspex account security settings.

Go to Server > Configuration > Security and set the following global default configurations in the Faspex

accounts section, then edit configurations for individual users, as needed:

a) Set anon-zero session timeout.

b) Lock usersout after five failed login attempts within five minutes.

¢) EnablePrevent concurrent login.

d) Set apassword expiration interval of 30 days.

€) Prevent reuse of the last three passwords and require strong passwords.

f) Set Keep user directory privateto Yes.

g) Disable Allow all usersto send to all other Faspex users.

h) Disable Userscan see global distribution lists.

i) Disablelgnoreinvalid recipients.

j) Disable Allow usersto changetheir email address.

Stay in Server > Configuration > Security for the next step.

. Configure Faspex account registration settings.

In Server > Configuration > Security, set the following configurations in the Registr ations section:

a) Set Self-registration to None.
When self-registration is enabled, it can be used to find out whether a certain account exists on the server. That
is, if you attempt to self-register a duplicate account, you receive a prompt stating that the user already exists.

b) Select Require external usersto register.
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By requiring external usersto register, you can better track their Faspex activity.
Stay in Server > Configuration > Security for the next step.
6. Configure outside email address settings.
In Server > Configuration > Security, set the following global default configurations in the Outside email
addresses section, then edit configurations for individual users, as needed:
a) Disable Allow inviting external senders.
b) EnableInvitation link expires and set an expiration policy.
¢) Disable Allow public submission URLSs.
d) Disable Allow sending to external email addresses.
€) Set apackagelink expiration.
f) Disable Allow external packagesto Faspex users.
Stay in Server > Configuration > Security for the next step.
7. Configure Faspex encryption.
In Server > Configuration > Security, set the following configurations in the Encryption section:
a) Enable Encrypt transfers.
b) If possiblein your work flow, set Use encryption-at-rest to Always.
See the next section, " Securing Content in your Workflow," for information about encryption at rest.
¢) Disable Allow dropboxesto have their own encryption settings.
8. Click Update when you have completed updating settings on the Secur ity page to activate your changes.
9. Hideyour server's | P address from email notifications.
If Faspex is configured to identify itself by IP address (rather than by domain name), then the URLs in your
notification emails contain your |P address (for example, "https://10.0.0./aspera/faspex™). Configure an aternate
IP address or domain name for users who are external to your organization.
a) Goto Server > Configuration > Web Server.
b) Select Enable alternate address then click Add alternate addr ess.
¢) Enter the address name and description, and select Show in emails.
d) Click Updateto activate your change.
€) Customize your email notification templates to use the alternate address.
Goto Server > Notifications.

Shares

The Shares server and its nodes should be secured as described for HSTS, including SSH server configuration,
firewall settings, and valid, signed SSL certificate installation. Y ou can a so secure the Shares application and its
network of nodes by restricting user permissions. Set the following settings globally, then edit the settings for specific
users and groups.

1. Configure Shares security settings.

On the Admin page, click User Security and set the following:

a) Set anon-zero session timeout.

b) Require strong passwords.

C) Set apassword expiration interval of 30 days.

d) Lock usersout after five failed login attempts within five minutes.

€) Do not alow self registration by setting Self Registration to None.
2. When setting up the email server (Admin > SMTP), select Use TL Sif available.
3. Configure the Nginx server to alow only strong TLS.

The default configuration of Shareshas TLS 1.0, 1.1 and 1.2 enabled. Older browsers require the older and less
secure versions (TLS 1.0 and 1.1). Y ou can disable support for older browsers by removing TLS1.0and TLS 1.1
from the configuration.

a) Open the Nginx configuration file on the Shares server for editing:
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[ opt / asper a/ shar es/ et ¢/ ngi nx/ ngi nx. conf
b) Delete TLSv1 and TLSv1.1 from the following line:

ssl _protocols TLSvl TLSvl.1 TLSvl. 2;

4. Configure secure transfer settings.

Go to System Settings > Transfer s and set the following:

a) Require aminimum Connect version of 3.6.1.

b) For Encryption, select AES-128.

¢) If possiblein your workflow, set Encryption at Rest to Required.

See the next section, " Securing Content in your Workflow," for information about encryption at rest.

5. Goto System Settings > Web Server and select Enable SSL/TLS.

This setting requires that the Shares server hasavalid, signed SSL certificate.
6. When adding new usersto Shares, disable API Login if users do not need to use the Shares API.

The Shares AP is used by clients connecting through IBM Aspera Drive and IBM Aspera Command-Line
Interface

7. When adding nodes to Shares, select Use SSL (required by Shares) and Verify SSL (requires that the node has a
valid, signed SSL certificate).

8. When authorizing auser or group to a share (share_name > Authorizations), set the minimum permissions
required based on their Shares use.

Shares 2.x

The Shares 2.x server and its nodes should be secured as described for HSTS, including configuring the SSH server,
firewall settings, and installing valid, signed SSL certificates. Y ou can aso secure the Share application and its
network of nodes by restricting user permissions. Set the following settings globally and then edit the settings for
specific users, groups, and administrators.
1. Configure Shares security settings.

Go to System Administration > Configuration > User Security and set the following:

a) Set anon-zero session timeout.

b) Set an accesstoken lifetime of 8 hours.

¢) Enablerefreshing of expired access tokens, with alifetime of 7 days.

Go to System Administration > Configuration > Local User Security and set the following:

a) Require strong passwords.

b) Set apassword expiration interval of 30 days.

¢) Lock usersout after five failed login attempts within five minutes.

d) Prevent reuse of the last three passwords and require strong passwords.

2. When setting up the email server (System Administration > Configuration > SMTP), select Use TLSif
available.

3. Configure secure transfer settings.
Go to System Administration > Configuration > Transfers and set the following:

a) Require aminimum Connect version of 3.6.1.
b) For Encryption, select AES-128 (or higher, if needed).
¢) If possibleinyour workflow, set Encryption at Rest to Yes.

See the next section, " Securing Content in your Workflow," for information about encryption at rest.
4. Goto System Administration > Configuration > Web Server and select Enable SSL/TLS.
This setting requires that the Shares server has avalid, signed SSL certificate.
5. Configure the Nginx server to allow only strong TLS.
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The default configuration of Shareshas TLS 1.0, 1.1 and 1.2 enabled. Older browsers require the older and less
secure versions (TLS 1.0 and 1.1). Y ou can disable support for older browsers by removing TLS1.0and TLS 1.1
from the configuration.

a) Open the Nginx configuration file on the Shares server for editing:

[ opt / asper a/ shar es/ et ¢/ ngi nx/ ngi nx. conf
b) Delete TLSv1 and TLSv1.1 from the following line:

ssl _protocols TLSvl TLSvl.1 TLSvl. 2;

6. When adding nodes to Shares, select Use SSL (required by Shares) and Verify SSL (requires that the node has a
valid, signed SSL certificate).

7. When authorizing a user or group to a share, set the minimum permissions required based on their Shares use.

Console

Console nodes should be secured as described for HSTS, including SSH server configuration, firewall settings, and
valid, signed SSL certificate installation. If possible for your workflow, limit Console and its nodes to your internal
network.

Y ou can also secure the Console application and its network of nodes by restricting user permissions:

1. Configure secure Console defaults.
Go to Configuration > Defaults and set the following:
a) Inthe drop-down menu for Default SSH encryption, select adefault SSH encryption algorithm of at least
AES-128 for non-Console nodes.
b) For Transport Encryption, select AES-128.
¢) Disable Smart Transfer Sharing.
d) Set anon-zero session timeout.
€) Lock usersout after five failed login attempts within five minutes.
f) Enable Prevent concurrent login.
g) Enable Suppresslogging of transfer tokensto prevent tokens from being written to the Consol e database.
h) Set apassword expiration interval of 30 days.
i) Prevent reuse of the last three passwords and require strong passwords.
2. When setting up the email server (Notifications > Email Server), select Use TL Sif available.
3. Restrict Console users permissions.
a) When creating a new user (Accounts > Users > New User), disable user login until their permissions are set
by clearing Active (allow user tolog in). Click permissions and enable only the permissions that the user

reguires. Once permissions are configured, allow the user to login by going to Accounts > Users, clicking the
user, and selecting Active (allow user tologin).

b) Assign usersto Console Groups with only the required transfer paths and permissions allowed.

Create agroup (Accounts > Groups > New Group) and restrict the group's transfers by clicking Add
Transfer Path. Assign specific endpointsto the group's transfer path, rather than Any, which grants
permission to transfer to all nodes. Limit the direction of the path, if the group's workflow allows.

4. When adding managed and unmanaged nodes, set the SSH port to 33001 and ensure SSH connections are
encrypted with AES-128 or higher.

5. When adding a managed cluster, select Use HTTPS to connect to node and Require signed SSL certificate.
6. When adding SSH endpoints, use SSH public key authentication rather than password authentication.
The key file on the node should not be a shared key; it should be a"private" key in the specified user account.

Securing Content in your Workflow
1. If your workflow alows, enable server-side encryption-at-rest (EAR).
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When files are uploaded from an Aspera client to the Aspera server, server-side encryption-at-rest (EAR) saves
files on disk in an encrypted state. When downloaded from the server, server-side EAR first decrypts files
automatically, and then the transferred files are written to the client's disk in an unencrypted state. Server-side
EAR provides the following advantages:

» It protectsfiles against attackers who might gain access to server-side storage. Thisisimportant primarily
when using NAS storage or cloud storage, where the storage can be accessed directly (and not just through the
computer running HSTS).

» Itisespecialy suited for cases where the server is used as atemporary location, such as when one client
uploads afile and another client downloadsiit.

« Server-side EAR can be used together with client-side EAR. When used together, content is doubly encrypted.

» Server-side EAR doesn't create an "envelope” as client-side EAR does. The transferred file stays the same
size asthe original file. The server stores the metadata necessary for server-side EAR separately in afile of
the same name with the file extension . asper a- net a. By contrast, client-side EAR creates a envelopefile
containing both the encrypted contents of the file and the encryption metadata, and it also changes the name of
thefile by adding the file extension . asper a- env.)

* It workswith both regular transfers (FASP) and HTTP fallback transfers.

Limitations and Other Consider ations

* Server-side EAR isnot designed for cases where files need to move in an encrypted state between multiple
computers. For that purpose, client-side EAR is more suitable: files are encrypted when they first leave the
client, then stay encrypted as they move between other computers, and are decrypted when they reach the
final destination and the passphrase is available. See Step 4 of this section for more information on client-side
encryption.

« Do not mix server-side EAR and non-EAR files in transfers, which can happen if server-side EAR is enabled
after the server isin use or if multiple users have access to the same area of the file system but have different
EAR configurations. Doing so can cause problems for clients by overwriting files when downloading or
uploading and corrupting metadata.

e Server-side EAR does not work with multi-session transfers (using ascp - Cor node APl mul ti _sessi on
set to greater than 1) or Watch Folders (versions prior to 3.8.0 that do not support URI docroots).

To enable server-side EAR:

a) Set users docrootsin URI format (local docroots are prepended withfile: ///).
# asconfigurator -x "set_user_data; user_nane, user nane; absol ute, file:///path"

b) Set the server-side EAR password.
Set adifferent EAR password for each user:

# asconfigurator -x
"set_user_dat a; user _nane, user nane; t ransf er _encrypti on_content _protection_secret, passphrase"

Important: If the EAR password islost or asper a. conf iscompromised, you cannot access the data on
the server.

¢) Require content protection and strong passwords.

These settings cause server-side EAR to fail if apassword is not given or if apassword is not strong enough.
For example, the following asconf i gur at or command adds both these options for all users (global):

# asconfigurator -x "set_node_data;transfer_encryption_content_protection_required,true”
# asconfigurator -x "set_node_data;transfer_encryption_content_protection_strong_pass_required,true"

. Never use "shared" user accounts.

Configure each user astheir own Asperatransfer user. Sharing Asperatransfer user account credentials with
multiple users limits user accountability (you cannot determine which of the users sharing the account performed
an action).

. Use passphrase-protected private keys.
Thessh- keygen tool can protect an existing key or create anew key that is passphrase protected.
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If you cannot use private key authentication and use password authentication, use strong passwords and change
them periodicaly.

. If your workflow allows, require client-side encryption-at-rest (EAR).

Asperaclients can set their transfers to encrypt content in transit and on the server, and the server can be
configured to require client-side EAR. Y ou can combine client-side and server-side EAR, in which casefiles are
doubly encrypted on the server. Client-side encryption-at-rest is not supported for ascp4 or async transfers.

Client configuration

The client specifies a password and the files are uploaded to the server with a. asper a- env extension. Anyone
downloading these . asper a- env files must have the password to decrypt them. Users can enable client-side
EAR inthe GUI or ontheascp command line.

GUI: Go to Connections > connection_name > Security. Select Encrypt uploaded files with a password and
set the password. Select Decrypt passwor d-protected files downloaded and enter the password.

Ascp command line: Set the encryption and decryption password as the environment variable
ASPERA SCP_FI LEPASS. For uploads (- - node=send), use--fi | e- crypt =encr ypt . For downloads
(--node=recv),use--fil e-crypt=decrypt.

Note: When atransfer to HSTSfallsback to HTTP or HTTPS, client-side EAR is no longer supported. If HTTP
fallback occurs while uploading, then the files are NOT encrypted. If HTTP fallback occurs while downloading,
then the files remain encrypted.

Server configuration

To configure the server to require client-side EAR and to require strong content protection passwords, run the
following commands:

# asconfigurator -x "set_node_data;transfer_encryption_content_protection_required,true"
# asconfigurator -x "set_node_data;transfer_encryption_content_protection_strong_pass_required,true"

Note: These commands set the global configuration. Depending on your work flow, you might want to reguire
client-side EAR and strong passwords for only specific users.

. For particularly sensitive content, do not store unecrypted content on any computer with network access.
HSTS, HSTE, and Desktop Client include the aspr ot ect and asunpr ot ect command-line toolsthat can be

used to encrypt and decrypt files. Use an external drive to physically move encrypted files between a network-
connected computer and an unconnected computer on which the files can be unencrypted.

e Toencrypt afile before moving it to a computer with network access, run the following commands to set the
encryption password and encrypt the file:

# export ASPERA SCP_FI LEPASS=passwor d
# [ opt/asperal/ bin/asprotect -o fil enane. aspera-env fil enane

* Todownload client-side-encrypted files without decrypting them immediately, run the transfer without
decryption enabled (clear Decrypt passwor d-protected files downloaded in the GUI or do not specify - -
file-crypt=decrypt ontheascp command line).

* Todecrypt encrypted files, run the following commands to set the encryption password and decrypt the file:

# export ASPERA SCP_FI LEPASS=passwor d
# |/ opt/asperal/ bin/asprotect -o filenane fil enane. asper a-env
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Setting Up Console High-Availability Environment

Introduction

IBM Aspera Console is a web-based management application that provides complete visibility over Aspera high-
speed transfer environments, enables real-time, centralized control over transfers, nodes and users, and maintains
comprehensive logging for customized reports and auditing.

With Console administrators can initiate, manage, and monitor all Aspera transfers between transfer servers and
managed transfer clients across a wide area network (WAN), including real-time notification, logging and reporting
capabilities, while maintaining a centralized transfer history database for detailed auditing and historical reporting.

Console can be deployed in a high availability environment. This document presents the Aspera Console HA Active/
Passive solution that leverages the Aspera Cluster Manager (ACM).

Intended Audience of This Document
This document requires that:

* You have background as a network engineer.

* You are knowledgeable about HA environments.

* You are familiar with the requirements of your use case.

e You are familiar with the Shares and High Speed Transfer Server products.

* You have expertise and experience configuring third-party systems, such as shared storage and load balancers.

How to Use This Document

This document isintended to be used as a basic guideline to inform and facilitate the customer's ability to craft a
HA solution to match the requirements of the customer's particular use case. Each use case differsin requirements,
including:

» Approved technology and software vendors

e Hardware sizing requirements

e Security requirements

» Type of shared storage

« Estimated traffic load and required bandwidth

e Budget to cover costs

Procedures for setting up third-party systems such as shared storage and load balancers are outside the scope of this
document.

Note: Due to the complexity of any high-availability setup due to differing requirements for each customer, Aspera
recommends customer engage with IBM professional servicesto do an HA install or upgrade of IBM Aspera
products. This document primarily serves as a reference detailing basic considerations and requirements to operate
IBM Sharesin an HA configuration. Y ou can engage professional services by contacting your sales representative.

Covered Use Case

The use case described in this guide isadual, Shares instance cluster, where the traffic is balanced between two
active nodes, providing a high-availability service with seamless automatic fail-over in the event that one node fails or
becomes unavailable.

It is possible to have more than two nodesin an HA environment, but that configuration is outside the scope of this
document.

It isalso possible to separate the web application from the transfer server portion in order to run these services on
different hosts. Y ou can find instructions on separating these processes in the IBM Aspera Shares Admin Guide, but
neither this document nor those instructions cover that procedure for HA environments.
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Note: ThisHA solution supports Linux platforms only.

Architecture for High Availability Systems

Overview of HA Architecture

Consol€'s active/passive architecture requires aload balancer that monitors the health of each node and directs the
traffic to the currently active system. One system is active and the second system is passive. The passive system
becomes active if the active system goes down; when the faulty node recovers, it comes back online in a passive state,
but isavailable for failover if the active system fails.

Console HA vs. Multiple Independent Consoles

As of Console 3.0, Console polls transfer serversto collect data. Each of the multiple Console systems collects and
stores the exact same data, but are linked by a shared MySQL database that allows you allows you to configure the
HA environment once to manage Asperatransfer serversinstead instead of needing to configure each Console system
separately. The currently active Console system collects and stores data in the shared database, making the same
configuration data available to the other Console systemsif the active system fails. The consolidated configuration
also removes the issue of scheduling the same transfers and reports for each Console system for redundancy, which
would result in multiple occurrences of those transfers or reports.

Console HA is an act i ve/ passi ve solution

In atypical Console HA setup, the load balancer is provisioned with avirtual 1P address (VIP) for user access and
then manages al the traffic related to the Console service. A fully qualified domain name (FQDN) #commonly
consol e. nydonai n. con¥is used to access the Console service and points to the VIP configured on the load
balancer. The load balancer’s VIP routes the inbound request to the I P address of the currently active backend
Console system.

Console A Console B
(Active Node) y —~ (Passive Node)

Shared
Storage

¥ Load Balancer

I
HTTPS
|

Neb

Browser

Since Console ACM isanact i ve/ passi ve solution, only the active server can respond to the inbound
connection. If the active server fails, there may be afew minutes delay until the failover process finalizes and the
backup server can respond. Usually this brief lag timeis not critical for the Aspera Console applicationand does not
affect the overall management of the Aspera environment.
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Note: Theimplemented load balancer implemented should also be highly available, otherwise the load balancer
becomes a single point of failurein the HA environment.

Console Services Stack

Asanact i ve/ passi ve solution, only one Console system is active and running all Console services. None of the
Console services are running on the passive system, but the Aspera Cluster Manager starts the services on apassive
system if the active system is no longer functioning. The ACM software running on both the active and passive
systems monitor files on the shared storage to determine whether they should or should not be running the Console
services.

The diagram below shows the Console services running on the active and passive systems.

C?lmlll]ﬁ Shared Storage ml :

ACM (cron) — ' ;n.::M- ' — ACM (cron)

Apache Files
MySQaL \ |
Console MySQL
Files
Background Services

A cron job executes ACM every minute on both the active and passive systems. Based on status files stored on the
shared storage, ACM determines whether it should do nothing if the active system is currently healthy, or should start
the Console services on the passive system if the active system has failed.

There are three primary services associated with the Console application: Apache, MySQL, and Console. The ACM
software is responsible for selecting the active system and starting these services if necessary. When ACM starts these
services, they in turn, start several additional processes that are required by Console.

The following processes are associated with the Console running on the active system

e aspera_httpd

e aspera_nysqld

e aspera_consol e

e aspera_db_space_wat cher

e AsperaBackground: Dat abasel ngest

e AsperaBackground: Sessi onDat aCol | ect or
e AsperaBackground: Nodel nf oCol | ect or
e AsperaBackground: Fi | eDat aCol | ect or
e AsperaBackground: Dat aCanoni cal i zer
e AsperaBackground: CustonFi el s

e AsperaBackground: Dat abaseUtility

e AsperaBackground: Transferlnitiator
e AsperaBackground: Ensi |

e AsperaBackground: Report
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IBM Aspera Cluster Manager (ACM) for IBM Aspera Console

ACM isthe software module responsible for starting the right services on a node according to that node’ s current
status (active or passive). It is also in charge of monitoring the active node to determine when to fail-over the
acti ve/ passi ve servicesfrom the active to the passive (when the active node becomes unresponsive).

Note: ACM mustrunasr oot .

How does it work?
ACM isinstalled on both nodes; it is launched simultaneously on both nodes—every minute—by the cr ond daemon.

Both instances of ACM first determine the status of the node on which they are running by checking a common status
file stored on the shared space dedicated to ACM. In order to avoid arace condition while accessing that common
status file, a specific locking mechanism (asl| ockf i | e) isused to synchronize both instances.

Once the status of anode is determined, the ACM instance running on the active node verifies that all of the services
arerunning, and it starts any service that is not running. Once this is done, the instance updates the status file in order
to keep its last modification date current.

The ACM instance running on the passive node checks that the status file is current, meaning that its last
modification date is not older than 2 minutes). If thefileis current, ACM checksthat theact i ve/ passi ve
services are up and running; it then starts al the services that are not running currently but should be running. If the
common status file is no longer current, then it is afail-over scenario, and ACM takes over as the new active node by
starting all of the services.

How long does a fail-over process take?

If the passive node fails, then ACM does nothing. It is up to the load balancer to detect that the passive node is
unresponsive and redirect the traffic accordingly. In the scenario covered by this documentation, the process typically
takes one minute or less.

If the active node fails, then ACM eventually detects that the statusfile is no longer current and it triggers afail-over.
Additionally, the load balancer detects that the active node is down and it redirects al traffic to the healthy node. This
process typically takes up to 5 minutes.

Related information

Expected L oad Balancer Behavior on page 208
A load balancer monitors the health of each Shares nodes and redirects the traffic accordingly, balancing the load
between all healthy nodes.

Expected Load Balancer Behavior
A load balancer monitors the health of each Shares nodes and redirects the traffic accordingly, balancing the load
between all healthy nodes.

This topic describes how the load balancer should function when handling HTTPS traffic and FASP transfers.

Note: Thistopic does not describe how to set up and configure aload balancer. For instructions on configuring a
load balancer, refer to the documentation of your load balancer.

HTTPS Traffic

The load balancer must monitor the health of the HTTPS service running on each node. To do this, it can either use
amethod based on an HTTPS request, or simply check whether TCP port 443 is responding, that is, whether aSYN
ACK packet is received after a SY N packet is sent by the monitoring service. If an RST packet is received instead, or
if no packet is received at all, then the monitoring feature must consider the monitored service to be down and discard
the related node (take it offline).

The load balancer can redirect any HTTPS request to any of the healthy nodes. Because the Shares web application
uses a database shared by both nodes, any healthy node can respond to any request.
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FASP Transfers

Once the FASP transfer isinitiated by a successful SSH connection (typically using TCP/33001 on the server side),
the FASP protocol uses UDP packets for data transfer (typically using a port range of 33001-33100).

When aclient establishes a SSH connection, the load balancer has to choose which node will handle this connection.
Once it has done so, and the SSH connection is established with one node, the load balancer must make sure that the
following istrue:

* The TCP connection related to the SSH session stays with the chosen node.

* Any subsequent UDP traffic coming from the same client is directed to the same node. This behavior is generally
known as a sticky/per sistent session, depending on the source |P address of the client.

In other words, if an SSH connection is established between a client with a particular |P address and node A, then all
subsequent UDP packets sent from that | P address must be redirected to node A.

If anode is declared unavailable by the load balancer (by checking the HTTPS service or the SSH service), the load
balancer needs to redirect all the traffic to the remaining healthy node.

The different types of traffic (SSH/TCP/33001 and FASP/UDP/33001-33100) may need to be joined together in a
pool of services on the load balancer side. The exact settings vary depending on the load balancer model.

HTTP Redirection

The Shares application uses HTTPS by default, and it sets an automatic redirection from HTTP/TCP/80 to HTTPS/
TCP/443 to force users to use a secure connection.

The load balancer can forward HT TP requests to the nodes, which then handle the redirection. Alternatively, the load
balancer itself can handle the redirection; this prevents any insecure connections from being established with a node.

Installation

System Requirements
Use the requirements below to assess whether your resources and third-party systems meet the requirements to deploy
ahigh availability environment.

Hardware Normal HA operations require two servers. Virtual machines can be used as
long as enough resources are allocated to them.

Operating Systems ACM only supports Linux platforms.
* RedHat6& 7
 CentOS6& 7

Note: Red Hat high-availability packages (such asri cci , | uci
r gmanager , and cnman) are not used, and therefore must not be installed or
activated in the environment.

The system clocks of all hostsin the HA environment must always be
kept in sync in order for ACM to operate correctly. IBM Asperatypicaly
recommends using the nt pd daemon, but any time-synchronization
mechanism should work fine.

Software IBM Aspera Console version 3.0.2 and higher.
IBM AsperaHigh Speed Transfer Server 3.8.0 and higher.
IBM Aspera Cluster Manager: ACM Package

Shared Storage Shared storage is used for:
* MySQL datafiles



https://download.asperasoft.com/download/sw-private/console/3.0.5/F8AAECDF-64A7-4DE9-A90A-0A0DA6FAA117/IBM-Aspera-Console-3.0.5-Linux64-ACM4-20181219.tar.gz
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* ACM files

Important: The shared storage must be 100% reliable and accessible 100%
of thetime for ACM to secure highly available Shares operation and to
prevent Shares data corruption.

IBM Aspera recommends dedicating storage for ACM whenever possible, in
order not to create I/O bottlenecks when large packages are being transferred
to shared storage at very high speeds.

ACM has been tested successfully on these shared file systems:

 NFS(nf s version 4 isrequired for MySQL data)
¢ Quantum StorNext (cvf s)

¢ Omneon MediaGrid (onf s)

e Oracle Cluster File system 2 (ocf s2)

Load Balancer/VIP A load balancer that implements a VIP (Virtual 1P) is required.

For more information about what is expected from the load balancer, see
Expected Load Balancer Behavior on page 208.

Single point of failure

Aspera strongly encourages customers to consider SPOF (single point(s) of failure) in the environment and to
recoghize the risks of SPOF. Often, these are situations where all nodes are plugged into the same power strip or
surge. It could also be that the shared storage or the load balancer are not HA.

Installing and Configuring the HA Environment
Install two standalone IBM Aspera Console servers and join them together into an HA environment.

Note: All commands are run asroot. (The examplesin this section are for a CentOS 6.5 system.)

Before You Start

1. Review the System Requirements on page 209.
2. Check your network settings and names.
Confirm that your network settings are correctly configured and that each host has a unique hostname properly

configured within the name resolution mechanism you use (DNS, hosts file, and so on). Each host must be able to
resolve its own name, as well as the name of the other node.

Run the following command on both nodes. The resulting system output should make sense in your environment.

# host nane
conl. mydonai n. com

Securing Your System
Perform the following steps for both nodes.

1. Disablelocal firewadls.

No traffic filter should be put in place between the two nodes. If your nodes are located behind a corporate
firewall (and thus appropriately protected), you should disable the Linux firewall components. Usechkconfi g
to prevent the firewall from becoming active when the system is rebooted.

# service iptables stop

i ptables: Flushing firewall rules: [ &K ]

i ptabl es: Setting chains to policy ACCEPT: filter [ XK ]
i ptabl es: Unl oadi ng nodul es: [ K ]

# service ip6tables stop

i p6t abl es: Flushing firewall rules: [ X ]
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i pétabl es: Setting chains to policy ACCEPT: filter [ &K ]
i p6t abl es: Unl oadi ng nmodules: [ OK ]

# chkconfig i ptabl es off

# chkconfi g i p6tabl es off

2. Disable SELinux.

SELinux must be disabled or set to per mi ssi ve inthe/ et ¢/ sel i nux/ confi g file on each High Speed
Transfer Server and each Shares server system. Y ou can confirm the SELinux current status by running the
sest at us command.

# sestatus
SELi nux status: disabl ed

3. Configure SSH security on each High Speed Transfer Server.

See the Securing your SSH Server section in the IBM Aspera Shares Admin Guide for additional information and
guidance.

Make sure that public/private key authentication has been enabled on each server. Look for the following linein
the/ et ¢/ ssh/ sshd_confi g file and verify that it is uncommented.
PubkeyAut henti cati on yes

If you have modified thesshd_conf i g file, you need to restart the sshd service:

# service sshd restart

4. Configure the node according to Adding Nodes to Console on page 21.
Installing and Configuring Console
1. Create user accounts and groups on each Console server.

Thenysql user accounts and groups must be created manually on both systems before installing any Aspera
packages to have consistent UID and GID across the HA environment.

Note: Itiscritical to ensure that the UID and GID for themysql user account are consistent across all Shares
servers.

Y ou can use the following commands on each node to create the required users and groups:

# groupadd -g 777 nysql && useradd -c¢ "Console MySQ." -d /hone/nysql -g
mysgl -m-s /bin/false -u 778 nysql

The UID and GID do not have to be 777 and 778, and you can use any value available. Just make sure you use the
same values on both systems.

2. Mount remote file systems on each Console server.
Console serversin HA environments must be configured with shared storage. There are 2 shared directories that
need to be available to each Shares server.

The following are example mount points. Y ours may be different.

Example Mount Usage Owner User Permissions | Notes

Point

/ mysqgl _data Used to store the nobody. r oot rwWx------
MySQL datafiles

facmfiles Used to store the nobody. nobody [rwx------ If using NFS, use the
common ACM files noac flag
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a) Configurethe/ et c/ f st ab file to automatically mount the directories when the system reboots.

10. 0. 75. 10: / export/ nysqgl _data /mysql _data nfs4
rw, sync, hard, intr,noac 0 O

10. 0. 75. 10: / export/acmfiles lacmfiles nf s4
rw, sync, hard,intr,noac 0 0

The aboveentriesinthe/ et ¢/ f st ab fileindicate that the shared directories (/ export/ nysql _dat a,

[ export/shares,and/ export/acm fil es) areshared from the NFS server with an IP address of

10. 0. 75. 10. These shared directories will be mounted to their corresponding local directories on each
Console server (/ mysql and/ acm fil es). The“nfs4” entry indicates the type of filesystem which is being
shared, and the remaining option entries define typical parameters used when mounting file systemsfor usein
Console HA environment.

Note: NFSversion 4 isrequired for the Console HA environment. If your version of Linux does not support
NF$4, upgrade your server to support NFS version 4.

Once you have configured the/ et ¢/ f st ab file, make sure the mount points have been created on both Shares
servers, and confirm each directory's ownership and permissions.

3. Install a standalone Console server on each system.
Follow the stepsin Installing Console on page 9 install your software and set up your license.
4, Usethesamesecret.ynl fileon each node.

Select one node to be the source system and copy itssecr et . ymi file (locatedin/ opt / asper a/ consol e/
conf i g) into the same directory on the other node, preserving the same owner and permissions.

Note: Remember which system you used as the source system for thesecr et . ym file. You will need to use
the same source system for additional configuration later in this procedure.

Share Resources Between Systems
1. Set MySQL passwords to be same on both systems.

Because the two Console systems are accessing the same MySQL database on the shared MySQL directory, itis
necessary to ensure that the passwords defined for MySQL accessinthedat abase. ynl file (/ opt / asper a/
consol e/ confi g/ dat abase. ynl ) are the same on both systems.

Openthedat abase. ynl file on the source system (the one you used as the source for thesecr et . ynl file)
and locate the passwor d fieldsin the pr oduct i on and pr oduct i on_r eport s sections. Confirm that the
valuesin thepasswor d fields of thedat abase. ynl files on both Console systems are identical.

2. Stop and disable Console services.

ACM takes charge of starting the Console services. Y ou must disable those services from the system boot-up
process.

First, stop all Console services on both nodes. If your node is running RHEL / CentOS 7 or later, run:
# systenct| disable consol e_asctl.service

Otherwise, run:
# asctl all:stop

Then disable the services by running these commands on both nodes:

# chkconfi g aspera nysqgld off; chkconfig aspera httpd of f; chkconfig
aspera_db_space_wat cher off; chkconfi g aspera_consol e of f

3. Movethe MySQL datafilesinto the shared volume.
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a) Backup the MySQL data, create a symlink to the mount point, and change the owner and group.

# cd /opt/asperal/ conmon/ nysql
# mv ./data ./data.orig

#1n -s /mysqgl _data ./data

# chown -h nysqgl.nmysqgl ./data

b) Check the permissions.

# |s -lah /opt/asperal/ conmon/ nysql

total 128K

drwxr-xr-x 11 nysql nysqgl 4.0K Jun 12 15:25 .
drwxr-xr-x 7 root root 4.0K Jan 28 13:58 ..

drwxr-x--- 2 nysql nysql 4.0K Jan 18 16: 13 bin

I rwxrwxrwx 1 mysgl nysql 4 Jun 12 15: 25 data -> /nysql _data
drwxr-x--- 5 nysqgl nysql 4.0K Jan 18 16: 26 data.orig
STWr----- 1 nysqgl nysql 14K Nov 28 2012 database_controller.rb
STWr----- 1 nysqgl nysql 14K Nov 28 2012 database.rb
STW---- - 1 nysql nysqgl 756 Jun 12 15: 26 database.rb. yn
drwxr-x--- 3 nysql nysql 4.0K Jan 18 16: 13 i ncl ude
drwxr-xr-x 3 nysql nysql 4.0K Jan 18 16:13 |ib

drwxr-x--- 2 nysqgl nysql 4.0K Jan 18 16:13 |i bexec
STWr----- 1 nysqgl nysql 1.3K Nov 28 2012 |inux_database.rb
-rwr--r-- 1 nysgl nysql 9.2K Jan 18 16: 14 nmy. cnf
-rwr--r-- 1 nysql nysql 9.2K Jan 18 16: 14 ny.i ni

STWr----- 1 nysql nysgl 9.1K Nov 28 2012 ny_tenpl ate.ini
drwxr-x--- 2 nysql nysql 4.0K Jan 18 16: 13 shin

drwxr-x--- 3 nmysqgl nysql 4.0K Jan 18 16:13 share

drwxr-x--- 3 nmysqgl nysql 4.0K Jan 18 16:13 var

SPWr----- 1 nysqgl nysqgl 13 Nov 28 2012 version.txt

¢) Onthefirst node, move the database file into the shared volume:

# sudo nv -u /opt/asperal/ common/ nysql /data.orig/* /opt/asperal common/
mysql / dat a/

d) On the other node, verify that you can see the datafilesin the directory / opt / asper a/ cormon/ mysql /
dat a/ .

Install ACM

1. Download ACM here: ACM Package
2. Extract it to the dedicated shared volume by running the following command:

# cd acm fil es_nount _poi nt
# tar xzvf /path/to/acm package.tar. gz

Note: You only need to perform this task from one node as the acm files_mount_point directory is shared by
both Shares servers.
Install and Configure ACM

Y ou only need to perform the following tasks from one node as the acm_files_mount_point directory is shared by
both Shares servers.

1. Create the following symbolic links on both nodes:

# 1n —s /acmfil es/acmiconsol e /opt/asperal/acm

2. You may need to edit theacmdconsol e file(/ opt / asper a/ acni bi n/ acndconsol e) to set correct
values to these variables:

MYSQLPWE" mysql _passwor d”


https://download.asperasoft.com/download/sw-private/console/3.0.5/F8AAECDF-64A7-4DE9-A90A-0A0DA6FAA117/IBM-Aspera-Console-3.0.5-Linux64-ACM4-20181219.tar.gz
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SYSLOG_FACI LI TY=I ocal 2
LOG TO_FI LE=O
LOG_TO_SYSLOG=1
CHECK_DEVI CE_I D=1

Note: The CHECK DEVI CE_| Dvariable definesif ACM should verify the Device ID of the storage volume
where ACM s located. Because that Device ID can change upon reboot with NFS volumes, you may want to set
thisvariable to 0 in order to disable the verification, which could prevent ACM and Shares from running correctly.

3. Install ACM inthecr ont ab on both nodes so that the system launches ACM every minute.
a) Disable ACM globally:

# [ opt/ aspera/ acm bi n/acnctl -D
b) Addthecr ont ab entry.

# crontab -e
* * % *x x [opt/asperal/acni bi n/acnmiconsol e | ocal i p_address devi ce_nunber
> [dev/null 2>&1

Two parameters are passed to the acmcommand. The first parameter isthe local |P address of the host. Y ou
can use the following command to find out the list of IP addresses available on a system:

# ip addr | grep "inet"

The second parameter is the device number of the partition where the ACM files are stored. Y ou can determine
the correct value by using this command:

# stat -c "%" /acmfiles/acm
For example:

# crontab -e
* * % * x [opt/asperalacni bi n/facndconsol e 10.0.0.0 21 /dev/null 2>&1

Onceinstalled in the crontab, ACM starts running, elects an active node, and starts the services on the different
nodes accordingly depending on their current status: active or passive.

4. Create ajob to backup Console database with theacntt | command.

Aspera recommends regularly backing up the database. In the example cr onj ob below, ACM performs a backup
every day at 1:30 AM. Choose the interval depending on your reguirements.

# crontab -e
* * * *x x [opt/asperal/acni bi n/facnmdconsol e 10.0.71.21 20 > /dev/null 2>&1
30 3 * * * [opt/asperal/acnibin/acnctl -b > /dev/null 2>&1

5. Createajobtoresetasct| logs.

Each time the system launches ACM, ACM writestotheasct | logs. Sincetheasct | logs do not get rotated,
the logs can start to cause performance issues if the files grow too large. In the example cr onj ob below, the
systemresetstheasct | logsevery 7 days at 3:45 AM. Choose the interval depending on your requirements.

# crontab -e

* * % * * [opt/asperal/acni bi n/facndconsol e 10.0.71.21 20 > /dev/null 2>&1
30 3 * * * [opt/asperal/acnibin/acnt|l -b > /dev/null 2>&1

45 3 * * 7 echo -n "" > /opt/asperal/ common/asctl /| og/asctl.log > /dev/null
2>&1

6. Run the acmctl command with the - s option on both nodes in order to verify some basic ACM prerequisites:

# [ opt/asperal/ acm bin/acnctl -s
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ACM sanity check

Checking if an entry for ACM seens to exist in the crontab (0
Checking that all the Shares services are disabled in chkconfig (04
Checking that SE Linux node is not set to enforcing (01

Checking that asctl uses the correct |load file procedure

(04

7. |f the verification looks good, start ACM on all the nodes at once, using theacntt| command with the—E
option:

# [ opt/asperal/acni bi n/acnctl -E
ACM i s enabl ed gl obally

Within afew minutes, ACM selects an active node, starts al the Console services, then monitor the status of the
active node.

If the services are running properly and the load balancer is correctly configured, you should now be able to connect
to the Console web application using the URL pointing to the VIP.

Upgrading the Environment

Upgrading the HA Environment

To upgrade an IBM Aspera Console HA deployment, you must upgrade each Console node individually and then
reconfigure them to run in an HA environment.

Stopping All Services for Upgrade

Y ou need to stop Console and MySQL services before performing the upgrade.

1. Stop the cronjob on both the nodes by commenting out the job.

# crontab -e

# * * * * * [opt/asperal acn bi n/ acmdconsol e 10.0.71.21 20 > /dev/null 2>&1
# 30 3 * * * [opt/aspera/acnm bin/acnt|l -b > /dev/null 2>&1

# 45 3 * * 7 echo -n "" > [opt/asperal/ conmon/asctl /| og/asctl.log > /dev/
nul | 2>&1

2. On the active node, back up the database:

# asctl consol e: backup_dat abase

3. Stop all Console services on the active node.
# asctl all:stop

Upgrading Console
Note: Perform the following steps on both nodes.

1. Download and install the newer Common Components and Console packages.

# rpm-Uvh i bm asper a- cormon-versi on. rpm
# rpm - Uvh i bm asper a- consol e-versi on. rpm

2. Run the Console upgrade.

# asctl consol e: upgrade

3. Veifythesecrets.ynml (/opt/asperal/ consol e/ confi g/ secrets. ym ) hasnot changed and isthe
same on both Console systems.
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4. Verify that the passwordsin dat abase. ym (/ opt/ asper a/ consol e/ confi g/ dat abase. ym ) have
not changed and are the same on both Console systems.

5. Disable stop al Console services by running the commands below on both nodes:

ACM takes charge of starting the Console services. Y ou must disable those services from the system boot-up
process.

First, stop all Console services on both nodes. If your node is running RHEL / CentOS 7 or later, run:
# systentt!l disable consol e _asctl.service

Otherwise, run:
# asctl all:stop

Then disable the services by running these commands on both nodes:

# chkconfi g aspera_consol e of f; chkconfig aspera_nysqld off; chkconfig
aspera_httpd of f; chkconfig aspera_db_space_wat cher off

Restarting the HA Environment
After upgrading,
1. Confirm that both systems are ready for ACM by running the following command on both systems:

# acnttl —s

2. Once you have completed al the steps above on both nodes, restart the cr onj obs on both the nodes by
uncommenting the jobs.

# crontab -e

* * % * * [opt/asperal/acni bi n/facndconsol e 10.0.71.21 20 > /dev/null 2>&1
30 3 * * * [opt/asperal/acn bin/acnt|l -b > /dev/null 2>&1

45 3 * * 7 echo -n "" > /opt/asperal/ common/asctl /| og/asctl.log > /dev/null
2>&1

3. Start acndconsol e globally (from either system)
# [ opt/asperal/acni bi n/acnctl -E

After 3-5 minutes, one system becomes active and the other system passive.

Maintenance of the HA Environment

The ACM Control Command (acnttl)
Youcanuseacnct | to diagnose and configure ACM.

Overview of the ACM Control Command (acnttl)

Theacntt| command controls the ACM. Running it with the—h (Help) option displays the available command
options:

# [opt/asperal/acni bi n/facnct!l -h

Aspera O uster Manager Control Command
Version: 0.5

Usage: acnctl {option}

Li st of options:

-i: Display the current state of ACM
-s: Performa sanity check of ACM

-D: Disable ACM gl obal ly



-E: Enabl e ACM gl obal | y
-d: Disable ACM Il ocally
-e: Enable ACM I ocally
- b:
-A

Back up the MySQL dat abase (active node only)
Di spl ay information about the version

Check that ACM works correctly

You can usethe#i option to display the current status of ACM on anode output shown from theact i ve node:

Aspera O uster Manager status

Local host nane: con2

Acti ve node: con2 (ne)
Status of this node: active
Status file: current
Di sabl ed gl obal | y: no

D sabl ed on this node: no

Dat abase configuration file

Dat abase host:

Consol e active/passive services status

Apache: runni ng

My SQL: runni ng

Consol e: runni ng

Asper aBackgr ound: : SshTunnel Manager
Asper aBackground: : Control | er

Asper aBackgr ound: : Mongr el Manager
Asper aBackgr ound: : Dat abasel ngest
Asper aBackgr ound: : Sessi onDat aCol | ect or
Asper aBackgr ound: : Nodel nf oCol | ect or
Asper aBackground: : Fi | eDat aCol | ect or
Asper aBackgr ound: : Dat aCanoni cal i zer
Asper aBackgr ound: : Cust onFi el d

Asper aBackground: : Dat abaseUtility
Asper aBackground: : Transferlnitiator
Asper aBackgr ound: : Enai

Asper aBackground: : Report

Thefollowing is an example of theacntt |

10. 0. 115. 102

Aspera C uster Manager status

Local host nane: conl
Acti ve node: con2
Status of this node: passi ve
Status fil e: current
Di sabl ed gl obal | y: no

Di sabl ed on this node: no

Dat abase configuration file

Dat abase host:

Consol e active/passi ve services status

10. 0. 115. 102

runni
runni
runni
runni
runni
r unni
runni
runni
runni
runni
runni
r unni
runni

—i output on the passi ve node:
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Apache: st opped
My SQL: st opped
Consol e: st opped

Data Provided by acntt!| -i
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Onboththeact i ve and passi ve systems, the output of theacntt| -i command provides useful information

about the status of the Shares servers:

Output Element

Definition

Hostname

The name of the local system.

Active node

The name and | P address of the node that is currently the
active node.

Status [of] file

Whether the/ opt / asper a/ acni run/
acmiconsol e. st at us fileis current or has expired.
A status of expi r ed usualy indicates afail-over
situation. The status file may not be available for a short
period during fail-over, and the St at us fi | e may
reportasUnabl e to find.

Disabled globally Answers the question: Is ACM disabled for all Shares
servers?

Disabled on this node Answers the question: Is ACM disabled on this node?

Database host The system that is currently managing the MySQL

database files.

Consoleact i ve/ passi ve service status

The active Console should show Apache, MySQL,
and Console services running, aswell as all Console
background processes. If run on the passive system, all
services should be shown as “ stopped”.

ACM Log Files
Use ACM logs to troubleshoot for errors.

Overview
ACM can write to two locations:
« Sysl og (loca?2)

 Thecommon acmiconsol e. | og file(/ opt / asper a/ acm | og/ acmiconsol e. | 0g)

By default, only Sysl og is enabled.

The following is an example of atypical log cycle when two instances of ACM are running (one on each IBM Aspera

Console system):

2016-03-02 14:19:01 (-0700) acn¥consol e

(0. 5)

2016-03-02 14:19: 01 (-0700) acn¥consol e

acquired

2016-03-02 14:19: 01 (-0700) acn#consol e
if this node is active or passive
2016-03-02 14:19:01 (-0700) acn¥consol e

file found

2016-03-02 14:19: 01 (-0700) acn¥consol e

con6. | ocal dormai n (27080): ACM START
con6. | ocal domai n (27080): Lock
con6. | ocal domai n (27080): Checking
con6. | ocal domai n (27080): Status

con6. | ocal donmai n (27080): From

status file: active host is conl.|ocal donmai n
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2016-03-02 14:19:01 (-0700) acmiconsol e con6. | ocal donai n (27080): This node
i s passive

2016-03-02 14:19: 01 (-0700) acn¥consol e con6. | ocal domai n (27080): Passive
processi ng BEG N

2016-03-02 14:19:01 (-0700) acmiconsol e con6. | ocal domai n (27080): Passive
processi ng END

2016- 03-02 14:19:01 (-0700) acn¥consol e conl. | ocal domain (14739): ACM START
(0.5)

2016-03-02 14:19: 01 (-0700) acn¥consol e conl. | ocal domain (14739): Skipping
Devi ce | D check

2016-03-02 14:19:01 (-0700) acmiconsol e conl. | ocal domain (14739): Lock
acquired

2016- 03-02 14:19:01 (-0700) acn¥consol e conl. | ocal domain (14739): Checking
if this node is active or passive

2016-03-02 14:19: 01 (-0700) acn¥consol e conl. | ocal domain (14739): Status
file found

2016-03-02 14:19:01 (-0700) acnmidconsol e conl. | ocal domain (14739): From
status file: active host is conl.local domain

2016- 03-02 14:19:01 (-0700) acn¥consol e conl. | ocal domain (14739): This node
is active

2016-03-02 14:19: 01 (-0700) acn¥consol e conl. | ocal domain (14739): Updating
file /opt/asperal acmiconsol e/ confi g/ dat abase. yn

2016-03-02 14:19:01 (-0700) acmiconsol e conl. | ocal domain (14739): Active
processi ng BEG N

Logging to a File

Y ou can configure ACM to also write logs to a specific file by editing the acmfile (/ opt / asper a/ acnt bi n/
acm) and setting LOG_TO _FI LE=1. ACM writeslogsto/ opt / asper a/ acni | og/ acmdconsol e. | og.

Note: IBM Asperarecommends logging to afile only for debugging purposes. Theacnmdconsol e. | og file does
not get rotated and can start to cause performance issues if the file grows too large.

Backing Up the Shares Database
Use the ACM Control Command (acntt | ) to regularly make backups of the Shares HA database.

Note: Aspera strongly recommends performing a backup of the Shares database on regular basis. If the database is
corrupted for any reason, restoring it from a healthy backup is the most (if not only) reliable solution.

Aspera a so recommends that backup files be stored on dedicated media, (for example, tape or removable disk) stored
at a secure location.

In order to back up the Shares database on aregular basis, you should use the - b optionto theacnct| command (/
opt / asperal/ acm bi n/ acntt | ). Thiscommand performs a backup of the Shares database whenever it runs on
the current active node (the node that runs the MySQL service).

Note: A backup is performed only if executed ontheact i ve node; running the command on apassi ve node
does not create a backup.

# [ opt/asperal/ acm bi n/acnctl -b

Starting backup

Shares: Backup dat abases... Database backed up in /opt/asperal/consol e/
backup/ 2014- 06- 24_052222

done

Conmpressing SQ files

done

Looking for ol d backups to renove

Found O files(s) nodified for the last tine nore than 15 day(s) ago
Backup procedure conpl ete
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When a backup is complete, the utility removes al backup files that are older than the default of 7 days. To modify
this default value, edit the/ opt / asper a/ acni bi n/ acntt| fileand set the BACKUP_MAX_AGE | N_DAYS=
variable to the desired number of days.

By default, backup files are created in a dedicated folder located on local storage: / opt / asper a/ consol e/
backup. You can change the default storage location by modifying the BACKUP_DI Rvariablein the/ opt /
asper a/ acni bi n/ acntt | fileor by replacing the default backup directory with a symbolic link pointing to
shared storage.

On both nodes, the command should be launched every day at a specific time from thecr ont ab:

# crontab -e
* * % * x [opt/asperal/acni bin/acm 10.0.71.21 20 > /dev/null 2>&1
30 2 * * 1-5 /opt/asperal/ acm bin/acnctl —-b > /dev/null 2>&1

The example shown above runs a backup of the Shares database at 2:30 AM every weekday of every month.
Note: Seethecr ont ab man pages for details about the cr ont ab file format.

Suspending ACM

Disabling and Re-enabling ACM on all Nodes
Use the ACM Control Command (acntt | ) to disable and re-enable ACM on all nodes.

1. Runtheacntt!| command with the—D option on any of the nodes to disable ACM on al nodes:

# [ opt/aspera/acm bin/acnctl -D
ACM i s di sabl ed gl obal |y

2. Verify the status of ACM.

a) Runtheacntt!| —i command to verify the status of ACM (the following example does not show the entire
output).
The following example was run on the active system. Notice that while ACM is disabled globally, the actual
services and background processes continue running. When you disable ACM, only new instances launched by
the cron daemon are disabled. Any running instance launched before ACM was disabled runs normally until it
has compl eted.

# [ opt/asperal/ acm bi n/acnct!| —i
Checki ng current ACM st at us.
Aspera C uster Manager status

Local host nane: conl

Acti ve node: conl (ne)

Status of this node: active

Status file: expi redDi sabl ed gl obal | y: yes

Di sabl ed on this node: no
Dat abase configuration file

Dat abase host: 10.0. 143.2

Consol e active/ passive services status

Apache: runni ng
My SQL: runni ng
Consol e: runni ng
Asper aBackgr ound: : SshTunnel Manager runni ng
Asper aBackground: : Control | er runni ng
Asper aBackgr ound: : Mongr el Manager runni ng

Asper aBackgr ound: : Dat abasel ngest runni ng
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Asper aBackgr ound: : Sessi onDat aCol | ect or runni ng

Asper aBackgr ound: : Nodel nf oCol | ect or runni ng
Asper aBackground: : Fi | eDat aCol | ect or runni ng
Asper aBackgr ound: : Dat aCanoni cal i zer runni ng
Asper aBackgr ound: : Cust onFi el d runni ng
Asper aBackground: : Dat abaseUtility runni ng
Asper aBackground: : Transferlnitiator runni ng
Asper aBackgr ound: : Enai | runni ng
Asper aBackground: : Report runni ng

b) Check thelogsat/ opt/ asperal/ acm | og/ acndconsol e. | og.

# tail /opt/asperal/acn | og/acndconsol e. | og

2016- 02-28 15:57:01 (-0700) conl.l ocal domain (13979): ACMis disabled
gl obal I y: aborting

2016- 02-28 15:57:01 (-0700) conl.l ocal domain (19366): ACMis disabled
gl obal | y: aborting

2016-02-28 15:57: 01 (-0700) conl.| ocal domain (26912): ACMis disabled
gl obal | y: aborting

3. Runtheacntt| command with the - E option to re-enable ACM operation on all nodes:

# [ opt/asperal/ acnl bi n/acnttl -E
ACM i s enabl ed gl obally

One of the Faspex servers becomestheact i ve node, with all associated services started, and the other will be
passi ve, with only thengi nx and cr ond services running.

Disabling and Re-enabling ACM on One Node
Use the ACM Control Command (acnctt | ) to disable and re-enable ACM on asingle node.

If you disable ACM locally on the active node, another node running ACM eventually takes over, possibly generating
conflicting access to some common files on the shared storage. Y ou should always use this option with extreme
caution, and stop all the Faspex services (asct | al | : st op) on the active node immediately after you disabled
ACM localy.

1. Todisable ACM for one node only, runacnct | with the - d option on that node;

# [ opt/ aspera/ acm bi n/acnctl -d
ACM i s disabled |ocally

2. Toverify ACM’s status for adisabled node, runtheacnctt| —i command on that node:

# [ opt/asperal/ acm bin/acnct!l -i
Checki ng current ACM status...

Aspera O uster Manager status

Local host nane: conl

Acti ve node: conl (ne)
Status of this node: active
Status file: current
Di sabl ed gl obal | y: no

Di sabl ed on this node: yes

3. Tore-enable ACM onanode, runtheacntt | command with the - e option on the node:

# [ opt/asperal/acnl bi n/acnctl -e
ACMis enabled locally
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Manually Failing-Over to the Passive Node
Toforceapassi ve nodeto assumetheact i ve role, disable ACM on the active node and stop all Faspex services
on that node.

1. Determine the active node with theacntt | command.

# [ opt/asperal/ acm bin/acnctl -i
Checki ng current ACM status...

Aspera C uster Manager status

Local host nane: con2
Acti ve node: con2 (ne)
Status of this node: active

2. Disable ACM locally.

# [ opt/asperal/acm bin/acnct!l -d
ACMis disabled |ocally

3. Check to confirm that no ACM instances are running.

# ps aux | grep acm
root 1248 0.0 0.0 103252 824 pts/0 S+ 17:18 0: 00 grep acn¥consol e

4. Stop the IBM Aspera Console services.

# asctl all:stop

| BM Aspera Consol e: Stop... done
MySQL: Stop... done

Apache: Stop... done

5. Runtheacntt! -i command to verify that all Faspex services have been stopped.

# [ opt/asperal/ acm bin/acnctl -i
Checki ng current ACM status...

Consol e active/ passive services status

Apache: st opped
My SQL: st opped
Consol e: st opped

6. Check the ACM logsto observe the other node taking over (this can take several minutes):

2016- 05-02 11:35:01 (-0700) acn¥consol e con6. | ocal dormai n (24425): ACM
START (0. 5)

2016-05-02 11:35:01 (-0700) acn¥consol e con6. | ocal donmai n (24425): Ski ppi ng
Devi ce | D check

2016-05-02 11:35:01 (-0700) acn¥dconsol e con6.| ocal domai n (24425): Lock
acquired

2016- 05-02 11:35:01 (-0700) acn¥consol e con6. | ocal domai n (24425): Checki ng
if this node is active or passive

2016-05-02 11:35:01 (-0700) acn¥consol e con6. | ocal domai n (24425): Status
file found

2016-05-02 11:35:01 (-0700) acn¥dconsol e con6.| ocal domai n (24425): active
host is conl.| ocal domain

2016- 05-02 11:35:01 (-0700) acnfconsol e con6. | ocal domai n (24425): This
node i s passive



2016-05-02 11:35:01 (-0700) acn#éconsol e con6
if the status file is current

2016-05-02 11:35:01 (-0700) acn¥consol e con6
file acmiconsole is too old (diff: 171)
2016-05-02 11:35:01 (-0700) acnmiconsol e con6
scenari o

2016-05-02 11:35:01 (-0700) acn¥consol e
MySQL on this node (if running)

2016-05-02 11:35:01 (-0700) acn¥consol e
if MyYSQL is still active on the active

2016-05-02 11:35:01 (-0700) acndconsol e
TC port 4406 on host 10.0.143.2

2016-05-02 11:35:01 (-0700) acn¥consol e

con6
con6
node
conb6

con6

. | ocal donmai
. 1 ocal donai
. | ocal donai
. | ocal donmai
. 1 ocal donai
. | ocal donai

.| ocal donai

n

n

Connection to 10.0.143.2 on port TCP/ 4406 failed, M/SQ

down
2016- 05- 02 11: 35:
the active node
2016- 05-02 11: 35:
RESET
2016- 05- 02 11: 35:
status file
2016- 05- 02 11: 35:
file deleted
2016-05-02 11:35:01 (-0700) acn#consol e
St oppi ng | BM Aspera Consol e servi ces
2016-05-02 11:35:01 (-0700) acn¥consol e con6
file /opt/asperalacni confi g/ dat abase. yn
2016-05-02 11:35:01 (-0700) acn¥consol e con6
processi ng BEG N
2016-05-02 11:35:01 (-0700) acn#dconsol e con6
processi ng END
2016-05-02 11:35:01 (-0700) acn¥consol e con6
status file

01 (-0700) acmiconsol e con6

01 (-0700) acmiconsol e con6

01 (-0700) acmiconsol e con6

01 (-0700) acmiconsol e con6

conb6

7. Check that the active node is no longer active.

# [ opt/asperal/ acm bin/acnct!l -i
Checki ng current ACM status..

Aspera C uster Manager status

Local host nane: conl

Acti ve node: conl (ne)
Status of this node: active
Status file: current
Di sabl ed gl obal | y: no

Di sabl ed on this node: yes

And check that the other node is now the active one:

# [ opt/asperal/ acm bin/acnct!l -i
Checki ng current ACM status..

Aspera O uster Manager status

Local host nane: conl

Acti ve node: conl (ne)
Status of this node: active
Status file: current
Di sabl ed gl obal | y: no

Di sabl ed on this node: no

. 1 ocal donai
. | ocal donai
. | ocal donmai
. 1 ocal donai
. | ocal donai
. | ocal donmai
. 1 ocal donai
. | ocal donai

.| ocal donai

n

n
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(24425): Checking
(24425): Status
(24425): Fail over
(24425): Stopping
(24425): Checking
(24425): Testing
(24425) :

is likely to be
(24425): Beconing
(24425): ACM
(24425): Deleting
(24425): Status
(24425):

(24425): Updating
(24425): Active
(24425): Active
(24425): Updating
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Dat abase host: 10. 0. 143. 6

| BM Aspera Consol e active/ passive services status

Apache: running

My SQL: runni ng
| BM Aspera Consol e: running

8. Re-enable ACM on the node that recently became passiveto let it start theact i ve/ act i ve Faspex services.

# [opt/asperal/acm bin/acnctl -e
ACMis enabled locally

Appendix

Shutting Down Shares HA
Completely shut down the Faspex HA environment.

1. Disable ACM globally.

# [ opt/aspera/acm bin/acnctl -D
ACM is disabled globally

2. Check to confirm that no ACM instances are running on either node. Run the following ps aux command on
both nodes:

# ps aux | grep acm
root 1248 0.0 0.0 103252 824 pts/0 S+ 17:18 0:00 grep acm

3. Stop the Faspex services on both nodes with theasct | command:
# asctl all:stop

Once you have applied that procedure, it is then safe to reboot both nodes or shut them down for maintenance. After a
reboot, re-enable ACM globally to start the Faspex services correctly:

# [ opt/aspera/acm bin/acnctl -E
ACM is enabl ed gl obally

List of System Commands Used by IBM Aspera Cluster Manager (ACM)
ACM uses many Linux system commands to perform its functions.

The following system commands must be available on any Linux system running ACM:

bash
dat e

sl eep
usl eep
sed

find
grep
host nanme
t ee

t ouch
readl i nk
cront ab
expr

st at
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| et

| ogger

nc

ip

gzip
chkconfi g
whi ch
sest at us

Technical Support

Support Websites
For an overview of IBM Aspera Support services, visit https://www.ibm.com/products/aspera/support.

To view product announcements, webinars, and knowledgebase articles, as well as access the Aspera Support
Community Forum, sign into the IBM Aspera Support site at https://www.ibm.com/mysupport/ using your IBMid
(not your company Aspera credentials), or set up a new account.

Technical Support

Y ou may contact Aspera support using the IBM Aspera Support Guide: https://www.ibm.com/support/home/pages/
support-guide/?product=3712142
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